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Guia do usuário

Obrigado por adquirir o material do curso LabVIEW Básico I. Você
pode começar a desenvolver uma aplicação logo depois que concluir os
exercícios deste manual. Este manual de treinamento e o software que
o acompanha são utilizados no curso prático de três dias do LabVIEW
Básico I. Você pode utilizar a aquisição deste material para obter um
desconto na inscrição no curso correspondente, se fizer a inscrição
dentro de 90 dias a partir da data de aquisição do material. Visite a seção
Customer Education no site ni.com para obter informações on-line sobre
programações de cursos, roteiros, centros de treinamento e inscrições
nos cursos.

A. Sobre este manual
Este manual de treinamento ensina você como utilizar o LabVIEW para
desenvolver aplicações de teste e medição, aquisição de dados, controle
de instrumento, registro de dados, análise de medição e geração de relatório.
Este manual assume que você está familiarizado com Windows, Macintosh
ou UNIX e que tem experiência em escrever algoritmos na forma de
fluxogramas ou diagramas de blocos.

O manual de treinamento é dividido em lições, cada uma abordando um
tópico ou um conjunto de tópicos. Cada lição consiste em:

• Uma introdução que descreve a finalidade da lição e o que você irá
aprender

• Uma descrição dos tópicos da lição

• Um conjunto de exercícios para reforçar os tópicos

• Um conjunto de exercícios adicionais para concluir o treinamento,
se houver tempo disponível

• Um resumo que destaca conceitos importantes e habilidades estudadas
na lição
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Vários exercícios contidos neste manual utilizam um dos seguintes produtos
da National Instruments:

• Um dispositivo de aquisição de dados multifunção (DAQ—Data
Acquisition) plug-in, conectado a um DAQ Signal Accessory, que
contém um sensor de temperatura, um gerador de função e LEDs

• Uma interface GPIB conectada ao NI Instrument Simulator

Mesmo que você não tenha estes hardwares, ainda assim poderá completar
a maioria dos exercícios. Utilize as versões demo dos VIs ao trabalhar nos
exercícios. Os exercícios que requerem o uso de hardware são indicados
com um ícone, como mostrado à esquerda. Você também pode estar
utilizando outros hardwares, em vez daqueles mencionados anteriormente.
Por exemplo, pode utilizar um instrumento GPIB no lugar do NI Instrument
Simulator ou um outro dispositivo DAQ da National Instruments conectado
à uma fonte de sinais, como um gerador de função.

Cada exercício exibe a imagem de um painel frontal e de um diagrama
de bloco concluído após a execução do VI, conforme a ilustração a seguir.
Após cada imagem de diagrama de bloco, há uma descrição de cada objeto
do diagrama.

1 Painel frontal 2 Diagrama de bloco 3 *Comentários* (não insira estes valores)

1

3

2
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B. O que você precisa para começar
Antes de utilizar este manual de treinamento, verifique se você possui todos
os seguintes itens:

❑ (Windows) Windows 95 ou superior instalado em seu computador;
(Macintosh) Power Macintosh com MacOS 7.6.1 ou superior em
execução; (UNIX) estação de trabalho Sun com Solaris 2.5 ou superior e
sistema de software XWindows em execução, uma estação de trabalho
HP 9000, modelo série 700, com HP-UX 10.20 ou superior em execução
ou um PC com Linux kernel 2.0x ou superior em execução para
arquitetura Intel x86

❑ (Windows) Dispositivo DAQ multifunção, configurado como
Board ID 1, que utiliza Measurement & Automation Explorer;
(Macintosh) Dispositivo DAQ multifunção instalado no slot 1

❑ DAQ Signal Accessory, fios e cabos

❑ (Windows e UNIX) Interface GPIB; (Macintosh) Interface GPIB no slot 2

❑ NI Instrument Simulator e fonte de alimentação

❑ LabVIEW Full ou Professional Development System 6.0 ou superior

❑ Um cabo serial

❑ Um cabo GPIB

❑ (Opcional) Um editor de texto, como (Windows) Bloco de Notas,
WordPad, (Macintosh) TeachText, (UNIX) Text Editor, vi ou vuepad

❑ Discos do curso LabVIEW Básico I que contêm os seguintes arquivos.

Nome do arquivo Descrição

Disco 1

LV Basics I Diretório para salvar os VIs criados durante o curso
e para fazer determinados exercícios do curso

basics1.llb Biblioteca de VIs que contém todos os subVIs
utilizados durante o curso

nidevsim.zip Arquivo Zip que contém o driver de instrumentos
do LabVIEW para o NI Instrument Simulator

Disco 2

bas1soln.exe Arquivo executável de descompactação que contém
as soluções dos exercícios do curso
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Nota Os exercícios de classe que utilizam o VI Thermometer irão utilizar o VI (Demo)
Thermometer nas soluções. O VI (Demo) Thermometer pode ser encontrado no arquivo  
basics1.llb.

C. Instalando o software do curso
Complete os passos a seguir para instalar o software do curso LabVIEW
Básico I.

Windows
1. Copie o arquivo basics1.llb do disco 1 para o diretório labview\

user.lib. Depois de iniciar o LabVIEW, o conteúdo deste diretório
encontra-se na paleta Functions»User Libraries.

2. Extraia o conteúdo de nidevsim.zip para o diretório labview\
instr.lib. Depois de iniciar o LabVIEW, o driver de instrumento
NI DevSim está localizado na paleta Functions»Instrument I/O»
Instrument Drivers.

3. Copie o diretório LV Basics I para o diretório c:\exercises.

4. (Opcional) Clique duas vezes no arquivo bas1soln.exe para instalar
as soluções de todos os exercícios no diretório c:\solutions\
LV Basics I.

Macintosh
1. Copie o arquivo basics1.llb do disco 1 do curso para a pasta

user.lib no diretório labview. Depois de iniciar o LabVIEW,
o conteúdo deste diretório encontra-se na paleta Functions»User
Libraries.

2. Em um computador com Windows, descompacte o conteúdo do
arquivo nidevsim.zip. Copie o diretório resultante no diretório
labview:instrlib. Depois de iniciar o LabVIEW, o driver de
instrumento NI DevSim está localizado na paleta Functions»
Instrument I/O»Instrument Drivers.

3. Copie o diretório LV Basics I para a pasta exercises.

4. (Opcional) Em um computador com Windows, extraia o conteúdo do
arquivo bas1soln.exe e copie-o para seu disco rígido, em uma pasta
apropriada para instalar as soluções de todos os exercícios.
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UNIX
1. Efetue logon como um superusuário.

2. Verifique se os discos do curso não estão protegidos contra gravação.

3. Instale o disco 1 do curso e copie o arquivo basics1.llb para o
diretório /labview/user.lib. Depois de iniciar o LabVIEW,
o conteúdo deste diretório encontra-se na paleta Functions»User
Libraries.

4. Em um computador com Windows, descompacte o conteúdo do
arquivo nidevsim.zip. Copie o diretório resultante para o diretório
/labview/instrlib. Depois de iniciar o LabVIEW, o driver de
instrumento NI DevSim está localizado na paleta Functions»
Instrument I/O»Instrument Drivers.

5. Copie o diretório LV Basics I para o diretório /exercises.

6. (Opcional) Em um computador com Windows, extraia o conteúdo
do arquivo bas1soln.exe e copie-o para seu disco rígido, em um
diretório apropriado para instalar as soluções de todos os exercícios.

7. Após copiar arquivos, utilize o comando chown para alterar o
proprietário de cada arquivo, desde o usuário raiz até o usuário atual.

D. Objetivos do curso
Este curso prepara você para:

• Utilizar o LabVIEW para criar aplicações.

• Utilizar diversas técnicas de depuração.

• Compreender painéis frontais, diagramas de bloco, ícones e painéis de
conectores.

• Utilizar VIs e subVIs.

• Criar e salvar VIs, de forma a ser utilizados como subVIs.

• Criar aplicações que utilizam porta serial e instrumentos GPIB.

• Criar aplicações que utilizam dispositivos DAQ plug-in.

Este curso não descreve nenhum dos seguintes itens:

• Teoria de programação

• O aprendizado de todos os VIs, funções ou objetos

• O funcionamento do barramento GPIB

• O funcionamento da porta serial

• Teoria de conversão analógico/digital (A/D—Analog-to-Digital)

• Desenvolvimento de um driver de instrumento

• Desenvolvimento de uma aplicação específica à aplicação
de um participante



Guia do usuário

Manual de treinamento do LabVIEW Básico I xii ni.com

E. Guia do curso
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Criando um subVI

Loops e diagramas
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Strings e I/O (entrada/saída)
de arquivo

Aquisição de dados e
formas de onda

Controle de instrumento

Personalizando VIs
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F. Convenções do curso
As seguintes convenções são utilizadas neste manual de treinamento:

» O símbolo » guia para menu e opções de caixa de diálogo até uma ação final.
A seqüência File»Page Setup»Options orienta-o a selecionar o menu File,
selecionar o item Page Setup e selecionar Options na última caixa de
diálogo.

Este ícone denota uma dica, que o alerta sobre informações consultivas.

Este ícone indica uma nota, que o alerta sobre informações importantes.

Este ícone indica um aviso, que o alerta sobre precauções que devem ser
tomadas para evitar acidentes pessoais, perda de dados ou pane do sistema.

Este ícone indica que um exercício requer uma interface GPIB ou um
dispositivo DAQ plug-in.

negrito Texto em negrito denota itens que você deve selecionar ou clicar no
software, como itens de menu e opções de caixa de diálogo. Texto em
negrito também denota nomes de parâmetro, controles e botões do painel
frontal, das caixas de diálogo, das seções de caixas de diálogo, dos nomes
de menu e dos nomes de paleta.

itálico Texto em itálico denota variáveis, ênfase, referência cruzada ou introdução
a um conceito. Esta fonte também denota o texto que é um marcador de
posição para uma palavra ou um valor que deve ser fornecido.

monospace Este tipo de fonte denota um texto ou o caractere que deve ser inserido pelo
teclado, seções de código, exemplos de programação e exemplos de sintaxe.
Essa fonte também é utilizada para indicar os nomes de unidades de disco,
caminhos, diretórios, programas, subprogramas, sub-rotinas, nomes de
dispositivos, funções, operações variáveis, nomes de arquivo e extensões e
citações de códigos.

monospace Este tipo de fonte em negrito denota as mensagens e as respostas que o
negrito computador coloca automaticamente na tela. Essa fonte também enfatiza as

linhas de código que são diferentes dos outros exemplos.

monospace Este tipo de fonte em itálico denota texto que é um identificador de posição
itálico para uma palavra ou um valor que deve ser fornecido

Platform Este tipo de fonte denota uma plataforma específica e indica que a descrição
a seguir se aplica apenas a essa plataforma.

clique com o (Macintosh) Pressione a tecla <Command> e clique para executar a
botão direito mesma ação de um clique com o botão direito.
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Lição 1
Introdução ao LabVIEW

Esta lição discute os princípios básicos do LabVIEW.

Consulte o LabVIEW Quick Reference Card para familiarizar-se
rapidamente com o LabVIEW. O guia de referência descreve as técnicas
genéricas de edição, ligação e depuração, além das paletas do LabVIEW.
Ele também fornece as teclas de atalho mais utilizadas e os recursos do
LabVIEW na Web.

Para visualizar uma versão PDF do guia, selecione Help»View Printed
Manuals. Na tela LabVIEW Library PDF, pressione a tecla <Page Down>
e clique no link LabVIEW Quick Reference Card.

Você aprenderá:

A. O que é o LabVIEW

B. O que é um instrumento virtual (VI)

C. Sobre o ambiente LabVIEW, incluindo janelas, menus e ferramentas

D. Sobre os manuais e a ajuda do LabVIEW
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A. LabVIEW
LabVIEW é uma linguagem de programação gráfica que utiliza ícones, em
vez de linhas de texto, para criar aplicações. Em contraste às linguagens de
programação baseadas em texto, em que instruções determinam a execução
do programa, o LabVIEW utiliza programação baseada em fluxo de dados,
onde o fluxo dos dados determina a execução.

No LabVIEW, você constrói uma interface de usuário, utilizando um
conjunto de ferramentas e objetos. A interface de usuário é conhecida como
Painel frontal. Então, você adiciona o código utilizando representações
gráficas de funções para controlar os objetos do painel frontal. O diagrama
de bloco contém esse código. Sob certos aspectos, o diagrama de bloco
assemelha-se a um fluxograma.

O LabVIEW está totalmente integrado para comunicação com diversos
hardwares, como GPIB, VXI, PXI, RS-232, RS-485 e dispositivos DAQ
plug-in. O LabVIEW também possui recursos internos para conectar sua
aplicação à Internet, utilizando o LabVIEW Web Server e aplicativos como
ActiveX e redes TCP/IP.

Utilizando o LabVIEW, você pode criar aplicações de teste e medição,
aquisição de dados, controle de instrumento, registro de dados, análise
de medição e geração de relatório. Também pode criar executáveis e
bibliotecas compartilhadas, como DLLs, já que o LabVIEW é um
compilador real de 32 bits.
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B. Instrumentos virtuais
Os programas em LabVIEW são chamados de instrumentos virtuais
(VIs—Virtual Instruments). Os VIs contêm três componentes principais:
o painel frontal, o diagrama de bloco e o painel de ícones e conectores.

O painel frontal é a interface com o usuário. O exemplo a seguir exibe um
painel frontal.

Você monta o painel frontal com controles e indicadores, que são
os terminais interativos de entrada e saída do VI, respectivamente.
Controles são botões, botões de pressão, dials e outros dispositivos de
entrada. Indicadores são gráficos, LEDs e outros displays. Os controles
simulam dispositivos de entrada de instrumentos e fornecem dados para o
diagrama de bloco do VI. Os indicadores simulam dispositivos de saída de
instrumentos e exibem os dados que o diagrama de bloco adquire ou gera.

Após a montagem do painel frontal, utilizando representações gráficas de
funções, você constrói o código para controlar os objetos do painel frontal.
O diagrama de bloco contém este código. Os objetos do painel frontal
aparecem como terminais, exibidos à esquerda, no diagrama de bloco.
Você não pode excluir um terminal do diagrama de bloco. O terminal
desaparece somente após a exclusão de seu objeto correspondente do painel
frontal. Os objetos do diagrama de bloco incluem terminais, subVIs,
funções, constantes, estruturas e ligações, que transferem dados entre
outros objetos do diagrama de bloco.



Lição 1 Introdução ao LabVIEW

Manual de treinamento do LabVIEW Básico I 1-4 ni.com

O exemplo a seguir mostra um diagrama de bloco e seu painel frontal
correspondente.

Após a montagem de um painel frontal e um diagrama de bloco, monte o
painel de ícones e conectores para que você possa utilizar o VI em um outro
VI. Um VI dentro de um outro VI é chamado subVI. Um subVI corresponde
a uma sub-rotina em linguagens de programação baseadas em texto. Todos
os VIs exibem um ícone, como mostrado à esquerda, no canto superior
direito das janelas do painel frontal e do diagrama de bloco. Um ícone
é a representação gráfica de um VI. Pode conter texto, imagens ou uma
combinação de ambos. Se você utilizar um VI como um subVI, o ícone
identificará o subVI no diagrama de bloco do VI.

Também é necessário montar um painel de conectores, como mostrado à
esquerda, para utilizar o VI como um subVI. O painel de conectores é um
conjunto de terminais que corresponde aos controles e indicadores do VI,
semelhante à lista de parâmetros de uma chamada de função em linguagens
de programação baseadas em texto. O painel de conectores define as
entradas e saídas que podem ser ligadas ao VI para que este possa ser
utilizado como um subVI. Um painel de conectores recebe dados em seus
terminais de entrada e transferem os dados para o código do diagrama de
bloco através dos controles do painel frontal, recebendo os resultados em
seus terminais de saída dos indicadores do painel frontal.

A vantagem do LabVIEW está na natureza hierárquica do VI. Após a
criação de um VI, você pode utilizá-lo como um subVI no diagrama de
bloco de um VI de alto nível. Não existe limite para a quantidade de níveis
na hierarquia. A utilização de subVIs ajuda você a gerenciar alterações e a
depurar o diagrama de bloco rapidamente.
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À medida que os VIs são criados, você pode perceber que uma determinada
operação é executada com freqüência. Considere a possibilidade de utilizar
subVIs ou loops (ciclos) para executar essa operação de forma repetitiva.
Consulte a Lição 4, Loops e diagramas, para obter mais informações sobre
utilização de loops. Por exemplo, o diagrama de bloco a seguir contém duas
operações idênticas.

Você pode criar um subVI que execute essa operação e chamar o subVI duas
vezes.Também pode reutilizar o subVI em outros VIs. O exemplo a seguir
utiliza o VI Temperature como um subVI em seu diagrama de bloco.
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C. Ambiente de programação LabVIEW
Quando você inicia o LabVIEW, a seguinte caixa de diálogo aparece.

A caixa de diálogo LabVIEW inclui os seguintes componentes:

• Clique no botão New VI para criar um novo VI. Clique na seta ao lado
do botão para criar um outro tipo de objeto em LabVIEW, como um
controle.

• Clique no botão Open VI para abrir um VI já existente. Clique na seta
ao lado do botão para abrir arquivos abertos recentemente.

• Clique no botão DAQ Solutions para inicializar o DAQ Solution
Wizard, que ajuda você a localizar soluções comuns para as aplicações
em aquisição de dados.

• Clique no botão Search Examples para abrir um arquivo de ajuda que
lista todos os exemplos de VIs do LabVIEW disponíveis.

• Clique no botão LabVIEW Tutorial para abrir o LabVIEW Tutorial
interativo. Utilize esse tutorial para aprender conceitos básicos do
LabVIEW.

• Clique no botão Exit para fechar o LabVIEW. (Macintosh) Clique no
botão Quit.

• Utilize a seção Quick Tip para aprender mais sobre o LabVIEW.
Clique no botão Next para visualizar mais dicas.

• Marque a caixa de seleção Do not show this window when launching
para desabilitar essa caixa de diálogo.

Janelas do painel frontal e do diagrama de bloco
Quando você clica no botão New VI, uma janela de painel frontal sem
título aparece. A janela exibe o painel frontal e é uma das duas janelas do
LabVIEW que você utiliza para montar um VI. A outra janela contém o
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diagrama de bloco. A ilustração a seguir exibe uma janela de painel frontal
e sua janela de diagrama de bloco correspondente.

1 Barra de ferramentas
2 Título do objeto
3 Controle numérico digital
4 Legenda livre
5 Terminal de controle

numérico digital

6 Terminal de controle numérico
7 Constante numérica
8 Função de multiplicação
9 Ícone
10 Controle numérico deslizante
11 Legenda de plotagem

12 Gráfico XY
13 Via de ligação de dados
14 Terminal do gráfico XY
15 Função de agrupamento
16 SubVI
17 Estrutura de For Loop

6

7

8

4

5

2 2

9

2

1

11

12

13

14

17

3

16

15

10
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Barra de ferramentas do painel frontal
Utilize os botões da barra de ferramentas para executar e editar um VI.
A seguinte barra de ferramentas aparece no painel frontal.

Clique no botão Run para executar o VI. Durante a execução do VI, o botão
será alterado conforme ilustrado a seguir, se o VI for um VI de alto nível.

O botão Run muitas vezes aparece quebrado, conforme mostrado à
esquerda, quando você cria ou edita um VI. Esse botão indica que o VI
está com defeito e não pode ser executado. Clique nesse botão para exibir
a janela Error list, que lista todos os erros.

Clique no botão Run Continuously para executar o VI até que você anule
ou interrompa sua execução. Também é possível clicar no botão novamente
para desabilitar a execução contínua.

Durante a execução do VI, o botão Abort Execution aparece. Clique nele
para parar a execução do VI imediatamente.

Nota Evite utilizar o botão Abort Execution para parar um VI. Deixe que o VI seja
executado até sua conclusão ou desenvolva um método para interromper a execução do
VI de forma programada. Fazendo isso, o VI sempre estará em um estado conhecido. Por
exemplo, você pode interromper a execução de um VI de forma programada, utilizando
uma chave do painel frontal.

Clique no botão Pause para dar uma pausa na execução de um VI. Quando
você clica no botão Pause, o LabVIEW destaca no diagrama de bloco o
local onde a execução foi interrompida. Clique no botão novamente para
continuar executando o VI.

Selecione o menu Text Settings na barra de ferramentas para alterar as
configurações de fonte do VI, incluindo tamanho, estilo e cor.

Selecione o menu Align Objects na barra de ferramentas para alinhar
objetos ao longo dos eixos, incluindo vertical, margem superior, esquerdo,
e assim por diante.

Selecione o menu Distribute Objects na barra de ferramentas para
distribuir objetos uniformemente, incluindo intervalos, compressão,
e assim por diante.
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Selecione o menu Reorder na barra de ferramentas quando você tiver
objetos que se sobrepõem um ao outro e desejar definir qual deles deve
ficar antes ou depois do outro. Selecione um dos objetos com a ferramenta
Positioning e selecione Move Forward, Move Backward, Move To Front
e Move To Back.

Barra de ferramentas do diagrama de bloco
Quando você executa um VI, botões aparecem na barra de ferramentas do
diagrama de bloco que pode ser utilizada para depurar o VI. A seguinte barra
de ferramentas aparece no diagrama de bloco.

Clique no botão Highlight Execution para ver o fluxo de dados através do
diagrama de bloco. Clique no botão novamente para desabilitar essa função.

Clique no botão Step Into para executar (passo a passo) um loop, um subVI,
e assim por diante. A execução passo a passo sobre um VI permite percorrer
o VI de nó a nó. Cada nó pisca para demonstrar quando ele está pronto para
ser executado. Ao avançar a um nó, você fica pronto para uma próxima
execução.

Clique no botão Step Over para entrar (diretamente) em um loop, um
subVI, e assim por diante. Ao passar diretamente pelo nó, você executa
o nó sem o esquema de passo único.

Clique no botão Step Out para sair de um loop, um subVI, e assim por
diante. Ao sair de um nó, você conclui a execução passo a passo através
do nó e vai para o próximo nó.

O botão Warning aparece quando há um problema potencial com o
diagrama de bloco, mas ele não faz com que o VI pare sua execução. Você
pode habilitar o botão Warning selecionando Tools»Options e Debugging
no menu superior.

Menus de atalho
O menu utilizado com mais freqüência é o menu de atalho do objeto. Todos
os objetos do LabVIEW e espaços vazios do painel frontal e do diagrama de
bloco têm menus de atalho associados. Utilize os itens do menu de atalho
para alterar a aparência ou o comportamento dos objetos do painel frontal e
do diagrama de bloco. Para acessar o menu de atalho, clique com o botão
direito no objeto, painel frontal ou diagrama de bloco.

(Macintosh) Pressione a tecla <Command> e clique no objeto, painel frontal
ou diagrama de bloco.
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Menus
Os menus localizados na parte superior de uma janela de VI contêm itens
que são comuns para outros aplicativos, como Open, Save, Copy e Paste,
e outros itens específicos para o LabVIEW. Alguns itens de menu também
apresentam combinações de teclas de atalho.

(Macintosh) Os menus aparecem na parte superior da tela.

Nota Alguns itens de menu ficam indisponíveis durante a execução de um VI.

• Utilize o menu File basicamente para abrir, fechar, salvar e imprimir
VIs.

• Utilize o menu Edit para pesquisar e modificar componentes de um VI.

• Utilize o menu Operate para executar, anular e alterar outras opções de
execução do VI.

• Utilize o menu Tools para se comunicar com instrumentos e
dispositivos DAQ, comparar VIs, montar aplicações, habilitar o
servidor Web e configurar o LabVIEW.

• Utilize o menu Browse para navegar pelo VI e por sua hierarquia.

• Utilize o menu Window para exibir janelas e paletas do LabVIEW.

• Utilize o menu Help para visualizar informações sobre paletas, menus,
ferramentas, VIs e funções, visualizar instruções passo a passo com
relação à utilização de recursos do LabVIEW, acessar os manuais do
LabVIEW e visualizar o número de versão do software e as informações
sobre a memória do computador.

Paletas
O LabVIEW tem paletas gráficas flutuantes para ajudar na criação e
execução dos VIs. As três paletas são Tools, Controls e Functions.
Você pode posicionar essas paletas em qualquer lugar da tela.

Paleta Tools
Você pode criar, modificar e depurar VIs, utilizando as ferramentas
localizadas na paleta flutuante Tools. A paleta Tools está disponível no
painel frontal e no diagrama de bloco. Uma ferramenta é um modo especial
de operação do cursor do mouse. Quando você seleciona uma ferramenta, o
ícone do cursor é alterado para o ícone da ferramenta. Utilize as ferramentas
para operar e modificar objetos do painel frontal e do diagrama de bloco.
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Selecione Window»Show Tools Palette para exibir a paleta Tools. Você
pode posicionar a paleta Tools em qualquer lugar da tela. Pressione a tecla
<Shift> e clique com o botão direito para exibir uma versão temporária da
paleta Tools na posição do cursor.

Para alternar entre as ferramentas da paleta Tools, pressione a tecla <Tab>.
Para alternar entre as ferramentas Positioning e Wiring no diagrama de
bloco ou entre as ferramentas Positioning e Operating no painel frontal,
pressione a barra de espaço.

Utilize a ferramenta Operating para alterar os valores de um controle ou
selecionar o texto em um controle. A ferramenta Operating é alterada para
o seguinte ícone ao ser movida sobre um controle de texto, como um
controle digital ou de string.

Utilize a ferramenta Positioning para selecionar, mover ou redimensionar
objetos. A ferramenta Positioning é alterada para um dos seguintes ícones
ao ser movida sobre um canto de um objeto redimensionável.

Utilize a ferramenta Labeling para editar texto e criar legendas livres.
A ferramenta Labeling é alterada para o seguinte ícone quando você cria
legendas livres.

Utilize a ferramenta Wiring para ligar objetos no diagrama de bloco.

Utilize a ferramenta Object Shortcut Menu para acessar ao menu de atalho
de um objeto com o botão esquerdo do mouse.

Utilize a ferramenta Scrolling para percorrer as janelas sem utilizar as barras
de rolagem.

Utilize a ferramenta Breakpoint para definir pontos de parada em VIs,
funções, nós, ligações e estruturas, a fim de interromper a execução naquela
localização.
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Utilize a ferramenta Probe para criar sensores no diagrama de bloco.
Utilize essa ferramenta para verificar valores intermediários em um
VI que apresenta resultados questionáveis ou inesperados.

Utilize a ferramenta Color Copy a fim de copiar cores para serem coladas
com a ferramenta Coloring.

Utilize a ferramenta Coloring para colorir um objeto. Ela também exibe as
configurações atuais de cores de primeiro plano e de fundo.

Paletas Controls e Functions
As paletas Controls e Functions contêm subpaletas de objetos que podem
ser utilizadas para criar um VI. Quando você clica em um ícone de
subpaleta, a paleta inteira é alterada para a subpaleta selecionada. Para
utilizar um objeto das paletas, clique no objeto e coloque-o no painel frontal
ou no diagrama de bloco.

Utilize os botões de navegação das paletas Controls e Functions para
navegar por controles, VIs e funções, bem como para pesquisá-los.
Também é possível clicar com o botão direito em um ícone de VI da
paleta e selecionar Open VI no menu de atalho para abrir o VI.

Paleta Controls
Utilize a paleta Controls para indicar controles e indicadores no painel
frontal. A paleta Controls está disponível somente no painel frontal.
Selecione Window»Show Controls Palette ou clique com o botão direito
no espaço de trabalho do painel frontal para exibir a paleta Controls. Você
também pode exibir a paleta Controls clicando com o botão direito em uma
área aberta do painel frontal. Fixe a paleta Controls, clicando no pino,
localizado no canto superior esquerdo da paleta.
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Paleta Functions
Utilize a paleta Functions para montar o diagrama de bloco. A paleta
Functions está disponível somente no diagrama de bloco. Selecione
Window»Show Functions Palette ou clique com o botão direito no espaço
de trabalho do diagrama de bloco para exibir a paleta Functions. Também
é possível exibir a paleta Functions clicando com o botão direito em uma
área aberta do diagrama de bloco. Fixe a paleta Functions clicando no pino,
localizado no canto superior esquerdo da paleta.

Este curso utiliza os VIs, localizados na paleta Functions»User Libraries»
Basics I Course, mostrados à esquerda.

Carregando VIs
Você carrega um VI na memória, selecionando File»Open. A caixa de
diálogo Choose the VI to open aparece, de forma que você possa navegar
para o VI a ser aberto.

Os VIs editados neste curso estão no diretório
c:\exercises\LV Basics I.
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À medida que o VI é carregado, a seguinte caixa de diálogo de status pode
aparecer.

O campo Loading lista os subVIs do VI conforme são carregados na
memória. Number Loaded é o número de subVIs carregados na memória
até o momento. Você pode cancelar o carregamento a qualquer instante,
clicando no botão Stop.

Se o LabVIEW não puder localizar imediatamente um subVI, ele começará
a pesquisar em todos os diretórios especificados no campo VI Search Path,
que poderá ser editado selecionando Tools»Options e, em seguida, Paths
no menu superior. O campo Searching lista os diretórios ou VIs, à medida
que o LabVIEW os pesquisa. Você pode fazer com que o LabVIEW ignore
um subVI, clicando no botão Ignore SubVI, ou pode clicar no botão
Browse para procurar o subVI que está faltando.

Salvando VIs
Selecione Save, Save As, Save All ou Save with Options no menu File
para salvar VIs como arquivos individuais ou agrupar diversos VIs e
salvá-los em uma biblioteca de VIs. Os arquivos da biblioteca de VIs
terminam com a extensão .llb. A National Instruments recomenda que
você salve os VIs como arquivos individuais, organizados em diretórios,
principalmente se diversos desenvolvedores estiverem trabalhando no
mesmo projeto.

O LabVIEW utiliza caixas de diálogo do Windows para carregar e salvar
arquivos. Você pode desabilitar esse recurso, selecionando Tools»Options
e, em seguida, Miscellaneous no menu superior.
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Movendo VIs entre plataformas
Você pode transferir VIs de uma plataforma para outra, como de Macintosh
para Windows. O LabVIEW automaticamente converte e recompila os VIs
na nova plataforma.

Como os VIs são arquivos, é possível utilizar qualquer método ou utilitário
de transferência de arquivo para mover VIs entre plataformas. Você pode
transferir VIs pela rede, utilizando os protocolos FTP, Z ou XModem
ou utilitários semelhantes. Tais transferências pela rede eliminam a
necessidade de se utilizar software adicional de conversão de arquivo.
Se você transferir VIs utilizando mídia magnética, como discos flexíveis
ou uma unidade de disco rígido externa móvel, necessitará de um
programa utilitário genérico de transferência de arquivos, como:

• (Windows) MacDisk e TransferPro transferem arquivos Macintosh para
o formato PC e vice-versa.

• (Macintosh) DOS Mounter, MacLink e Apple File Exchange convertem
arquivos PC no formato Macintosh e vice-versa.

• (Sun) PC File System (PCFS) converte arquivos PC no formato Sun
e vice-versa.

• (HP-UX) O comando doscp instala discos de PC e copia seus arquivos.

Nota Determinados VIs específicos do sistema operacional não são transferíveis entre
plataformas, como VIs DDE (Dynamic Data Exchange), VIs ActiveX e AppleEvents.
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Exercise 1-1 VI Frequency Response
Objetivo: Abrir e executar um VI.

1. Selecione Start»Programs»National Instruments»LabVIEW 6»
LabVIEW para inicializar o LabVIEW. A caixa de diálogo LabVIEW
aparece.

2. Clique no botão Search Examples. O arquivo de ajuda que aparece lista
e vincula todos os exemplos de VIs do LabVIEW disponíveis.

3. Clique em Demonstrations, Instrument I/O e Frequency Response.
O painel frontal do VI Frequency Response aparece.

Nota Você também pode abrir o VI, clicando no botão Open VI e navegando para
labview\examples\apps\freqresp.llb\Frequency Response.vi.

Painel frontal
4. Clique no botão Run da barra de ferramentas, como mostrado à

esquerda, para executar esse VI. Esse VI simula o envio de um sinal para
uma unidade em teste (UUT—Unit Under Test) e a leitura da resposta.
A curva de resposta de freqüência resultante é exibida no gráfico do
painel frontal, conforme mostrado na ilustração a seguir.
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5. Utilize a ferramenta Operating, mostrada à esquerda, para alterar o valor
do botão Amplitude. Clique na marca localizada no botão e arraste-o
para a posição desejada, utilize as setas de incremento ou decremento
do controle digital ou posicione o cursor no display digital e insira um
número.

Se você inserir um número no display digital, o botão Enter, como
mostrado à esquerda, aparecerá na barra de ferramentas. O número não
será transferido para o VI, até você clicar nesse botão ou pressionar a
tecla <Enter>.

(Macintosh e Sun) Pressione a tecla <Return>.

6. Clique no botão Run para executar o VI novamente. Tente ajustar os
outros controles do painel e executar o VI para ver as alterações que
ocorrem.

Diagrama de bloco
7. Selecione Window»Show Diagram ou pressione as teclas <Ctrl-E>

para exibir o seguinte diagrama de bloco do VI Frequency Response.

(Macintosh) Pressione as teclas <Command-E>. (Sun) Pressione as
teclas <Meta-E>. (HP-UX e Linux) Pressione as teclas <Alt-E>.

Esse diagrama de bloco contém muitos dos elementos básicos de
diagrama de bloco, incluindo subVIs, funções e estruturas, sobre
os quais você aprenderá posteriormente neste curso.
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8. Utilize a ferramenta Operating para clicar duas vezes no seguinte
ícone DMM.

Esse ícone é um subVI, chamado VI Demo Fluke 8840A. Depois de
clicar duas vezes nele, o seguinte painel frontal desse subVI será aberto.

Esse painel foi projetado para parecer com a interface de usuário de
um multímetro. É por esse motivo que os programas LabVIEW são
chamados de instrumentos virtuais. Tornando as aplicações do
LabVIEW modulares, você pode modificar somente partes da aplicação
ou reutilizar essas partes na mesma ou em outras aplicações. Por
exemplo, esse subVI simula a ação de um multímetro Fluke, mas você
pode modificar esse VI de forma que ele controle um instrumento.

9. Selecione File»Close para fechar o painel frontal do VI Demo
Fluke 8840A.

10. Não feche o VI Frequency Response, pois ele será utilizado no
Exercício 1-2.

Final do exercício 1-1
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D. Ajuda e manuais do LabVIEW
Utilize a janela Context Help e a seção Ajuda do LabVIEW para ajudá-lo a
montar e editar VIs. Consulte a Ajuda do LabVIEW e os manuais para obter
mais informações.

Janela Context Help
Para exibir a janela Context Help, selecione Help»Show Context Help
ou pressione as teclas <Ctrl-H>.

(Macintosh) Pressione as teclas <Command-H>. (Sun) Pressione as
teclas <Meta-H>. (HP-UX e Linux) Pressione as teclas <Alt-H>.

Quando você move o cursor sobre objetos do painel frontal e do diagrama
de bloco, a janela Context Help exibe o ícone para subVIs, funções,
constantes, controles e indicadores, com as conexões de cada terminal.
Quando você move o cursor sobre opções da caixa de diálogo, a janela
Context Help exibe descrições dessas opções. Na janela, conexões
obrigatórias estão em negrito, conexões recomendadas em texto normal
e conexões opcionais estão obscurecidas ou não aparecem. A ilustração
a seguir é um exemplo da janela Context Help.
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Clique no botão Simple/Detailed Context Help, localizado no canto
inferior esquerdo da janela Context Help, para alterar entre ajuda de
contexto simples e detalhada. O modo simples enfatiza as conexões
importantes. Terminais opcionais são mostrados por pontas de ligações,
informando você que existem outras conexões. O modo detalhado exibe
todos os terminais, conforme mostrado no seguinte exemplo.

Clique no botão Lock Context Help para bloquear o conteúdo atual da
janela Context Help. Quando o conteúdo está bloqueado, o movimento
do cursor sobre um outro objeto não altera o conteúdo da janela. Para
desbloquear a janela, clique no botão novamente. Você também pode
acessar essa opção no menu Help.

Clique no botão More Help para exibir o tópico correspondente da Ajuda
do LabVIEW, que descreve o objeto em detalhes.

Ajuda do LabVIEW
Você pode acessar a Ajuda do LabVIEW, clicando no botão More Help da
janela Context Help, selecionando Help»Contents and Index ou clicando
em Click here for more help na janela Context Help.

A Ajuda do LabVIEW contém descrições detalhadas da maioria das paletas,
menus, ferramentas, VIs e funções. A Ajuda do LabVIEW também inclui
instruções passo a passo sobre a utilização de recursos do LabVIEW e
links para o LabVIEW Tutorial, exemplo de VIs, versões PDF de todos os
manuais e Application Notes do LabVIEW e recursos do suporte técnico
no site da National Instruments na Web.
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Exercise 1-2 Utilizar os manuais e a ajuda do LabVIEW
Objetivo: Utilizar os utilitários de ajuda do LabVIEW para obter informações sobre objetos

e recursos do painel frontal e do diagrama de bloco.

Parte A. Janela Context Help
1. O VI Frequency Response ainda deve estar aberto no Exercício 1-1.

Se não estiver, abra-o conforme descrito no Exercício 1-1.

2. Selecione Window»Show Diagram para exibir o diagrama de bloco.

3. Selecione Help»Show Context Help ou pressione as teclas <Ctrl-H>
para exibir a janela Context Help.

(Macintosh) Pressione as teclas <Command-H>. (Sun) Pressione as
teclas <Meta-H>. (HP-UX e Linux) Pressione as teclas <Alt-H>.

4. Exiba informações sobre objetos na janela Context Help, à medida que
você move o cursor sobre eles.

a. Mova a ferramenta Positioning, mostrada à esquerda, sobre a
função Logarithm Base 10, localizada sob o título Bode Plot.
Uma descrição da função aparece na janela Context Help.

b. Clique no botão More Help, como mostrado à esquerda, da janela
Context Help para abrir o tópico correspondente na Ajuda do
LabVIEW. Você também pode clicar no link Click here for more
help, na parte inferior da janela Context Help, para abrir o tópico
correspondente na Ajuda do LabVIEW.

A Ajuda do LabVIEW contém descrições detalhadas da maioria das
paletas, menus, ferramentas, VIs e funções. Acesse a ajuda para
obter outras funções.

c. Mova a ferramenta Wiring, mostrada à esquerda, sobre os terminais
da função Logarithm Base 10. Os terminais correspondentes piscam
na janela Context Help à medida que a ferramenta é movida sobre
eles.

d. Mova a ferramenta Wiring sobre uma ligação. A janela Context
Help exibe o tipo de dados da ligação.
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Parte B. Ajuda do LabVIEW
5. Selecione Help»Contents and Index para abrir Ajuda do LabVIEW.

A Ajuda do LabVIEW inclui instruções passo a passo para a utilização
de recursos do LabVIEW e links para o LabVIEW Tutorial, exemplos de
VIs, versões PDF de todos os manuais e Application Notes do LabView
e recursos do suporte técnico no site da National Instruments na Web.

6. Utilize o índice da Ajuda do LabVIEW.

a. Clique na guia Index para exibir o índice da Ajuda do LabVIEW.

b. Digite Frequency Response na caixa de texto. O índice exibe as
duas opções mais próximas.

c. Clique em cada entrada. A Ajuda do LabVIEW exibe o tópico.

d. Clique na guia Contents para exibir o índice da Ajuda do LabVIEW,
que mostra onde o tópico está localizado no arquivo de ajuda.

e. Clique na guia Index novamente.

f. Digite GPIB examples na caixa de texto, pois o VI Frequency
Response é uma simulação de uma aplicação do GPIB.

g. Clique na entrada do índice para exibir um tópico que contém um
link para o VI Frequency Response.

7. Execute uma pesquisa de texto completo da Ajuda do LabVIEW.

a. Clique na guia Search.

b. Digite Frequency Response na caixa de texto. Na caixa de texto
inferior, clique no resultado da pesquisa GPIB Examples.

Tip Enquanto a guia Search estiver visível, selecione Search»Options para
personalizar a pesquisa de texto completo.

8. Se seu computador tiver o Adobe Acrobat Reader instalado, clique na
guia Contents e abra a versão PDF do LabVIEW User Manual na Ajuda
do LabVIEW.

a. Clique na página Related Documentation, na parte superior da guia
Contents. O tópico Related Documentation aparece.

b. Clique no link LabVIEW User Manual para abrir a versão PDF do
manual na janela LabVIEW Help.

c. Clique no botão Help Topics da barra de ferramentas para ocultar
a guia Contents da janela LabVIEW Help.

d. Clique no botão Help Topics novamente para exibir a guia
Contents.

e. Clique no botão Back para retornar ao tópico Related
Documentation.
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9. Se seu computador estiver conectado à Internet, acesse os recursos
de suporte técnico no site da National Instruments na Web.

a. Localize o manual Technical Support Resources na parte inferior
da guia Contents.

b. Clique no manual para expandi-lo e clique na página Technical
Support Resources. O tópico Technical Support Resources
aparece.

c. Clique no link Technical Support para abrir a seção Technical
Support do site ni.com na janela LabVIEW Help.

Tip Clique no link Open this page in your browser, na parte superior do tópico
Technical Support Resources, para abrir um site da Web em seu próprio navegador.

d. Clique no botão Back da barra de ferramentas para retornar ao
tópico Technical Support Resources.

e. Clique no link NI Developer Zone para abrir a seção Developer
Zone da National Instruments.

f. Digite Frequency Response na caixa de texto e clique em GO.
Os diferentes tópicos que aparecem fornecem soluções para serem
utilizadas com diversos produtos diferentes da National Instruments.

g. Clique no botão Back da barra de ferramentas para retornar ao
tópico Technical Support Resources.

Parte C. LabVIEW Library PDF
10. Se seu computador tiver o Adobe Acrobat Reader instalado, selecione

Help»View Printed Manuals para exibir o LabVIEW Library PDF.
Você pode utilizar esse PDF para pesquisar versões PDF de todos os
manuais e Application Notes do LabVIEW.

11. Clique no link Search do LabVIEW Library PDF. A caixa de diálogo
Adobe Acrobat Search aparece.

12. Digite Frequency Response na caixa de texto e clique no botão
Search. O LabVIEW Library PDF pesquisa todos os manuais e
Application Notes do LabVIEW e retorna uma lista de resultados.

13. Clique duas vezes no primeiro resultado da pesquisa. O LabVIEW
Library PDF exibe a localização exata de Frequency Response 
no documento.

14. Selecione Edit»Search»Results para exibir os resultados da pesquisa
novamente.
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15. Visualize os outros resultados da pesquisa e saia do Acrobat Reader
quando tiver finalizado.

16. No painel frontal, selecione File»Close para fechar o VI Frequency
Response. Não salve nenhuma alteração.

Final do exercício 1-2
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Resumo, dicas e suplementos

• Os instrumentos virtuais (VIs—Virtual Instruments) contêm três
componentes principais: o painel frontal, o diagrama de bloco e o
painel de ícones e conectores.

• O painel frontal é a interface de usuário de um VI e especifica as
entradas e exibe as saídas do VI.

• O diagrama de bloco contém o código fonte gráfico, composto de nós,
terminais e ligações.

• Utilize a paleta Tools para criar, modificar e depurar VIs. Pressione
a tecla <Shift> e clique com o botão direito para exibir uma versão
temporária da paleta Tools na localização do cursor.

• Utilize a paleta Controls para indicar controles e indicadores no painel
frontal. Clique com o botão direito em uma área aberta do painel frontal
para exibir a paleta Controls.

• Utilize a paleta Functions para montar o diagrama de bloco. Clique com
o botão direito em uma área aberta do diagrama de bloco para exibir a
paleta Functions.

• Todos os objetos do LabVIEW e o espaço vazio no painel frontal e
no diagrama de bloco possuem menus de atalho associados, que você
acessa clicando com o botão direito em um objeto, no painel frontal
ou no diagrama de bloco.

(Macintosh) Acesse aos menus de atalho, pressionando a tecla
<Command> enquanto você clica em um objeto, no painel frontal
ou no diagrama de bloco.

• Utilize o menu Help para exibir a janela Context Help e a Ajuda
do LabVIEW, que descreve a maioria das paletas, dos menus, das
ferramentas, dos VIs e das funções e inclui instruções passo a passo
para utilização de recursos do LabVIEW.

• Selecione Help»View Printed Manuals para exibir o LabVIEW
Library PDF, que você pode utilizar para pesquisar versões PDF
de todos os manuais e Application Notes do LabVIEW.
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Anotações
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Lição 2
Criando, editando e depurando um VI

Esta lição introduz os princípios básicos de criação de um VI.

Você aprenderá:

A. Como criar VIs

B. Técnicas de edição

C. Técnicas de depuração
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A. Criando um VI
Os VIs contêm três componentes principais: o painel frontal, o diagrama de
bloco e o painel de ícones e conectores. Consulte a Lição 3, Criando um
subVI, para obter mais informações sobre o painel de ícones e conectores.

Painel frontal
Você monta o painel frontal com controles e indicadores, que são os
terminais interativos de entrada e saída do VI, respectivamente. Controles
são botões, botões de pressão, dials e outros dispositivos de entrada.
Indicadores são gráficos, LEDs e outros displays. Os controles simulam
dispositivos de entrada de instrumentos e fornecem dados para o diagrama
de bloco do VI. Os indicadores simulam dispositivos de saída de
instrumentos e exibem os dados que o diagrama de bloco adquire ou gera.

Utilize a paleta Controls para indicar controles e indicadores no painel
frontal. A paleta Controls está disponível somente no painel frontal.
Selecione Window»Show Controls Palette ou clique com o botão direito
no espaço de trabalho do painel frontal para exibir a paleta Controls.

Controles e indicadores numéricos
Os dois objetos numéricos mais utilizados são: os controles e os indicadores
digitais, conforme mostrado na ilustração a seguir.

Para inserir ou alterar valores em um controle digital, você pode clicar nos
botões de seta de incremento com a ferramenta Operating ou clicar duas
vezes no número com a ferramenta Labeling ou Operating, digitar um novo
número e pressionar a tecla <Enter>.

(Macintosh e Sun) Pressione a tecla <Return>.

1 Botões de seta de incremento 2 Controle digital 3 Indicador digital

21

3



Lição 2 Criando, editando e depurando um VI

© National Instruments Corporation 2-3 Manual de treinamento do LabVIEW Básico I

Controles e indicadores Booleanos
Utilize controles e indicadores Booleanos para inserir e exibir valores
Booleanos (TRUE ou FALSE). Objetos Booleanos simulam chaves, botões
de pressão e LEDs. Os objetos Booleanos mais comuns são a chave toggle
vertical e o LED redondo, conforme mostrado na ilustração a seguir.

Configurando controles e indicadores
Você pode configurar quase todos os controles e indicadores, utilizando os
menus de atalho. Para acessar o menu de atalho de um controle ou indicador,
clique com o botão direito no objeto. Por exemplo, para configurar um
título, clique com o botão direito no título. Para configurar um display
digital, clique com o botão direito no display digital.

Diagrama de bloco
O diagrama de bloco é composto por nós, terminais e ligações, como
mostrado na seguinte ilustração.

1 Nós 2 Terminais do indicador 3 Ligações 4 Terminais de controle

1

2

4

3
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Nós
Nós são objetos do diagrama de bloco que possuem entradas e/ou saídas
e executam operações quando o VI é executado. Eles são semelhantes
a declarações, operadores, funções e sub-rotinas em linguagens de
programação baseadas em texto. Os tipos de nós incluem funções, subVIs e
estruturas. Funções são elementos de execução internos, comparáveis a um
operador, uma função ou uma declaração. SubVIs são VIs utilizados no
diagrama de bloco de um outro VI, comparáveis a sub-rotinas. Estruturas
são elementos de controle de processo, como estruturas Case (condicionais)
e Sequence (seqüenciais), For Loops ou While Loops. Os nós Add e
Subtract no diagrama de bloco anterior são nós de função.

Terminais
Os objetos do painel frontal aparecem como terminais no diagrama
de bloco. Os terminais representam o tipo de dados do controle ou do
indicador. Por exemplo, um terminal DBL, como mostrado à esquerda,
representa um controle ou indicador numérico de ponto flutuante e dupla
precisão.

Terminais são portas de entrada e saída que trocam informações entre o
painel frontal e o diagrama de bloco. Os terminais são semelhantes a
parâmetros e constantes em linguagens de programação baseadas em texto.
Os tipos de terminais incluem terminais de controle ou indicador e terminais
de nós. Os terminais de controle e indicador pertencem a controles e
indicadores do painel frontal. Os dados inseridos nos controles do painel
frontal são inseridos no diagrama de bloco através dos terminais de controle.
Em seguida, os dados são inseridos nas funções Add e Subtract. Quando as
funções Add e Subtract completam seus cálculos internos, elas produzem
novos valores de dados. O fluxo de dados para os terminais de indicador, em
que eles saem do diagrama de bloco, são inseridos novamente no painel
frontal e aparecem nos indicadores do painel frontal.

Os terminais do diagrama de bloco anterior pertencem aos quatro controles
e indicadores do painel frontal. Os painéis de conectores das funções Add
e Subtract, mostrados à esquerda, têm três nós de terminal. Para exibir o
painel de conectores, clique com o botão direito no nó da função e selecione
Visible Items»Terminals no menu de atalho.

Ligações
Você transfere dados entre objetos do diagrama de bloco através de
ligações. Eles são semelhantes a variáveis em linguagens de programação
baseadas em texto. Cada ligação tem uma única fonte de dados, mas
você pode ligá-la a vários VIs e funções que fazem a leitura dos dados.
As ligações são de cores, estilos e espessuras diferentes, dependendo de
seus tipos de dados. Os exemplos a seguir apresentam os tipos mais
comuns de ligações.
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Ligando objetos automaticamente
O LabVIEW liga automaticamente objetos, conforme você os posiciona no
diagrama de bloco. Você também pode ligar automaticamente objetos que
já estão no diagrama de bloco. O LabVIEW conecta os terminais de melhor
compatibilidade e deixa desconectados os terminais que não são
compatíveis.

À medida que você move um objeto selecionado próximo a outros objetos
do diagrama de bloco, o LabVIEW instala ligações temporárias a fim
de exibir conexões válidas. Quando você solta o botão do mouse para
posicionar o objeto no diagrama de bloco, o LabVIEW conecta as ligações
automaticamente.

Alterne a ligação automática, pressionando a barra de espaço, enquanto
você move um objeto utilizando a ferramenta Positioning. Você pode
ajustar as configurações de ligação automática, selecionando Tools»
Options e Block Diagram no menu superior.

Exibindo terminais
Para certificar-se de que ligou os terminais corretos nas funções, exiba
o painel de conectores clicando com o botão direito no nó da função e
selecionando Visible Items»Terminals no menu de atalho.

Para retornar ao ícone, clique com o botão direito no nó da função e
selecione Visible Items»Terminals no menu de atalho para remover
a marca de verificação.

Programação do fluxo de dados
O LabVIEW segue um modelo de fluxo de dados para executar VIs.
Um nó do diagrama de bloco é executado quando todas as suas entradas
estão disponíveis. Quando um nó completa sua execução, fornece dados
para seus terminais de saída e transfere os dados de saída para o próximo
nó no caminho do fluxo de dados.

Tipo de ligação Escalar Arranjo 1D Arranjo 2D Cor

Numérico Laranja (ponto flutuante),
Azul (inteiro)

Booleano Verde

String Rosa
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Visual Basic, C++, JAVA e a maioria das outras linguagens de programação
baseadas em texto seguem um modelo de fluxo de controle de execução de
programas. No fluxo de controle, a ordem seqüencial de elementos do
programa determina a ordem de execução de um programa.

Por exemplo, considere um diagrama de bloco que adiciona dois números
e depois subtrai 50,0 do resultado da adição. Nesse caso, o diagrama de
bloco é executado da esquerda para a direita, não porque os objetos foram
posicionados nessa ordem, mas sim porque uma das entradas da função
Subtract não será válida até que a execução da função Add seja concluída
e que os dados sejam transferidos para a função Subtract. Lembre-se de que
um nó é executado apenas quando os dados estão disponíveis em todos os
seus terminais de entrada e de que o nó fornece dados para seus terminais de
saída apenas quando conclui a execução.

No exemplo a seguir, considere qual segmento de código será executado
primeiro, a função Add, Random Number ou Divide. Não é possível
realmente saber porque as funções Add e Divide estão disponíveis ao
mesmo tempo e porque a função Random Number não possui entradas.
Em uma situação em que um segmento de código deve ser executado antes
de outro e não existe nenhum tipo de dependência de dados entre as funções,
utilize uma estrutura Sequence para forçar a ordem de execução. Consulte a
Lição 6, Estruturas Case e Sequence, para obter mais informações sobre
estruturas Sequence.
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Pesquisando controles, VIs e funções
Utilize os seguintes botões de navegação das paletas Controls e Functions
para navegar e pesquisar controles, VIs e funções:

• Up: eleva você um nível na hierarquia da paleta.

• Search: altera a paleta para o modo de pesquisa. Em modo de pesquisa,
você pode executar pesquisas baseadas em texto para localizar
controles, VIs ou funções nas paletas.

• Options: abre a caixa de diálogo Function Browser Options, na qual
você pode configurar a aparência das paletas.

Por exemplo, se você desejar localizar a função Random Number, clique
no botão Search da barra de ferramentas da paleta Functions e comece a
digitar Random Number na caixa de texto, localizada na parte superior da
paleta. O LabVIEW lista todos os itens correspondentes que começam
com o texto digitado ou que o contenham. Você pode clicar em um dos
resultados da pesquisa e arrastá-lo para o diagrama de bloco, conforme
mostrado no exemplo a seguir.

Clique duas vezes no resultado da pesquisa para destacar sua localização na
paleta. Em seguida, você pode clicar no botão Up to Owning Palette para
visualizar a hierarquia de localização do VI.
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Exercise 2-1 VI Convert C to F
Objetivo: Montar um VI.

Complete os passos a seguir para criar um VI que tenha um número que
represente graus Celsius e converta-o em um número que represente graus
Fahrenheit.

Nas ilustrações de ligação, a seta no final do ícone do mouse mostra onde
clicar e o número na seta indica quantas vezes é necessário clicar.

Painel frontal

1. Selecione File»New para abrir um novo painel frontal.

(Windows, Sun e HP-UX) Se você fechou todos os VIs abertos, clique no
botão New VI na caixa de diálogo LabVIEW.

2. (Opcional) Selecione Window»Tile Left and Right para exibir o painel
frontal e o diagrama de bloco lado a lado.

3. Crie um controle digital numérico. Você utilizará esse controle para
inserir o valor para graus centígrados.

a. Selecione o controle digital na paleta Controls»Numeric. Se a
paleta Controls não estiver visível, clique com o botão direito em
uma área aberta do painel frontal para exibi-lo.

b. Mova o controle para o painel frontal e clique para posicionar
o controle.

c. Digite deg C dentro do título e clique fora dele, ou clique no botão
Enter da barra de ferramentas, como mostrado à esquerda. Se você
não digitar o nome imediatamente, o LabVIEW utilizará um título
padrão. Você pode editar um título a qualquer momento, utilizando
a ferramenta Labeling, como mostrada à esquerda.

4. Crie um indicador digital numérico. Você utilizará esse indicador para
exibir o valor para graus Fahrenheit.

a. Selecione o indicador digital na paleta Controls»Numeric.

b. Mova o indicador para o painel frontal e clique para posicionar
o indicador.

c. Digite deg F dentro do título e clique fora do título, ou clique
no botão Enter.

1
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O LabVIEW cria terminais correspondentes de indicador e de controle
no diagrama de bloco. Os terminais representam o tipo de dados do
controle ou do indicador. Por exemplo, um terminal DBL, como
mostrado à esquerda, representa um controle ou indicador numérico
de ponto flutuante e dupla precisão.

Nota Os terminais de controle têm uma borda mais espessa que os terminais de
indicador.

Diagrama de bloco

5. Exiba o diagrama de bloco clicando nele ou selecionando Window»
Show Diagram.

6. Selecione as funções Multiply e Add na paleta Functions»Numeric
e coloque-as no diagrama de bloco. Se a paleta Functions não estiver
visível, clique com o botão direito em uma área aberta do diagrama
de bloco para exibi-la.

7. Selecione a constante numérica na paleta Functions»Numeric e
posicione duas constantes numéricas no diagrama de bloco. Quando
você posicionar a constante numérica pela primeira vez, ela será
destacada para que seja possível digitar um valor.

8. Digite 1.8 em uma constante e 32.0 na outra.

Se você moveu as constantes antes de digitar um valor, utilize a
ferramenta Labeling para inserir os valores.

9. Utilize a ferramenta Wiring, como mostrada à esquerda, para ligar os
ícones conforme indicado no diagrama de bloco anterior.

• Para ligar de um terminal a outro, utilize a ferramenta Wiring
para clicar no primeiro terminal, mova a ferramenta para o
segundo terminal e clique nele, como mostrado na ilustração
a seguir. É possível iniciar a ligação em qualquer terminal.

1 1
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• Você pode fazer curvas em uma ligação, clicando para fixá-la e
movendo o cursor em uma direção perpendicular. Pressione a barra
de espaço para alternar a direção da ligação.

• Para identificar terminais nos nós, clique com o botão direito nas
funções Multiply e Add e selecione Visible Items»Terminals no
menu de atalho para exibir o painel de conectores. Retorne aos
ícones após a ligação, clicando com o botão direito nas funções
e selecionando Visible Items»Terminals no menu de atalho para
remover a marca de verificação.

• Quando você move a ferramenta Wiring sobre um terminal, a área
do terminal pisca, indicando que se clicar irá conectar a ligação a
esse terminal e uma pequena dica aparece, com o nome do terminal.

• Para cancelar uma ligação que você iniciou, pressione a tecla <Esc>,
clique com o botão direito ou clique no terminal de origem.

10. Exiba o painel frontal clicando nele ou selecionando Window»Show
Panel.

11. Salve o VI, pois ele será utilizado posteriormente no curso.

a. Selecione File»Save.

b. Acesse o diretório c:\exercises\LV Basics I.

Nota Salve todos os VIs que você editar neste curso no diretório
c:\exercises\LV Basics I.

c. Digite Convert C to F.vi na caixa de diálogo.

d. Clique no botão Save.

12. Insira um número no controle digital e execute o VI.

a. Utilize a ferramenta Operating, como mostrada à esquerda, ou
Labeling para clicar duas vezes no controle digital e digite um
novo número.

b. Clique no botão Run, como mostrado à esquerda, para executar
o VI.

c. Tente diversos números diferentes e execute o VI novamente.

13. Selecione File»Close para fechar o VI Convert C to F.

Final do exercício 2-1
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B. Técnicas de edição

Criando objetos
Além de criar objetos do painel frontal na paleta Controls, você também
pode criar controles, indicadores e constantes, clicando com o botão direito
em um terminal de nó e selecionando Create no menu de atalho.

Você não pode excluir um terminal de controle ou de indicador do diagrama
de bloco. O terminal somente desaparece depois de você excluir seu objeto
correspondente do painel frontal.

Selecionando objetos
Utilize a ferramenta Positioning para clicar em um objeto, com o intuito
de selecioná-lo no painel frontal e no diagrama de bloco.

Quando o objeto está selecionado, há um contorno tracejado em movimento
ao seu redor. Para selecionar mais de um objeto, pressione a tecla <Shift>
enquanto você clica em cada objeto a ser selecionado.

Você também pode selecionar vários objetos, clicando em uma área aberta
e arrastando o cursor até que todos os objetos estejam no retângulo de
seleção.

Movendo objetos
Você pode mover um objeto, clicando com a ferramenta Positioning nele
e arrastando-o para uma localização desejada. Também pode mover objetos
selecionados, pressionando as teclas de seta. Pressione a tecla <Shift> ao
mesmo tempo que pressiona as teclas de seta para mover objetos diversos
pixels de cada vez.

Você pode restringir a direção de movimentação de um objeto selecionado
para horizontal ou vertical, pressionando a tecla <Shift> enquanto move o
objeto. A direção na qual você move o objeto inicialmente determina se ele
está limitado ao movimento vertical ou horizontal.

Excluindo objetos
Você pode excluir objetos utilizando a ferramenta Positioning para
selecioná-los e pressionando a tecla <Delete> ou selecionando Edit»Clear.

Desfazer/Refazer
Se você cometer algum erro enquanto estiver editando um VI, poderá
desfazer ou refazer os passos selecionando Undo ou Redo no menu Edit.
Você pode definir o número de ações que poderão ser desfeitas ou refeitas,
selecionando Tools»Options e, em seguida, Block Diagram no menu
superior.
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Duplicando objetos
Você pode duplicar a maioria dos objetos, pressionando a tecla <Ctrl>,
enquanto estiver utilizando a ferramenta Positioning para clicar e arrastar
uma seleção.

(Macintosh) Pressione a tecla <Option>. (Sun) Pressione a tecla <Meta>.
(HP-UX e Linux) Pressione a tecla <Alt>.

(HP-UX) Você também pode duplicar objetos, clicando e arrastando o objeto
com o botão do meio do mouse.

Depois de arrastar a seleção para uma nova localização e soltar o botão do
mouse, uma cópia do ícone aparece na nova localização e o ícone original
permanece na localização antiga. Este processo é chamado de clonagem.

Você também pode duplicar objetos, selecionando Edit»Copy e,
em seguida, Edit»Paste.

Rotulando objetos
Utilize títulos para identificar objetos no painel frontal e no diagrama de
bloco. O LabVIEW inclui dois tipos de títulos: títulos do objeto e legendas
livres. Os títulos pertencem a um objeto específico e são movidos com ele
e fazem comentários somente a esse objeto. Um título do objeto pode ser
movido independentemente, mas quando você move o objeto que possui
o título, o título move-se com o objeto. As legendas livres não são ligadas
a nenhum objeto, e você pode criá-las, movê-las, girá-las ou excluí-las
independentemente. Utilize-os para fazer anotações nos painéis frontais
e diagramas de bloco.

Para criar uma legenda livre, utilize a ferramenta Labeling para clicar em
qualquer área aberta e digite o texto a ser exibido no título da caixa que
aparece. Após a digitação do título, clique em qualquer lugar fora dele ou no
botão Enter da barra de ferramentas. A tecla <Enter> adiciona uma nova
linha. Pressione as teclas <Shift-Enter> para finalizar a entrada de texto.
Para finalizar a entrada de texto com a tecla <Enter>, selecione Tools»
Options, selecione Front Panel no menu superior e marque a caixa de
seleção End text entry with Return key.

(Macintosh) A tecla <Return> adiciona uma nova linha.
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Selecionando e excluindo ligações
Um segmento de ligação é um único trecho de ligação horizontal ou vertical.
Uma curva em uma ligação é a junção de dois segmentos. O ponto em
que três ou quatro segmentos de ligação se unem é uma junção. Uma
ramificação de ligação conterá todos os segmentos de ligação, de junção
a junção, de terminal a junção ou de terminal a terminal, se não houver
junções entre os terminais. Para selecionar um segmento de ligação, utilize
a ferramenta Positioning para clicar na ligação. Clique duas vezes para
selecionar uma ramificação e clique três vezes para selecionar a ligação
inteira.

Extensão da ligação
Você pode mover um ou mais objetos ligados, utilizando a ferramenta
Positioning, para arrastar os objetos selecionados para uma nova
localização, como mostrado no exemplo a seguir.

1 Segmento
2 Junção
3 Curva

4 Ramificação
5 Seleciona um

segmento

6 Seleciona uma ramificação
7 Seleciona uma ligação inteira

1 2 3

1

4
2

3 5 6 7

1 2 3
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Ligações interrompidas
Uma ligação interrompida aparece como uma linha preta tracejada,
conforme mostrado no exemplo a seguir. Ligações interrompidas ocorrem
por vários motivos, como quando você tenta ligar dois objetos com tipos de
dados incompatíveis.

Mova a ferramenta Wiring sobre uma ligação interrompida para visualizar
a pequena dica que descreve o porquê que a ligação foi interrompida. Clique
três vezes na ligação com a ferramenta Positioning e pressione a tecla
<Delete> para remover uma ligação interrompida. Você pode remover todas
as ligações interrompidas, selecionando Edit»Remove Broken Wires.

Cuidado Tenha cuidado ao remover todas as ligações interrompidas. Algumas vezes
uma ligação parece estar interrompida, pois você não concluiu a ligação do diagrama
de bloco.

Alterando fonte, estilo e tamanho de texto
Você pode alterar a fonte, o estilo, o tamanho e o alinhamento de qualquer
texto exibido em um título ou o display de um controle ou indicador,
selecionando o menu Text Settings na barra de ferramentas.

Determinados controles e indicadores utilizam texto em mais de um display.
Os exemplos incluem eixos de gráficos e indicadores digitais ou marcadores
de escala em escalas numéricas.

1 Ligação tracejada (interrompida) 2 Ligação sólida (correta)

1

2
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Você pode modificar cada exibição de texto de maneira independente,
utilizando a ferramenta Labeling para destacar o texto, como mostrado no
gráfico a seguir. Em seguida, selecione o menu Text Settings na barra de
ferramentas.

Redimensionando objetos
Você pode alterar o tamanho da maioria dos objetos do painel frontal.
Quando você move a ferramenta Positioning sobre um objeto
redimensionável, alças de redimensionamento, como mostradas à
esquerda, aparecem nos cantos de um objeto retangular ou círculos
de redimensionamento aparecem em um objeto circular. Quando você
redimensiona um objeto, o tamanho de fonte permanece o mesmo. Arraste
as alças ou os círculos de redimensionamento até que a borda tracejada
esteja contornando o tamanho de objeto desejado e solte o botão do mouse.
Pressione a tecla <Shift> enquanto arrasta as alças ou os círculos de
redimensionamento para manter o objeto proporcional a seu tamanho
original.

Você também pode redimensionar objetos do diagrama de bloco,
como estruturas e constantes.

Alinhando e distribuindo objetos
Para alinhar um grupo de objetos ao longo dos eixos, selecione os objetos
a serem alinhados e depois selecione o menu Align Objects na barra de
ferramentas. Para distribuir objetos uniformemente, selecione os objetos
e o menu Distribute Objects na barra de ferramentas.

Copiando objetos entre VIs e de outras aplicações
Você pode copiar e colar objetos de um VI para outro, selecionando
Edit»Copy e, em seguida, Edit»Paste. Também pode copiar imagens ou
texto de outras aplicações e colá-los no painel frontal ou diagrama de bloco.
Se os dois VIs estiverem abertos, você poderá copiar objetos entre VIs,
arrastando-os de um VI ao outro.
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Colorindo objetos
Você pode alterar a cor de vários objetos, mas não de todos eles. Por
exemplo, os terminais do diagrama de bloco de ligações e objetos do painel
frontal utilizam cores específicas para o tipo e a representação de dados que
eles contêm. Portanto, suas cores não podem ser alteradas.

Utilize a ferramenta Coloring e clique com o botão direito em um objeto
ou espaço de trabalho para adicionar ou alterar a cor de objetos do painel
frontal ou de espaços de trabalho do painel frontal e diagrama de bloco.
Você também pode alterar as cores padrão da maioria dos objetos,
selecionando Tools»Options e Colors no menu superior.

Além disso, também pode tornar objetos do painel frontal transparentes para
colocá-los em camadas. Clique com o botão direito em um objeto com a
ferramenta Coloring e selecione a caixa que possui uma letra T dentro dela
para tornar um objeto transparente.



Lição 2 Criando, editando e depurando um VI

© National Instruments Corporation 2-17 Manual de treinamento do LabVIEW Básico I

Exercise 2-2 VI Editing Exercise
Objetivo: Editar um VI.

Complete os passos a seguir para modificar o VI Editing Exercise já
existente, conforme o painel frontal a seguir, e para ligar os objetos
no diagrama de bloco com o intuito de tornar o VI operacional.

Nota Lembre-se de que você pode selecionar Edit»Undo se cometer algum erro.

Painel frontal
1. Selecione File»Open e acesse o diretório c:\exercises\

LV Basics I para abrir o VI Editing Exercise.

(Windows, Sun e HP-UX) Se você fechou todos os VIs abertos, clique no
botão Open VI na caixa de diálogo LabVIEW.

2. Reposicione o controle digital.

a. Utilize a ferramenta Positioning, como mostrada à esquerda, para
clicar no controle digital e arrastá-lo para um outro local. O título do
controle segue sua posição.

b. Clique em um espaço em branco do painel frontal para desmarcar
o controle.

c. Clique no título e arraste-o para uma outra localização. O controle
não segue a posição do título. É possível posicionar o título de um
objeto em qualquer local. O título segue seu objeto, se você mover
o objeto.
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3. Reposicione as três chaves deslizantes em um grupo.

a. Utilize a ferramenta Positioning para clicar em uma área aberta,
próxima às três chaves, e arraste um retângulo de seleção ao redor
das chaves.

b. Clique e arraste uma das chaves selecionadas para uma localização
diferente. Todas as chaves selecionadas são movidas juntas.

4. Alinhe os três LEDs no sentido horizontal e distribua-os de maneira
uniforme.

a. Utilize a ferramenta Positioning para clicar em uma área aberta,
próxima aos três LEDs, e arraste um retângulo de seleção ao redor
dos LEDs.

b. Selecione o menu Align Objects na barra de ferramentas e selecione
Vertical Centers, como mostrado à esquerda, para alinhar os LEDs
no sentido horizontal.

c. Selecione o menu Distribute Objects na barra de ferramentas e
selecione Horizontal Centers, como mostrado à esquerda, para
distribuir os LEDs de maneira uniforme.

5. Redimensione o LED redondo.

a. Mova a ferramenta Positioning sobre o LED. Círculos de
redimensionamento aparecem no LED.

b. Clique no cursor e arraste-o para aumentar o LED. Pressione a tecla
<Shift> enquanto arrasta o cursor para manter o LED proporcional
a seu tamanho original.

6. Altere a cor do LED redondo.

a. Como padrão, o estado do LED é OFF (Desligado) e sua cor é verde
escuro (FALSE). Utilize a ferramenta Operating, como mostrada à
esquerda, para clicar no LED e alterar seu estado para ON (Ligado)
e sua cor para verde claro (TRUE).

b. Utilize a ferramenta Coloring, como mostrada à esquerda, para
clicar com o botão direito no LED e exibir a paleta de cores.

c. Selecione uma cor vermelho para alterar o estado ON para
vermelho.

7. Exiba e edite o título do objeto do indicador digital.

a. Utilize a ferramenta Labeling, como mostrada à esquerda, para
clicar com o botão direito no indicador digital e selecione Visible
Items»Label no menu de atalho. Uma pequena caixa aparece, com
um cursor de texto na margem esquerda para digitar o texto no título.

b. Digite Digital Indicator na caixa.

c. Clique em qualquer lugar fora do título ou clique no botão Enter
da barra de ferramentas, como mostrado à esquerda, para finalizar.
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8. Exclua o controle de string.

a. Utilize a ferramenta Positioning para selecionar o controle de string.

b. Pressione a tecla <Delete> ou selecione Edit»Clear.

9. Duplique a legenda livre.

a. Pressione a tecla <Ctrl> e utilize a ferramenta Positioning para
clicar na legenda.

(Macintosh) Pressione a tecla <Option>. (Sun) Pressione a
tecla <Meta>. (HP-UX e Linux) Pressione a tecla <Alt>.

b. Arraste a cópia para um novo local.

10. Altere as características do texto e oculte a caixa ao redor da legenda
livre.

a. Utilize a ferramenta Positioning para selecionar a legenda livre.

b. Selecione o menu Text Settings na barra de ferramentas, como
mostrado à esquerda, e altere as características do texto.

c. Utilize a ferramenta Coloring para clicar com o botão direito no
título e selecione a letra T no selecionador de cores.

11. Altere as características do texto e a cor do texto do eixo y.

a. Utilize a ferramenta Labeling para destacar 10.0 no eixo y.

b. Selecione o menu Text Settings na barra de ferramentas e altere
as características e a cor do texto.

12. Clique duas vezes em 0.0 e digite 10.0 para alterar a faixa do eixo y.

Diagrama de bloco
13. Selecione Window»Show Diagram para exibir o diagrama de bloco.

Ligue os terminais do diagrama de bloco conforme mostrado na figura
a seguir.
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• A função Multiply multiplica uma constante numérica, 5.00,
pelo valor do controle digital.

• O VI Uniform White Noise gera um padrão pseudo-aleatório
uniformemente distribuído, cujos valores estão na faixa [–a:a], em
que a é o valor absoluto de amplitude, 10.00, e transfere o padrão
para o gráfico de forma de onda.

• A função Not inverte o valor da chave Booleana A e transfere
o valor para o LED.

14. Clique com o botão direito no terminal inferior esquerdo da função
Multiply e selecione Create»Constant no menu de atalho para criar
uma constante numérica, como mostrada à esquerda.

15. Digite 5 na caixa de texto e clique no botão Enter da barra de
ferramentas.

16. Utilize a ferramenta Wiring, como mostrada à esquerda, e os passos
a seguir para ligar o diagrama de bloco:

• Selecione Help»Show Context Help para exibir a janela Context
Help. Utilize essa janela para determinar quais terminais são
obrigatórios. Os terminais obrigatórios estão em negrito, as
conexões recomendadas estão em texto comum e as conexões
opcionais estão em cinza.

• Para identificar terminais nos nós, clique com o botão direito no
ícone e selecione Visible Items»Terminal no menu de atalho para
exibir o painel de conectores. Quando a ligação estiver concluída,
clique com o botão direito no painel de conectores e selecione
Visible Items»Terminal no menu de atalho para remover a marca
de verificação.

• Para adicionar uma ramificação a uma ligação, clique no local da
ligação onde você deseja iniciar a ramificação.

• Para cancelar uma ligação que você iniciou, pressione a tecla <Esc>,
clique com o botão direito ou clique no terminal de origem.

17. Selecione File»Save para salvar o VI.

18. Exiba o painel frontal clicando nele ou selecionando Window»
Show Panel.

19. Utilize a ferramenta Operating para alterar o valor dos controles do
painel frontal.

20. Clique no botão Run da barra de ferramentas para executar o VI.

21. Selecione File»Close para fechar o VI.

Final do exercício 2-2
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C. Técnicas de depuração
Se um VI não executar, será um VI com defeito ou não executável. O botão
Run muitas vezes aparece quebrado, como mostrado à esquerda, quando
você cria ou edita um VI. Se ele ainda estiver quebrado quando você
concluir a ligação do diagrama de bloco, o VI estará com defeito e não
executará.

Localizando erros
Clique no botão Run quebrado ou selecione Windows»Show Error List
para exibir a janela Error list, que apresenta uma lista de todos os erros.
Clique duas vezes em uma descrição de erro para exibir o diagrama de bloco
ou o painel frontal e destacar o objeto que contém o erro.

Animação de execução
Visualize uma animação da execução do diagrama de bloco, clicando no
botão Highlight Execution, como mostrado à esquerda. A animação de
execução mostra o movimento de dados no diagrama de bloco de um nó
para outro. Utilize a execução animada juntamente com a execução passo
a passo para ver como os dados se movem de um nó ao outro através de
um VI.

Nota A execução animada reduz bastante a velocidade de execução do VI.

Executando passo a passo
Execute um VI passo a passo para visualizar cada ação do VI no diagrama
de bloco, à medida que o VI é executado. Os botões de execução passo a
passo afetam a execução somente de um VI ou subVI em modo passo a
passo. Entre no modo passo a passo clicando no botão Step Over ou Step
Into. Mova o cursor sobre o botão Step Over, Step Into ou Step Out para
visualizar uma pequena dica que descreve o próximo passo se você clicar no
botão correspondente. Voce pode executar subVIs passo a passo ou
executá-los normalmente.

Se você executar um VI passo a passo com a animação de execução ativada,
uma flecha de execução, como mostrada à esquerda, aparecerá nos ícones
dos subVIs que estão sendo executados no momento.
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Pontas de prova
Utilize a ferramenta Probe, como mostrada à esquerda, para verificar
valores em uma ligação enquanto o VI é executado. Quando a execução é
interrompida em um nó devido a um modo passo a passo ou um ponto de
parada, você também pode sondar a ligação que acabou de ser executada
para ver o valor que passou por essa ligação.

Também pode-se criar uma ponta de prova personalizada para especificar
que indicador você utiliza para visualizar os dados sondados. Por exemplo,
se você estiver visualizando dados numéricos, poderá optar por ver os dados
em um gráfico. Para criar uma ponta de prova, clique com o botão direito
em uma ligação e selecione Custom Probe no menu de atalho.

Pontos de parada
Utilize a ferramenta Breakpoint, como mostrada à esquerda, para indicar um
ponto de parada em um VI, um nó ou uma ligação do diagrama de bloco para
interromper a execução. Quando você define um ponto de parada em uma
ligação, a execução é interrompida depois que os dados passam pela ligação.
Selecione um ponto de parada no espaço de trabalho do diagrama de bloco
para interromper a execução depois que todos os nós do diagrama forem
executados. Pontos de parada são indicados com quadros vermelhos para
nós e diagramas de bloco e pontos vermelhos para ligações. Quando você
move o cursor sobre um ponto de parada já existente, a área em preto do
cursor da ferramenta Breakpoint aparece em branco.
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Exercise 2-3 VI Debug Exercise (principal)
Objetivo: Praticar técnicas de depuração.

Complete os passos a seguir para carregar um VI com defeito e corrigir
o erro e para utilizar execução passo a passo e execução animada para
percorrer o VI.

1. Selecione File»Open e acesse o diretório c:\exercises\
LV Basics I para abrir o VI Debug Exercise (principal).

(Windows, Sun e HP-UX) Se você fechou todos os VIs abertos, clique
no botão Open VI na caixa de diálogo LabVIEW.

O painel frontal a seguir aparece.

O botão Run quebrado, como mostrado à esquerda, aparece na barra
de ferramentas, indicando que o VI está com defeito.

2. Selecione Window»Show Diagram para exibir o seguinte diagrama
de bloco.

A função Random Number (0–1) gera um número aleatório entre 0 e 1.

A função Multiply multiplica o número aleatório por 10.0.

A constante numérica é o número que será multiplicado pelo número
aleatório.

O VI Debug Exercise (sub) adiciona 100.0 e calcula a raiz quadrada
do valor.

3. Localize e corrija cada erro.

a. Clique no botão Run quebrado. A janela Error list que aparece lista
todos os erros.

b. Clique em cada descrição de erro para obter mais informações
sobre ele.
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c. Clique no botão Show Error para exibir o diagrama de bloco
ou painel frontal e para destacar o objeto que contém o erro.

d. Utilize as informações da seção Details para corrigir cada erro.

4. Selecione File»Save para salvar o VI.

5. Exiba o painel frontal clicando nele ou selecionando Window»
Show Panel.

6. Clique no botão Run para executar o VI várias vezes.

7. Selecione Window»Show Diagram para exibir o diagrama de bloco.

8. Visualize o fluxo de dados através do diagrama de bloco.

a. Clique no botão Highlight Execution, como mostrado à esquerda,
para habilitar a execução animada.

b. Clique no botão Step Into, como mostrado à esquerda, para iniciar
a execução passo a passo. A animação de execução mostra o
movimento de dados no diagrama de bloco de um nó para outro.
Os nós piscam com o intuito de indicar que estão prontos para
serem executados.

c. Clique no botão Step Over, como mostrado à esquerda, depois que
cada nó percorrer todo o diagrama de bloco. Cada vez que você
clicar no botão Step Over, o nó atual será executado até o próximo
nó, o qual estará pronto para ser executado novamente.

Os dados aparecem no painel frontal conforme você percorre o VI.
O VI gera um número aleatório e multiplica-o por 10.0. O subVI
adiciona 100.0 e extrai a raiz quadrada do resultado.

d. Quando o contorno do diagrama de bloco piscar, clique no botão
Step Out, como mostrado à esquerda, para cessar a execução passo
a passo no VI Debug Exercise (principal).

9. Execute passo a passo o VI e seu subVI.

a. Clique no botão Step Into para iniciar a execução passo a passo.

b. Quando o VI Debug Exercise (sub) piscar, clique no botão Step
Into. O seguinte diagrama de bloco aparece.

c. Exiba o diagrama de bloco do VI Debug Exercise (principal)
clicando nele. Uma flecha verde, como mostrado à esquerda,
aparece sobre o ícone do subVI do diagrama de bloco do VI Debug
Exercise (principal), indicando que ele está em modo de execução
passo a passo.
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d. Exiba o VI Debug Exercise (sub) clicando nele.

e. Clique no botão Step Out duas vezes para concluir a execução passo
a passo pelo diagrama de bloco do subVI. O diagrama de bloco do
VI Debug Exercise (principal) está ativo.

f. Clique no botão Step Out para interromper a execução passo
a passo.

10. Utilize uma ponta de prova para visualizar os dados à medida que fluem
por uma ligação.

a. Utilize a ferramenta Probe, como mostrada à esquerda, e clique em
qualquer objeto. A seguinte janela aparece.

O número na barra de título da janela Probe corresponde ao número
do diagrama de bloco em que você inseriu a ponta de prova.

b. Execute o VI em modo passo a passo novamente. A janela Probe
exibe os dados à medida que eles fluem por cada segmento de
ligação.

11. Selecione pontos de parada no diagrama de bloco para interromper
a execução nos locais determinados.

a. Utilize a ferramenta Breakpoint, como mostrada à esquerda, para
clicar em nós ou ligações. O clique no espaço de trabalho do
diagrama de bloco é similar a uma parada na primeira linha de
execução.

b. Clique no botão Run para executar o VI. O VI pára nos pontos
de parada definidos.

c. Clique no botão Continue, como mostrado à esquerda, para
continuar a execução do VI.

d. Utilize a ferramenta Breakpoint para clicar nos pontos de paradas
definidos e removê-los.

12. Clique no botão Highlight Execution para desabilitar a execução
animada.

13. Selecione File»Close para fechar o VI e todas as janelas abertas.

Final do exercício 2-3
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Resumo, dicas e suplementos

Resumo
• Você monta o painel frontal com controles e indicadores, que são

os terminais interativos de entrada e saída do VI, respectivamente.

• Os terminais de controle têm uma borda mais espessa que os terminais
de indicador. Para alterar um controle para um indicador, ou vice-versa,
clique com o botão direito no objeto e selecione Change to Indicator
ou Change to Control no menu de atalho.

• O diagrama de bloco é composto por nós, terminais e ligações.

• Utilize a ferramenta Operating para configurar controles e indicadores
do painel frontal. Utilize a ferramenta Positioning para selecionar,
mover e redimensionar objetos. Utilize a ferramenta Wiring para ligar
objetos no diagrama de bloco.

• Utilize o botão Search das paletas Controls e Functions para pesquisar
controles, VIs e funções.

• O botão Run quebrado aparece na barra de ferramentas para indicar
que o VI está com defeito. Clique no botão Run quebrado para exibir
a janela Error list, que apresenta uma lista com todos os erros.

• Utilize execução animada, execução passo a passo, pontas de prova e
pontos de parada para depurar VIs, animando o fluxo de dados através
do diagrama de bloco.

Dicas e suplementos
A maioria das dicas e dos suplementos a seguir instrui você a pressionar
a tecla <Ctrl>.

(Macintosh) Pressione a tecla <Option>, em vez da tecla <Ctrl>.
(Sun) Pressione a tecla <Meta>. (HP-UX e Linux) Pressione a tecla <Alt>.

Operando
• As opções de menu utilizadas com mais freqüência têm atalhos

equivalentes de teclado. Por exemplo, para salvar um VI, você pode
selecionar File»Save ou pressionar as teclas <Ctrl-S>. Atalhos comuns
de teclado são:

<Ctrl-R> Executa um VI.

<Ctrl-E> Alterna entre o painel frontal e o diagrama de bloco.

<Ctrl-H> Exibe ou oculta a janela Context Help.
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<Ctrl-B> Remove todas as ligações interrompidas.

<Ctrl-F> Localiza VIs, globais, funções, texto ou outros objetos
carregados na memória ou em uma lista especificada de
VIs.

• Para alternar entre as ferramentas da paleta Tools, pressione a tecla
<Tab>. Para alternar entre as ferramentas Positioning e Wiring no
diagrama de bloco, ou entre as ferramentas Positioning e Operating
no painel frontal, pressione a barra de espaço.

• Para rapidamente incrementar ou decrementar valores nos controles
digitais, utilize as ferramentas Operating ou Labeling para posicionar o
cursor no controle e pressione a tecla <Shift> juntamente com as teclas
de seta para cima ou para baixo.

• Você pode desabilitar as ferramentas de depuração para reduzir
requisitos de memória e aumentar um pouco o desempenho. Selecione
File»VI Properties, selecione Execution no menu superior e remova
a marca da caixa de seleção Allow Debugging.

Editando
• Utilize os seguintes atalhos para criar constantes, controles e

indicadores:

– Clique com o botão direito em um terminal de função e selecione
Create»Constant, Create»Control ou Create»Indicator no menu
de atalho.

– Arraste controles e indicadores do painel frontal para o diagrama
de bloco com o intuito de criar uma constante.

– Arraste constantes do diagrama de bloco para o painel de controle
a fim de criar um controle.

• Para duplicar um objeto, pressione a tecla <Ctrl> enquanto estiver
utilizando a ferramenta Positioning para clicar em uma seleção e
arrastá-la.

• Para restringir a direção de movimento de um objeto à horizontal
ou vertical, utilize a ferramenta Positioning para selecionar o objeto
e pressione a tecla <Shift> enquanto o move.

• Para manter um objeto proporcional a seu tamanho original conforme
você o redimensiona, pressione a tecla <Shift> enquanto arrasta as alças
ou os círculos de redimensionamento.

• Para redimensionar um objeto à medida que o coloca no painel frontal,
pressione a tecla <Ctrl> enquanto você clica para posicionar o objeto
e arrasta as alças ou os círculos de redimensionamento.

• Para substituir nós, clique com o botão direito no nó e selecione Replace
no menu de atalho.
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• Para exibir o diagrama de bloco de um subVI a partir da chamada de VI,
pressione a tecla <Ctrl> e utilize a ferramenta Operating ou Positioning
para clicar duas vezes no subVI do diagrama de bloco.

• Para exibir o painel frontal de um subVI a partir da chamada de VI,
utilize a ferramenta Operating ou Positioning para clicar duas vezes
no subVI do diagrama de bloco. Você também pode selecionar
Browse»This VI’s SubVIs.

• Após a digitação de um título, pressione as teclas <Shift-Enter> para
finalizar a entrada de texto.

• Para adicionar itens rapidamente a controles de anel e estruturas Case,
pressione as teclas <Shift-Enter> após cada item. Pressionando-se as
teclas <Shift-Enter> aceita-se o item e posiciona-se o cursor para
adicionar o próximo item.

• Para copiar a cor de um objeto e transferi-la para um segundo objeto,
sem utilizar um selecionador de cores, utilize a ferramenta Color
Copy para clicar no objeto do qual você deseja copiar a cor. Utilize
a ferramenta Coloring para clicar no objeto a ser aplicada a cor. Você
também pode copiar a cor de um objeto, utilizando a ferramenta
Coloring e pressionando a tecla <Ctrl>.

• Selecione Edit»Undo se cometer um erro.

• Para criar mais espaço em branco no diagrama de bloco, pressione
a tecla <Ctrl> enquanto você utiliza a ferramenta Positioning para
desenhar um retângulo no diagrama de bloco.

Ligando
• Selecione Help»Show Context Help para exibir a janela Context Help.

Utilize essa janela para determinar quais terminais são obrigatórios.
Os terminais obrigatórios estão em negrito, as conexões recomendadas
estão em texto comum e as conexões opcionais estão em cinza.

• Pressione a barra de espaço para alternar a direção da ligação.

• Você pode curvar uma ligação, clicando para fixá-la e movendo o cursor
em uma direção perpendicular. Para fixar uma ligação e interrompê-la,
clique duas vezes.
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• Para mostrar pontos em junções de ligações no diagrama de bloco,
selecione Tools»Options e Block Diagram no menu superior.

• Para mover objetos um pixel, pressione as teclas de seta. Para mover
objetos vários pixels, pressione a tecla <Shift> juntamente com as teclas
de seta.

• Para cancelar uma ligação que você iniciou, pressione a tecla <Esc>,
clique com o botão direito ou clique no terminal de origem.

• Utilize as pequenas dicas que aparecem à medida que você move
a ferramenta Wiring sobre os terminais.

• Exiba o painel de conectores clicando com o botão direito no nó
e selecionando Visible Items»Terminals no menu de atalho.

Depurando
• Ao executar em modo passo a passo, utilize os seguintes atalhos

de teclado:

<Ctrl-seta para baixo> Vai para um nó.

<Ctrl-seta para a direita> Executa um nó passo a passo.

<Ctrl-seta para cima> Sai de um nó.

1 Fixar uma ligação clicando nela
2 Fixar e interromper a ligação clicando duas vezes

1
2

1 2
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Exercícios adicionais
2-4 Monte um VI que compare dois números e acenda um LED se

o primeiro número for maior ou igual ao segundo número.

Tip Utilize a função Greater or Equal?, localizada na paleta Functions»Comparison.

Salve o VI como Compare.vi.

2-5 Monte um VI que gere um número aleatório entre 0.0 e 10.0 e
divida esse número por um número especificado no painel frontal.
Se o número inserido for 0, o VI deverá acender um LED do painel
frontal para indicar um erro de divisão por zero.

Salve o VI como Divide.vi.
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Anotações
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Anotações
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Lição 3
Criando um subVI

Esta lição descreve o painel de ícones e conectores de um VI e descreve
como você pode utilizar um VI como um subVI em outros VIs.

Você aprenderá:

A. O que é um subVI

B. Como criar um painel de ícones e conectores

C. Como utilizar um VI como um subVI

D. Como criar subVIs a partir de seções de um outro VI
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A. SubVIs
Após a montagem de um VI e a criação de seu painel de ícones e conectores,
você pode utilizá-lo em um outro VI. Um VI dentro de um outro VI é
chamado subVI. Um subVI corresponde a uma sub-rotina em linguagens
de programação baseadas em texto. Um nó de subVI corresponde a uma
chamada de sub-rotina em linguagens de programação baseadas em texto.
O nó não é o subVI propriamente dito, assim como uma declaração de
chamada de sub-rotina em um programa não é a sub-rotina propriamente
dita. A utilização de subVIs ajuda você a gerenciar alterações e a depurar
o diagrama de bloco rapidamente. Consulte o Manual de treinamento do
LabVIEW Básico II para obter mais informações sobre desenvolvimento
de aplicações.

O pseudocódigo e os diagrama de bloco a seguir demonstram a analogia
entre subVIs e sub-rotinas.

Código de função Código de chamada de programa

function average (in1, 
in2, out)

{
out = (in1 + in2) / 2.0;

}

main 
{
average (point1, point2,

pointavg)

}

Diagrama de bloco do subVI
Diagrama de bloco
de chamada de VI
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B. Painel de ícones e conectores
Após a montagem do painel frontal e do diagrama de bloco de um VI,
monte o painel de ícones e conectores para que você possa utilizar o VI
como um subVI.

Criando um ícone
Todos os VIs exibem um ícone, como mostrado à esquerda, no canto
superior direito das janelas do painel frontal e do diagrama de bloco.
Um ícone é a representação gráfica de um VI. Pode conter texto, imagens
ou uma combinação de ambos. Se você utilizar um VI como um subVI,
o ícone identificará o subVI no diagrama de bloco do VI.

O ícone padrão contém um número que indica quantos novos VIs você
abriu desde a inicialização do LabView. Crie ícones personalizados para
substituir o ícone padrão, clicando com o botão direito no ícone que está
no canto superior direito do painel frontal ou do diagrama de bloco,
selecionando Edit Icon no menu de atalho ou clicando duas vezes no ícone
no canto superior direito do painel frontal. Você também pode editar ícones
selecionando File»VI Properties, selecionando General no menu
Category na barra de ferramentas e clicando no botão Edit Icon.

Utilize as ferramentas que estão do lado esquerdo da caixa de diálogo Icon
Editor para criar o desenho do ícone na área de edição. A imagem do ícone
em tamanho normal aparece na caixa adequada, à direita da área de edição,
como mostrado na caixa de diálogo a seguir.
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Você também pode arrastar um gráfico de qualquer lugar do seu sistema
de arquivo e pode soltá-lo no canto superior direito do painel frontal
ou diagrama de bloco. O LabVIEW converte o gráfico em um ícone de
32 × 32 pixels.

Dependendo do tipo de monitor que você utiliza, poderá projetar um
ícone separado para modo de cor monocromático, de 16 e de 256 cores.
O LabVIEW utiliza o ícone monocromático na impressão, a não ser que
você tenha uma impressora colorida. O padrão é o modo de 256 cores.
Selecione a opção Copy from para alterar modos.

Utilize as ferramentas que estão do lado esquerdo da caixa de diálogo
Icon Editor para executar as seguintes tarefas:

Utilize a ferramenta Pencil para desenhar e apagar pixel por pixel.

Utilize a ferramenta Line para desenhar linhas retas. Para desenhar linhas
horizontais, verticais e diagonais, pressione a tecla <Shift> enquanto você
utiliza essa ferramenta para arrastar o cursor.

Utilize a ferramenta Color Copy para copiar a cor de primeiro plano de um
elemento no ícone.

Utilize a ferramenta Fill para preencher uma área delimitada com a cor de
primeiro plano.

Utilize a ferramenta Rectangle para desenhar uma borda retangular na cor
de primeiro plano. Clique duas vezes nessa ferramenta para enquadrar o
ícone na cor de primeiro plano.

Utilize a ferramenta Filled Rectangle para desenhar um retângulo com um
quadro de cor de primeiro plano e preenchido com a cor de fundo. Clique
duas vezes nessa ferramenta para enquadrar o ícone na cor de primeiro
plano e preenchê-lo com a cor de fundo.

Utilize a ferramenta Select a fim de selecionar uma área do ícone para
recortar, copiar, mover ou fazer outras alterações. Clique duas vezes nessa
ferramenta e pressione a tecla <Delete> para excluir o ícone inteiro.

Utilize a ferramenta Text para inserir texto no ícone. Clique duas vezes
nessa ferramenta para selecionar uma fonte diferente. (Windows) A opção
Small Fonts funciona bem em ícones.

Utilize a ferramenta Foreground/Background para exibir as cores de
primeiro plano e de fundo. Clique em cada retângulo para exibir uma paleta
de cores, em que você pode selecionar novas cores.
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Utilize as opções do lado direito da área de edição para executar as seguintes
tarefas:

• Show Terminals: exibe o padrão de terminal do painel de conectores

• OK: salva o desenho como um ícone e retorna ao painel frontal

• Cancel: retorna ao painel frontal sem salvar as alterações

A barra de menus na caixa de diálogo Icon Editor contém mais opções
de edição, como Undo, Redo, Cut, Copy, Paste e Clear.

Configurando o painel de conectores
Para utilizar um VI como subVI, é necessário montar um painel de
conectores, como mostrado à esquerda. O painel de conectores é um
conjunto de terminais que corresponde aos controles e indicadores do VI,
semelhante à lista de parâmetros de uma chamada de função em linguagens
de programação baseadas em texto. O painel de conectores define as
entradas e saídas que podem ser ligadas ao VI para que ele possa ser
utilizado como um subVI.

Defina as conexões atribuindo um controle ou indicador de painel frontal
a cada um dos terminais do painel de conectores. Para definir um painel
de conectores, clique com o botão direito no ícone, localizado no canto
superior direito do painel frontal, e selecione Show Connector no menu de
atalho. O painel de conectores substitui o ícone. Cada retângulo do painel
de conectores representa um terminal. Utilize os retângulos para atribuir
entradas e saídas. O número de terminais que o LabVIEW exibe no painel
de conectores depende do número de controles e indicadores do painel
frontal. O painel frontal a seguir tem quatro controles e um indicador. Dessa
forma, o LabVIEW exibe quatro terminais de entrada e um terminal de saída
no painel de conectores.
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Selecionando e modificando padrões de terminal
Selecione um padrão diferente de terminal para um VI, clicando com o
botão direito no painel de conectores e selecionando Patterns no menu
de atalho. Selecione um padrão de painel de conectores com terminais
adicionais. Você pode deixar os terminais adicionais desconectados até
necessitar deles. Esta flexibilidade permite fazer alterações, provocando
mínimo efeito na hierarquia dos VIs. Você também pode ter mais controles
ou indicadores de painel frontal do que terminais.

Uma borda sólida destaca o padrão associado ao ícone no momento.
O número máximo de terminais disponíveis para um subVI é 28.

Nota Tente não atribuir mais do que 16 terminais para um VI. Terminais em excesso
podem reduzir a leitura e a utilidade do VI.

Para alterar a organização espacial dos padrões do painel de conectores,
clique com o botão direito no painel de conectores e selecione Flip
Horizontal, Flip Vertical ou Rotate 90 Degrees no menu de atalho.

Atribuindo terminais a controles e indicadores
Após a seleção de um padrão a ser utilizado em seu painel de conectores,
você deve definir conexões, atribuindo um controle ou indicador de painel
frontal a cada um dos terminais do painel de conectores. Quando você
conectar controles e indicadores ao painel de conectores, coloque as
entradas do lado esquerdo e as saídas do lado direito para evitar ligações
complicadas e pouco evidentes em seus VIs.

Para atribuir um terminal a um controle ou indicador de painel frontal,
clique em um terminal do painel de conectores. Clique no controle ou
indicador do painel frontal a ser atribuído ao terminal. Clique em uma
área aberta do painel frontal. A cor do terminal é alterada para a mesma
cor do tipo de dados do controle, indicando que você conectou o terminal.

Você também pode selecionar o controle ou indicador primeiro e,
em seguida, selecionar o terminal.

Nota Apesar de você utilizar a ferramenta Wiring para atribuir terminais do painel de
conectores a controles e indicadores do painel frontal, nenhuma ligação é feita entre o
painel de conectores e esses controles e indicadores.
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Exercise 3-1 VI Convert C to F
Objetivo: Criar um painel de ícones e conectores para que você possa utilizar

um VI como um subVI.

Complete os passos a seguir para criar um painel de ícones e conectores para
o VI que você criou com o intuito de alterar temperaturas de graus C para
graus F.

Painel frontal
1. Selecione File»Open e acesse o diretório c:\exercises\

LV Basics I a fim de abrir o VI Convert C to F.

(Windows, Sun e HP-UX) Se você fechou todos os VIs abertos, clique
no botão Open VI na caixa de diálogo LabVIEW.

Tip Clique na seta ao lado do botão Open VI, na caixa de diálogo LabVIEW, para abrir
arquivos abertos recentemente, como Convert C to F.vi.

O seguinte painel frontal aparece.

2. Clique com o botão direito no ícone localizado no canto superior direito
do painel frontal e selecione Edit Icon no menu de atalho. A caixa de
diálogo Icon Editor aparece.

3. Clique duas vezes na ferramenta Select, como mostrada à esquerda,
localizada no lado esquerdo da caixa de diálogo Icon Editor, para
selecionar o ícone padrão.

4. Pressione a tecla <Delete> para remover o ícone padrão.

5. Clique duas vezes na ferramenta Rectangle, como mostrada à esquerda,
para redesenhar a borda.
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6. Crie o seguinte ícone.

a. Utilize a ferramenta Text, como mostrada à esquerda, para clicar
na área de edição.

b. Digite C e F.

c. Clique duas vezes na ferramenta Text e altere a fonte para Small
Fonts.

d. Utilize a ferramenta Pencil, como mostrada à esquerda, para criar
a seta.

Nota Para desenhar linhas retas horizontais e verticais, pressione a tecla <Shift>
enquanto você utiliza a ferramenta Pencil para arrastar o cursor.

e. Utilize a ferramenta Select e as teclas de seta para mover o texto
e a seta criados.

f. Selecione o ícone B & W e selecione 256 Colors no campo Copy
from para criar um ícone preto-e-branco, que o LabVIEW utiliza
para impressão, a não ser que você tenha uma impressora colorida.

g. Quando o ícone estiver completo, clique no botão OK para fechar a
caixa de diálogo Icon Editor. O ícone aparece no ícone localizado
no canto superior direito do painel frontal e do diagrama de bloco.

7. Clique com o botão direito no ícone do painel frontal e selecione Show
Connector no menu de atalho para definir o padrão de terminal do
painel de conectores.

O LabVIEW seleciona um padrão de painel de conectores com base
no número de controles e indicadores do painel frontal. Por exemplo,
este painel frontal tem dois terminais, deg C e deg F, dessa forma o
LabVIEW seleciona um padrão de painel de conectores com dois
terminais, como os mostrados à esquerda.
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8. Atribua os terminais ao controle e ao indicador digital.

a. Selecione Help»Show Context Help para exibir a janela Context
Help. Visualize cada conexão na janela Context Help, à medida que
são estabelecidas.

b. Clique no terminal esquerdo do painel de conectores. A ferramenta
automaticamente é alterada para a ferramenta Wiring e a cor do
terminal muda para preta.

c. Clique no controle deg C. A cor do terminal esquerdo muda para
laranja e uma marca destaca o controle.

d. Clique em uma área aberta do painel frontal. A marca desaparece e
a cor do terminal é alterada para a cor do tipo de dados do controle,
indicando que você conectou o terminal.

e. Clique no terminal direito do painel de conectores e clique no
indicador deg F. A cor do terminal direito muda para laranja.

f. Clique em uma área aberta do painel frontal. Ambos os terminais
estão na cor laranja.

g. Mova o cursor sobre o painel de conectores. A janela Context Help
mostra que os dois terminais estão conectados a valores de ponto
flutuante.

9. Selecione File»Save para salvar o VI, pois você o utilizará
posteriormente no curso.

10. Selecione File»Close para fechar o VI Convert C to F.

Final do exercício 3-1
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C. Utilizando subVIs
Após a montagem de um VI e a criação de seu painel de ícones e conectores,
você pode utilizá-lo como um subVI. Para indicar um subVI no diagrama
de bloco, selecione Functions»Select a VI. Acesse o VI que você deseja
utilizar como um subVI, clique duas vezes nele e posicione-o no diagrama
de bloco.

Você também pode posicionar um VI aberto no diagrama de bloco de um
outro VI aberto, utilizando a ferramenta Positioning para clicar no ícone no
canto superior direito do painel frontal ou diagrama de bloco do VI a ser
utilizado como um subVI e para arrastar o ícone para o diagrama de bloco
do outro VI.

Abrindo e editando subVIs
Para exibir o painel frontal de um subVI a partir da chamada de VI, utilize
a ferramenta Operating ou Positioning para clicar duas vezes no subVI
do diagrama de bloco. Você também pode selecionar Browse»This VI’s
SubVIs. Para exibir o diagrama de bloco de um subVI a partir da chamada
de VI, pressione a tecla <Ctrl> e utilize a ferramenta Operating ou
Positioning para clicar duas vezes no subVI do diagrama de bloco.

(Macintosh) Pressione a tecla <Option>. (Sun) Pressione a tecla <Meta>.
(HP-UX e Linux) Pressione a tecla <Alt>.

Todas as alterações feitas a um subVI afetam apenas a ocorrência atual do
subVI, até você o salvar. Quando você salva o subVI, as alterações afetam
todas as chamadas feitas para o subVI, não apenas a ocorrência atual.

Definindo entradas e saídas obrigatórias, recomendadas e opcionais
Na janela Context Help, que você poderá acessar selecionando Help»Show
Context Help, as conexões obrigatórias estarão em negrito, as conexões
recomendadas estarão em texto normal e as conexões opcionais estarão em
cinza, se você selecionou a imagem Detailed, ou não aparecerão se você
selecionou a imagem Simple.

Você pode designar quais entradas e saídas são obrigatórias, recomendadas
e opcionais para evitar que os usuários se esqueçam de estabelecer conexões
de subVIs.

Clique com o botão direito no painel de conectores e selecione This
Connection Is no menu de atalho. Uma marca de verificação indica
a configuração do terminal. Selecione Required, Recommended ou
Optional.
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Quando uma entrada ou saída é obrigatória, você não pode executar o VI
como um subVI sem o ligar corretamente. Quando uma entrada ou saída é
recomendada, você pode executar o VI, mas o LabVIEW relata um aviso na
janela Window»Show Error List se você colocou uma marca na caixa de
seleção Show Warnings da janela Error list. O LabVIEW utiliza o valor
padrão para entradas e saídas opcionais não ligadas e não relata nenhum
aviso.

O LabVIEW define entradas e saídas de VIs que você cria, por padrão,
para a opção Recommended. Defina uma configuração de terminal como
obrigatória somente se o VI tiver de ter a entrada ou a saída para que execute
corretamente. Consulte a função Read File, localizada na paleta Functions»
File I/O, para obter exemplos de entradas e saídas obrigatórias,
recomendadas e opcionais.



Lição 3 Criando um subVI

Manual de treinamento do LabVIEW Básico I 3-12 ni.com

Exercise 3-2 VI Thermometer
Objetivo: Montar um VI e criar seu painel de ícones e conectores para que você

o possa utilizar como um subVI.

Complete os passos a seguir para criar um VI que mede temperatura,
utilizando o sensor de temperatura do DAQ Signal Accessory. O sensor
retorna uma tensão proporcional à temperatura. Por exemplo, se a
temperatura for 23 °C, a tensão de saída do sensor será 0,23 V.
Você também pode exibir a temperatura em graus Fahrenheit.

Meça a tensão utilizando o dispositivo DAQ plug-in do computador e
converta a tensão em uma leitura de temperatura. O sensor está conectado
fisicamente ao canal 0 do dispositivo DAQ.

Painel frontal
1. Selecione File»New para abrir um novo painel frontal.

(Windows, Sun e HP-UX) Se você fechou todos os VIs abertos, clique
no botão New VI na caixa de diálogo LabVIEW.

2. Crie o indicador de termômetro, como mostrado no seguinte painel
frontal.

a. Selecione o termômetro na paleta Controls»Numeric e posicione-o
no painel frontal.

b. Digite Temperature dentro do título e clique fora dele ou clique no
botão Enter da barra de ferramentas, como mostrado à esquerda.

c. Clique com o botão direito no termômetro e selecione Visible
Items»Digital Display no menu de atalho a fim de exibir o display
digital para o termômetro.

3. Crie um interruptor vertical.

a. Selecione a chave toggle vertical na paleta Controls»Boolean.

b. Digite Temp Scale dentro do título e clique fora dele ou clique
no botão Enter.
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c. Utilize a ferramenta Labeling, como mostrada à esquerda, para criar
uma legenda livre, deg C, ao lado da posição TRUE da chave, como
mostrado no painel frontal anterior.

d. Posicione uma legenda livre, deg F, ao lado da posição FALSE
da chave.

4. Faça uma descrição para o VI que aparece na janela Context Help
quando você move o cursor sobre o ícone do VI.

a. Selecione File»VI Properties. A caixa de diálogo VI Properties
aparece.

b. Selecione Documentation no menu Category na barra de
ferramentas.

c. Digite a seguinte descrição para o VI no campo VI Description:
Esse VI mede a temperatura utilizando o sensor de 
temperatura do DAQ Signal Accessory.

d. Clique no botão OK.

5. Faça uma descrição para o indicador de termômetro e para o interruptor
que aparecem na janela Context Help quando você move o cursor sobre
um objeto, e também com pequenas dicas que aparecem no painel
frontal e no diagrama de bloco quando você executa essa mesma ação.

a. Clique com o botão direito no indicador de termômetro e selecione
Description and Tip no menu de atalho.

b. Digite a seguinte descrição para o termômetro no campo
Description:
Demonstra a medida de temperatura.

c. Digite temperature no campo Tip.

d. Clique no botão OK.

e. Clique com o botão direito no interruptor vertical e selecione
Description and Tip no menu de atalho.

f. Digite a seguinte descrição para o interruptor vertical no campo
Description:
Determina a escala (Celsius ou Fahrenheit) utilizada 
para medir a temperatura.

g. Digite scale - C or F no campo Tip.

h. Clique no botão OK.

6. Selecione Help»Show Context Help para exibir a janela Context Help.

7. Mova o cursor sobre os objetos do painel frontal e o ícone do VI para
exibir as descrições na janela Context Help.
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Diagrama de bloco
8. Selecione Window»Show Diagram para exibir o diagrama de bloco.

9. Monte o seguinte diagrama de bloco.

a. Selecione o VI Read Voltage, localizado na paleta Functions»
User Libraries»Basics I Course. Esse VI faz a leitura da tensão
em Channel 0 ou device 1.

Nota Se um dispositivo DAQ e/ou DAQ Signal Accessory não estiverem disponíveis,
utilize o VI (Demo) Read Voltage, localizado na paleta Functions»User Libraries»
Basics I Course, em vez do VI Read Voltage, para simular a operação do VI Read
Voltage.

b. Selecione a função Multiply, localizada na paleta Functions»
Numeric. Essa função multiplica a tensão que o VI Read Voltage
retorna por 100.0 para obter a temperatura em graus Celsius.

c. Selecione Functions»Select a VI. Acesse o diretório
c:\exercises\LV Basics I, clique duas vezes no VI Convert
C to F, que você montou no Exercício 3-1, e selecione o VI. Esse VI
converte as leituras de graus Celsius em graus Fahrenheit.

d. Selecione a função Select, localizada na paleta Functions»
Comparison. Essa função retorna o valor de temperatura em
Fahrenheit (FALSE) ou Celsius (TRUE), dependendo do valor
especificado em Temp Scale.

e. Clique com o botão direito no terminal device do VI Read Voltage,
selecione Create»Constant, digite 1 e pressione a tecla <Enter>
para criar uma constante numérica.

f. Clique com o botão direito no terminal y da função Multiply,
selecione Create»Constant, digite 100 e pressione a tecla <Enter>
para criar uma outra constante numérica.

g. Clique com o botão direito no terminal channel do VI Read Voltage,
selecione Create»Constant, digite 0 e pressione as teclas
<Shift-Enter> para criar uma constante de string.
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h. Utilize a ferramenta Positioning, mostrada à esquerda, para
posicionar os ícones, como ilustrado no diagrama de bloco anterior,
e utilize a ferramenta Wiring, como mostrada à esquerda, para
ligá-los.

Tip Para identificar terminais nos nós, clique com o botão direito no ícone e selecione
Visible Items»Terminal no menu de atalho para exibir o painel de conectores.

10. Exiba o painel frontal clicando nele ou selecionando Window»
Show Panel.

11. Clique no botão Continuous Run, como mostrado à esquerda, para
executar o VI continuamente.

12. Coloque seu dedo no sensor de temperatura e observe o aumento
de temperatura.

13. Clique novamente no botão Continuous Run para interromper
a execução do VI.

14. Crie o ícone a seguir, de forma que você possa utilizar o VI Temperature
como um subVI.

a. Clique com o botão direito no ícone localizado no canto superior
direito do painel frontal e selecione Edit Icon no menu de atalho.
A caixa de diálogo Icon Editor aparece.

b. Clique duas vezes na ferramenta Select, como mostrada à esquerda,
localizada no lado esquerdo da caixa de diálogo Icon Editor, para
selecionar o ícone padrão.

c. Pressione a tecla <Delete> para remover o ícone padrão.

d. Clique duas vezes na ferramenta Rectangle, como mostrada à
esquerda, para redesenhar a borda.
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e. Utilize a ferramenta Pencil, como mostrada à esquerda, para
desenhar um ícone que representa um termômetro.

f. Utilize as ferramentas Foreground e Fill para colorir o termômetro
de vermelho.

Nota Para desenhar linhas retas horizontais e verticais, pressione a tecla <Shift>
enquanto você utiliza a ferramenta Pencil para arrastar o cursor.

g. Clique duas vezes na ferramenta Text, como mostrada à esquerda,
e altere a fonte para Small Fonts.

h. Selecione o ícone B & W e selecione 256 Colors no campo Copy
from para criar um ícone preto-e-branco, que o LabVIEW utiliza
para impressão, a não ser que você tenha uma impressora colorida.

i. Quando o ícone estiver concluído, clique no botão OK. O ícone
aparece no canto superior direito do painel frontal.

15. Clique com o botão direito no ícone, selecione Show Connector
no menu de atalho e atribua terminais à chave e ao termômetro.

a. Clique no terminal esquerdo do painel de conectores.

b. Clique no controle Temp Scale. A cor do terminal esquerdo muda
para verde.

c. Clique no terminal direito do painel de conectores.

d. Clique no indicador Temperature. A cor do terminal direito muda
para laranja.

e. Clique em uma área aberta do painel frontal.

16. Salve o VI, pois ele será utilizado posteriormente no curso.

a. Selecione File»Save.

b. Acesse o diretório c:\exercises\LV Basics I.

c. Digite Thermometer.vi na caixa de diálogo.

d. Clique no botão Save.

17. Selecione File»Close para fechar o VI.

Final do exercício 3-2
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D. Criando um subVI a partir de seções de um VI
Você pode simplificar o diagrama de bloco de um VI, convertendo seções
do diagrama de bloco em subVIs. Converta uma seção de um VI em um
subVI, utilizando a ferramenta Positioning para selecionar a seção do
diagrama de bloco a ser reutilizada e selecionando Edit»Create SubVI.
Um ícone para o novo subVI substitui a seção selecionada do diagrama de
bloco. O LabVIEW cria controles e indicadores para o novo subVI e conecta
o subVI às ligações já existentes. O exemplo a seguir mostra como converter
uma seleção em um subVI.

Nota Você não pode converter uma seção com mais de 28 entradas e saídas, pois esse é
o número máximo de terminais disponíveis em um painel de conectores.
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Resumo, dicas e suplementos

• Um VI dentro de um outro VI é chamado subVI. A utilização de subVIs
ajuda você a gerenciar alterações e a depurar o diagrama de bloco
rapidamente.

• Após a montagem do painel frontal e do diagrama de bloco de um VI,
monte o painel de ícones e conectores para que você possa utilizar o VI
como um subVI.

• O painel de conectores é um conjunto de terminais que corresponde
aos controles e indicadores desse VI. Defina conexões atribuindo um
controle ou indicador do painel frontal a cada um dos terminais do
painel de conectores.

• Crie ícones personalizados para substituir o ícone padrão, clicando duas
vezes no ícone localizado no canto superior direito do painel frontal.

• Na caixa de diálogo Icon Editor, clique duas vezes na ferramenta Text
para selecionar uma fonte diferente.

• Você pode designar quais entradas e saídas são obrigatórias,
recomendadas e opcionais para evitar que usuários se esqueçam de ligar
conexões de subVIs, clicando com o botão direito em um terminal do
painel de conectores e selecionando This Connection Is no menu de
atalho.

• Faça uma descrição para um VI selecionando File»VI Properties
e depois Documentation no menu Category na barra de ferramentas.
Quando você move o cursor sobre um ícone do VI, a janela Context
Help exibe esta descrição e indica quais terminais são obrigatórios,
recomendados ou opcionais.

• Adicione descrições e pequenas dicas para controles e indicadores,
clicando com o botão direito neles e selecionando Description and Tip
no menu de atalho. Quando você move o cursor sobre controles e
indicadores, a janela Context Help exibe essa descrição.

• Converta uma seção de um VI em um subVI, utilizando a ferramenta
Positioning para selecionar a seção do diagrama de bloco a ser
reutilizada e selecionando Edit»Create SubVI.
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Exercício adicional
3-3 Monte um VI que calcule a inclinação entre dois segmentos X-Y,

como mostrado no painel frontal e diagrama de bloco a seguir.

Documente inteiramente o VI e crie um painel de ícones
e conectores. Selecione o cálculo de inclinação e selecione
Edit»Create SubVI para criar um subVI.

Salve o VI como Slope.vi.
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Anotações
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Lição 4
Loops e diagramas

Estruturas são representações gráficas dos loops (ciclos) e das declarações
condicionais de linguagens de programação baseadas em texto. Utilize
estruturas no diagrama de bloco para repetir blocos de código e executar
código de forma condicional ou em uma ordem específica. O LabVIEW
inclui cinco estruturas: While Loop, For Loop, Case (condicionais),
Sequence (seqüenciais) e Formula Node.

Esta lição introduz o While Loop, o For Loop, o diagrama de forma de onda
e o registrador de deslocamento.

Você aprenderá:

A. Como utilizar um While Loop

B. Como exibir dados em um diagrama de forma de onda

C. O que é um registrador de deslocamento e como utilizá-lo

D. Como utilizar um For Loop



Lição 4 Loops e diagramas

Manual de treinamento do LabVIEW Básico I 4-2 ni.com

A. While Loops
Semelhante a um Do Loop ou um Repeat-Until Loop em linguagens
de programação baseadas em texto, um While Loop, como mostrado à
esquerda, executa um subdiagrama até que uma condição seja alcançada.
A estrutura de While Loop está localizada na paleta Functions»Structures.

Utilize o cursor para arrastar um retângulo de seleção ao redor da seção do
diagrama de bloco a ser repetida. Quando você soltar o botão do mouse, um
limite de While Loop circundará a seção selecionada.

Adicione objetos do diagrama de bloco ao While Loop, arrastando-os
e soltando-os dentro da estrutura.

O While Loop executa o subdiagrama até que o terminal condicional,
um terminal de entrada, receba um valor Booleano específico.
O comportamento e a aparência padrão do terminal condicional é
Continue If True, como mostrados à esquerda. Quando um terminal
condicional está configurado como Continue If True, o While Loop
executa seu subdiagrama até o terminal condicional receber um valor
FALSE. O terminal de iteração (um terminal de saída), como mostrado
à esquerda, contém o número de iterações concluídas. A contagem de
iterações sempre inicia em zero. Durante a primeira iteração, o terminal
de iteração retorna o valor 0.

No diagrama de bloco a seguir, o While Loop será executado até que a
saída do subVI seja menor que 10.00 ou o controle Enable seja FALSE.
A função And retorna um valor TRUE apenas se as duas entradas são
TRUE. Do contrário, retorna um valor FALSE.
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Você pode alterar o comportamento e a aparência do terminal condicional,
clicando com o botão direito no terminal ou na borda do While Loop e
selecionando Stop If True, como mostrado à esquerda. Você também
pode utilizar a ferramenta Operating para clicar no terminal condicional,
com o intuito de alterar a condição. Quando um terminal condicional está
configurado como Stop If True, o While Loop executa seu subdiagrama até
que o terminal condicional receba um valor TRUE, como mostrado no
diagrama de bloco a seguir.

O While Loop é executado até que a saída do subVI seja maior que ou igual
a 10.00 e o controle Enable seja TRUE.
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B. Diagramas de forma de onda
O diagrama de forma de onda é um indicador numérico especial que exibe
uma ou mais plotagens. O diagrama de forma de onda está localizado na
paleta Controls»Graph. Eles podem exibir uma plotagem única ou várias
plotagens. O painel frontal a seguir mostra um exemplo de um diagrama de
forma de onda de várias plotagens.

Os diagramas utilizam três modos diferentes para rolar dados, como
mostrado no painel frontal a seguir. Clique com o botão direito no diagrama
e selecione Advanced»Update Mode no menu de atalho. Selecione Strip
Chart, Scope Chart ou Sweep Chart. O modo padrão é Strip Chart.

Um Strip Chart mostra dados sendo executados continuamente da esquerda
para a direita pelo diagrama. Um Scope Chart mostra um item de dados,
como um pulso ou uma onda, rolando parcialmente pelo diagrama, da
esquerda para a direita. Uma exibição de varredura é semelhante a uma
exibição EKG. Um modo sweep funciona basicamente como um modo
scope, exceto pelo fato de ela mostrar os dados antigos do lado direito
e os dados novos do lado esquerdo, separados por um linha vertical.
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O Scope Chart e o Sweep Chart têm exibições de retorno semelhantes a
um osciloscópio. Devido ao fato de haver menos overhead no retorno de
uma plotagem, o Scope Chart e o Sweep Chart exibem plotagens de forma
bem mais rápida que o Strip Chart.

Ligando diagramas
Você pode ligar uma saída escalar diretamente a um diagrama de forma de
onda. O tipo de dados mostrado no terminal do diagrama de forma de onda
a seguir corresponde ao tipo de dados de entrada.

Os diagramas de forma de onda podem exibir várias plotagens.
Agrupe as várias plotagens utilizando a função Bundle, localizada na
paleta Functions»Cluster. No diagrama de bloco a seguir, a função
Bundle agrupa as saídas dos três VIs a serem plotadas no diagrama de
forma de onda.

O terminal do diagrama de forma de onda é alterado para corresponder à
saída da função Bundle. Para adicionar mais plotagens, utilize a ferramenta
Positioning para redimensionar a função Bundle.
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Exercise 4-1 VI Temperature Monitor
Objetivo: Utilizar um While Loop e diagrama de forma de onda para adquirir e exibir dados.

Complete os passos a seguir para montar um VI que meça temperatura
e plote os valores num diagrama de forma de onda.

Painel frontal
1. Abra um novo VI.

2. Monte o painel frontal a seguir.

a. Selecione a chave toggle vertical na paleta Controls»Boolean
e posicione-a no painel frontal. Você utilizará a chave para cessar
a aquisição de dados.

b. Digite Power dentro do título e clique fora dele ou clique no botão
Enter da barra de ferramentas, como mostrado à esquerda.

c. Selecione um diagrama de forma de onda na paleta Controls»
Graph e posicione-o no painel frontal. O diagrama de forma
de onda exibirá a temperatura em tempo real.

d. Digite Temperature History dentro do título e clique fora dele,
ou clique no botão Enter.

e. A legenda do diagrama de forma de onda denomina a plotagem
como Plot 0. Utilize a ferramenta Labeling para clicar três vezes
em Plot 0 na legenda do diagrama, digite Temp e clique fora do
título ou clique no botão Enter para modificar a legenda.

f. O sensor de temperatura mede a temperatura da sala. Utilize a
ferramenta Labeling para clicar duas vezes em 10.0 no eixo y,
digite 90 e clique fora do título ou clique no botão Enter para
modificar a escala do diagrama.

g. Altere –10.0 no eixo y para 70.

h. Nomeie o eixo y Temp (Deg F) e o eixo x Time (sec).
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Diagrama de bloco
3. Selecione Window»Show Diagram para exibir o diagrama de bloco.

4. Inclua os dois terminais em um While Loop, como mostrado no
diagrama de bloco a seguir.

a. Selecione o While Loop na paleta Functions»Structures.

b. Clique e arraste um retângulo de seleção ao redor dos dois terminais.

c. Utilize a ferramenta Positioning para redimensionar o loop, se
necessário.

5. Selecione Functions»Select a VI, acesse o diretório c:\exercises\
LV Basics I, clique duas vezes no VI Thermometer, que você montou
no Exercício 3-2 e posicione o VI no diagrama de bloco. Esse VI
demonstra a medida de temperatura do sensor de temperatura.

6. Ligue os objetos do diagrama de bloco, como mostrado no diagrama
de bloco anterior.

Nota Para medir a temperatura em graus Celsius, ligue uma constante Booleana,
localizada na paleta Functions»Boolean, à entrada Temp Scale do VI Thermometer.
Altere as escalas nos diagramas e gráficos nos exercícios subseqüentes para uma faixa
de 20 e 32, em vez de 70 e 90.

7. Salve o VI como Temperature Monitor.vi, pois você o utilizará
posteriormente neste curso.

8. Exiba o painel frontal clicando nele ou selecionando Window»
Show Panel.

9. Utilize a ferramenta Operating para clicar na chave toggle vertical
e mudá-la para a posição ON.

10. Execute o VI.

A seção do diagrama de bloco que está dentro da borda do While Loop,
ou subdiagrama, é executada até que a condição especificada seja
TRUE. Por exemplo, enquanto a chave estiver ligada (TRUE), o VI
Thermometer retorna uma nova medida e exibe-a no diagrama de forma
de onda.
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11. Clique na chave toggle vertical para cessar a aquisição. A condição é
FALSE e a execução do loop é interrompida.

12. Formate e personalize as escalas X eY do diagrama de forma de onda.

a. Clique com o botão direito no diagrama e selecione Y Scale»
Formatting no menu de atalho. A seguinte caixa de diálogo
aparece.

b. Clique no ícone Scale Style e selecione estilos diferentes para o eixo
y. Você também pode selecionar diferentes modos de mapeamento,
opções de grade, fatores de escala e formatos e precisões.

c. Selecione as opções mostrada na caixa de diálogo anterior e clique
no botão OK.

13. Clique com o botão direito no diagrama de forma de onda e selecione
Data Operations»Clear Chart no menu de atalho para limpar o buffer
de exibição e reinicializar o diagrama de forma de onda. Se o VI estiver
sendo executado, você poderá selecionar Clear Chart no menu de
atalho.

Alterando a ação mecânica de chaves Booleanas
Cada vez que você executa o VI, primeiro deve ligar a chave toggle vertical
e, depois, clicar no botão Run. Você pode modificar a ação mecânica de
controles Booleanos, selecionando uma das seguintes opções.

• Switch When Pressed: altera o valor do controle cada vez que você
clica nele com a ferramenta Operating. A ação é semelhante àquela
de uma chave de projetor luminoso. A freqüência com que o VI lê
o controle não afeta essa ação.
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• Switch When Released: altera o valor do controle somente depois que
você soltar o botão do mouse durante um clique dentro do limite gráfico
do controle. A freqüência com que o VI lê o controle não afeta essa ação.

• Switch Until Released: altera o valor do controle quando você clica
no controle e mantém o novo valor até você soltar o botão do mouse,
momento em que o controle é revertido para seu valor original. A ação
é semelhante àquela de uma campainha tipo cigarra. A freqüência com
que o VI lê o controle não afeta essa ação.

• Latch When Pressed: altera o valor do controle quando você clica
no controle e mantém o novo valor até que o VI o leia mais uma vez,
momento em que o controle é revertido para seu valor padrão. Essa ação
acontece se você continuar segurando o botão do mouse. Essa ação é
semelhante àquela de um disjuntor e é útil para parar While Loops ou
forçar o VI a executar uma ação apenas uma vez, cada vez que você
definir o controle.

• Latch When Released: altera o valor do controle apenas após a
liberação do botão do mouse. Após o VI ler o valor uma vez, o controle
será revertido para o valor antigo. Essa ação garante, pelo menos, um
novo valor.

• Latch Until Released: altera o valor do controle quando você clica no
controle e mantém o valor até que o VI o leia uma vez ou até que você
solte o botão do mouse, o que sempre ocorre por último.

14. Modifique a chave toggle vertical, de forma que a temperatura seja
plotada no gráfico cada vez que o VI é executado.

a. Pare o VI se estiver sendo executado.

b. Utilize a ferramenta Operating para clicar na chave toggle vertical
e mudá-la para a posição ON.

c. Clique com o botão direito na chave e selecione Data Operations»
Make Current Value Default no menu de atalho. Isso define
a posição ON como o valor padrão.

d. Clique com o botão direito na chave e selecione Mechanical
Action»Latch When Pressed no menu de atalho.

15. Execute o VI.

16. Utilize a ferramenta Operating para clicar na chave vertical, com o
intuito de cessar a aquisição de dados. A chave será alterada para a
posição OFF e retornada para a posição ON depois que o terminal
condicional ler o valor.
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Adicionando temporização
Quando este VI é executado, o While Loop executa o mais rápido possível.
Complete os passos a seguir para obter dados em determinados intervalos,
como uma vez a cada meio segundo, como mostrado no diagrama de bloco
a seguir.

a. Selecione a função Wait Until Next ms Multiple, localizada na
paleta Functions»Time & Dialog. Neste exercício, essa função
verifica se cada iteração ocorre sempre a cada meio segundo
(500 ms).

b. Clique com o botão direito na entrada millisecond multiple da
função Wait Until Next ms Multiple, selecione Create»Constant
no menu de atalho, digite 500 e pressione a tecla <Enter>.
A constante numérica determina uma espera de 500 ms, assim
sendo o loop é executado uma vez a cada meio segundo.

c. No painel frontal, clique com o botão direito no diagrama e
selecione X Scale»Formatting no menu de atalho. Altere o valor
dX para 0.5, pois foi adicionada uma espera de 500 ms entre
iterações do loop.

17. Salve o VI, pois ele será utilizado posteriormente no curso.

18. Execute o VI.

19. Tente diferentes valores para a constante numérica e execute o VI
novamente.

20. Feche o VI.

Final do exercício 4-1



Lição 4 Loops e diagramas

© National Instruments Corporation 4-11 Manual de treinamento do LabVIEW Básico I

Exercise 4-2 VI Random Signal (opcional)
Objetivo: Adicionar temporização a um diagrama de forma de onda,

utilizando um controle numérico.

Complete os passos a seguir para montar um VI que gere dados aleatórios
e exiba-os em um diagrama de forma de onda, no modo de atualização de
scope.

1. Posicione um controle numérico deslizante no painel frontal para ajustar
a taxa de loop entre 0 e 2 segundos, como mostrado no painel frontal
a seguir.

2. Adicione uma chave para interromper a execução do VI.

3. Configure a chave, de forma que não seja necessário ligá-la toda vez
que você for executar o VI.

4. Monte o painel frontal anterior, utilizando as seguintes dicas:

• Clique com o botão direito no diagrama de forma de onda e
selecione Visible Items»Plot Legend no menu de atalho para
ocultar a legenda.

• Clique com o botão direito no título Time e selecione Visible Scale
Label no menu de atalho para remover o título de escala do eixo X.
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5. Monte o diagrama de bloco, utilizando as seguintes dicas:

• Utilize a função Random Number (0–1), localizada na paleta
Functions»Numeric, para gerar os dados.

• Multiplique o terminal de controle numérico por 1,000 para
converter segundos em milissegundos. Utilize esse valor como
a entrada para a função Wait Until Next ms Multiple, localizada
na paleta Functions»Time & Dialog.

• Clique com o botão direito no diagrama e selecione Advanced»
Update Mode no menu de atalho para definir o modo do diagrama.

6. Salve o VI como Random Signal.vi.

7. Execute o VI.

8. Altere o valor do controle Loop Delay durante a execução do VI.

9. Feche o VI.

Final do exercício 4-2
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Exercise 4-3 VI Auto Match
Objetivo: Transmitir dados para fora de um While Loop através de um túnel.

Complete os passos a seguir para montar um VI que gere números aleatórios
até que o número gerado corresponda a um número que você especificar.
O terminal de contagem do loop grava o número de iterações antes que
ocorra a correspondência.

Painel frontal
1. Abra um novo painel frontal.

2. Monte o painel frontal a seguir e modifique os controles e indicadores,
como mostrado e descrito neste exercício.

O controle Number to Match especifica o número que você deseja
corresponder. O indicador Current Number exibe o número aleatório
atual. O indicador # of iterations exibe o número de iterações anteriores
a uma correspondência.

Definindo a faixa de dados
Utilize a opção Data Range para evitar que o usuário selecione um valor
não compatível com uma faixa ou um incremento definido. Você pode
ignorar o erro ou forçá-lo a estar dentro da faixa. Complete os passos
a seguir para definir a faixa entre 0 e 10,000 com um incremento
de 1 e um valor padrão de 50.

3. Clique com o botão direito no controle Number to Match e selecione
Data Range no menu de atalho. A caixa de diálogo Data Range
aparece.

4. Remova a marca de verificação da caixa de seleção Use Defaults.
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5. Selecione as opções, como mostrado na caixa de diálogo a seguir.

6. Clique no botão OK.

Modificando a precisão dos indicadores numéricos
Como padrão, o LabVIEW exibe controles e indicadores numéricos
em notação decimal com duas casas decimais, como 3.14. Utilize a
opção Format & Precision para alterar a precisão ou exibir os controles
e indicadores numéricos em notação científica, de engenharia ou de
hora/minuto/segundo. Complete os passos a seguir para alterar
a precisão para 0.

7. Clique com o botão direito no indicador Current Number e selecione
Format & Precision no menu de atalho. A caixa de diálogo Format &
Precision aparece.

8. Digite 0 na caixa de texto Digits of Precision e clique no botão OK.

9. Repita os passos 7 e 8 para o indicador # of iterations.
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Diagrama de bloco
10. Monte o seguinte diagrama de bloco.

a. Selecione a função Random Number (0–1), localizada na paleta
Functions»Numeric. Essa função gera um número aleatório
entre 0 e 1.

b. Selecione a função Multiply, localizada na paleta Functions»
Numeric. Essa função multiplica o número aleatório por 10.000.

c. Clique com o botão direito no terminal y da função Multiply,
selecione Create»Constant no menu de atalho, digite 10000
e pressione a tecla <Enter> para criar uma constante numérica.

d. Selecione a função Round To Nearest, localizada na paleta
Functions»Numeric. Essa função arredonda o número aleatório
entre 0 e 10.000 para o número inteiro mais próximo.

e. Selecione a função Not Equal?, localizada na paleta Functions»
Comparison. Essa função compara o número aleatório com
Number to Match e retorna o valor TRUE se os números forem
diferentes. Do contrário, retorna o valor FALSE.

f. Selecione um While Loop, localizado na paleta Functions»
Structures.

O quadrado azul que aparece na borda de While Loop é chamado
túnel. Os túneis transmitem dados dentro e fora de estruturas.
Os dados são extraídos de um loop após o término de sua execução.
Quando um túnel insere dados em um loop, o loop somente é
executado depois que os dados chegam ao túnel.

O loop é executado enquanto não existe nenhuma correspondência.
Isso significa que a função Not Equal? retornará o valor TRUE
se os dois números não corresponderem. Cada vez que o loop
é executado, o terminal de iteração é incrementado em um.
A contagem de iteração é extraída do loop após o término de sua
execução. A esse valor é acrescentado 1, na parte externa do loop,
pois a contagem inicia em 0.
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g. Selecione a função Increment, localizada na paleta Functions»
Numeric. Essa função adiciona 1 à contagem de While Loop. Um
ponto de coerção cinza aparece no terminal de saída para indicar que
o LabVIEW forçou para que a representação numérica do terminal
de iteração correspondesse à representação numérica do terminal de
saída. Consulte a Seção D, For Loops, para obter mais informações
sobre conversão numérica.

11. Salve o VI como Auto Match.vi.

12. Exiba o painel frontal e altere o número no controle Number to Match.

13. Execute o VI. Altere o controle Number to Match e execute o VI
novamente.

O indicador Current Number é atualizado a cada iteração do loop,
porque está dentro do loop. O indicador # of iterations é atualizado
na conclusão, pois ele está fora do loop.

14. Para ver como o VI atualiza os indicadores, habilite a execução
animada. No diagrama de bloco, clique no botão Highlight Execution,
como mostrado à esquerda, para habilitar a execução animada.
A execução animada visualiza o fluxo de dados através do diagrama
de bloco, de forma que você pode ver cada número conforme ele
é gerado.

15. Altere o controle Number to Match para um número que esteja fora
da faixa de dados, que vai de 0 até 10.000, com incremento de 1.

16. Execute o VI. O LabVIEW força o valor que está fora da faixa para
o valor mais próximo dentro da faixa de dados especificada.

17. Feche o VI.

Final do exercício 4-3



Lição 4 Loops e diagramas

© National Instruments Corporation 4-17 Manual de treinamento do LabVIEW Básico I

C. Registradores de deslocamento
Utilize os registradores de deslocamento em For Loops e While Loops
para transferir valores de uma iteração de loop para a próxima. Crie um
registrador de deslocamento clicando com o botão direito na borda esquerda
ou direita de um loop e selecionando Add Shift Register no menu de atalho.

Um registrador de deslocamento aparece como um par de terminais, como
mostrado à esquerda, diretamente em oposição um ao outro nas laterais
verticais da borda do loop. O terminal da direita contém uma seta para cima
e armazena os dados ao concluir uma iteração. O LabVIEW transfere os
dados conectados ao lado direito do registrador para a próxima iteração.

Um registrador de deslocamento transfere qualquer tipo de dados e
automaticamente altera para o tipo de dados do primeiro objeto ligado a ele.
Os dados que você ligar aos terminais de cada registrador de deslocamento
devem ser do mesmo tipo. Você pode criar vários registradores de
deslocamento em uma estrutura e pode ter mais de um terminal esquerdo
para armazenar mais do que um valor anterior, como mostrado na ilustração
a seguir.

Você pode utilizar registradores de deslocamento para armazenar valores de
iterações anteriores. Esta técnica é útil para calcular a média de pontos de
dados. Para configurar um registrador de deslocamento a fim de carregar
valores para a próxima iteração, clique com o botão direito no terminal
esquerdo e selecione Add Element no menu de atalho. Por exemplo, se
você adicionar mais dois elementos ao terminal esquerdo, os valores das
últimas três iterações serão transferidos para a próxima iteração.

Inital
Value

Inital
Value

New
Value

New
Value

Previous
Value

New
Value

Previous
Value

New
Value

4

1

3

2
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Inicializando registradores de deslocamento
Para inicializar um registrador de deslocamento, ligue qualquer valor
da parte externa do loop ao terminal esquerdo. Se você não inicializar o
registrador, o loop utilizará o valor gravado no registrador quando o loop
foi executado pela última vez ou utilizará o valor padrão para o tipo de
dados se o loop nunca tiver sido executado. Por exemplo, se o tipo de dados
do registrador de deslocamento for Boolean, o valor inicial será FALSE.
De forma semelhante, se o tipo de dados do registrador de deslocamento
for numérico, o valor inicial será 0.

Utilize um loop com um registrador de deslocamento não inicializado para
executar o VI repetidamente. Dessa forma, cada vez que o VI for executado,
a saída inicial do registrador de deslocamento será o último valor da
execução anterior. Deixe a entrada para o terminal esquerdo do registrador
de deslocamento desligada para um registrador não inicializado, com o
intuito de preservar informações de estado entre execuções subseqüentes
de um VI.

Initial Value 0

Initial Value 7

Initial Value 5

Initial Value 54

1

3

2
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Exercise 4-4 VI Shift Register Example
Objetivo: Utilizar registradores de deslocamento para acessar valores

de iterações anteriores.

Painel frontal
1. Abra o VI Shift Register Example. O seguinte painel frontal já estará

montado.

O indicador X(i) exibe o valor atual, que será deslocado para o terminal
esquerdo no início da próxima iteração. O indicador X(i-1) exibe o valor
da última iteração, o indicador X(i-2) exibe o valor da penúltima
iteração, e assim sucessivamente.

Diagrama de bloco
2. Exiba o diagrama de bloco a seguir e verifique se o painel frontal e

o diagrama de bloco estão visíveis. Se necessário, feche ou mova as
paletas Tools e Functions.

O valor 0 ligado ao terminal esquerdo inicializa os elementos do
registrador de deslocamento para 0.

3. Clique no botão Highlight Execution, como mostrado à esquerda,
para habilitar a execução animada.
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4. Execute o VI e observe as lâmpadas que se movem ao longo das
ligações. Se as lâmpadas estiverem se movendo muito rápido, clique
nos botões Pause and Step Over, como mostrados à esquerda, para
tornar a execução mais lenta.

Em cada iteração do While Loop, o VI é transferido para os valores
anteriores pelos terminais esquerdos do registrador de deslocamento.
Cada iteração do loop adiciona 5 aos dados atuais, X(i). Esse valor
é deslocado para o terminal esquerdo, X(i-1), no início da próxima
iteração. Os valores do terminal esquerdo são transferidos para baixo
através dos terminais. Esse VI retém os três últimos valores. Para
reter mais valores, adicione mais elementos ao terminal esquerdo do
registrador de deslocamento, clicando com o botão direito no terminal
esquerdo e selecionando Add Element no menu de atalho.

5. Feche o VI. Não salve nenhuma alteração.

Final do exercício 4-4
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Exercise 4-5 VI Temperature Running Average
Objetivo: Utilizar registradores de deslocamento para calcular uma média de execução.

Complete os passos a seguir para modificar o VI Temperature Monitor com
o intuito de calcular a média das três últimas medições de temperatura e de
exibir a média em um diagrama de forma de onda.

Painel frontal
1. Abra o VI Temperature Monitor , que você montou no Exercício 4-1.

2. Selecione File»Save As e renomeie o VI para Temperature Running 
Average.vi.

Diagrama de bloco
3. Exiba o diagrama de bloco.

4. Clique com o botão direito na borda direita ou esquerda do While Loop
e selecione Add Shift Register no menu de atalho para criar um
registrador de deslocamento.

5. Clique com o botão direito no terminal esquerdo do registrador de
deslocamento e selecione Add Element no menu de atalho para
adicionar um elemento ao registrador de deslocamento.

6. Modifique o diagrama de bloco da seguinte forma.

a. Pressione a tecla <Ctrl> enquanto você clica no VI Thermometer e
arraste-o para fora do While Loop a fim de criar uma cópia do subVI.

(Macintosh) Pressione a tecla <Option>. (Sun) Pressione a
tecla <Meta>. (HP-UX e Linux) Pressione a tecla <Alt>.

O VI Thermometer retorna uma medição de temperatura do sensor
de temperatura e inicializa os registradores de deslocamento da
esquerda antes do loop iniciar.
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b. Selecione a função Compound Arithmetic, localizada na paleta
Functions»Numeric. Essa função retorna a soma das leituras de
temperatura atual e das duas leituras de temperatura anterior. Utilize
a ferramenta Positioning para redimensionar a função para ter três
terminais esquerdos, como mostrados à esquerda.

c. Selecione a função Divide, localizada na paleta Functions»
Numeric. Essa função retorna a média das últimas três leituras
de temperatura.

d. Clique com o botão direito no terminal y da função Divide, selecione
Create»Constant, digite 3 e pressione a tecla <Enter>.

e. Utilize a ferramenta Labeling para clicar duas vezes na constante
numérica ligada à função Wait Until Next ms Multiple, digite 500
e pressione a tecla <Enter>.

7. Salve o VI, pois ele será utilizado posteriormente no curso.

8. Execute o VI.

Durante cada iteração do While Loop, o VI Thermometer tira uma
medição de temperatura. O VI adiciona este valor às duas últimas
medições armazenadas nos terminais esquerdos do registrador de
deslocamento. O VI divide o resultado por três para encontrar a média
das três medições, ou seja, a medição atual mais as duas medições
anteriores. Ele exibe a média no diagrama de forma de onda. Observe
que o VI inicializa o registrador de deslocamento com uma medição
de temperatura.

9. Selecione a função Bundle, localizada na paleta Functions»Cluster,
para exibir a média e a medição de temperatura atual no mesmo
diagrama de forma de onda. Essa função agrupa a média e a temperatura
atual para plotagem no diagrama de forma de onda.
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10. Salve e execute o VI. O VI exibe duas plotagens no diagrama de forma
de onda. As plotagens ficam sobrepostas. Ou seja, elas compartilham a
mesma escala vertical.

Personalizando diagramas
Complete os passos a seguir para personalizar o diagrama de forma de onda,
como mostrado no painel frontal a seguir. Você pode exibir uma legenda de
plotagem, uma legenda de escala, uma paleta de gráfico, um display digital,
uma barra de rolagem e um buffer. Como padrão, o diagrama de forma de
onda exibe a legenda de plotagem.

11. Personalize o eixo y.

a. Utilize a ferramenta Labeling e clique duas vezes em 70.0 no
eixo y. Digite 75.0 e pressione a tecla <Enter>.

b. Utilize a ferramenta Labeling para clicar duas vezes no segundo
número da parte inferior do eixo y, digite 80.0 e pressione a tecla
<Enter>. Esse número determina o espaçamento numérico das
divisões do eixo y.

Por exemplo, se o número acima 75.0 for 77.5, indicando uma
divisão do eixo y de 2.5, a alteração de 77.5 para 80.0 reformatará
o eixo y para múltiplos de 5.0 (75.0, 80.0, 85.0, e assim por
diante).

Nota O tamanho do diagrama de forma de onda tem efeito direto sobre a exibição
de escalas do eixo. Aumente o tamanho do diagrama de forma de onda se você tiver
problemas com o escalonamento do eixo.
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12. Clique com o botão direito do mouse no diagrama de forma de onda
e selecione Visible Items»Scale Legend no menu de atalho para exibir
a legenda de escala, como mostrado na ilustração a seguir. Você pode
posicionar a legenda de escala em qualquer lugar do painel frontal.

13. Utilize a legenda de escala para personalizar cada eixo.

a. Verifique se LED Autoscale está verde e se o botão Lock Autoscale
aparece bloqueado, assim o eixo y ajusta os valores mínimos e
máximos para que se ajustem aos dados no diagrama.

b. Clique no botão Scale Format para alterar o formato, a precisão,
o modo de mapeamento, a visibilidade da escala e as opções de
grade para cada eixo.

14. Utilize a legenda de plotagem para personalizar as plotagens.

a. Utilize a ferramenta Positioning para redimensionar a legenda de
plotagem para incluir duas plotagens.

b. Utilize a ferramenta Labeling para alterar Temp para Running Avg
e Plot 1 para Current Temp. Se o texto não couber, utilize a
ferramenta Positioning para redimensionar a legenda de plotagem.

c. Clique com o botão direito na legenda de plotagem para definir os
estilos de linha e ponto e a cor do fundo ou dos traços da plotagem.

15. Clique com o botão direito no diagrama de forma de onda e selecione
Visible Items»Graph Palette no menu de atalho para exibir a paleta de
gráfico, como mostrado na ilustração a seguir. Você pode posicionar
a paleta de gráfico em qualquer lugar do painel frontal.

1 Eixo X
2 Eixo Y
3 Títulos de escala

4 Botão de bloqueio de escala
5 Botão de escala automática
6 Botão de formatação de escala

43 65
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Utilize o botão Zoom para ampliar ou reduzir seções do diagrama
ou o diagrama inteiro. Utilize a ferramenta Panning para selecionar a
plotagem e movê-la ao redor da exibição. Utilize a ferramenta Cursor
Movement para mover o cursor no gráfico.

16. Salve e execute o VI. Enquanto o VI é executado, utilize os botões da
legenda de escala e da paleta de gráfico para modificar o diagrama de
forma de onda.

Nota Se você modificar os títulos dos eixos, a exibição poderá exceder o tamanho
máximo que o VI pode apresentá-lo.

17. Utilize a ferramenta Operating para clicar na chave Power e interromper
a execução do VI.

18. Salve e feche o VI.

Final do exercício 4-5

1 Ferramenta Cursor Movement
2 Botão Zoom

3 Ferramenta Panning
4 Menu Zoom

4

1 32
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D. For Loops
Um For Loop, como mostrado à esquerda, executa um subdiagrama
por um definido número de vezes. O For Loop está localizado na paleta
Functions»Structures. O valor no terminal de contagem (um terminal de
entrada), como mostrado à esquerda, indica quantas vezes é possível repetir
o subdiagrama. O terminal de iteração (um terminal de saída), como
mostrado à esquerda, contém o número de iterações concluídas. A contagem
de iterações sempre inicia em zero. Durante a primeira iteração, o terminal
de iteração retorna o valor 0.

O For Loop difere do While Loop, pois o For Loop é executado por um
número definido de vezes. O While Loop interromperá a execução do
subdiagrama apenas se existir o valor no terminal condicional.

O For Loop a seguir gera 100 números aleatórios e exibe os pontos em um
diagrama de forma de onda.

Conversão numérica
O LabVIEW pode representar tipos de dados numéricos como números
inteiros (byte, palavra ou comprimento), números com ponto flutuante
(precisão simples, dupla ou estendida) ou dados numéricos complexos
(precisão simples, dupla ou estendida). Quando você liga duas ou mais
entradas numéricas de diferentes representações a uma função, esta
geralmente retorna uma saída no formato de dados mais abrangente.
As funções forçam as representações menos abrangentes à representação
mais abrangente antes da execução e o LabVIEW coloca um ponto de
coerção no terminal onde a conversão ocorre.
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Por exemplo, o terminal de contagem de For Loop é um inteiro longo.
Se você ligar um dado numérico de ponto flutuante e dupla precisão ao
terminal do contagem, o LabVIEW converterá o dado numérico em um
inteiro longo. Um ponto de coerção cinza aparece no terminal de contagem
do primeiro For Loop, como mostrado na ilustração a seguir.

Para alterar a representação de um objeto numérico, clique com o botão
direito no objeto e selecione Representation no menu de atalho. Selecione
o tipo de dados que melhor representa seus dados.

Quando o LabVIEW converte dados numéricos de ponto flutuante
em números inteiros, o valor é arredondado para o inteiro mais próximo.
O LabVIEW arredonda x.5 para o número inteiro par mais próximo.
Por exemplo, o LabVIEW arredonda 2,5 para 2 e 3,5 para 4.
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Exercise 4-6 VI Random Average
Objetivo: Montar um VI que exiba duas plotagens, uma plotagem aleatória e uma média

dos últimos quatro pontos em um diagrama de forma de onda em modo de
atualização de sweep.

1. Monte este VI, utilizando as seguintes dicas:

• Utilize um For Loop (n = 200), em vez de um While Loop.
O Sweep Chart deve ser semelhante ao diagrama a seguir.

• Utilize um registrador de deslocamento com três terminais
esquerdos para calcular a média dos quatro últimos pontos de dados.

• Utilize a função Random Number (0–1), localizada na paleta
Functions»Numeric, para gerar os dados.

• Utilize a função Bundle, localizada na paleta Functions»Cluster,
para agrupar os dados aleatórios com a média de dados calculada
antes da plotagem.

2. Salve o VI como Random Average.vi.

3. Feche o VI.

Final do exercício 4-6
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Resumo, dicas e suplementos

• Utilize estruturas no diagrama de bloco para repetir blocos de código
e executar o código de forma condicional ou em uma ordem específica.

• O While Loop executa o subdiagrama até que o terminal condicional
receba um valor Booleano específico. Como padrão, o While Loop
executa seu subdiagrama até o terminal condicional receber um valor
FALSE.

• O For Loop executa um subdiagrama por um número definido de vezes.

• Você cria loops utilizando o cursor para arrastar um retângulo de seleção
ao redor da seção do diagrama de bloco a ser repetida ou arrastando e
soltando objetos do diagrama de bloco dentro do loop.

• A função Wait Until Next ms Multiple verifica se cada iteração ocorre
em intervalos de tempo. Utilize essa função para adicionar temporização
aos loops.

• O diagrama de forma de onda é um indicador numérico especial que
exibe uma ou mais plotagens.

• O diagrama de forma de onda tem os seguintes três modos de
atualização:

– Um Strip Chart mostra dados sendo executados continuamente da
esquerda para a direita pelo diagrama.

– Um Scope Chart mostra um item de dados, como um pulso ou
uma onda, rolando parcialmente pelo diagrama, da esquerda para
a direita.

– Uma exibição de varredura é semelhante a uma exibição EKG. Um
modo sweep funciona basicamente como um modo scope, exceto
pelo fato de que ele mostra os dados antigos no lado direito do
diagrama e os dados novos no lado esquerdo, separados por uma
linha vertical.

• Utilize registradores de deslocamento em For Loops e While Loops
para transferir valores de uma iteração de loop para a próxima.

• Crie um registrador de deslocamento clicando com o botão direito
na borda esquerda ou direita de um loop e selecionando Add Shift
Register no menu de atalho.

• Para configurar um registrador de deslocamento de forma que ele
carregue os valores para a próxima iteração, clique com o botão direito
no terminal esquerdo e selecione Add Element no menu de atalho.
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• Clique com o botão direito em um diagrama de forma de onda em seus
componentes para definir atributos do diagrama e suas plotagens.

• Pontos de coerção aparecem quando o LabVIEW força para que uma
representação numérica de um terminal corresponda à representação
numérica de um outro terminal.
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Exercícios adicionais
4-7 Utilizando apenas um While Loop, monte uma combinação For

Loop e While Loop que pare quando atingir um número de iterações
especificadas no controle do painel frontal ou quando você clicar em
um botão de parada.

Salve o VI como Combo While-For Loop.vi.

4-8 Monte um VI que meça constantemente a temperatura a cada
segundo e exiba-a em um Scope Chart. Se a temperatura estiver
acima ou abaixo dos limites especificados nos controles do painel
frontal, o VI acenderá um LED no painel frontal. O diagrama plota
a temperatura e os limites de temperatura superior e inferior. Você
deve ser capaz de definir o limite no painel frontal a seguir.

Salve o VI como Temperature Limit.vi.

4-9 Modifique o VI que você criou no Exercício 4-8 para exibir os
valores máximos e mínimos do rastreamento de temperatura.

Tip Utilize registradores de deslocamento e duas funções Max & Min, localizadas
na paleta Functions»Comparison.

Salve o VI como Temp Limit (max-min).vi.

Desafio
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Anotações
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Lição 5
Arranjos, gráficos e clusters

Esta lição descreve como utilizar arranjos (ou matrizes), exibir dados
em gráficos de forma de onda e XY e utilizar clusters. Arranjos agrupam
elementos de dados do mesmo tipo. Clusters agrupam elementos de
dados de tipos diferentes.

Você aprenderá:

A. Sobre arranjos

B. Como criar arranjos com loops

C. Como utilizar as funções de Array

D. Sobre polimorfismo

E. Como utilizar gráficos para exibir dados

F. Sobre clusters

G. Como utilizar as funções de Cluster
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A. Arranjos
Arranjos agrupam elementos de dados do mesmo tipo. Um arranjo consiste
em elementos e dimensões. Elementos são os dados que constituem o
arranjo. Uma dimensão é o comprimento, a altura ou a profundidade de um
arranjo. Um arranjo pode ter uma ou mais dimensões e até 231 –1 elementos
por dimensão, limitados pela quantidade de memória.

Você pode montar arranjos de tipos de dados numéricos, Booleanos,
diretório, string, forma de onda e cluster. Considere a possibilidade
de utilizar arranjos quando você trabalhar com um conjuntos de dados
semelhantes e quando executar cálculos repetitivos. Os arranjos são ideais
para armazenar dados coletados de formas de onda ou dados gerados em
loops, em que cada iteração de um loop produz um elemento do arranjo.

Você não pode criar arranjos de arranjos. No entanto, pode criar um arranjo
de clusters, em que cada cluster contenha um ou mais arranjos.

Os elementos do arranjo são ordenados, assim como os nove planetas têm
uma ordem estabelecida em relação à distância deles do Sol. Um arranjo
utiliza um índice, de forma que você possa acessar rapidamente qualquer
elemento específico. O índice é baseado em zero, o que significa que ele está
na faixa de 0 até n – 1, em que n é o número de elementos no arranjo. Neste
exemplo, n = 9 para os nove planetas. Dessa forma, o índice varia de 0 a 8.
Terra é o terceiro planeta e tem um índice 2.

Criando controles e indicadores de arranjo
Para criar um controle ou indicador de arranjo, como mostrado no exemplo
a seguir, selecione um arranjo na paleta Controls»Array & Cluster,
coloque-o no painel frontal e arraste um controle ou indicador para a caixa
de arranjo. Se você tentar arrastar um controle ou indicador inválido, como
um gráfico XY na caixa de arranjo, não conseguirá soltar o controle ou
indicador na caixa de arranjo.

Você deve inserir um objeto na caixa de arranjo, antes de utilizar o arranjo
no diagrama de bloco. Do contrário, o terminal de arranjo aparece em preto
e com um colchete vazio.

1 Exibição de índice 2 Exibição de elemento

2

1
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Arranjos bidimensionais
Um arranjo 2D armazena elementos em uma grade. Ele requer um índice de
coluna e um índice de linha para localizar um elemento, ambos com base
zero. A seguinte ilustração mostra um arranjo 2D com 6 colunas e 4 linhas,
que contém 6 × 4 = 24 elementos.

Para adicionar uma dimensão de cada vez a um arranjo, clique com o botão
direito na exibição de índice e selecione Add Dimension no menu de atalho.
Você também pode utilizar a ferramenta Positioning para redimensionar a
exibição de índice, até que tenha todas as dimensões desejadas.

Criando constantes de arranjo
Você pode criar uma constante de arranjo no diagrama de bloco,
selecionando-a na paleta Functions»Array, posicionando-a no diagrama
de bloco e arrastando-a para a caixa de arranjo.

Column Index

0
1
2
3

Row Index

0 1 2 3 4 5
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B. Indexação automática
Se você ligar um arranjo a um túnel de entrada For Loop ou While Loop,
poderá ler e processar todos os elementos desse arranjo, habilitando a
função de indexação automática. Quando você faz a indexação automática
do túnel de saída de um arranjo, o arranjo de saída recebe um novo elemento
de cada iteração do loop.A ligação do túnel de saída ao indicador de arranjo
torna-se mais espessa, à medida que ela se transforma em um arranjo na
borda do loop, e o túnel de saída contém colchetes que representam um
arranjo, como mostrado na ilustração a seguir.

Desabilite a indexação automática, clicando com o botão direito no túnel e
selecionando Disable Indexing no menu de atalho. Por exemplo, desabilite
a indexação automática se precisar apenas do último valor transferido para
o túnel no exemplo anterior, sem criar um arranjo.

Nota Como você pode utilizar For Loops para processar arranjos de um elemento
de cada vez, o LabVIEW habilita a indexação automática para todos os arranjos que
você liga a um For Loop. Como padrão, a indexação automática para While Loops fica
desabilitada. Para habilitá-la, clique com o botão direito em um túnel e selecione Enable
Indexing no menu de atalho.

Criando arranjos bidimensionais
Você pode utilizar dois For Loops, um dentro do outro, para criar um arranjo
2D. O For Loop externo cria os elementos de linha e o For Loop interno cria
os elementos de coluna, como mostrado no exemplo a seguir.
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Utilizando indexação automática para definir contagem de For Loop
Quando você habilita a indexação automática em um arranjo ligado a um
terminal de entrada de For Loop, o LabVIEW define o terminal de contagem
de acordo com o tamanho do arranjo, para que você não precise ligar o
terminal de contagem. Se você habilitar a indexação automática para mais
de um túnel ou definir o terminal de contagem, a contagem se tornará a
menor entre as duas opções. Por exemplo, se você ligar um arranjo com
10 elementos a um túnel de entrada de For Loop e definir o terminal de
contagem como 15, o loop será executado 10 vezes.
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C. Funções de Array
Utilize as funções de Array, localizadas na paleta Functions»Array,
para criar e manipular arranjos. As funções de Array são:

• Array Size: retorna a quantidade de elementos existentes em cada
dimensão de um arranjo. Se o arranjo for n-dimensional, a saída size
será um arranjo de n elementos. Por exemplo, a função Array Size
retorna um valor size 3 para o seguinte arranjo.

• Initialize Array: cria um arranjo n-dimensional, em que cada elemento
é inicializado com o valor de elemento. Redimensione a função para
aumentar a quantidade de dimensões do arranjo de saída. Por exemplo,
a função Initialize Array retorna o seguinte arranjo para um element
de 4, um dimension size de 3 e um terminal dimension size.

• Build Array: concatena vários arranjos ou anexa elementos a um
arranjo n-dimensional. Redimensione a função para aumentar a
quantidade de elementos no arranjo de saída. Por exemplo, se você
concatenar os dois arranjos anteriores, a função Build Array retornará
o seguinte arranjo.

Para concatenar as entradas em um arranjo mais longo da mesma
dimensão, como mostrado no arranjo a seguir, clique com o botão
direito no nó da função e selecione Concatenate Inputs no menu
de atalho.

• Array Subset: retorna uma parte de um arranjo que inicia no índice
e contém elemento de comprimento. Por exemplo, se você utilizar
o arranjo anterior como a entrada, a função Array Subset retornará
o arranjo a seguir para um index de 2 e um length de 3.

7 4 2

4 4 4

7 4 2

4 4 4

7 4 2 4 4 4

2 4 4
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• Index Array: retorna um elemento de um arranjo em index.
Por exemplo, se você utilizar o arranjo anterior como a entrada,
a função Index Array retornará 2 para um index de 0.

Você também pode utilizar a função Index Array para extrair uma linha
ou coluna de um arranjo 2D e criar um subarranjo do arranjo original.
Para fazer isso, ligue um arranjo 2D à entrada da função. Dois terminais
index estão disponíveis. O primeiro terminal index indica a linha e o
segundo terminal indica a coluna. Você pode ligar entradas aos dois
terminais index para indexar um único elemento ou pode ligar apenas
um terminal para extrair uma linha ou uma coluna de dados.
Por exemplo, ligue o seguinte arranjo à entrada da função.

A função Index Array retorna o seguinte arranjo para um index (row)
de 0.

7 4 2

4 4 4

7 4 2
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D. Polimorfismo
As funções de Numeric, localizadas na paleta Functions»Numeric,
são polimórficas. Isto significa que as entradas para essas funções podem
ser diferentes estruturas de dados, como números escalares e arranjos.
Por exemplo, você pode utilizar a função Add para adicionar um número
escalar a um arranjo ou adicionar dois arranjos juntos. Ligue um número
escalar 2 e o seguinte arranjo à função Add.

A função adiciona o escalar a cada elemento do arranjo e retorna o arranjo
a seguir como resultado.

Se você ligar os dois arranjos anteriores à função Add, a função adicionará
cada elemento de um arranjo ao elemento correspondente do outro arranjo
e retornará o arranjo a seguir como resultado.

Ligue dois arranjos de tamanhos diferentes à função Add, como o arranjo
anterior e o próximo arranjo.

A função adiciona elementos correspondentes e retorna o arranjo a seguir,
que tem o tamanho do menor arranjo de entrada.

Você pode utilizar as funções de Numeric com clusters da mesma maneira
que as utiliza com arranjos de valores numéricos. Consulte a Seção F,
Clusters, para obter mais informações sobre clusters.

1 3 2

3 5 4

4 8 6

3 1 2 3

7 9 8
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Exercise 5-1 VI Array Exercise
Objetivo: Criar arranjos e familiarizar-se com as funções de Array.

Complete os passos a seguir para montar um VI que cria um arranjo de
números aleatórios, escalone o arranjo resultante e cria um subconjunto
do arranjo final.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

a. Selecione um arranjo, localizado na paleta Controls»
Array & Cluster.

b. Nomeie o arranjo como Random Array.

c. Determine um indicador digital, localizado na paleta Controls»
Numeric da caixa de arranjo.

d. Utilize a ferramenta Positioning para redimensionar o controle
de arranjo, de forma que contenha 10 indicadores digitais.

e. Pressione a tecla <Ctrl>, ao mesmo tempo que clica e arrasta
o controle Random Array para criar duas cópias do controle.

f. Nomeie as cópias Final Array e Subset Array.

g. Selecione três controles digitais e nomeie-os Scaling Factor,
Start Subset e # of Elements.

h. Clique com o botão direito nos controles Start Subset e
# of Elements, selecione Representation no menu de atalho
e selecione I32.

i. Ainda não altere os valores dos controles do painel frontal.
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Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

a. Selecione a função Random Number (0–1), localizada na paleta
Functions»Numeric. Essa função gera um número aleatório
entre 0 e 1.

b. Selecione um For Loop, localizado na paleta Functions»
Structures. Esse loop acumula um arranjo de 10 números aleatórios
no túnel de saída. Crie uma constante de 10 para o terminal de
contagem.

c. Selecione a função Array Subset, localizada na paleta Functions»
Array. Essa função retorna uma parte de um arranjo que inicia em
Start Subset e contém elementos # of Elements.

3. Salve o VI como Array Exercise.vi.

4. Exiba o painel frontal, altere os valores dos controles e execute o VI
algumas vezes.

A estrutura de For Loop executa 10 iterações. Cada iteração gera um
número aleatório e armazena-o no túnel de saída. Random Array exibe
um arranjo de 10 números aleatórios. O VI multiplica cada valor contido
em Random Array por Scaling Factor para criar Final Array. O VI
assume um subconjunto de Final Array que inicia em Start Subset
para # of Elements e exibe o subconjunto em Subset Array.

5. Feche o VI.

Final do exercício 5-1
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E. Gráficos de forma de onda e XY
Os VIs com gráficos geralmente coletam os dados em um arranjo e, em
seguida, plotam-nos no gráfico. A seguinte ilustração mostra os elementos
de um gráfico.

Os gráficos localizados na paleta Controls»Graph incluem os gráficos XY
e de forma de onda. O gráfico de forma de onda plota somente funções
com valores individuais, como em y = f(x), com pontos distribuídos
uniformemente ao longo do eixo x, como formas de onda adquiridas com
variação de tempo. Os gráficos XY exibem qualquer conjunto de pontos,
igualmente amostrados ou não.

Redimensione a legenda de plotagem para exibir várias plotagens. Utilize
várias plotagens para economizar espaço no painel frontal e para fazer
comparações entre elas. Gráficos XY e de forma de onda adaptam-se
automaticamente ao modo de plotagem múltipla.

Gráficos de forma de onda de plotagem simples
O gráfico de forma de onda aceita um único arranjo de valores e interpreta
os dados como pontos no gráfico e incrementa o índice x, iniciando em
x = 0. O gráfico também aceita um cluster com um valor inicial x, um ∆x
e um arranjo de dados y. Consulte o VI Waveform Graph no diretório
examples\general\graphs\gengraph.llb para obter exemplos dos
tipos de dados que aceitam gráficos de forma de onda de plotagem simples.

1 Legenda de plotagem
2 Cursor (apenas gráfico)
3 Marca da grade

4 Marca da minigrade
5 Paleta de gráficos
6 Movimentador do cursor

7 Legenda do cursor
8 Legenda da escala
9 Escala X

10 Escala Y
11 Título

10

11

9

1

3

4

8

5

7

6

2
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Gráficos de forma de onda com várias plotagens
Um gráfico de forma de onda com várias plotagens aceita um arranjo 2D
de valores, em que cada linha do arranjo é uma plotagem simples. O gráfico
interpreta os dados como pontos no gráfico e incrementa o índice x em um,
iniciando com x = 0. Ligue um tipo de dados de arranjo 2D ao gráfico,
clique com o botão direito no gráfico e selecione Transpose Array no
menu de atalho para tratar cada coluna do arranjo como uma plotagem.
Consulte o gráfico (Y) Multi Plot 1 no VI Waveform Graph, localizado no
diretório examples\general\graphs\gengraph.llb, para obter um
exemplo de gráfico que aceita esse tipo de dados.

Um gráfico de forma de onda com várias plotagens também aceita um
cluster com um valor x, um valor ∆x e um arranjo 2D de dados y. O gráfico
interpreta os dados y como pontos no gráfico e incrementa o índice x por ∆x,
iniciando em x = 0. Consulte o gráfico (Xo, dX, Y) Multi Plot 3 no VI
Waveform Graph, localizado no diretório examples\general\graphs\
gengraph.llb, para obter um exemplo de gráfico que aceita esse tipo de
dados.

Um gráfico de forma de onda com várias plotagens aceita um cluster com
um valor inicial x, um valor ∆x e um arranjo que contém clusters. Cada
cluster contém um arranjo de ponto com os dados y. Utilize a função Bundle
para agrupar os arranjos em clusters e a função Build Array para montar
os clusters resultantes em um arranjo. Você também pode utilizar a função
Build Cluster Array, que cria arranjos de clusters que contenham as entradas
especificadas. Consulte o gráfico (Xo, dX, Y) Multi Plot 2 no VI Waveform
Graph, localizado no diretório examples\general\graphs\
gengraph.llb, para obter um exemplo de gráfico que aceita esse tipo
de dados.

Gráficos XY
O gráfico XY é um diagrama de gráficos Cartesianos de uso geral que plota
funções com vários valores, como formas circulares ou formas de onda com
base de tempo variável.

Gráficos XY de plotagem simples
O gráfico XY de plotagem simples aceita um cluster que contém um arranjo
x e um arranjo y. O gráfico XY também aceita um arranjo de pontos, em que
um ponto é um cluster que contém um valor x e um valor y. Consulte o
VI XY Graph, localizado no diretório examples\general\graph\
gengraph.llb, para obter um exemplo de tipos de dados de gráfico XY
de plotagem simples.
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Gráficos XY de várias plotagens
O gráfico XY de várias plotagens aceita um arranjo de plotagens, em que
uma plotagem é um cluster que contém um arranjo x e um arranjo y. Esse
gráfico também aceita um arranjo de clusters de plotagens, em que uma
plotagem é um arranjo de pontos. Um ponto é um cluster que contém um
valor x e um valor y. Consulte o VI XY Graph, localizado no diretório
examples\general\graph\gengraph.llb, para obter um exemplo
de tipos de dados de gráfico XY de várias plotagens.
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Exercise 5-2 VI Graph Waveform Array
Objetivo: Criar um arranjo através da indexação automática de um For Loop e plotar o arranjo

em um gráfico de forma de onda.

Complete os passos a seguir para montar um VI que gera e plota um arranjo
em um gráfico e para modificar o VI a fim de traçar um gráfico de várias
plotagens.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

a. Selecione um arranjo, localizado na paleta Controls»
Array & Cluster.

b. Nomeie o arranjo como Waveform Array.

c. Determine um indicador digital, localizado na paleta
Controls»Numeric da caixa de arranjo.

d. Selecione um gráfico de forma de onda, localizado na paleta
Controls»Graph.
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Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

Tip Quando você ligar dados a diagramas e gráficos, utilize a janela Context Help para
determinar como ligá-los, incluindo se irá utilizar ou não uma função Build Array ou
Bundle, a ordem dos terminais de entrada, e assim por diante. Em geral, utilize um
diagrama de forma de onda para pontos escalares únicos, um gráfico de forma de onda
para um arranjo de valores y e um gráfico XY para um arranjo de valores x e um arranjo
de valores y. Por exemplo, se você mover o cursor sobre um terminal de gráfico de forma
de onda no diagrama de bloco, as seguintes informações aparecerão na janela Context
Help. Selecione Help»Examples e Fundamentals»Graphs and Charts para acessar
o exemplo do VI Waveform Graph. Consulte a Lição 8, Aquisição de dados e formas de
onda, para obter mais informações sobre o tipo de dados de forma de onda.

a. Selecione Functions»Select a VI, acesse o diretório
c:\exercises\LV Basics I, clique duas vezes no VI
Thermometer, que você montou no Exercício 3-2, e insira o VI
no diagrama de bloco. Esse VI retorna um ponto de dados de
temperatura simulada durante cada iteração de For Loop.

b. Selecione um For Loop, localizado na paleta Functions»
Structures. Cada iteração de For Loop gera um valor de
temperatura e armazena-o no túnel. Crie uma constante
de 100 para o terminal de contagem.

3. Salve o VI como Graph Waveform Array.vi.



Lição 5 Arranjos, gráficos e clusters

Manual de treinamento do LabVIEW Básico I 5-16 ni.com

4. Exiba o painel frontal e execute o VI. O VI plota o arranjo de forma
de onda indexado automaticamente no gráfico de forma de onda.

5. Insira o índice de qualquer elemento na exibição de índice Waveform
Array para visualizar o valor desse elemento. Se você inserir um
número maior que o tamanho do arranjo, que é 100, a exibição escurece.

6. Utilize a ferramenta Positioning para redimensionar Waveform Array,
com o intuito de visualizar mais de um elemento. O indicador exibe
elementos em ordem crescente de índice, começando com o índice que
você inseriu.

7. Exiba o diagrama de bloco.

Neste diagrama de bloco, você utiliza o valor padrão do valor inicial de
x e ∆x para a forma de onda. Nos casos em que o valor inicial de x e ∆x
for um valor específico, utilize a função Bundle para especificar um
valor inicial de x e ∆x para um arranjo de forma de onda.

8. Monte o seguinte diagrama de bloco.

a. Selecione a função Bundle, localizada na paleta Functions»
Cluster. Essa função monta os elementos de plotagem em um
cluster único. Os elementos incluem o valor inicial de x (20),
o valor de ∆x (0.5) e o arranjo y de dados de forma de onda.

b. Selecione duas constantes numéricas, localizadas na paleta
Functions» Numeric para os valores iniciais de x e ∆x.

c. Nomeie a constante ∆x, digitando Dx. Utilize a ferramenta Labeling
para selecionar a letra D e selecione a fonte Symbol no menu Text
Settings na barra de ferramentas. A letra D é convertida no símbolo
de delta (∆).

9. Exiba o painel frontal.

10. Salve e execute o VI.

O gráfico exibe os mesmos 100 pontos de dados com um valor inicial 20
e um valor ∆x 0.5 para cada ponto no eixo x. Em um teste temporizado,
esse gráfico corresponde a 50 segundos do valor de dados que inicia a
20 segundos.
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11. Clique com o botão direito no gráfico de forma de onda e selecione
Visible Items»Graph Palette no menu de atalho para exibir a paleta de
gráficos. Clique no botão Zoom para ver os dados do gráfico com mais
detalhes.

12. Clique com o botão direito no gráfico e selecione Visible Items»Scale
Legend no menu de atalho para exibir a legenda de escala.

13. Exiba o diagrama de bloco.

14. Altere os valores x0 e ∆x para 0 e 1, respectivamente.

15. Exiba o painel frontal e altere a configuração da escala, como mostrado
no painel frontal a seguir.

Tip Altere os valores iniciais de x e ∆x em apenas um lugar, na função Bundle ou em
X Scale»Formatting.

a. Clique com o botão direito no gráfico de forma de onda e selecione
X Scale»Formatting no menu de atalho.

b. Altere a opção Format para Time & Date.

c. Verifique se a opção HH:MM:SS está selecionada.

d. Altere a opção Scaling Factors para um valor Xo de
7:30:00.00 AM 01/15/2000 e um valor dX de 0:10:00.00.

e. Clique no botão OK para confirmar as alterações.

Se o texto do eixo x não estiver visível, utilize a ferramenta
Positioning para diminuir o tamanho da exibição interna (área preta)
do gráfico.

f. Salve e execute o VI.
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Gráficos de várias plotagens
Complete os passos a seguir para criar um gráfico de forma de onda com
várias plotagens, montando um arranjo 2D do tipo de dados geralmente
transferido para um gráfico de plotagem simples.

16. Monte o seguinte diagrama de bloco.

a. Selecione a função Sine, localizada na paleta Functions»Numeric»
Trigonometric. Utilize essa função para montar um arranjo de
pontos que representa um ciclo de uma onda senoidal.

b. Selecione a função Build Array, localizadana paleta Functions»
Array. Essa função cria a estrutura de dados para plotar dois
arranjos em um gráfico de forma de onda.

c. Selecione a constante pi, localizada na paleta Functions»
Numeric»Additional Numeric Constants.

d. Selecione as funções de Numeric e crie as constantes numéricas,
como mostrado no diagrama de bloco anterior.

17. Exiba o painel frontal.

18. Salve e execute o VI. As duas formas de onda são plotadas no mesmo
gráfico de forma de onda.

19. Exiba o diagrama de bloco.

20. Clique com o botão direito na ligação de Waveform Array, selecione
Custom Probe»Graph no menu de atalho e selecione um gráfico de
forma de onda para inserir uma ponta de prova na ligação.

21. Exiba o painel frontal e execute o VI. A ponta de prova mostra apenas
o arranjo de dados. A onda senoidal não está presente, pois você não
inseriu a ponta de prova na ligação em que a onda senoidal está
agrupada.

22. Feche a janela Probe.
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23. Amplie uma parte do gráfico.

a. Clique no botão Zoom da paleta de gráficos, mostrada à esquerda,
para exibir o seguinte menu.

b. Selecione Zoom by X Rectangle, conforme mostrado.

c. Clique e arraste um retângulo de seleção no gráfico. Quando você
soltar o botão do mouse, a exibição do gráfico será ampliada na área
selecionada.

d. Você também pode selecionar Zoom by Y Rectangle ou Zoom by
Selected Area. Teste estas opções.

e. Selecione Undo Zoom no canto inferior esquerdo do menu para
desfazer um zoom ou clique nos botões de ajuste dos eixos x e y
na legenda de escala, mostrado à esquerda.

24. Utilize a ferramenta Panning, mostrada à esquerda, para clicar na
exibição do gráfico e arrastá-la. Clique nos botões de ajuste único dos
eixos x e y novamente a fim de restaurar a exibição para sua posição
original.

25. Utilize a ferramenta Cursor Movement, mostrada à esquerda, para
retornar o cursor ao modo padrão.

26. Salve e feche o VI.

Final do exercício 5-2
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Exercise 5-3 VI Temperature Analysis
Objetivo: Traçar gráfico e analisar dados.

Complete os passos a seguir para montar um VI que meça a temperatura
a cada 0,25 segundos, por 10 segundos. Durante a aquisição, o VI exibe
as medições em tempo real de um diagrama de forma de onda. Após a
conclusão da aquisição, o VI plota os dados em um gráfico e calcula as
temperaturas máxima, mínima e média. O VI exibe o melhor ajuste do
gráfico de temperatura.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal, utilizando as dicas

a seguir.

• Defina o estilo do ponto da plotagem do diagrama de forma de onda
para um valor x pequeno.

• Oculte a legenda de plotagem do diagrama de forma de onda.

• Clique com o botão direito no diagrama de forma de onda, selecione
X Scale»Formatting no menu de atalho e altere dX para 0.25 e
Digits of Precision para 2.

• Utilize a ferramenta Positioning para redimensionar a legenda de
plotagem do gráfico de forma de onda.

• Utilize a ferramenta Labeling a fim de renomear Plot 0 para Temp
e Plot 1 para Fitted.
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• Defina o estilo de ponto da plotagem Temp do gráfico de forma
de onda para um quadrado pequeno.

• Ainda não crie os indicadores Mean, Max e Min.

Diagrama de bloco

2. Monte o seguinte diagrama de bloco.

a. Selecione Functions»Select a VI, acesse o diretório
c:\exercises\LV Basics I, clique duas vezes no VI
Thermometer, que você montou no Exercício 3-2, e insira o VI
no diagrama de bloco. Esse VI apresenta um ponto de dados de
temperatura simulada.

b. Selecione a função Wait Until Next ms Multiple, localizada na
paleta Functions»Time & Dialog e crie uma constante de 250.
Essa função faz com que o For Loop seja executado a cada
0,25 s (250 ms).

c. Selecione a função Array Max & Min, localizada na paleta
Functions»Array. Essa função retorna os valores de temperatura
máxima e mínima.

d. Selecione o VI Mean, localizado na paleta Functions»
Mathematics»Probability and Statistics. Esse VI retorna a média
das medições de temperatura.

e. Clique com o botão direito nos terminais de saída da função Array
Max & Min e do VI Mean e selecione Create» Indicator no menu
de atalho para criar os indicadores Max, Min e Mean.

f. Selecione o VI General Polynomial Fit, localizado na paleta
Functions»Mathematics»Curve Fitting. Esse VI retorna ao
arranjo de temperatura um arranjo que é um ajuste polinomial.
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g. Selecione a a função Bundle, localizada na paleta Functions»
Cluster. Pressione a tecla <Ctrl> enquanto você arrasta a função
para copiá-la. Essa função monta os elementos de plotagem em um
cluster único. Os elementos incluem o valor inicial de x (0), o valor
de ∆x (0.25) e o arranjo y de dados de temperatura. O valor ∆x de
0.25 é requerido, de forma que o VI plota os pontos do arranjo de
temperatura a cada 0,25 s no gráfico de forma de onda.

h. Selecione a função Build Array, localizada na paleta Functions»
Array. Essa função cria um arranjo de clusters a partir do cluster
de temperatura e do cluster mais adequado.

3. Salve o VI como Temperature Analysis.vi.

4. Exiba o painel frontal e execute o VI.

O gráfico exibe os dados de temperatura e a curva mais adequada
da forma de onda de temperatura.

5. Tente especificar valores diferentes para a constante de ordem
polinomial no diagrama de bloco e execute o VI novamente.

6. Altere a aparência dos gráficos, modificando os estilos de plotagem
e preenchimento.

a. Clique com o botão direito na exibição de plotagem Temp da
legenda de plotagem e selecione Common Plots»Scatter Plot
no menu de atalho, a primeira opção do meio.

b. Clique com o botão direito na exibição de plotagem Fitted da
legenda de plotagem, selecione Bar Plots no menu de atalho e
selecione a segunda opção na linha do meio. O gráfico de forma
de onda deve ser similar ao gráfico de forma de onda a seguir.

7. Salve e feche o VI.

Final do exercício 5-3
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Exercise 5-4 VI Graph Circle (opcional)
Objetivo: Plotar dados utilizando um Gráfico XY.

Complete os passos a seguir para montar um VI que plota um círculo
utilizando arranjos x e y independentes.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

a. Selecione um gráfico XY, localizado na paleta Controls»Graph.

b. Nomeie o gráfico como XY Circle Graph.

c. Altere Plot 0 para Circle na legenda de plotagem.

d. Clique com o botão direito na legenda de plotagem, selecione
Point Style no menu de atalho e selecione o quadrado pequeno.

e. Altere os títulos e as faixas de escala, como mostrado no painel
frontal.
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Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

a. Selecione a função Sine & Cosine, localizada na paleta Functions»
Numeric»Trigonometric. Essa função monta um arranjo de pontos
que representa um ciclo de uma onda senoidal e de uma onda
co-senoidal.

b. Selecione a função Bundle, localizada na paleta Functions»
Cluster. Essa função monta os arranjos senoidal e co-senoidal, de
forma que o arranjo senoidal seja plotado em oposição ao arranjo
co-senoidal para produzir um círculo.

c. Selecione a constante Pi Multiplied by 2, localizada na paleta
Functions»Numeric»Additional Numeric Constants.

3. Salve o VI como Graph Circle.vi.

4. Exiba o painel frontal e execute o VI.

5. Feche o VI.

Final do exercício 5-4
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F. Clusters
Você pode utilizar a função Bundle com diagramas e gráficos, a fim de
agrupar informações para as plotagens. A função Bundle retorna um tipo
de dados chamado cluster. Os clusters agrupam elementos de dados de tipos
diferentes, como um feixe de fios em um cabo de telefone, em que cada fio
do cabo representa um elemento diferente do cluster. Um cluster é similar
a um registro ou uma estrutura em linguagens de programação baseadas
em texto.

O agrupamento de diversos elementos de dados em clusters elimina a
desordem das ligações no diagrama de bloco e reduz a quantidade de
terminais do painel de conectores que os subVIs necessitam. O painel de
conectores tem, no máximo, 28 terminais. Se seu painel frontal contiver
mais do que 28 controles e indicadores a serem utilizados de forma
programática, agrupe alguns deles em um cluster e atribua o cluster a um
terminal no painel de conectores. Assim como um arranjo, o cluster pode
ser um controle ou um indicador. Um cluster não pode conter uma mistura
de controles e indicadores.

Apesar de os elementos de clusters e arranjos serem ambos ordenados, você
deve desagrupar todos os elementos do cluster de uma só vez, em vez de
indexar um elemento de cada vez. Você também pode utilizar a função
Unbundle By Name para acessar elementos específicos do cluster.

Criando controles e indicadores de clusters
Para criar um controle ou indicador de cluster, selecione um cluster na
paleta Controls»Array & Cluster, coloque-o no painel frontal e arraste
controles ou indicadores para o ícone do cluster. Redimensione o ícone
de cluster, arrastando o cursor enquanto você posiciona o ícone do cluster.

O exemplo a seguir é de um cluster de três controles.
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Criando constantes de cluster
Você pode criar uma constante de cluster no diagrama de bloco,
selecionando-a na paleta Functions»Cluster, colocando-a no
diagrama de bloco e arrastando-a para o ícone do cluster.

Se você tiver um controle ou indicador de cluster no painel frontal e desejar
criar uma constante de cluster que contém os mesmos elementos do
diagrama de bloco, poderá arrastar esse cluster do painel frontal para o
diagrama de bloco ou clicar com o botão direito no cluster do painel frontal
e selecionar Create»Constant no menu de atalho.

Ordem dos clusters
Quando o LabVIEW manipula clusters de dados, tanto os tipos de dados
dos elementos individuais do cluster e quanto a ordem dos elementos no
cluster são importantes. Os elementos do cluster têm uma ordem lógica
que não está relacionada a suas posições no ícone. O primeiro objeto que
você insere no ícone do cluster é o elemento 0, o segundo é o elemento 1,
e assim por diante. Se você excluir um elemento, a ordem será ajustada
automaticamente. Utilize a ordem do cluster para acessar seus elementos,
da mesma forma que você utiliza indexação automática para arranjos.

Você pode alterar a ordem dos objetos em um controle, um indicador ou
uma constante de cluster no painel frontal ou no diagrama de bloco, clicando
com o botão direito na borda do cluster e selecionando Reorder Controls
In Cluster no menu de atalho. A barra de ferramentas e o cluster são
alterados, como mostrado no exemplo a seguir.

1 Botão Confirm
2 Botão Cancel

3 Cursor de ordem de cluster
4 Ordem atual

5 Nova ordem

5 4

1

3

2
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A caixa branca em cada elemento mostra sua posição atual na ordem do
cluster. A caixa preta mostra a nova localização de um elemento na ordem
do cluster. Para definir a ordem de um elemento do cluster, digite o número
da nova ordem no campo Click to set to e clique no elemento. A ordem de
cluster do elemento é alterada e a ordem de cluster de outros elementos
ajustada. Salve as alterações, clicando no botão Confirm da barra de
ferramentas. Reverta para as definições originais, clicando no botão Cancel.

Elementos correspondentes, determinados pela ordem do cluster, devem ter
tipos de dados compatíveis. Por exemplo, em um cluster, o elemento 0 é um
controle numérico e o elemento 1 é um controle de string. Em um segundo
cluster, o elemento 0 é um indicador numérico e o elemento 1 é um
indicador de string. O controle de cluster é ligado corretamente ao indicador
de cluster.

Entretanto, se você alterar a ordem do cluster do indicador de maneira que o
indicador de string seja elemento 0 e o indicador numérico seja elemento 1,
a ligação que conecta o controle de cluster ao indicador de cluster parecerá
interrompida, indicando que os tipos de dados são incompatíveis.
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G. Funções de Cluster
Utilize as funções de Cluster, localizadas na paleta Functions»Cluster,
para criar e manipular clusters. Utilize as funções Bundle e Bundle by Name
para montar e manipular clusters e utilize as funções Unbundle e Unbundle
by Name para desmontar clusters.

Você também pode criar as funções Bundle, Bundle by Name, Unbundle e
Unbundle by Name, clicando com o botão direito em um terminal do cluster
no diagrama de bloco e selecionando Cluster Tools no menu de atalho.
As funções Bundle e Unbundle automaticamente contêm o número correto
de terminais. As funções Bundle by Name e Unbundle by Name aparecem
com o primeiro elemento no cluster.

Montando clusters
Utilize a função Bundle para montar elementos de entrada individuais em
um cluster único ou para alterar os valores de elementos individuais em um
cluster já existente. Utilize a ferramenta Positioning para redimensionar
a função ou clique com o botão direito em um terminal component e
selecione Add Input no menu de atalho. Se você ligar um cluster ao
terminal de entrada cluster, o número de terminais de entrada deverá
corresponder ao número de elementos do cluster de entrada.

Se você ligar o terminal de entrada cluster, poderá ligar apenas os
componentes a serem alterados. Por exemplo, o cluster a seguir contém
três controles.
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Se você souber a ordem do cluster, poderá utilizar a função Bundle para
alterar o valor de Command, ligando os seguintes elementos.

Substituindo ou acessando elementos do cluster
Utilize a função Bundle by Name para substituir ou acessar elementos
de um cluster já existente. A função Bundle by Name funciona de forma
semelhante à função Bundle, mas, em vez de fazer referência a elementos
do cluster de acordo com sua ordem, faz referência de acordo com seus
títulos. Você só pode acessar elementos com títulos. O número de terminais
de entrada não precisa corresponder ao número de elementos em um cluster
nomeado.

Utilize a ferramenta Operating para clicar em um terminal de entrada e
selecionar um elemento do menu. Você também pode clicar com o botão
direito no terminal de entrada e selecionar o elemento no menu de atalho
Select Item.

No exemplo a seguir, você pode utilizar a função Bundle by Name para
alterar Command e Function.

Utilize a função Bundle by Name para estruturas de dados que podem ser
alteradas durante o desenvolvimento. Se você adicionar um novo elemento
ao cluster ou modificar sua ordem, não precisará ligar novamente a função
Bundle by Name, pois os nomes ainda serão válidos.
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Desmontando clusters
Utilize a função Unbundle para dividir um cluster em seus elementos
individuais.

Utilize a função Unbundle by Name para retornar os elementos do cluster,
cujos nomes você especifica. O número de terminais de saída não depende
do número de elementos no cluster de entrada.

Utilize a ferramenta Operating para clicar em um terminal de saída e
selecione um elemento no menu. Você também pode clicar com o botão
direito no terminal de saída e selecionar o elemento no menu de atalho
Select Item.

Por exemplo, se você utilizar a função Unbundle com o cluster a seguir, ele
terá quatro terminais de saída que corresponderão aos quatro controles do
cluster. É necessário saber a ordem do cluster para que você possa associar
o terminal Booleano correto do cluster desagrupado à chave correspondente
no cluster. Neste exemplo, os elementos são ordenados de cima para baixo,
iniciando com o elemento 0. Se você utilizar a função Unbundle by Name,
poderá ter um número arbitrário de terminais de saída e acessar elementos
individuais por nome em qualquer ordem.
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Exercise 5-5 VI Cluster Exercise
Objetivo: Criar clusters no painel frontal e utilizar as funções de Cluster para montar

e desmontar clusters.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

a. Selecione um botão Stop, um indicador digital e um LED redondo.

b. Selecione um cluster, localizado na paleta Controls»
Array & Cluster.

c. Selecione os quatro objetos do painel frontal no cluster.

d. Crie Modified Cluster duplicando Cluster, renomeando-o
e clicando com o botão direito no ícone e selecionando Change
to Indicator no menu de atalho.

e. Repita o passo d para criar Small Cluster e altere os indicadores,
como mostrado no painel frontal anterior.

2. Verifique a ordem do cluster de Cluster e Small Cluster. A caixa
Modified Cluster deve ter a mesma ordem que a caixa Cluster.

a. Clique com o botão direito no limite de cada cluster e selecione
Reorder Controls in Cluster no menu de atalho.

b. Defina as ordens dos clusters a seguir.
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Diagrama de bloco
3. Monte o seguinte diagrama de bloco.

a. Selecione a função Unbundle, localizada na paleta Functions»
Cluster. Essa função desmonta Cluster. Redimensione essa função
para quatro terminais de saída ou ligue o cluster de entrada para
redimensionar a função automaticamente.

b. Selecione a função Bundle, localizada na paleta Functions»
Cluster. Essa função monta Small Cluster.

c. Selecione a função Unbundle by Name, localizada na paleta
Functions»Cluster. Essa função retorna dois elementos de Cluster.
Redimensione-a para ter dois terminais de saída. Se os nomes dos
títulos não estiverem corretos, clique com o botão direito no nome
e selecione o nome correto no menu de atalho Select Item.

d. Selecione a função Increment, localizada na paleta Functions»
Numeric. Essa função adiciona um ao valor de Numeric.

e. Selecione a função Not, localizada na paleta Functions»Boolean.
Essa função retorna o valor lógico oposto ao valor de Boolean.
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f. Selecione a função Bundle by Name, localizada na paleta
Functions»Cluster. Essa função substitui os valores de Numeric
e Boolean em Cluster e cria Modified Cluster. Redimensione
essa função para ter dois terminais de entrada. Se os nomes dos
títulos não estiverem corretos, clique com o botão direito no nome
e selecione o nome correto no menu de atalho Select Item.

g. Clique com o botão direito no terminal condicional da estrutura
de While Loop e selecione Stop If True no menu de atalho.
O VI cessará quando você clicar no botão Stop.

4. Salve o VI como Cluster Exercise.vi.

5. Exiba o painel frontal e execute o VI.

6. Insira valores diferentes em Cluster e execute o VI novamente.

7. Feche o VI.

Final do exercício 5-5
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Exercise 5-6 VI Cluster Scaling (opcional)
Objetivo: Montar um VI que utiliza polimorfismo com clusters.

Complete os passos a seguir para montar um VI que escalone valores
armazenados em um cluster, em que cada elemento do cluster tenha
um fator de escala diferente. Assuma que as tensões foram medidas
por transdutores que mediram a pressão, a proporção de escoamento
e a temperatura. Em seguida, o VI escalona estes valores para obter os
valores reais presentes no sistema.

Painel frontal
1. Abra o VI Cluster Scaling. O painel frontal já está montado.

2. Altere os controles do painel frontal, como mostrado.

Diagrama de bloco
3. Monte o seguinte diagrama de bloco. Certifique-se de aplicar os

fatores de escala corretos para cada elemento no cluster Raw Data.

4. Salve e execute o VI.

5. Altere os controles do painel frontal e execute o VI novamente.

6. Feche o VI.

Final do exercício 5-6
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Resumo, dicas e suplementos

• Arranjos agrupam elementos de dados do mesmo tipo. Você pode
montar arranjos de tipos de dados numéricos, Booleanos, diretório,
string, forma de onda e cluster.

• O índice é baseado em zero, o que significa que ele está na faixa
de 0 até n – 1, em que n é o número de elementos no arranjo.

• Você deve inserir um objeto na caixa de arranjo, antes de utilizar
o arranjo no diagrama de bloco. Do contrário, o terminal de arranjo
aparece em preto e com um colchete vazio.

• Para criar um controle ou indicador de arranjo, selecione um arranjo na
paleta Controls»Array & Cluster, insira-o no painel frontal e arraste
um controle ou indicador para a caixa de arranjo.

• Se você ligar um arranjo a um túnel de entrada For Loop ou While Loop,
poderá ler e processar todos os elementos desse arranjo, habilitando a
função de indexação automática.

• Utilize as funções de Array, localizadas na paleta Functions»Array,
para criar e manipular arranjos.

• Por padrão, o LabVIEW habilita a indexação automática em For Loops
e desabilita-a em While Loops.

• Polimorfismo é a capacidade de uma função ser ajustada para dados de
entrada de diferentes estruturas de dados.

• Os gráficos de forma de onda e XY exibem dados de arranjos.

• Clique com o botão direito em um gráfico ou em seus elementos para
configurá-lo.

• Você pode exibir mais de uma plotagem em um gráfico, utilizando a
função Build Array, disponível na paleta Functions»Array, e a função
Bundle, disponível na paleta Functions»Cluster para diagramas e
gráficos XY. O gráfico torna-se um gráfico de várias plotagens quando
você liga o arranjo de saída ao terminal.

• Quando você ligar dados a diagramas e gráficos, utilize a janela Context
Help para determinar como ligá-los.

• Os clusters agrupam elementos de dados de tipos diferentes. Um cluster
não pode conter uma mistura de controles e indicadores.

• Se seu painel frontal contiver mais de 28 controles e indicadores que
você deseja utilizar de forma programática, agrupe alguns deles em um
cluster e atribua o cluster a um terminal para eliminar a desordem no
diagrama de bloco.
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• Para criar um controle ou indicador de cluster, selecione um cluster na
paleta Controls»Array & Cluster, coloque-o no painel frontal e arraste
controles ou indicadores para o ícone do cluster.

• Utilize as funções de Cluster, localizadas na paleta Functions»Cluster,
para criar e manipular clusters.
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Exercícios adicionais
5-7 Monte um VI que reverta a ordem de um arranjo que contém

100 números aleatórios. Por exemplo, array[0] torna-se array[99],
array[1] torna-se array[98], e assim por diante.

Tip Utilize a função Reverse 1D Array, disponível na paleta Functions»Array para
reverter a ordem do arranjo.

Salve o VI como Reverse Random Array.vi.

5-8 Monte um VI que acumule um arranjo de valores de temperatura,
utilizando o VI Thermometer, que você montou no Exercício 3-2.
Defina o tamanho do arranjo com um controle no painel frontal.
Inicialize um arranjo utilizando a função Initialize Array do mesmo
tamanho, em que todos os valores são iguais a 10. Adicione os dois
arranjos, calcule o tamanho do arranjo final e extraia o valor
intermediário do arranjo final. Exiba as funções Temperature
Array, Initialized Array, Final Array e Mid Value.

Salve o VI como Find Mid Value.vi.

5-9 Monte um VI que gere um arranjo 2D de três linhas por 10 colunas,
contendo números aleatórios. Após a geração do arranjo, indexe
cada linha e plote cada linha em seu próprio gráfico. O painel frontal
deve conter três gráficos.

Salve o VI como Extract 2D Array.vi.

5-10 Monte um VI que simule a jogada de um dado com valores possíveis
de 1 a 6 e grave o número de vezes que o dado cai em cada valor.
A entrada é o número de vezes que o dado deve ser jogado e as
saídas incluem o número de vezes que o dado cai em um valor
possível. Utilize apenas um registrador de deslocamento.

Salve o VI como Die Roller.vi.

5-11 Monte um VI que gere um arranjo 1D e multiplique pares de
elementos juntos, iniciando com os elementos 0 e 1, e retorne o
arranjo resultante. Por exemplo, o arranjo de entrada com valores
1 23 10 5 7 11 resulta em um arranjo de saída 23 50 77.

Tip Utilize a função Decimate 1D Array, disponível na paleta Functions»Array.

Salve o VI como Array Pair Multiplier.vi.

Desafio

Desafio
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Anotações



© National Instruments Corporation 6-1 Manual de treinamento do LabVIEW Básico I

Lição 6
Estruturas Case e Sequence

Esta lição descreve as estruturas Case (condicionais) e Sequence
(seqüenciais) e o Formula Node, disponíveis na paleta Functions»
Structures, e o Expression Node, disponível na paleta Functions»
Numeric.

Você aprenderá:

A. Como utilizar a estrutura Case

B. Como utilizar a estrutura Sequence

C. Como utilizar o Formula Node

D. Como substituir estruturas Sequence
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A. Estruturas Case
A estrutura Case, como como mostrada à esquerda, tem dois ou mais
subdiagramas ou condições. Apenas um subdiagrama pode ser visto
de cada vez, e a estrutura executa apenas uma condição de cada vez.
Um valor de entrada determina qual subdiagrama será executado.
A estrutura Case é semelhante às declarações condicionais ou declarações
if...then...else em linguagens de programação baseadas em texto.

O identificador do seletor de condições na parte superior da estrutura Case,
como mostrado à esquerda, contém o identificador do seletor de condições
no centro e botões de seta de incremento e decremento de cada lado. Utilize
os botões de seta de incremento e decremento para rolar pelas condições
disponíveis.

Ligue um valor de entrada, ou seletor, ao terminal do seletor, como
mostrado à esquerda, para determinar qual condição será executada. Você
deve ligar um número inteiro, um valor Booleano, uma string ou um valor
de tipo numérico ao terminal do seletor. Você pode posicionar o terminal do
seletor em qualquer lugar da borda esquerda da estrutura Case. Se o terminal
do seletor for Booleano, a estrutura terá uma condição TRUE e uma
condição FALSE. Se o terminal do seletor for um inteiro, uma string ou
um valor de tipo numérico, a estrutura poderá ter até 231–1 condições.

Você pode especificar uma condição padrão para a estrutura Case. Você
deve especificar uma condição padrão para tratar de valores fora de faixa
ou listar expressamente todos os valores possíveis de entrada. Por exemplo,
se você especificou condições para 1, 2 e 3, mas obteve uma entrada de 4,
a estrutura Case executará a condição padrão.

Clique com o botão direito na borda da estrutura Case para adicionar,
duplicar, remover ou reorganizar condições e selecionar uma condição
padrão.

Túneis de entrada e saída
Você pode criar vários túneis de entrada e saída para uma estrutura Case.
Há entradas disponíveis para todos os subdiagramas, mas eles não precisam
utilizar todas elas. Entretanto, você deve definir um túnel de saída para cada
condição. Quando você cria um túnel de saída em uma condição, os túneis
aparecem na mesma posição na borda em todas as outras condições. Túneis
de saída não ligados aparecem como quadrados brancos. Você pode definir
diferentes tipos de dados para o mesmo túnel de saída em cada condição,
mas os tipos de dados devem ser compatíveis.
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Ligue o túnel de saída para cada condição não ligada, clicando no túnel a
cada vez. Você também pode ligar constantes ou controles às condições não
ligadas, clicando com o botão direito no túnel e selecionando Create»
Constant ou Create»Control no menu de atalho.

Exemplos
Nos exemplos a seguir, os dados numéricos passam pelos túneis para
obterem a estrutura Case e são adicionados ou subtraídos, dependendo
do valor ligado ao terminal do seletor.

Estrutura Case Booleana
O exemplo a seguir é uma estrutura Case Booleana.

Se o controle Booleano ligado ao terminal do seletor for TRUE, o VI
adicionará os dados numéricos. Do contrário, o VI subtrairá os dados
numéricos.

Estrutura Case utilizando números inteiros
O exemplo a seguir é uma estrutura Case que utiliza números inteiros.

Integer é um controle tipo “text ring”, localizado na paleta Controls»Ring
& Enum, que associa dados numéricos a um texto. Se o controle “text ring”
ligado ao terminal do seletor for 0 (add), o VI irá adicionar os dados
numéricos. Se o valor for 1 (subtract), o VI irá subtrair os dados
numéricos.
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Estrutura Case de string
O exemplo a seguir é uma estrutura Case de string.

Se String for add, o VI adicionará os dados numéricos. Se String for
subtract, o VI subtrairá os dados numéricos.

Selecionando uma condição
Para selecionar uma condição, digite os valores no identificador do seletor
de condição ou utilize a ferramenta Labeling para editar os valores.

Especifique um único valor ou listas e faixas de valores para selecionar a
condição. Em listas de valores, utilize vírgulas para separá-los. Selecione
uma faixa, como 10..20, para todos os números de 10 a 20. Você também
pode utilizar faixas ilimitadas. Por exemplo, ..100 representa todos os
números menores ou iguais a 100. Você também pode combinar listas e
faixas, por exemplo, ..5, 6, 7..10, 12, 13, 14. Quando você insere
um seletor que contém faixas sobrepostas, a estrutura Case exibe novamente
o seletor em um formato mais compacto. O exemplo anterior é demonstrado
como ..10, 12..14.

Se você inserir um valor de seletor que não seja do mesmo tipo do
objeto ligado ao terminal do seletor, o VI não funcionará e o valor
aparecerá em vermelho para indicar que deve ser apagado, ou editado
antes que a estrutura possa ser executada. Além disso, devido ao possível
erro de arredondamento inerente à aritmética de ponto flutuante, você não
pode utilizar dados numéricos de ponto flutuante como valores do seletor
de condição. Se você ligar um valor de ponto flutuante à condição, o
LabVIEW arredondará o valor para o número par e inteiro mais próximo.
Se você digitar um valor de ponto flutuante no seletor, o valor aparecerá
em vermelho para indicar que é necessário apagar ou editar o valor antes
de a estrutura ser executada.
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Exercise 6-1 VI Square Root
Objetivo: Utilizar a estrutura Case.

Complete os passos a seguir para montar um VI que verifique se um número
é positivo. Se sim, o VI calculará a raiz quadrada do número. Do contrário,
o VI retorna uma mensagem de erro.

Cuidado Não execute esse VI continuamente.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

a. Selecione uma estrutura Case, localizada na paleta Functions»
Structures.

b. Clique nos botões de seta de incremento e decremento para
selecionar a condição FALSE.

c. Selecione a função Greater or Equal to 0?, localizada na paleta
Functions»Comparison. Essa função retorna uma condição
TRUE se o indicador Numeric for maior ou igual a 0.

d. Clique com o botão direito na constante numérica e selecione
Format & Precision no menu de atalho. Defina Digits of Precision
como 1, selecione Floating Point Notation e clique no botão OK.

e. Selecione a função One Button Dialog, localizada na paleta
Functions»Time & Dialog. Essa função exibe uma caixa de diálogo
que contém a mensagem Error...Negative Number.
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f. Clique com o botão direito no terminal message da função One
Button Dialog, selecione Create»Constant no menu de atalho,
digite Error...Negative Number e pressione a tecla <Enter>.
Consulte a Lição 7, Strings e I/O (entrada/saída) de arquivo, para
obter mais informações sobre strings.

g. Selecione a condição TRUE e a função Square Root, localizada na
paleta Functions»Numeric, como mostrado no diagrama de bloco
a seguir. Essa função retorna a raiz quadrada de Numeric.

3. Salve o VI como Square Root.vi.

4. Exiba o painel frontal e execute o VI.

Se Numeric for positivo, o VI executará a condição TRUE e retornará
a raiz quadrada de Numeric. Se Numeric for negativo, o VI executará
a condição FALSE, retornará o valor –99999.0 e exibirá uma caixa de
diálogo com a mensagem Error...Negative Number.

5. Feche o VI.

Final do exercício 6-1
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Exercise 6-2 VI Temperature Control
Objetivo: Utilizar a estrutura Case.

Complete os passos a seguir para montar um VI que detecta quando uma
temperatura está fora da faixa. Se a temperatura exceder o limite, um LED
acenderá e um sinal sonoro será emitido.

Painel frontal
1. Abra o VI Temperature Running Average, que você montou no

Exercício 4-5.

2. Modifique o painel frontal conforme indicado.

3. Clique com o botão direito na exibição do diagrama e selecione
Visible Items»Digital Display no menu de atalho para exibir os
valores numéricos.

4. Salve o VI como Temperature Control.vi.
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Diagrama de bloco

5. Modifique o diagrama de bloco da seguinte forma. A condição FALSE
da estrutura Case está vazia.

a. Selecione a função Greater?, localizada na paleta Functions»
Comparison. Essa função retornará uma condição TRUE se
a temperatura exceder o valor especificado em High Limit.

Do contrário, a função retornará uma condição FALSE.

b. Selecione o VI Beep, localizado na paleta Functions»Graphics &
Sound»Sound. Esse VI emitirá um sinal sonoro se o terminal do
seletor da estrutura Case receber a condição TRUE.

c. (Macintosh) Forneça valores para os terminais de entrada do VI
Beep.

6. Salve o VI, pois este será utilizado posteriormente no curso.

7. Exiba o painel frontal, insira 80 em High Limit e execute o VI.

Se o VI retornar um valor de temperatura maior que o controle digital
High Limit, o LED Warning acenderá, o VI executará uma condição
TRUE e um sinal sonoro será emitido. Se o valor de temperatura for
menor que o controle digital High Limit, o LED Warning apagará,
o VI executará a condição FALSE e nenhum sinal sonoro será emitido.

8. Feche o VI.

Final do exercício 6-2
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B. Estruturas Sequence
Uma estrutura Sequence, como mostrada à esquerda, contém um ou
mais subdiagramas, ou quadros, que são executados em ordem seqüencial.
Uma estrutura Sequence executa o quadro 0, depois o quadro 1, depois
o quadro 2, e assim por diante. Essa estrutura não completa sua execução
nem retorna nenhum dado até que o último quadro seja executado.

Utilize a estrutura Sequence para controlar a ordem de execução quando
não existir dependência natural de dados. Um nó que recebe dados de um
outro nó depende do outro nó para obter dados e sempre é executado após a
conclusão da execução do outro nó. Dentro de cada quadro de uma estrutura
Sequence, assim como no restante do diagrama de bloco, a dependência dos
dados é que determina a ordem de execução dos nós.

Os túneis das estruturas Sequence podem ter apenas uma fonte de dados,
diferente das estruturas Case. A saída pode ser emitida a partir de qualquer
quadro, mas os dados deixam a estrutura Sequence somente quando a
execução de todos os quadros estiver concluída, e não quando quadros
individuais concluírem suas execuções. Assim como nas estruturas Case,
os dados em túneis de entrada estão disponíveis para todos os quadros.

Seqüências locais
Para transferir dados de um quadro para qualquer quadro subseqüente,
utilize um terminal de seqüência local (sequence local), como mostrado à
esquerda. Uma seta apontando para fora aparece no terminal de seqüências
locais do quadro que contém a fonte de dados. O terminal nos quadros
subseqüentes contém uma seta apontando para dentro, indicando que o
terminal é uma fonte de dados para aquele quadro. Você não pode utilizar o
terminal de seqüências locais em quadros que antecedem o primeiro quadro,
onde você ligou a seqüência local. Clique com o botão direito na borda da
estrutura e selecione Add Sequence Local no menu de atalho para criar
uma seqüência local.

O exemplo a seguir mostra uma estrutura Sequence de três quadros. Uma
seqüência local no quadro 1 transfere o valor que o VI Thermometer retorna
para o quadro 2, conforme indicado pela seta que está apontando para o
quadro 2. Esse valor não está disponível no quadro 0, conforme indicado
pelo quadrado escuro.
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Exercise 6-3 VI Time to Match
Objetivo: Utilizar a estrutura Sequence.

Complete os passos a seguir para montar um VI que calcule o tempo
necessário para gerar um número aleatório que corresponda a um
número que você especificar.

Painel frontal
1. Abra o VI Auto Match, que você montou no Exercício 4-3.

2. Modifique o painel frontal conforme indicado.

a. Altere Number to Match, Current Number e # of iterations
para representação I32.

b. Altere Time to Match para representação DBL com 3 dígitos
de precisão.

3. Salve o VI como Time to Match.vi.

Diagrama de bloco
4. Modifique o diagrama de bloco conforme indicado.
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a. Selecione uma estrutura Sequence, localizada na paleta
Functions»Structures.

b. Clique com o botão direito na borda da estrutura e selecione
Add Frame After no menu de atalho para adicionar um quadro.

c. Selecione a função Tick Count (ms), localizada na paleta
Functions»Time & Dialog. Essa função lê o valor atual do
relógio do sistema operacional e retorna o valor em milissegundos.

5. Salve o VI.

6. Exiba o painel frontal, insira um número em Number to Match
e execute o VI.

No quadro 0, o VI executa o While Loop, enquanto Current Number
não corresponde a Number to Match. No quadro 1, a função Tick
Count (ms) lê o relógio do sistema operacional. O VI subtrai o novo
valor da leitura de tempo inicial e retorna o tempo decorrido em
segundos.

Nota Se Time to Match for sempre 0.000, o VI poderá estar sendo executado muito
rapidamente. Execute um VI com o modo de animação de execução habilitado ou
aumente o valor da constante numérica ligada à função Multiply no quadro 0 para
um valor maior, como 1000000.

7. Feche o VI.

Final do exercício 6-3
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C. Estrutura de fórmula e expressão
Utilize as estruturas Formula Node e Expression Node para executar
operações matemáticas no ambiente LabVIEW. Para obter funcionalidade
mais avançada, vincule às aplicações matemáticas HiQ e MATLAB para
desenvolver equações. HiQ e MATLAB são pacotes de software que
ajudam você a organizar e visualizar problemas reais de engenharia,
ciência e matemática.

Estrutura de fórmula
O Formula Node é um conveniente nó baseado em texto que você pode
utilizar para executar operações matemáticas no diagrama de bloco.
As estruturas de fórmula são úteis para equações que possuem muitas
variáveis ou são complicadas demais e para a utilização de código baseado
em texto já existente. Você pode copiar e colar o código baseado em texto
já existente em um Formula Node, em vez de recriá-lo graficamente no
diagrama de bloco.

Crie os terminais de entrada e saída do Formula Node, clicando com o botão
direito na borda da estrutura e selecionando Add Input ou Add Output no
menu de atalho. Digite a equação na estrutura. Cada declaração da equação
deve terminar com um ponto-e-vírgula (;).

O Formula Node pode executar várias operações diferentes. Consulte a
Ajuda do LabVIEW para obter mais informações sobre funções, operações
e sintaxe do Formula Node.

Estrutura de expressão
Utilize as estruturas de expressão para calcular expressões ou equações que
contenham uma só variável. As estruturas de expressão são úteis quando
uma equação possui apenas uma variável, mas mesmo assim é complicada.
Essas estruturas utilizam o valor que você transfere para o terminal de
entrada como o valor da variável. O terminal de saída retorna o valor do
cálculo.
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Exercise 6-4 VI Formula Node Exercise
Objetivo: Utilizar o Formula Node.

Complete os passos a seguir para montar um VI que utilize o Formula
Node para executar uma operação matemática complexa e que represente
graficamente os resultados.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

a. Selecione o Formula Node, localizado na paleta Functions»
Structures.

b. Crie o terminal de entrada x, clicando com o botão direito na
borda esquerda e selecionando Add Input no menu de atalho.

c. Crie os terminais de saída y e a, clicando com o botão direito na
borda direita e selecionando Add Output no menu de atalho. Você
deve criar terminais de saída para variáveis temporárias, como a.

Nota Quando você cria um terminal de entrada ou saída, deve utilizar um nome de
variável que corresponda exatamente ao nome especificado na equação. Os nomes
de variáveis coincidem maiúsculas e minúsculas.
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d. Digite as seguintes equações no Formula Node, em que ** é o
operador de exponenciação. Consulte a Ajuda do LabVIEW para
obter mais informações sobre a sintaxe do Formula Node.
a = tanh(x) + cos(x);

y = a**3 + a;

3. Salve o VI como Formula Node Exercise.vi.

4. Exiba o painel frontal e execute o VI. O gráfico exibe a plotagem
da equação y = f(x)3 + f(x), em que f(x) = tanh(x) + cos(x).

Durante cada iteração, o VI divide o valor do terminal de iteração
por 15,0. O quociente é ligado ao Formula Node, que calcula o
valor da função. O VI plota o arranjo como um gráfico.

5. Feche o VI.

Final do exercício 6-4
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D. Evitando o excesso de utilização de estruturas Sequence
Para tirar proveito da característica de execução paralela no LabVIEW,
evite utilizar estruturas Sequence demais. As estruturas Sequence garantem
a ordem de execução e desabilitam operações paralelas. Por exemplo,
tarefas assíncronas que utilizam dispositivos de I/O (entrada/saída), como
PXI, GPIB, portas seriais e dispositivos DAQ, poderão ser executadas
simultaneamente com outras operações se as estruturas Sequence não as
impedirem de fazer isso. As estruturas Sequence também ocultam seções
do diagrama de bloco e o fluxo natural de dados da esquerda para a direita.

Quando você precisar controlar a ordem de execução, considere o
estabelecimento de dependência de dados entre os nós. Por exemplo, você
pode utilizar a I/O de erros para controlar a ordem de execução de I/O.

Além disso, não utilize estruturas Sequence se desejar atualizar um
indicador de quadros diferentes dessa estrutura. Por exemplo, um VI
utilizado em uma aplicação de teste deve ter um indicador Status que exibe
o nome do teste atual em andamento. Se cada teste for um subVI chamado
de um quadro diferente, você não poderá atualizar o indicador de cada
quadro, como mostrado pela ligação interrompida no diagrama de bloco
a seguir.

Como todos os quadros de uma estrutura Sequence são executados antes de
qualquer dado sair da estrutura, somente um quadro pode atribuir um valor
ao indicador Status.

Em vez disso, utilize uma estrutura Case e um While Loop, como mostrado
no exemplo a seguir.
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Cada condição da estrutura Case é equivalente a um quadro da estrutura
Sequence. Cada iteração do While Loop executa a próxima condição. O
indicador Status exibe o status do VI para cada condição. Esse indicador é
atualizado na condição anterior àquela que chama o subVI correspondente,
pois os dados saem da estrutura após a execução de cada condição.

Diferente de uma estrutura Sequence, uma estrutura Case podem transferir
dados para finalizar o While Loop durante qualquer condição. Por exemplo,
se um erro ocorrer durante a execução do primeiro teste, a estrutura Case
pode enviar uma condição FALSE para o terminal condicional finalizar
o loop. No entanto, uma estrutura Sequence deve executar todos os seus
quadros, mesmo se ocorrer um erro.
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Resumo, dicas e suplementos

• Uma estrutura Case tem dois ou mais subdiagramas, ou condições.
Apenas um subdiagrama pode ser visto de cada vez, e a estrutura
executa apenas uma condição de cada vez. Se o terminal do seletor for
Booleano, a estrutura terá uma condição TRUE e uma condição FALSE.
Se o terminal do seletor for um inteiro, uma string ou um valor de tipo
numérico, a estrutura poderá ter até 231–1 condições.

• Há entradas disponíveis para todos os subdiagramas, mas eles não
precisam utilizar todas elas. Entretanto, você deve definir um túnel de
saída para cada condição. Túneis de saída não ligados aparecem como
quadrados brancos.

• Uma estrutura Sequence contém um ou mais subdiagramas, ou quadros,
que são executados em ordem seqüencial. Uma estrutura Sequence
executa o quadro 0, depois o quadro 1, depois o quadro 2, até executar
o último quadro. Essa estrutura não completa sua execução nem retorna
nenhum dado até que o último quadro seja executado.

• Para transferir dados de um quadro para qualquer quadro subseqüente,
utilize um terminal de seqüência local. Clique com o botão direito na
borda da estrutura e selecione Add Sequence Local no menu de atalho
para criar uma seqüência local.

• As estruturas de fórmula são úteis para equações que possuem muitas
variáveis ou são complicadas demais e para a utilização de código
baseado em texto já existente. Cada declaração da equação deve
terminar com um ponto-e-vírgula (;).

• Utilize estruturas de expressão para calcular expressões ou equações que
contenham uma só variável.

• Para tirar proveito da característica de execução paralela no LabVIEW,
evite utilizar estruturas Sequences demais. Quando você precisar
controlar a ordem de execução, utilize o estabelecimento de
dependência de dados entre os nós.

• Não utilize estruturas Sequence se você desejar atualizar um
indicador de quadros diferentes dessa estrutura. Em vez disso,
utilize uma estrutura Case e um While Loop.
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Exercícios adicionais
6-5 Monte um VI que utilize o Formula Node para calcular as seguintes

equações:

y1 = x3 + x2 + 5

y2 = mx + b

Utilize apenas um Formula Node para as duas equações e utilize
um ponto-e-vírgula (;) após cada equação no nó.

Salve o VI como Equations.vi.

6-6 Monte um VI que funcione como uma calculadora. No painel
frontal, utilize controles digitais para inserir dois números e um
indicador digital para exibir o resultado da operação (Add, Subtract,
Divide ou Multiply) que o VI executa com os dois números. Utilize
um controle deslizante para especificar a operação a ser executada.

Salve o VI como Calculator.vi.

6-7 Modifique o VI Square Root, que você montou no Exercício 6-1, de
maneira que o VI execute todos os cálculos e todas as verificações
de condição utilizando o Formula Node.

Salve o VI como Square Root 2.vi.

6-8 Monte um VI com duas entradas, Threshold e Input Array, e
uma saída, Output Array. Output Array contém valores de
Input Array que são maiores do que os valores de Threshold.

Salve o VI como Array Over Threshold.vi.

Crie um outro VI que gere um arranjo de números aleatórios entre
0 e 1 e utilize o VI Array Over Threshold para fornecer um arranjo
com os valores maiores do que 0.5.

Salve o VI como Using Array Over Threshold.vi.

Desafio
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Anotações
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Anotações
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Lição 7
Strings e I/O (entrada/saída) de arquivo

Strings agrupam seqüências de caracteres ASCII. Operações de I/O
de arquivo transferem dados de/para arquivos.

Você aprenderá:

A. Como criar controles e indicadores de string

B. Como utilizar várias funções de String

C. Como executar operações de I/O de arquivo

D. Como formatar arquivos de texto para serem utilizados em planilhas

E. Como utilizar os VIs File I/O de alto nível



Lição 7 Strings e I/O (entrada/saída) de arquivo

Manual de treinamento do LabVIEW Básico I 7-2 ni.com

A. Strings
Uma string é uma seqüência de caracteres ASCII exibíveis ou não exibíveis.
As strings proporcionam um formato independente de plataforma para
informações e dados. Algumas das aplicações mais comuns de strings são:

• Criar mensagens de texto simples.

• Transferir dados numéricos como strings de caracteres para
instrumentos e, em seguida, converter as strings em dados numéricos.

• Armazenar dados numéricos em disco. Para armazenar dados numéricos
em um arquivo ASCII, primeiro é necessário converter os dados
numéricos em strings, antes de os gravar em um arquivo de disco.

• Instruir o usuário com caixas de diálogo ou enviar mensagens a ele
através delas.

No painel frontal, as strings aparecem como tabelas, caixas de entrada de
texto e títulos.

Criando controles e indicadores de string
Utilize o controle e o indicador de string, localizados na paleta Controls»
String & Path, para simular caixas de entrada de texto e títulos. Utilize a
ferramenta Operating ou Labeling para criar ou editar texto em um controle
de string. Utilize a ferramenta Positioning para redimensionar um objeto de
string do painel frontal. Para reduzir o espaço que um objeto de string ocupa,
clique com o botão direito no objeto e selecione a opção Show Scrollbar no
menu de atalho.

Clique com o botão direito em um controle ou indicador de string do painel
frontal para selecionar entre os tipos de exibição mostrados na tabela a
seguir. A tabela também mostra um exemplo de mensagem em cada tipo
de exibição.

Tipo de
exibição Descrição Mensagem

Exibição
normal

Exibe caracteres imprimíveis,
utilizando a fonte do controle. Os
caracteres não imprimíveis são
exibidos como caixas.

There are four display types.

\ is a backslash.

Exibição de
códigos ‘\’

Exibe códigos de barras invertidas
para todos os caracteres não
imprimíveis.

There\sare\sfour\sdisplay\sty
pes.\n\\\sis\sa\sbackslash.
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Exibição de
senha

Exibe um asterisco (*) para cada
caractere, incluindo espaços.

*****************************

*****************

Exibição
hexadecimal

Exibe o valor ASCII de cada
caractere em formato hexadecimal,
em vez do próprio caractere.

5468 6572 6520 6172 6520 666F 
7572 2064 6973 706C 6179 2074 
7970 6573 2E0A 5C20 6973 2061 
2062 6163 6B73 6C61 7368 2E

Tipo de
exibição Descrição Mensagem
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B. Funções de String
Utilize as funções de String, localizadas na paleta Functions»String,
para editar e manipular strings no diagrama de bloco. As funções de
String incluem:

• String Length: retorna o número de caracteres presentes em uma string,
incluindo espaços. Por exemplo, a função String Length retorna um
tamanho = 19 para a seguinte string:
The quick brown fox

• Concatenate Strings: concatena strings de entrada e arranjos 1D
de strings em uma única string de saída. Redimensione a função para
aumentar o número de entradas. Por exemplo, concatene a string
anterior com o seguinte arranjo de strings:

A função Concatenate Strings retorna a seguinte string:
The quick brown fox jumped over the lazy dog.

• String Subset: retorna a substring que inicia em offset e contém um
número de caracteres de tamanho. O offset do primeiro caractere na
string é 0. Por exemplo, se você utilizar a string anterior como a entrada,
a função String Subset retornará a seguinte substring para um offset de
4 e um tamanho de 5.
quick

• Match Pattern: procura uma expressão regular em uma string que
inicia em offset e, se localizar uma correspondência, divide a string em
três substrings. Se nenhuma correspondência for localizada, a substring
de correspondência ficará vazia e a correspondência de passagem de
offset será –1. Por exemplo, utilize uma expressão regular de : e
utilize a seguinte string como a entrada:
VOLTS DC: +1.22863E+1;

A função Match Pattern retorna uma before substring (substring
anterior) VOLTS DC, uma match substring (substring correspondente)
:, uma after substring (substring posterior)+1.22863E+1;, e um
offset past match de 9.

Strings e dados numéricos
Utilize as funções Format Into String e Scan From String para converter
strings em dados numéricos ou vice-versa. A função Format Into String
converte um dado numérico em uma string e a função Scan From String
converte uma string em um dado numérico. Ambas as funções possuem
clusters error in e error out.

jumped over the lazy dog.
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Convertendo dados numéricos em strings
A função Format Into String converte argumentos de qualquer formato,
como dados numéricos, em uma string. Redimensione a função para
aumentar o número de argumentos.

Por exemplo, a função Format Into String retorna a string a seguir para uma
format string de %.4f, uma input string de Voltage is com um espaço
após a string e um argument de 1.28:
Voltage is 1.2800

Em format string, o símbolo % inicia o especificador de formato, . inicia a
precisão, 4 indica o número de dígitos à direita do ponto decimal e f indica
um dado numérico de ponto flutuante com formato fracionário. Clique com
o botão direito na função e selecione Edit Format String no menu de atalho
para criar ou editar uma format string. Consulte a Ajuda do LabVIEW para
obter mais informações sobre a sintaxe do especificador de formato.

Convertendo strings em dados numéricos
A função Scan From String converte uma string que contém caracteres
numéricos válidos, como 0–9, +, –, e, E e ponto final (.), em um dado
numérico. A função começa a varrer a input string em initial search
location. A função pode varrer a input string em vários tipos de dados,
como numéricos ou Booleanos, com base na format string. Redimensione
a função para aumentar o número de saídas (outputs).

Por exemplo, utilize uma format string de %f, uma initial search location
de 8 e a seguinte string como a input string:
VOLTS DC+1.28E+2

A função Scan From String retorna 128.00.

Em format string, % inicia o especificador de formato e f indica um dado
numérico de ponto flutuante com formato fracionário. Clique com o botão
direito na função e selecione Edit Scan String no menu de atalho para criar
ou editar uma format string. Consulte a Ajuda do LabVIEW para obter mais
informações sobre a sintaxe do especificador de formato.
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Exercise 7-1 VI Build String
Objetivo: Utilizar as funções Format Into String, Concatenate Strings e String Length.

Complete os passos a seguir para montar um VI que converta um dado
numérico em uma string, concatene a string com outras strings para formar
uma única string de saída e determine o tamanho da string de saída. O VI
também verifica a correspondência de um padrão em uma string e converte
a string restante em um dado numérico.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

a. Clique com o botão direito em String 2 e selecione ‘\’ Codes
Display no menu de atalho.

b. Altere String Length e Offset Past Match para representação I32.

Diagrama de bloco
2. Monte o seguinte diagrama de bloco.
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a. Selecione a função Format Into String, localizada na paleta
Functions»String. Essa função converte Numeric em uma string.

b. Clique com o botão direito na função Format Into String e selecione
Edit Format String no menu de atalho para exibir caixa de diálogo
Edit Format String.

c. Marque a caixa de seleção Use specified precision e digite 4 na
caixa de texto correspondente para criar uma format string que
converte Numeric em uma string com quatro dígitos após o ponto
decimal.

d. Clique no botão OK. O LabVIEW cria uma format string de %.4f,
utilizando as opções selecionadas.

e. Utilize a ferramenta Labeling para digitar um espaço em cada um
dos lados da constante %.4f e pressione as teclas <Shift-Enter> para
que Numeric apareça com espaços em cada um dos lados em
Combined String.

f. Clique com o botão direito na constante e selecione ‘\’ Codes
Display no menu de atalho. Os espaços digitados são alterados
para \s.

g. Selecione a função Concatenate Strings, localizada na paleta
Functions»String. Essa função concatena strings de entrada
em uma única string de saída.

h. Selecione a função String Length, localizada na paleta Functions»
String. Essa função retorna o número de caracteres contidos em
Combined String.

i. Selecione a função Match Pattern, localizada na paleta Functions»
String. Essa função procura pelo sinal de dois pontos em String 2.

j. Clique com o botão direito no terminal de entrada da expressão
regular, selecione Create»Constant no menu de atalho, digite dois
pontos (:) e pressione as teclas <Shift-Enter>.

k. Selecione a função Scan from String, localizada na paleta
Functions»String. Essa função converte a string, após os
dois pontos, em um dado numérico.

3. Exiba o painel frontal e crie o seguinte painel de ícones e conectores,
de forma que você possa utilizar o VI como um subVI posteriormente
neste curso. Consulte a Lição 3, Criando um subVI, para obter mais
informações sobre criação de painéis de ícones e conectores.
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4. Salve o VI como Build String.vi, pois irá utilizá-lo posteriormente
neste curso.

5. Altere os valores dos controles do painel frontal e execute o VI.

O VI concatena Header, Numeric e Trailer em Combined String
e exibe o tamanho da string.

O VI também pesquisa o sinal de dois pontos em String 2, converte a
string que vem após os dois pontos em Numeric Out e exibe o índice
do primeiro caractere depois dos dois pontos em Offset Past Match.

6. Salve e feche o VI.

Final do exercício 7-1
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C. Funções e VIs de File I/O
Operações de I/O de arquivo transferem dados para arquivos e de arquivos.
Utilize os VIs e as funções de File I/O, localizadas na paleta Functions»
File I/O, para tratar todos os aspectos de I/O de arquivos, incluindo o
seguinte:

• Abertura e fechamento de arquivos de dados

• Leitura de dados de arquivos e gravação de dados em arquivos

• Leitura de arquivos formatados em planilha e gravação em arquivos
desse tipo

• Movimento e renomeação de arquivos e diretórios

• Alteração de características de arquivos

• Criação, modificação e leitura de um arquivo de configuração

VIs File I/O de alto nível
Utilize os VIs File I/O de alto nível, localizados na primeira linha da paleta
Functions»File I/O, para executar operações comuns de I/O. Consulte a
seção E, VIs File I/O de alto nível, para obter mais informações sobre os
VIs File I/O de alto nível.

Você pode economizar tempo e esforço de programação, utilizando os
VIs de alto nível para gravar e ler arquivos. Os VIs de alto nível executam
operações de leitura e gravação, bem como de abertura e fechamento de
arquivos. Se ocorrer um erro, os VIs de alto nível exibem uma caixa de
diálogo que descreve o erro. Você pode escolher interromper a execução
ou continuar.

Funções e VIs de File I/O de baixo nível
Utilize as funções e os VIs de File I/O de baixo nível, localizadas na linha
do meio da paleta Functions»File I/O, e as funções avançadas de File I/O,
localizadas na paleta Functions»File I/O»Advanced File Functions para
controlar cada operação de I/O de arquivos individualmente.

Utilize as principais funções de baixo nível para criar ou abrir um arquivo,
gravar dados nele, ler dados dele e fechá-lo. Os VIs e as funções de baixo
nível podem tratar a maioria das necessidades de I/O de arquivos. Consulte
o Manual de treinamento do LabVIEW Básico II para obter mais
informações sobre funções avançadas de File I/O.
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Conceitos básicos de I/O de arquivos
Uma operação comum de I/O de arquivos envolve o seguinte processo.

1. Crie ou abra um arquivo. Indique o local onde um arquivo já existente
está ou onde você deseja criar um novo arquivo, especificando um
caminho ou respondendo a uma caixa de diálogo para direcionar o
LabVIEW até a localização do arquivo. Após a abertura do arquivo, um
refnum (número de referência) representa o arquivo. Consulte a seção
Salvando dados em um arquivo novo ou já existente para obter mais
informações sobre refnums.

2. Leia ou grave o arquivo.

3. Feche o arquivo.

Utilize os VIs e as funções a seguir para executar uma operação básica de
I/O de arquivos:

• Open/Create/Replace File: abre ou substitui um arquivo já existente ou
cria um novo arquivo. Se o campo file path estiver vazio, o VI exibirá
uma caixa de diálogo na qual você pode selecionar o arquivo já existente
ou o novo arquivo.

• Read File: lê dados do arquivo especificado por refnum e retorna-os em
data, em que count é a quantidade de dados a ser lida. A leitura começa
no local especificado por pos mode e pos offset e depende do formato
do arquivo especificado.

• Write File: grava dados no arquivo especificado por refnum.
A gravação inicia em uma localização especificada em pos mode
e pos offset para arquivos de fluxo de bytes e no final do arquivo
para arquivos datalog.

• Close File: fecha o arquivo especificado por refnum.

Tratamento de erro
Os VIs e as funções de File I/O de baixo nível retornam informações de erro.
Ligue as informações de erro do início ao fim do VI. Inclua um VI tratador
de erro, como o VI Simple Error Handler, localizado na paleta Functions»
Time & Dialog, ao final do VI para determinar se não ocorreram erros em
sua execução. Utilize os clusters error in e error out em cada VI que você
utilizar ou montar para transferir as informações de erro pelo VI.

À medida que o VI é executado, o LabVIEW testa cada nó de execução para
verificar se há erros. Se o LabVIEW não localizar nenhum erro, o nó será
executado normalmente. Se o LabVIEW detectar um erro, o nó transferirá
o erro para o próximo nó sem executá-lo. O próximo nó faz a mesma coisa,
e assim por diante. No final do fluxo de execução, o LabVIEW relata o erro.
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Clusters de erro
Os clusters de erro, localizados na paleta Controls»Array & Cluster,
incluem os seguintes componentes de informação:

• status é um valor Booleano que retorna a condição TRUE se ocorreu
um erro.

• code é um inteiro de 32 bits com sinal que identifica o erro
numericamente. Um código de erro diferente de zero, juntamente
com um status FALSE sinaliza um aviso, em vez de um erro fatal.

• source é uma string que identifica o local onde o erro ocorreu.
Consulte o Manual de treinamento do LabVIEW Básico II para
obter mais informações sobre clusters de erro.

Salvando dados em um arquivo novo ou já existente
Você pode gravar qualquer tipo de dado em um arquivo que você abriu ou
criou com as funções e os VIs de File I/O. Se outros usuários ou aplicações
precisarem acessar o arquivo, grave no arquivo os dados da string em
formato ASCII.

Você pode acessar arquivos de forma programática ou através de uma caixa
de diálogo. Para acessar um arquivo através de uma caixa de diálogo, não
ligue o terminal file path no VI Open/Create/Replace File. Você pode
economizar tempo ligando programaticamente os nomes de arquivo e de
caminho ao VI. A tabela a seguir descreve como os nomes de caminho
são organizados.

Plataforma Nome de caminho

Windows Consiste em um nome de unidade, dois pontos, nomes de diretório separados por
barras invertidas e nome do arquivo. Por exemplo, c:\testdata\test1.dat
é o nome de caminho de um arquivo chamado test1.dat e que se encontra no
diretório testdata.

UNIX Consiste em nomes de diretórios separados por barras normais e no nome do
arquivo. Por exemplo, /home/testdata/test1.dat é o nome de caminho
de um arquivo chamado test1.dat que se encontra no diretório testdata
que, por sua vez, está no diretório /home. Os nomes de arquivo e de caminho
coincidem maiúsculas e minúsculas.

Macintosh Consiste no nome de volume (o nome do disco), dois pontos, nomes de
pastas separados por dois pontos e nome do arquivo. Por exemplo, Hard 
Disk:testdata:test1.dat é o nome de caminho de um arquivo chamado
test1.dat que se encontra na pasta chamada testdata, em um disco
denominado Hard Disk.
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O exemplo a seguir mostra como gravar dados de string em um arquivo já
existente enquanto se faz a ligação programática dos nomes de caminho e
de arquivo.

O VI Open/Create/Replace File abre o arquivo test1.dat. O VI também
gera um refnum e um cluster de erro. Um número de referência, ou refnum,
é um identificador exclusivo para um objeto, como um arquivo, um
dispositivo ou uma conexão de rede. Quando você abre um arquivo,
um dispositivo ou uma conexão de rede, o LabVIEW cria um refnum
associado ao arquivo, ao dispositivo ou à conexão de rede. Todas as
operações executadas em arquivos, dispositivos ou conexões de rede
abertos utilizam os refnums para identificar cada objeto.

O cluster de erro e o refnum são transferidos em seqüência de um nó para
o próximo. Como um nó não pode ser executado até que receba todas as
suas entradas, a transferência desses dois parâmetros força os nós a serem
executados em ordem. O VI Open/Create/Replace File transfere o refnum
e o cluster de erro para a função Write File, que grava os dados no disco.
A função Close File fecha o arquivo após receber o cluster de erro e o
refnum da função Write File. O VI Simple Error Handler examina o cluster
de erro e exibe uma caixa de diálogo se ocorreu um erro. Se um erro ocorrer
em um nó, os nós subseqüentes não serão executados e o VI transferirá o
cluster de erro para o VI Simple Error Handler.
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Exercise 7-2 VI File Writer
Objetivo: Gravar dados em um arquivo.

Complete os passos a seguir para montar um VI que concatena uma string
de mensagem, um dado numérico e uma string de unidade a um arquivo.
No Exercício 7-3, você montará um VI para ler o arquivo e exibir o seu
conteúdo.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

a. Determine um indicador de caminho, localizado na paleta
Controls»String & Path. Esse indicador exibe o caminho para
o arquivo de dados criado.

b. Clique com o botão direito em String to Write e selecione Visible
Items»Scrollbar no menu de atalho para exibir uma barra de
rolagem.

Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

a. Selecione um VI Build String, que você montou no Exercício 7-1.
Esse VI concatena as três strings de entrada a uma única string
combinada.
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b. Selecione o VI Open/Create/Replace File, localizado na paleta
Functions»File I/O. Esse VI exibe uma caixa de diálogo para
abrir ou criar um arquivo.

c. Clique com o botão direito no terminal de entrada prompt
e selecione Create»Constant no menu de atalho para criar
a constante Enter Filename.

d. Clique com o botão direito no terminal de entrada function e
selecione Create»Constant no menu de atalho. Utilize a ferramenta
Operating para selecionar create or replace.

e. Selecione a função Write File, localizada na paleta Functions»
File I/O. Essa função grava as strings concatenadas no arquivo.

f. Selecione a função Close File, localizada na paleta Functions»
File I/O. Essa função fecha o arquivo.

g. Selecione o VI Simple Error Handler, localizado na paleta
Functions»Time & Dialog. Esse VI verifica o cluster de erro
e exibe uma caixa de diálogo se ocorreu um erro.

3. Salve o VI como File Writer.vi.

4. Altere os valores dos controles do painel frontal e execute o VI.
Uma caixa de diálogo Enter Filename aparece.

5. Digite demofile.txt e clique no botão Save ou OK.

O VI grava os valores de String to Write, Numeric to Write e Unit to
Write no arquivo.

Final do exercício 7-2
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Exercise 7-3 VI File Reader
Objetivo: Ler dados de um arquivo.

Complete os passos a seguir para montar um VI que leia o arquivo criado
no Exercício 7-2 e exiba a informações em um indicador de string.

Painel frontal
1. Abra um novo VI e monte o painel frontal a seguir utilizando o controle

de caminho, localizado na paleta Controls»String & Path.

Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

a. Selecione o VI Open/Create/Replace File, localizado na paleta
Functions»File I/O. Esse VI exibe uma caixa de diálogo que
você utiliza para abrir ou criar um arquivo.

b. Clique com o botão direito no terminal de entrada prompt
e selecione Create»Constant no menu de atalho para criar
a constante Select Filename.

c. Clique com o botão direito no terminal de entrada function e
selecione Create»Constant no menu de atalho. Utilize a ferramenta
Operating para selecionar open.

d. Selecione a função Read File, localizada na paleta Functions»
File I/O. Essa função lê os bytes de dados count do arquivo,
começando no início do arquivo.
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e. Selecione a função Close File, localizada na paleta Functions»
File I/O. Essa função fecha o arquivo.

f. Selecione o VI Simple Error Handler, localizado na paleta
Functions»Time & Dialog. Esse VI verificará o cluster de erro
e exibirá uma caixa de diálogo se um erro ocorrer.

3. Salve o VI como File Reader.vi.

4. Exiba o painel frontal e utilize a ferramenta Operating para clicar
no botão Browse no controle de caminho.

5. Acesse o diretório demofile.txt e clique no botão Open ou OK.

6. Execute o VI. O indicador String Read from File exibe o conteúdo
do arquivo.

7. Modifique o VI para que o dado numérico seja analisado e exibido em
um indicador digital. Depois que você terminar, salve e feche o VI.

Tip Utilize a função Match Pattern para pesquisar o primeiro caractere numérico.

Final do exercício 7-3

Desafio
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D. Formatando strings de planilha
Para gravar dados em um arquivo de planilha, você deve formatar a string
como uma string de planilha, que é uma string que inclui delimitadores,
como tabulações. Em várias aplicações de planilha, o caractere de tabulação
separa colunas e o caractere de fim de linha separa linhas.

Nota Utilize a constante de fim de linha, localizada na paleta Functions»String,
para garantir a portabilidade de VIs entre plataformas. (Windows) A constante insere
um caractere de retorno de carro e um caractere de mudança de linha. (Macintosh) A
constante insere um caractere de retorno de carro. (UNIX) A constante insere um caractere
de mudança de linha.

Utilize a função Format Into File para formatar string, dados numéricos,
caminho e dados Booleanos como texto e gravá-los em um arquivo. Muitas
vezes, você pode utilizar essa função, em vez de formatar separadamente a
string com a função Format Into String e gravar a string resultante com o
VI Write Characters To File ou a função Write File.

Utilize a função Format Into File para determinar a ordem em que os dados
aparecem no arquivo de texto. Entretanto, você não pode utilizar essa
função para anexar dados a um arquivo nem para substituir dados já
existentes em um arquivo. Para essas operações, utilize a função Format
Into String, juntamente com a função Write File. Você pode ligar um
refnum ou caminho ao terminal input file ou pode deixar essa entrada
desligada para que uma caixa de diálogo solicite o nome do arquivo.

No diagrama de bloco a seguir, o VI Open/Create/Replace File abre um
arquivo e o For Loop For é executado cinco vezes. A função Format Into
String converte a contagem de iterações e o número aleatório em strings e
insere os caracteres de tabulação e de fim de linha nas posições corretas para
criar duas colunas e uma linha no formato de planilha. Depois que o loop
completar cinco iterações, o arquivo será fechado e o VI verificará a
condição de erro.
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Esse VI cria o seguinte arquivo de texto, em que uma seta (→) indica uma
tabulação e um símbolo de parágrafo (¶) indica um caractere de fim de
linha.
0→0.798141¶
1→0.659364¶
2→0.581409¶
3→0.526433¶
4→0.171062¶

Abra o arquivo de texto anterior em uma aplicação de planilha para exibir
a planilha a seguir.
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Exercise 7-4 VI Temperature Logger
Objetivo: Salvar dados em um arquivo, de forma que uma planilha ou um processador

de texto possa acessá-los.

Complete os passos a seguir para salvar a hora e a temperatura atual em um
arquivo de dados.

Painel frontal
1. Abra o VI Temperature Control, que você montou no Exercício 6-2, e

salve-o como Temperature Logger.vi. Você não precisa modificar
o painel frontal a seguir.

Diagrama de bloco
2. Modifique o diagrama de bloco da seguinte forma.
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a. Selecione o VI Open/Create/Replace File, localizado na paleta
Functions»File I/O. Esse VI exibe uma caixa de diálogo que
você utiliza para abrir ou criar um arquivo.

b. Selecione a função Get Date/Time String, localizada na paleta
Functions»Time & Dialog. Essa função retorna o horário, em
formato de string, em que a medida de temperatura foi tirada.

c. Selecione a constante Booleana TRUE, localizada na paleta
Functions»Boolean. Essa constante define a função para incluir
os segundos na string.

d. Selecione a função Format Into File, localizada na paleta
Functions»File I/O. Essa função converte a medida de temperatura
em uma string e monta e grava em um arquivo uma string de dados
formatada.

e. Selecione as constantes de tabulação e de fim de linha, localizadas
na paleta Functions»String.

f. Selecione a função Unbundle by Name, localizada na paleta
Functions»Cluster. Essa função remove status do cluster de erro.

g. Selecione as funções Not e And, localizadas na paleta Functions»
Boolean. As funções Not e And definem o terminal condicional para
continuarem a execução enquanto Power for TRUE e nenhum erro
ocorrer.

h. Selecione a função Close File, localizada na paleta Functions»
File I/O. Essa função fecha o arquivo.

i. Selecione o VI Simple Error Handler, localizado na paleta
Functions»Time & Dialog. Esse VI verificará o cluster de erro
e exibirá uma caixa de diálogo se um erro ocorrer.

3. Salve o VI, pois ele será utilizado posteriormente no curso.

4. Execute o VI. Uma caixa de diálogo Enter Filename aparece.

5. Digite temp.txt e clique no botão Save ou OK.

O VI cria um arquivo chamado temp.txt. O VI faz as leituras a cada
meio segundo e salva os dados de tempo e temperatura em um arquivo,
até você clicar na chave Power ou ocorrer um erro. Quando o VI
terminar sua execução, o arquivo será fechado.

6. Feche o VI.

7. Abra uma aplicação de processador de texto ou de planilha, como
Bloco de Notas ou WordPad (Windows), TeachText (Macintosh) ou
Text Editor (UNIX).
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8. Abra o arquivo temp.txt. A hora aparece na primeira coluna e
os dados de temperatura aparecem na segunda coluna.

9. Saia da aplicação de processador de texto ou de planilha e retorne
ao LabVIEW.

Final do exercício 7-4
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E. VIs File I/O de alto nível
Utilize os VIs File I/O de alto nível, localizados na linha superior da
paleta Functions»File I/O, para executar operações comuns de I/O,
como gravação ou leitura dos seguintes tipos de dados:

• Caracteres de ou para arquivos de texto

• Linhas de arquivos de texto

• Arranjos 1D ou 2D de dados numéricos de precisão simples para ou
de arquivos de texto de planilhas

• Arranjos 1D ou 2D de dados numéricos de precisão simples ou de
inteiros de 16 bits com sinais para ou de arquivos binários

Os VIs File I/O de alto nível incluem:

• Write Characters to File: grava uma string de caracteres em um
novo arquivo ou anexa-a a um arquivo já existente. O VI abre ou
cria o arquivo antes de gravar nele e fecha-o após a utilização.

• Read Characters From File: lê number of characters de um arquivo
que inicia em start of read offset. O VI abre o arquivo antes de iniciar
a leitura e fecha-o quando concluir a leitura.

• Write to Spreadsheet File: converte um arranjo 2D ou 1D de dados
numéricos de precisão simples em uma string de texto e grava a string
em um novo arquivo ou anexa-a a um arquivo já existente. Você pode
também transpor os dados. O VI abre ou cria o arquivo antes de gravar
nele e fecha-o após a utilização. Você pode utilizar esse VI para criar um
arquivo de texto que possa ser lido pela maioria das aplicações de
planilha.

• Read From Spreadsheet File: lê um número específico de linhas de um
arquivo de texto numérico, iniciando em start of read offset, e converte
os dados em um arranjo 2D de dados numéricos de precisão simples.
O VI abre o arquivo antes de iniciar a leitura e fecha-o quando concluir
a leitura. Você pode utilizar esse VI para ler um arquivo de planilha
salvo em formato de texto.

• Read Lines From File: lê um número específico de linhas de um
arquivo de texto ou binário, iniciando em start of read offset. O VI abre
o arquivo antes de iniciar a leitura e fecha-o quando concluir a leitura.

• Binary File VIs: lê e grava arquivos em formato binário. Os dados
podem ser números inteiros ou números de ponto flutuante de precisão
simples.
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Tabelas
Utilize o controle de tabela, localizado na paleta Controls»List & Table
para criar uma tabela no painel frontal. Cada célula da tabela é uma string
e cada célula reside em uma coluna e uma linha. Portanto, uma tabela é um
display para um arranjo 2D de strings. A ilustração a seguir mostra uma
tabela e todas as suas partes.

Defina células na tabela, utilizando a ferramenta Operating ou Labeling
para selecionar uma célula e digitando o texto na célula selecionada.

O indicador de controle de tabela é um arranjo 2D de strings. Dessa forma,
você deve converter arranjos numéricos 2D em arranjos 2D de string antes
de exibir os dados em um indicador de tabela. Os cabeçalhos de linha e
coluna não são exibidos automaticamente em uma planilha. Você deve criar
um arranjo 1D (de uma dimensão) de string para os cabeçalhos das linhas
e colunas.

1 Célula indicada por valores de índice
2 Cabeçalhos de colunas
3 Barra de rolagem vertical
4 Barra de rolagem horizontal

5 Cabeçalhos de linhas
6 Índice horizontal
7 Índice vertical

7

6

5

4

3

21
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Exercise 7-5 Exemplo de planilha de VI
Objetivo: Salvar um arranjo 2D em um arquivo de texto de maneira que uma aplicação de

planilha possa acessar o arquivo e exibir os dados numéricos em uma tabela.

No Exercício 7-4, você formatou uma string de forma que as tabulações
separassem as colunas e os caracteres de fim de linha separassem as linhas.
Complete os passos a seguir para examinar um VI que salva arranjos
numéricos em um arquivo, em um formato que possa ser acessado com
uma planilha.

Painel frontal
1. Abra o Exemplo de planilha de VI. O seguinte painel frontal já estará

montado.

2. Execute o VI.

O VI gera um arranjo 2D de 128 linhas × 3 colunas. A primeira coluna
contém dados para uma forma de onda senoidal, a segunda coluna
contém dados para uma forma de onda de ruído e a terceira coluna
contém dados para uma forma de onda co-senoidal. O VI plota cada
coluna em um gráfico e exibe os dados em uma tabela. Depois que o
VI exibe os dados, aparece uma caixa de diálogo.

3. Digite wave.txt e clique no botão Save ou OK. Mais tarde, você irá
examinar este arquivo.
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Diagrama de bloco
4. Exiba o diagrama de bloco a seguir para examiná-lo.

• O VI Sine Pattern, localizado na paleta Functions»Analyze»Signal
Processing»Signal Generation, retorna um arranjo numérico de
128 elementos que contém um padrão senoidal. A constante 90.0,
no segundo nó, especifica a fase do padrão senoidal ou co-senoidal.

• O VI Uniform White Noise, localizado na paleta Functions»
Analyze»Signal Processing»Signal Generation, retorna um
arranjo numérico de 128 elementos que contém um padrão de ruído.

• A função Build Array, localizada na paleta Functions»Array,
monta o seguinte arranjo 2D a partir dos arranjos senoidal, de ruído
e co-senoidal.

• A função Transpose 2D Array, localizada na paleta Functions»
Array, reorganiza os elementos do arranjo 2D de maneira que o
elemento [i,j] torna-se o elemento [j,i], conforme indicado a seguir.

Sine Array …

Noise Array …

Cosine Array …

S N C

… … …
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• O VI Write To Spreadsheet File, localizado na paleta Functions»
File I/O formata o arranjo 2D em uma string de planilha e grava a
string em um arquivo. A string tem o seguinte formato, em que uma
seta (→) indica uma tabulação e um símbolo de parágrafo (¶) indica
um caractere de fim de linha.

• A função Number To Fractional String, localizada na paleta
Functions»String»String/Number Conversion converte um
arranjo de valores numéricos em um arranjo de strings que a
tabela exibe.

5. Feche o VI.

Nota Este exemplo armazena apenas três arranjos no arquivo. Para incluir mais
arranjos, aumente o número de entradas na função Build Array.

6. (Opcional) Abra o arquivo utilizando uma aplicação de processador
de texto ou de planilha e visualize seu conteúdo.

a. Abra uma aplicação de processador de texto ou de planilha, como
Bloco de Notas ou WordPad (Windows), TeachText (Macintosh) ou
Text Editor (UNIX).

b. Abra o arquivo wave.txt. Os dados da forma de onda senoidal
aparecem na primeira coluna, os dados da forma de onda aleatória
aparecem na segunda coluna e os dados da forma de onda
co-senoidal aparecem na terceira coluna.

c. Saia da aplicação de processador de texto ou de planilha e retorne
ao LabVIEW.

Final do exercício 7-5

S N C

→ → ¶

→ → ¶

→ → ¶

… … …

→ → ¶
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Exercise 7-6 VI Temperature Application
Objetivo: Aplique o que você aprendeu até agora neste curso—estruturas, registradores de

deslocamento, seqüências locais, diagramas de forma de onda, arranjos, gráficos,
I/O de arquivos, e assim sucessivamente.

Crie um VI com o seguinte painel frontal que completa os passos a seguir
e salve o VI como Temperature Application.vi.

1. Tire uma medida de temperatura uma vez a cada segundo, até você
interromper a execução do VI ou ocorrer um erro.

2. Exiba a temperatura atual e a média das últimas três medições em um
diagrama de forma de onda.

3. Se a temperatura ultrapassar um limite predefinido, um LED acenderá.

4. Após cada medição, registre a data, a hora, incluindo os segundos, a
temperatura, a média das últimas três medições e uma mensagem de
uma palavra que descreva se a temperatura é normal ou está acima
do limite. Registre os dados, de forma que cada item apareça em uma
coluna de uma planilha, como mostrado no exemplo a seguir.

Desafio
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5. Depois que você cessar a aquisição, plote os dados originais de
temperatura e uma curva aproximada em um gráfico XY e exiba
as temperaturas máxima, mínima e média.

Tip Inicie com o VI Temperature Logger, que você montou no Exercício 7-4.
Para concluir o passo 5, utilize partes do VI Temperature Analysis, que você montou
no Exercício 5-3.

Final do exercício 7-6
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Resumo, dicas e suplementos

• Strings agrupam seqüências de caracteres ASCII. Utilize o controle
e o indicador de string, localizados na paleta Controls»String & Path,
para simular caixas de entrada de texto e títulos.

• Para reduzir o espaço que um objeto de string ocupa, clique com o
botão direito no objeto e selecione a opção Show Scrollbar no menu
de atalho.

• Utilize as funções de String, localizadas na paleta Functions»String,
para editar e manipular strings no diagrama de bloco.

• Utilize as funções Format Into String e Scan From String para converter
strings em dados numéricos ou vice-versa. A função Format Into String
converte um dado numérico em uma string e a função Scan From String
converte uma string em um dado numérico.

• Clique com o botão direito na função Format Into String ou Scan From
String e selecione Edit Format String ou Edit Scan String no menu de
atalho para criar ou editar uma format string.

• Utilize os VIs e as funções de File I/O, localizadas na paleta Functions»
File I/O, para tratar todos os aspectos de I/O de arquivos.

• Utilize os VIs File I/O de alto nível, localizados na linha superior da
paleta Functions»File I/O, para executar operações comuns de I/O.

• Utilize os VIs e as funções de File I/O de baixo nível, localizadas na
linha central da paleta Functions»File I/O, e as funções avançadas
de File I/O, localizadas na paleta Functions»File I/O»Advanced File
Functions, para controlar cada operação de I/O de arquivos
individualmente.

• Ao gravar um arquivo, você abre, cria ou substitui um arquivo, grava os
dados e fecha o arquivo. De forma similar, ao ler de um arquivo, você
abre um arquivo já existente, lê os dados e fecha o arquivo.

• Para acessar um arquivo através de uma caixa de diálogo, não ligue
o terminal file path no VI Open/Create/Replace File.

• Para gravar dados em um arquivo de planilha, você deve formatar
a string como uma string de planilha, que é uma string que inclui
delimitadores, como tabulações. Utilize a função Format Into File para
formatar strings, dados numéricos, caminhos e dados Booleanos como
texto e para gravar o texto em um arquivo.
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Exercícios adicionais
7-7 Monte um VI que gere um arranjo 2D de 3 linhas × 100 colunas de

números aleatórios e grave os dados transpostos para um arquivo de
planilha. Adicione um cabeçalho a cada coluna. Utilize os VIs File
I/O de alto nível, localizados na paleta Functions»File I/O.

Tip Utilize o VI Write Characters To File para gravar o cabeçalho e o VI Write To
Spreadsheet File para gravar os dados numéricos no mesmo arquivo.

Salve o VI como More Spreadsheets.vi.

7-8 Monte um VI que converta strings de planilha delimitadas por
tabulações em strings de planilha delimitadas com vírgula, isto
é, strings de planilha com colunas separadas por vírgulas e linhas
separadas por caracteres de fim de linha. Exiba os dois tipos de
strings no painel frontal.

Tip Utilize a função Search and Replace String.

Salve o VI como Spreadsheet Converter.vi.

7-9 Modifique o VI Temperature Logger, que você montou no
Exercício 7-4, de forma que o VI não crie um novo arquivo a cada
vez que você executar o VI. Anexe os dados ao final do arquivo
temp.dat já existente que o VI Temperature Logger criou. Execute
o VI várias vezes e utilize uma aplicação de processador de texto
para confirmar que o VI anexou novas leituras de temperatura.

Tip Exclua a função Format Into File e a substitua-a pelas funções Format Into String
e Write File. Utilize os parâmetros pos mode e pos offset da função Write File para
mover a marca do arquivo atual.

Salve o VI como Temperature Logger 2.vi.

Desafio
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Anotações
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Anotações
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Lição 8
Aquisição de dados e formas de onda

Esta lição descreve como utilizar dispositivos de aquisição de dados
(DAQ—Data Acquisition) plug-in no LabVIEW. Consulte o LabVIEW
DAQ Basics Course Manual para obter mais informações sobre aquisição
de dados no LabVIEW.

Você aprenderá:

A. Sobre dispositivos DAQ plug-ins

B. Sobre a organização de VIs Data Acquisition

C. Como executar uma entrada analógica simples

D. Sobre assistentes DAQ

E. Sobre entrada analógica de forma de onda

F. Como gravar formas de onda em arquivo

G. Como varrer vários canais analógicos

H. Como executar saída analógica

I. Como operar as linhas de I/O digitais

J. Sobre DAQ com buffer
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A. Visão geral e configuração
O LabVIEW inclui um conjunto de VIs que permitem configurar,
adquirir dados e enviar dados a dispositivos DAQ. Geralmente, um
dispositivo pode executar várias funções, como operações de conversão
analógico/digital (A/D), de conversão digital/analógico (D/A), de I/O
digital e de contador/temporizador. Cada dispositivo suporta diferentes
velocidades DAQ e de geração de sinal. Além disso, cada dispositivo
DAQ foi projetado para plataformas de hardware e sistemas operacionais
específicos. Consulte o Product Catalog da National Instruments no site
ni.com/catalog para obter mais informações sobre dispositivos DAQ.

Componentes do sistema DAQ
A ilustração a seguir mostra duas opções para um sistema DAQ. Na opção
A, o dispositivo DAQ plug-in está instalado no computador. Na opção B,
o dispositivo DAQ é externo. Com dispositivos externos, você pode
montar sistemas DAQ utilizando computadores que não têm slots plug-in
disponíveis, como alguns laptops. O computador e o módulo DAQ
comunicam-se através de vários barramentos, como a porta paralela, a porta
serial e a rede Ethernet. Esses sistemas são práticos para aplicações remotas
de DAQ e de controle.

A principal tarefa de um sistema DAQ é medir ou gerar sinais físicos reais.
Antes de um sistema baseado em computador poder medir um sinal físico,
um sensor ou transdutor deverá converter o sinal físico em sinal elétrico,
como tensão ou corrente. O dispositivo DAQ plug-in geralmente é
considerado como o sistema DAQ completo, embora, na verdade, ele seja

1 Transdutores
2 Condicionamento de sinal
3 Sinais condicionados

4 Dispositivo DAQ plug-in
5 Software

6 Enlace de porta paralela
7 Módulo DAQ
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apenas um componente do sistema. Diferente da maioria dos instrumentos
autônomos, você nem sempre pode conectar diretamente os sinais a um
dispositivo DAQ plug-in. Nestes casos, é necessário utilizar acessórios para
condicionar os sinais antes de os dispositivos DAQ plug-in convertê-los em
informações digitais. O software controla o sistema DAQ, adquirindo os
dados originais, analisando esses dados e apresentando os resultados.

Entrada analógica
Ao medir sinais analógicos com um dispositivo DAQ, você deve considerar
os seguintes fatores que afetam a qualidade do sinal digitalizado: modo,
resolução, faixa, ganho, taxa de amostragem, precisão e ruído.

Modo
Em um sistema de medição de um só ponto, todas as entradas fazem
referência a um ponto comum de ligação à terra. Utilize esse sistema quando
os sinais de entrada forem de alto nível (maior que 1 V), os condutores da
fonte de sinal até o hardware de entrada analógica forem curtos (menos
que 4,5 m) e todos os sinais de entrada compartilharem uma referência de
ligação à terra comum. Do contrário, utilize um sistema de medição
diferencial, de forma que cada entrada possa ter sua própria referência e
você não precise conectar nenhuma entrada a uma referência fixa, como
terra ou aterramento de construção. Em geral, é preferível utilizar um
sistema de medição diferencial, pois ele não rejeita apenas erros induzidos
por loops de aterramento, mas também rejeita o ruído obtido no ambiente
a um certo grau. Por outro lado, um sistema de medição de um só ponto
permite utilizar o dobro do número de canais de medição e é aceitável
quando a magnitude dos erros induzidos é menor que a precisão requerida
dos dados.

Resolução
O número de bits utilizados para representar um sinal analógico determina
a resolução do ADC. A resolução em um dispositivo DAQ é similar às
marcações de uma régua. Quanto maior o número de marcas na régua, maior
a precisão das medições. Quanto maior a resolução de um dispositivo DAQ,
maior o número de divisões em que seu sistema poderá interromper a faixa
ADC e, portanto, menor a capacidade de detecção de alterações. Um ADC
de 3-bits divide a faixa em 23 ou 8 divisões. Um código binário ou digital
entre 000 e 111 representa cada divisão. O ADC converte cada medição do
sinal analógico em uma das divisões digitais. A ilustração a seguir mostra a
imagem digital de uma onda senoidal de 5 kHz, obtida com um ADC de
3-bits. O sinal digital não representa o sinal original de forma adequada,
pois o conversor possui poucas divisões digitais para representar a variação
de tensão do sinal analógico. Entretanto, aumente a resolução para 16 bits,
a fim de aumentar o número de divisões do ADC de 8 (23) para 65.536 (216).
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O ADC de 16-bits pode obter uma representação extremamente precisa do
sinal analógico.

Faixa do dispositivo
Faixa refere-se aos níveis máximo e mínimo dos sinais analógicos que
o ADC pode digitalizar. Vários dispositivos DAQ apresentam faixas
selecionáveis (tipicamente, 0 a 10 V ou –10 a 10 V), de forma que você
pode corresponder a faixa do ADC à faixa do sinal para obter uma melhor
vantagem da resolução disponível e medir o sinal com precisão. Por
exemplo, na ilustração a seguir, o ADC de 3-bits do diagrama esquerdo tem
oito divisões digitais na faixa de 0 a 10 V. Se você selecionar uma faixa de
–10 a 10 V, como mostrado no diagrama da direita, o mesmo ADC separará
uma faixa de 20 V em oito divisões. A menor tensão detectável varia de
1,25 a 2,50 V e o diagrama da direita é uma representação bem menos
precisa do sinal.

1 Faixa = 0 a 10 V 2 Faixa = –10 to 10 V
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Ganho
Ganho inclui qualquer amplificação ou atenuação de um sinal que possa
ocorrer antes de ele ser digitalizado. Aplicando ganho a um sinal, você
pode diminuir efetivamente a faixa de entrada de um ADC e, assim,
permitir que o ADC utilize a maior quantidade possível de divisões digitais
para representar o sinal. Por exemplo, utilizando um ADC de 3 bits e um
intervalo de 0 a 10 V, a seguinte ilustração mostra os efeitos de se aplicar
ganho a um sinal que flutua entre 0 e 5 V. Sem ganho aplicado ou com
um ganho = 1, o ADC utiliza apenas quatro das oito divisões disponíveis
na conversão. Amplificando o sinal com um ganho igual a 2 antes da
digitalização, o ADC utiliza todas as oito divisões digitais e a representação
digital é bem mais precisa. Efetivamente, o dispositivo possui uma faixa de
entrada permitida de 0 a 5 V, pois qualquer sinal acima de 5 V, quando
amplificado por um fator dois, torna a entrada ao ADC maior que 10 V.

A faixa, a resolução e o ganho disponíveis em um dispositivo DAQ
determinam a menor alteração detectável na tensão de entrada. Essa
alteração na tensão representa o bit menos significativo (LSB—Least
Significant Bit) do valor digital e também é denominado largura de
código. A menor alteração detectável é calculada da seguinte forma:

faixa de tensão/(ganho × 2resolução em bits)

Por exemplo, um dispositivo DAQ de 12-bits com uma faixa de entrada de
0 a 10 V e um ganho igual a 1 detecta uma alteração de 2,4 mV, enquanto o
mesmo dispositivo com uma faixa de entrada de –10 a 10 V detectaria
apenas uma alteração de 4,8 mV.
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Taxa de amostragem
A taxa de amostragem determina com que freqüência ocorre uma conversão
A/D. Uma taxa de amostragem rápida adquire mais pontos em um
determinado período de tempo e, portanto, pode formar com freqüência uma
melhor representação do sinal original do que uma taxa mais lenta. Todos
os sinais devem ser amostrados em uma taxa suficientemente rápida para
reproduzir o sinal com precisão. A amostragem muito lenta pode resultar
em uma representação de má qualidade do sinal analógico. A ilustração a
seguir mostra um sinal adequadamente amostrado, bem como os efeitos da
subamostragem. Essa representação inadequada de um sinal, ou alias, faz
com que o sinal aparente ter uma freqüência diferente da que realmente tem.

De acordo com o Teorema de Nyquist, você deve amostrar um sinal a
uma taxa pelo menos duas vezes mais rápida do que o sinal que está sendo
aquisitado para obter dados de freqüência confiáveis. Por exemplo, sinais de
áudio convertidos em sinais elétricos geralmente têm dados de freqüência
de até 20 kHz. Dessa forma, você precisa de um dispositivo com uma taxa
de amostragem maior do que 40 kHz para adquirir apropriadamente o sinal.
Por outro lado, transdutores de temperatura geralmente não requerem uma
alta taxa de amostragem, pois a temperatura não altera rapidamente na
maioria das aplicações. Dessa forma, um dispositivo com uma taxa de
aquisição mais lenta pode adquirir sinais de temperatura de forma adequada.

Filtrando e calculando a média
Ruído indesejado distorce o sinal analógico antes de ele ser convertido
em um sinal digital. A fonte desse ruído pode ser externa ou interna ao
computador. Você pode limitar o erro de ruído externo, utilizando
condicionamento de sinal adequado. Você também pode minimizar os
efeitos desse ruído efetuando a sobreamostragem do sinal e, em seguida,
calculando a média dos pontos sobreamostrados. O nível de ruído é
reduzido por um fator de:

1 Adequadamente amostrada 2 Com alias devido à subamostragem

1

2

number of points averaged
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Por exemplo, se você calcular a média de 100 pontos, o efeito do ruído no
sinal será reduzido por um fator de 10.

Configuração de hardware DAQ
Você deve completar vários passos antes de poder utilizar os VIs de
aquisição de dados. Os dispositivos são configurados para os computadores
desta classe.

Windows
Esta seção descreve a configuração para computador com barramento PCI,
PCMCIA ou ISA. O instalador do LabVIEW copia os arquivos requeridos
para DAQ em seu computador. Os VIs de aquisição de dados acessam a
DLL de 32 bits NI-DAQ para Windows padrão da National Instruments.
NI-DAQ para Windows suporta todos os dispositivos DAQ e SCXI da
National Instruments.

A DLL NI-DAQ, a interface de alto nível para o dispositivo, está carregada
no diretório windows\system. Em seguida, a DLL NI-DAQ estabelece
interface com o Registro do Windows para obter os parâmetros de
configuração definidos pelo Measurement & Automation Explorer.
Como o Measurement & Automation Explorer é parte integrante do
DAQ, ele será descrito em mais detalhes posteriormente nesta seção.

O Gerenciador de configuração do Windows mantém uma lista de todos
os componentes de hardware instalados em seu sistema, incluindo os
dispositivos DAQ da National Instruments. Se você possui um dispositivo
Plug & Play (PnP), como um dispositivo MIO série E, o Gerenciador de
configuração do Windows automaticamente detecta e configura o
dispositivo. Se você tiver um dispositivo não-PnP, ou um dispositivo já

Measurement & Automation Explorer

Windows Configuration

Data Acquisition VIs

LabVIEW for Windows

NI-DAQ for Windows

Windows Registry

DAQ Device
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existente (legacy), terá de configurar o dispositivo manualmente, utilizando
a opção Adicionar novo hardware do Painel de controle.

Você pode verificar a configuração do Windows, acessando ao Gerenciador
de dispositivos, disponível ao selecionar Iniciar»Configurações»Painel de
controle»Sistema»Gerenciador de dispositivos. Você pode ver a opção
Data Acquisition Devices, que lista todos os dispositivos DAQ instalados
em seu computador. Clique duas vezes em um dispositivo DAQ para exibir
uma caixa de diálogo com páginas com guias. General exibe informações
gerais a respeito do dispositivo. Resources especifica os recursos de sistema
para o dispositivo, como níveis de interrupção, DMA e endereço base
para os dispositivos configuráveis por software. NI-DAQ Information
especifica o tipo de barramento do dispositivo DAQ. Driver especifica
a versão e a localização do driver para o dispositivo DAQ.

O LabVIEW instala um utilitário de configuração, o Measurement &
Automation Explorer, para estabelecer todos os parâmetros de configuração
de dispositivos e canais. Após instalar um dispositivo DAQ em seu
computador, execute o utilitário de configuração. O Measurement &
Automation Explorer lê as informações que o Gerenciador de dispositivos
grava no registro do Windows e atribui um número de dispositivo lógico
a cada dispositivo DAQ. Utilize o número de dispositivo para consultar o
dispositivo no LabVIEW. Acesse o Measurement & Automation Explorer,
clicando duas vezes em seu ícone na área de trabalho ou selecionando
Tools»Measurement & Automation Explorer no LabVIEW. A figura
a seguir é a janela principal do Measurement & Automation Explorer.
O Measurement & Automation Explorer também pode ser utilizada para
a configuração do SCXI.

1: AT-MIO-64E-3
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O Measurement & Automation Explorer detectou todos os componentes de
hardware da National Instruments, incluindo a interface GPIB. Consulte a
Lição 9, Controle de instrumento, para obter mais informações sobre GPIB.

Os parâmetros de dispositivo que podem ser definidos com o utilitário
de configuração dependem do dispositivo. O Measurement & Automation
Explorer salva o número de dispositivo lógico e os parâmetros de
configuração no registro do Windows.

O recurso Plug & Play do Windows detecta automaticamente e configura
dispositivos DAQ sem comutador, como o PCI-MIO-16XE-50 ou um
DAQCard. Quando você instala um dispositivo em seu computador,
o dispositivo é detectado automaticamente.

Macintosh
O LabVIEW instala os drivers de software NI-DAQ para Macintosh
necessários para a comunicação com os dispositivos DAQ da National
Instruments. Utilize o utilitário de configuração NI-DAQ para configurar
o dispositivo DAQ e seus acessórios.

Quando você instalar o NI-DAQ para Macintosh, instale a versão 4.9, se
tiver um dispositivo NB ou Lab Series. Do contrário, instale a versão 6.0
ou superior para os dispositivos PCI e DAQCard.

Data Acquisition VIs

LabVIEW for Macintosh

NI-DAQ Configuration Utility

DAQ Device
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Exercise 8-1 (Apenas para Windows)
Objetivo: Utilizar o Measurement & Automation Explorer para examinar a configuração DAQ

atual, testar o dispositivo interativamente e adicionar três canais virtuais.

Complete os passos a seguir para utilizar o Measurement & Automation
Explorer a fim de examinar a configuração do dispositivo DAQ instalado
em seu computador, utilizar as rotinas de teste no Measurement &
Automation Explorer a fim de confirmar a operação do dispositivo
e configurar três canais virtuais a fim de serem utilizados com o DAQ
Signal Accessory.

Parte A. Examinando as definições do dispositivo DAQ
1. Inicie o Measurement & Automation Explorer clicando duas vezes

no ícone da área de trabalho ou selecionando Tools»Measurement &
Automation Explorer no LabVIEW. O utilitário pesquisa o sistema
para verificar se há hardware da National Instruments instalado e exibe
as informações.

2. Expanda a seção Devices and Interfaces para visualizar os dispositivos
da National Instruments instalados. O exemplo a seguir mostra os
dispositivos PCI-MIO-16XE-50 e PCI-GPIB.

O Measurement & Automation Explorer exibe o hardware e o software
da National Instruments presentes em seu sistema. O número do
dispositivo está entre parênteses, logo após o nome do dispositivo.
Os VIs de aquisição de dados utilizam esse número de dispositivo
para determinar qual deles executa operações DAQ.



Lição 8 Aquisição de dados e formas de onda

© National Instruments Corporation 8-11 Manual de treinamento do LabVIEW Básico I

Nota Você pode ter um dispositivo diferente instalado e algumas das opções mostradas
podem ser diferentes. Clique no botão Show/Hide, no canto superior direito da janela
Measurement & Automation Explorer, para ocultar a ajuda on-line e mostrar as
informações do dispositivo DAQ.

3. Você pode obter mais informações sobre a configuração dos
dispositivos examinando suas propriedades. Com o dispositivo
DAQ destacado, clique no botão Properties da barra de ferramentas.
Aparece uma caixa de diálogo que você pode utilizar para configurar
o dispositivo de múltiplas entradas/saídas (MIO—Multiple
Input/Output).

Essa caixa de diálogo contém várias guias. A guia System exibe
os recursos de sistema atribuídos ao dispositivo através do registro
do Windows. Utilize as guias restantes para configurar os vários
parâmetros analógicos de entrada, de saída e de acessório, bem
como os parâmetros DAQ para o dispositivo.

4. Clique na guia System e clique no botão Test Resources para testar
os recursos de sistema atribuídos ao dispositivo, de acordo com o
Gerenciador de dispositivos do Windows. O dispositivo deve ser
aprovado neste teste, pois ele já está configurado.

Parte B. Testando os componentes do dispositivo DAQ
5. Clique no botão OK duas vezes para retornar ao Measurement &

Automation Explorer.

6. Clique no botão Test Panel para testar as funções individuais do
dispositivo DAQ, como entrada e saída analógica. A caixa de diálogo
Test Panel aparece.

Utilize a guia Analog Input para testar os vários canais de entrada
analógica do dispositivo DAQ. Lembre-se de que o canal 0 é conectado
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ao sensor de temperatura do DAQ Signal Accessory. Coloque seu dedo
sobre o sensor para verificar se a tensão aumenta. Você também pode
mover a chave Noise para a posição On com o intuito de ver a alteração
de sinal.

7. Clique na guia Analog Output para configurar uma tensão simples ou
uma onda senoidal em um dos canais de saída analógica do dispositivo
DAQ.

8. Altere o campo Output Mode para Sine Generator e clique no botão
Start Sine Generator. O LabVIEW gera uma onda senoidal contínua
no canal de saída analógica 0.

9. Na caixa externa do DAQ Signal Accessory, ligue Analog Out Ch0 a
Analog In Ch1.

10. Clique na guia Analog Input e altere o canal para 1. O LabVIEW exibe
a onda senoidal gerada a partir do canal 0 de saída analógica.

11. Clique na guia Counter I/O para determinar se o contador/temporizador
do dispositivo DAQ estão funcionando apropriadamente.

12. Para verificar a operação do contador/temporizador, altere o modo
de contagem para Simple Event Counting e clique no botão Start.
O valor do contador irá aumentar rapidamente. Clique em Reset para
interromper o teste do contador.

13. Clique na guia Digital I/O para testar as linhas digitais do dispositivo
DAQ.

14. Defina as linhas de 0 a 3 como saída e ative/desative as caixas de seleção
Logic Level. À medida que você ativa/desativa as caixas, os LEDs do
acessório de sinal DAQ acendem ou apagam. Os LEDs utilizam lógica
negativa. Clique no botão Close para fechar a caixa de diálogo Test
Panel e retornar ao Measurement & Automation Explorer.

Parte C. Configurando canais no dispositivo DAQ
15. Clique com o botão direito no ícone Data Neighborhood e selecione

Create New no menu de atalho. Selecione Virtual Channel e clique no
botão Finish.

16. Digite as seguintes informações nos painéis que aparecem para
configurar um canal, a fim de obter uma leitura do sensor de temperatura
(canal 0 de entrada analógica) no DAQ Signal Accessory. Clique no
botão Next para exibir cada uma das seguintes definições.

Tipo de medição Analog Input

Nome do canal temp
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17. Na janela Verify Scale, verifique a plotagem de escala e modifique
a representação, se for necessário.

18. Crie um segundo canal, clicando com o botão direito no ícone Data
Neighborhood e selecionando Create New no menu de atalho.
Selecione Virtual Channel e clique no botão Finish. Insira as
seguintes definições.

Descrição do canal This is the temperature sensor on 
the DAQ Signal Accessory.

Tipo de sensor Voltage e marque a caixa de seleção This will
be a temperature measurement

Unidades Deg C

Faixa Manter os valores padrão

Escala New Custom Scale

Nome da escala tempscale

Descrição da escala V * 100 = deg C

Tipo de escala Linear

m = 100.0, b = 0.0

Hardware DAQ
utilizado

Dev1 (your DAQ device)

Canal 0

Modo de entrada
analógica

Differential

Tipo de medição Analog Input

Nome do canal chan1

Descrição do canal This is Analog Input ch1 on the DAQ 
Signal Accessory.

Tipo de sensor Voltage

Unidades V

Faixa –10.0 V to 10.0 V

Escala No Scaling



Lição 8 Aquisição de dados e formas de onda

Manual de treinamento do LabVIEW Básico I 8-14 ni.com

19. Crie o terceiro e último canal, clicando com o botão direito em chan1
e selecionando Duplicate no menu de atalho. A caixa de diálogo Copy
Virtual Channel aparece.

20. Mantenha os valores padrão e clique no botão OK. O Measurement &
Automation Explorer exibe um canal virtual, chamado chan2, que
possui os mesmos parâmetros que chan1.

21. Verifique estas definições e atualize a descrição, clicando com o botão
direito em chan2 e selecionando Properties no menu de atalho.

22. Expanda todas as seções. O Measurement & Automation Explorer deve
ser semelhante ao seguinte exemplo.

23. Feche o utilitário Measurement & Automation Explorer, selecionando
File»Exit.

Final do exercício 8-1

Hardware DAQ
utilizado

Dev1 (your DAQ device)

Canal 1

Modo de entrada
analógica

Differential
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B. Organização de VIs de aquisição de dados
A maioria dos VIs de aquisição de dados localizados na paleta Functions»
Data Acquisition possui os seguintes níveis na subpaleta, de acordo com
suas funcionalidades:

• VIs fáceis

• VIs intermediários

• VIs utilitários

• VIs avançados

Por exemplo, a subpaleta a seguir contém todos os níveis citados
anteriormente.

Embora este manual descreva VIs intermediários, a maioria dos exercícios
utiliza VIs fáceis.

VIs fáceis
Os VIs fáceis executam operações DAQ simples e geralmente estão
localizados na primeira linha de VIs de uma subpaleta. Você pode executar
esses VIs no painel frontal ou utilizá-los como subVIs em aplicações
básicas.

Você necessita de apenas um VI fácil para executar cada operação DAQ
básica. Diferente dos VIs intermediários e avançados, os VIs fáceis alertam
você automaticamente sobre erros com uma caixa de diálogo que permitem
interromper a execução do VI ou ignore o erro.

1 VIs fáceis de entrada analógica
2 VIS intermediários de entrada

analógica

3 VIs avançados de entrada analógica
4 VIs utilitários de entrada analógica

1

2

3

4
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VIs intermediários
Os VIs intermediários têm uma maior funcionalidade de hardware
e eficiência no desenvolvimento de aplicações do que os VIs fáceis.
Utilize os VIs intermediários na maioria das aplicações.

Esses VIs proporcionam-lhe um maior controle sobre o tratamento de
erro do que os VIs fáceis. Com cada VI, você pode verificar se há erros
ou transmitir o cluster de erro para outros VIs.

VIs utilitários
Os VIs utilitários também são VIs de nível intermediário e, dessa
forma, possuem uma maior funcionalidade de hardware e eficiência no
desenvolvimento de aplicações do que os VIs fáceis. Os VIs utilitários
consistem em agrupamentos convenientes de VIs intermediários. Eles são
destinados a situações em que você necessita de um maior controle de
funcionalidade do que os VIs de I/O fáceis podem fornecer, mas deseja
limitar o número de VIs chamados.

VIs avançados
Os VIs avançados são a interface de nível mais baixo para o driver DAQ.
Muito poucas aplicações requerem a utilização dos VIs avançados, os quais
retornam a maior quantidade de informações de status do driver DAQ.
Utilize os VIs avançados quando os VIs fáceis ou intermediários não
tiverem as entradas necessárias para controlar uma função DAQ incomum.
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C. Executando uma entrada analógica simples
Utilize os VIs Analog Input, localizados na paleta Functions»Data
Acquisition»Analog, para executar conversões analógico/digital (A/D).

Para adquirir um único ponto do sinal conectado ao dispositivo DAQ, utilize
AI Sample Channel.

O AI Sample Channel mede o sinal vinculado ao canal especificado e
retorna a tensão medida. Device é o número do dispositivo DAQ. Channel
especifica o nome do canal de entrada analógica. High limit e low limit
especificam a faixa do sinal de entrada. As entradas padrão são +10 V e –10
V, respectivamente. Se ocorrer um erro durante a operação do AI Sample
Channel, uma caixa de diálogo exibirá o código de erro e você terá a opção
de anular a operação ou continuar a execução.

Para adquirir um ponto único a partir de diversos canais de entrada
analógica no dispositivo DAQ, utilize AI Sample Channels.

AI Sample Channels mede os sinais vinculados a vários canais e retorna
aqueles valores medidos em um arranjo. Device é o número do dispositivo
DAQ. Channels especifica a partir de quais canais de entrada analógica
deve-se fazer a leitura. High limit e low limit especificam a faixa do sinal
de entrada. As entradas padrão são +10 V e –10 V, respectivamente.
Samples é o arranjo de saída das tensões lidas. A ordem dos valores no
arranjo de amostras corresponde à ordem solicitada no controle de nomes
de canais DAQ. Por exemplo, se channels for 1, 2, 4, samples[0] será
de CH 1, samples[1] de CH 2 e samples[2] de CH 4. Se um erro ocorrer
durante a operação de AI Sample Channels, uma caixa de diálogo exibirá
o código do erro e você terá a opção de anular a operação ou continuar a
execução.

Controle de nomes de canais DAQ
O controle de nomes de canais DAQ, localizado na paleta Controls»I/O,
é um tipo de dados do LabVIEW utilizado pelos VIs de aquisição de dados
para comunicação com os dispositivos DAQ da National Instruments.

Insira os nomes dos canais no controle utilizando a ferramenta Operating
para clicar no controle de nomes de canais DAQ e selecionar o nome do
canal definido no Measurement & Automation Explorer.

Você também pode clicar com o botão direito no controle de nomes de
canais DAQ e selecionar Allow Undefined Names no menu de atalho.
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Exercise 8-2 VI Voltmeter
Objetivo: Adquirir um sinal analógico, utilizando um dispositivo DAQ.

Complete os passos a seguir para montar um VI que meça a tensão que
o sensor de temperatura do DAQ Signal Accessory fornece. O sensor de
temperatura fornece um tensão proporcional à temperatura. O sensor está
conectado fisicamente ao canal 0 do dispositivo DAQ.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

a. Selecione o medidor, localizado na paleta Controls»Numeric.

b. Configure a escala do medidor para 0.0 a 0.4. Para fazer isso,
utilize a ferramenta Labeling para clicar duas vezes em 10.0 e
digite 0.4. Talvez seja necessário aumentar o medidor para exibir
a escala no painel frontal anterior.

c. Configure a chave toggle vertical para o valor padrão TRUE
e para uma ação mecânica de Latch When Pressed.

d. Clique com o botão direito em Channel, selecione Allow
Undefined Names no menu de atalho e digite 0.
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Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

a. Selecione o VI AI Sample Channel, localizado na paleta Functions»
Data Acquisition»Analog Input. Esse VI lê um canal de entrada
analógica e retorna o valor da tensão.

Nota Se você não tiver um dispositivo DAQ ou um DAQ Signal Accessory, selecione
o VI (Demo) AI Sample Channel, localizado na paleta Functions»User Libraries»
Basics I Course, em vez do VI AI Sample Channel. Esse VI simula uma leitura de um
canal de entrada analógica.

b. Selecione a função Wait Until Next ms Multiple, localizada na
paleta Functions»Time & Dialog. Essa função faz com que o loop
seja executado a cada 100 ms.

3. Salve o VI como Voltmeter.vi, pois você irá utilizá-lo
posteriormente no curso.

4. Exiba o painel frontal e execute o VI.

O medidor exibe a tensão que o sensor de temperatura envia. Coloque
seu dedo no sensor de temperatura e observe que a tensão aumenta.

Se ocorrer um erro, os VIs de I/O fáceis exibirão uma caixa de diálogo
que mostra o código e a descrição do erro.

5. Defina Channel como temp. Execute o VI e a temperatura é exibida
no medidor. Os valores de temperatura são 100 vezes maiores do que
os valores de tensão. Altere a escala do medidor para ver os valores
corretos.

6. Feche o VI.

Final do exercício 8-2
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Exercise 8-3 VI Measurement Averaging (opcional)
Objetivo: Reduzir o ruído em medições analógicas através da sobreamostragem e do cálculo

de média.

1. Abra e execute o VI Measurement Averaging. Esse VI mede a saída de
tensão do sensor de temperatura uma vez por segundo e plota a tensão
no diagrama de forma de onda.

Nota Se você não tiver um dispositivo DAQ ou um DAQ Signal Accessory, substitua
o VI AI Sample Channel pelo VI (Demo) AI Sample Channel, localizado na paleta
Functions»User Libraries»Basics I Course. Esse VI simula uma leitura do canal 0
de entrada analógica.

2. Introduza ruído na medida de temperatura, invertendo a chave
Temp Sensor Noise do DAQ Signal Accessory para a posição ON.
As medições começam a flutuar com picos de ruído.

3. Pare a execução do VI e exiba o diagrama de bloco. Modifique a
condição TRUE no diagrama de bloco para que faça 30 medições,
calcule a média dos dados e plote a média das 30 medições.

4. Execute o VI. Os picos de ruído caem quando a chave Averaging
está ligada.

5. Salve e feche o VI.

Final do exercício 8-3
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D. Assistentes de DAQ
O LabVIEW contém vários assistentes que ajudam você a desenvolver
aplicações com mais rapidez. O DAQ Solution Wizard permite selecionar
entre vários exemplos de DAQ atuais ou projetar uma aplicação DAQ
personalizada. Ele funciona com entrada e saída analógica, I/O digital e
contador/temporizadores. O DAQ Solution Wizard é um utilitário interativo
que utiliza uma série de janelas que exibem perguntas sobre a aplicação.
Um exemplo de VI é criado, de maneira que você possa salvá-lo em um
novo local.

O DAQ Solution Wizard também utiliza o DAQ Channel Wizard para
definir quais sinais estão conectados a quais canais no dispositivo DAQ.
Quando você clica no botão Go to DAQ Channel Wizard, o Measurement
& Automation Explorer abre. Então, você pode modificar ou adicionar
novos canais virtuais e novas escalas para a aplicação DAQ. Em seguida,
pode fazer referência ao nome do canal do sinal de entrada em toda a
aplicação, e todos os processos de conversão são executados de forma
transparente.
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Exercise 8-4 VI Simple Data Logger
Objetivo: Utilizar os assistentes de DAQ para criar um VI de registro de dados

de vários canais.

Complete os passos a seguir para montar um VI que adquira vários canais
de dados, exiba esses dados em um Strip Chart e registre-os em um arquivo.
Utilize os canais virtuais que você definiu no Measurement & Automation
Explorer.

Conecte a saída de onda senoidal a Analog In CH1 e a saída de onda
quadrada a Analog In CH2 no DAQ Signal Accessory.

1. Abra um novo VI.

2. Selecione Tools»Data Acquisition»DAQ Solution Wizard para exibir
a caixa de diálogo DAQ Solution Wizard.

3. Clique no botão View Current Wizard Configuration para visualizar
os canais definidos. Utilize os canais temp, chan1 e chan2 neste
exercício. Esses canais correspondem ao sensor de temperatura e aos
canais 1 e 2 de entrada analógica do DAQ Signal Accessory. Para
visualizar definições desses canais em mais detalhes, abra o DAQ
Channel Wizard clicando no botão Go to DAQ Channel Wizard.

4. Selecione Use channel names specified in DAQ Channel Wizard
e clique no botão Next.

5. Você pode criar uma aplicação personalizada ou visualizar os VIs na
Common Solutions Gallery. Para este exercício, selecione Solutions
Gallery e clique no botão Next.

6. Selecione Data Logging na seção Gallery Categories e selecione
Simple Data Logger na seção Common Solutions.

7. Clique no botão Next para exibir a caixa de diálogo Specify
Inputs/Outputs.

8. Selecione quais os canais de dados a serem registrados e clique no botão
Open Solution. O seguinte painel frontal aparece. Os canais já estão
definidos.
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9. Exiba e examine o diagrama de bloco. Ele utiliza o VI AI Sample
Channels para adquirir os dados e o VI Write Characters to File para
registrá-los em disco. Esses dois VIs são VIs de I/O de alto nível.
Uma caixa de diálogo aparecerá se ocorrer um erro.

10. Exiba o painel frontal, defina Time Between Points como 1 segundo
e execute o VI. Aparece um prompt de nome de arquivo. Crie
logger.txt no diretório LabVIEW.

11. Pare a execução do VI, feche o VI Simple Data Logger e saia do
Solution Wizard.

Final do exercício 8-4
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E. Entrada analógica de forma de onda
Em muitas aplicações, a aquisição de um ponto de cada vez pode não ser
rápida o suficiente. Além disso, é difícil manter um intervalo de amostra
constante entre cada ponto, pois o intervalo depende de uma série de fatores,
como velocidade de execução do loop, overhead de chamada de software,
entre outros. Com determinados VIs, você pode obter vários pontos com
taxas maiores do que o VI AI Sample Channel pode alcançar. Além disso,
os VIs podem aceitar taxas de amostragem especificadas pelo usuário.
Um exemplo é a AI Acquire Waveform.

A AI Acquire Waveform adquire o número especificado de amostras na
taxa de amostragem especificada em um canal de entrada simples e retorna
os dados adquiridos. Device é o número do dispositivo DAQ. Channel
especifica o número do canal da entrada analógica. Number of samples
é o número de amostras a serem adquiridas. Sample rate é o número
de amostras a serem adquiridas por segundo. High limit e low limit
especificam a faixa do sinal de entrada. As entradas padrão são
+10 V e –10 V, respectivamente. Waveform contém os dados amostrados
e as informações de temporização.
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Dados de forma de onda
Os VIs de aquisição de dados retornam dados de forma de onda. O tipo de
dados de forma de onda é um tipo de dados do LabVIEW que combina os
dados lidos do dispositivo DAQ com as informações de temporização.
A forma de onda está localizada na paleta Controls»I/O.

Você liga o terminal de saída de forma de onda de um VI de aquisição
de dados diretamente ao tipo de dados de forma de onda e recebe o tempo
inicial em que os dados foram adquiridos, o tempo delta para cada ponto de
dados e um arranjo dos valores dos dados. Você também pode ligar o tipo
de dados de forma de onda diretamente a um gráfico de forma de onda e ele
escalona apropriadamente o eixo x com os dados de tempo, como mostrado
no exemplo a seguir.
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Exercise 8-5 VI Acquire Waveform
Objetivo: Adquirir e exibir uma forma de onda analógica.

Complete os passos a seguir para montar um VI que utiliza os VIs de
aquisição de dados para adquirir um sinal e plotá-lo em um gráfico.

No DAQ Signal Accessory, conecte o Analog Input CH1 à saída de
onda senoidal do gerador de funções.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

# of Samples especifica o número de pontos a serem amostrados.
Samples/Sec especifica a taxa de amostragem.

a. Determine um indicador de forma de onda, localizado na paleta
Controls»I/O.

b. Defina os dígitos de precisão da escala do eixo x do gráfico de forma
de onda como 1. Uma letra m aparece depois que os valores de escala
do eixo x para indicar milissegundos.
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Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

3. Selecione o VI AI Acquire Waveform, localizado na paleta Functions»
Data Acquisition»Analog Input. Esse VI adquire 1.000 pontos a uma
taxa de amostragem de 10.000 amostras/seg. do canal 1.

Nota Se você não tiver um dispositivo DAQ ou um DAQ Signal Accessory, selecione
o VI (Demo) Acquire Waveform, localizado na paleta Functions»User Libraries»
Basics I Course, em vez do VI AI Acquire Waveform. Esse VI simula a aquisição de
dados do canal 1 de entrada analógica a uma taxa de amostragem especificada, bem como
simula o retorno do número de amostras especificado.

4. Salve o VI como Acquire Waveform.vi.

5. Exiba o painel frontal, insira valores para os controles e execute o VI.
O gráfico plota a forma de onda analógica. Tente especificar diferentes
valores para a taxa de amostragem e o número de amostras.

6. Deixe esse VI aberto quando você terminar, pois irá utilizá-lo no
próximo exercício.

Final do exercício 8-5
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F. Gravando dados de forma de onda em arquivo
Utilize os VIs Waveform File I/O, localizados na paleta Functions»
Waveform»Waveform File I/O para gravar dados de forma de onda
em um arquivo.

Os VIs Write Waveforms to File e Read Waveforms from File gravam
dados em um arquivo de dados binários especial do LabVIEW, chamado
arquivo datalog. Consulte o Manual de treinamento do LabVIEW Básico II
para obter mais informações sobre arquivos datalog.

Você utiliza o VI Export Waveforms to Spreadsheet File para gravar os
dados de forma de onda em um formato de planilha.

O VI Export Waveforms to Spreadsheet File executa uma operação
semelhante ao VI Write to Spreadsheet File de alto nível. Ele abre um
arquivo de dados especificado pela entrada file path ou abre uma caixa de
diálogo se o caminho estiver vazio. Você liga a waveform diretamente à
entrada e esse VI converte os dados em formato de planilha, utilizando um
delimitador Tab como o padrão. Você pode selecionar a opção para anexar
a um arquivo já existente ou para gravar em um novo arquivo. Também
pode adicionar um cabeçalho ao arquivo ou gravar várias colunas de tempo
no arquivo. O arquivo é fechado depois que os dados são gravados nele.
Os clusters error in e error out monitoram as condições de erro.
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Exercise 8-6 VI Acquire Waveform to File
Objetivo: Gravar dados adquiridos de um canal de entrada analógica em um arquivo.

Complete os passos a seguir para gravar os dados do VI Acquire Waveform
em um arquivo de planilha.

1. Abra o VI Acquire Waveform, que você montou no Exercício 8-5.

2. Salve o VI como Acquire Waveform to File.vi.

Diagrama de bloco
3. Modifique o diagrama de bloco da seguinte forma.

a. Selecione o VI Export Waveforms to Spreadsheet File, localizado na
paleta Functions»Waveform»Waveform File I/O. Esse VI abre
um arquivo, formata e grava dados de forma de onda no arquivo com
um cabeçalho e fecha o arquivo.

b. Selecione o VI Simple Error Handler, localizado na paleta
Functions»Time & Dialog. Esse VI verificará o cluster de erro
e exibirá uma caixa de diálogo se um erro ocorrer.

4. Salve o VI.

5. Exiba o painel frontal e execute o VI. Após a aquisição do VI e a
exibição da forma de onda, uma caixa de diálogo solicita que você
digite o nome do arquivo.

6. Digite acquire.txt e clique no botão OK.

7. Abra o arquivo acquire.txt em uma aplicação de planilha ou de
processamento de texto. As informações de cabeçalho encontram-se
na primeira linha. Elas descrevem a hora de início e os valores de
incremento de tempo. Os dados de forma de onda encontram-se no
restante do arquivo, com os valores de data e hora especificados na
primeira coluna e as tensões na segunda coluna.

8. Feche todas as janelas abertas.

Final do exercício 8-6
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G. Varrendo vários canais de entrada analógica
Com o VI Analog Input Easy I/O AI Acquire Waveforms, você
pode adquirir formas de onda de vários canais em uma só execução.

O VI AI Acquire Waveforms adquire o número especificado de amostras à
taxa de varredura especificada, a partir de vários canais, e retorna os dados
adquiridos. Device é o número do dispositivo DAQ. Channels é um
controle de nome de canal DAQ que especifica os canais de entrada
analógica a serem medidos. Uma vírgula separa os canais na string.
Por exemplo, 1, 2, 4. Number of samples/ch é o número de amostras
por canal a serem adquiridas. Scan rate é o número de amostras a serem
adquiridas por segundo para cada canal. High limit e low limit especificam
a faixa do sinal de entrada. As entradas padrão são +10 V e –10 V,
respectivamente. Waveforms é um arranjo 1D, em que cada elemento é
um tipo de dados de forma de onda com elementos do arranjo especificados
na mesma ordem que os nomes de canal.

Os próximos dois exemplos mostram o VI AI Acquire Waveforms para uma
varredura de quatro canais. A seqüência de varredura é 1, 2, 4 e 6. Para cada
canal, 100 amostras são adquiridas a 2.000 Hz. O AI Acquire Waveforms
retorna um arranjo 1D de formas de onda. Os dados do primeiro canal são
armazenados no elemento 0, do segundo canal no elemento 1, e assim por
diante. A função Index Array extrai os dados para cada canal; uma forma de
onda no primeiro exemplo.
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Formas de onda e gráficos varridos
Você pode ligar diretamente a saída do VI AI Acquire Waveforms à
um gráfico de forma de onda para plotagem. O exemplo a seguir mostra
a varredura de quatro canais plotada em um gráfico.
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Exercise 8-7 Exemplo de varredura de VI
Objetivo: Utilizar os VIs de I/O fáceis para executar uma aquisição de dados varrida.

Complete os passos a seguir para examinar e executar o VI que adquire
duas formas de onda diferentes e plota cada uma delas em um gráfico.

Conecte a saída de onda senoidal a Analog In CH1 e a saída de onda
quadrada a Analog In CH2 no DAQ Signal Accessory.

1. Abra o Exemplo de varredura de VI, que já está montado.

2. Exiba e examine o diagrama de bloco.

Nota Se você não tiver um dispositivo DAQ ou o DAQ Signal Accessory, substitua
o VI AI Acquire Waveforms pelo VI (Demo) Acquire Waveforms, localizado na paleta
Functions»User Libraries»Basics I Course. Esse VI simula a leitura de uma onda
senoidal no canal 1 e de uma onda quadrada no canal 2.

3. Execute o VI. Os gráficos exibem as formas de onda.

4. Feche o VI. Não salve nenhuma alteração.

Final do exercício 8-7
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Exercise 8-8 VI Scan Two Waveforms (opcional)
Objetivo: Adquirir dados de vários canais no dispositivo DAQ e exibi-los em um gráfico.

Complete os passos a seguir para adquirir dados de vários canais e exibi-los
em um gráfico.

1. Conecte a saída de onda senoidal a Analog In CH1 e a saída de onda
quadrada a Analog In CH2 no DAQ Signal Accessory.

2. Crie um VI que varre os dados dos canais 1 e 2 e plota as duas formas
de onda em um único gráfico de forma de onda. Obtenha 500 pontos
de cada canal a 10.000 Hz. Grave os dados varridos em um arquivo
de planilha, de maneira que quando o arquivo for aberto com uma
aplicação de planilha, cada canal seja exibido em uma coluna.

Nota Se você não tiver um dispositivo DAQ ou o DAQ Signal Accessory, substitua
o VI AI Acquire Waveforms pelo VI (Demo) Acquire Waveforms, localizado na paleta
Functions»User Libraries»Basics I Course. Esse VI simula a leitura de uma onda
senoidal no canal 1 e de uma onda quadrada no canal 2.

3. Salve o VI como Scan Two Waveforms.vi. Utilize o seguinte painel
frontal para iniciar.

Final do exercício 8-8
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H. Saída analógica
A biblioteca Analog Output contém VIs que executam conversões
digital/analógico (D/A) ou múltiplas conversões.

O AO Update Channel grava um valor de tensão especificado em um canal
de saída analógica. Device é o número do dispositivo DAQ. Channel é uma
string que especifica o nome do canal de saída analógica. Value é a tensão
a ser fornecida para saída.

Se ocorrer um erro durante a operação de AO Update Channel, uma caixa
de diálogo exibirá o código de erro e você terá a opção de anular a operação
ou continuar a execução.

Geração de formas de onda
Em muitas aplicações, a geração um ponto de cada vez pode não ser rápida
o suficiente. Além disso, é difícil manter um intervalo de amostra constante
entre cada ponto, pois o intervalo depende de uma série de fatores, como
velocidade de execução do loop, overhead de chamada de software, entre
outros. Com o VI AO Generate Waveform, você pode gerar vários pontos a
taxas superiores às que o VI AO Update Channel pode alcançar. Além disso,
o VI pode aceitar taxas de atualização especificadas pelo usuário.

O AO Generate Waveform gera uma forma de onda de tensão em um canal
de saída analógica na taxa de atualização especificada. Device é o número
do dispositivo DAQ. Channel especifica o nome do canal de saída
analógica. Update rate é o número de atualizações de tensão a serem
geradas por segundo. Waveform contém os dados a serem gravados no
canal de saída analógica em volts.
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Exercise 8-9 Exemplo de VI de saída de tensão
Objetivo: Fornecer uma tensão analógica de saída utilizando o dispositivo DAQ.

Complete os passos a seguir para examinar um VI que gera uma tensão de
saída de 0 a 9,5 V em graduações de 0,5 V.

Conecte o Analog Out CH0 ao Analog In CH1 no DAQ Signal Accessory.

Painel frontal
1. Abra o Exemplo de VI de saída de tensão. O seguinte painel frontal já

estará montado.

Channel especifica o canal de saída analógica. Voltage Out exibe a
saída de tensão atual.

Diagrama de bloco
2. Exiba e examine o diagrama de bloco a seguir.

• O VI AO Update Channel, localizado na paleta Functions»
Data Acquisition»Analog Output, retorna a tensão especificada
utilizando o canal 0 de saída analógica.

Nota Se você não tiver um dispositivo DAQ ou um DAQ Signal Accessory, substitua
cada VI AO Update Channel pelo VI (Demo) Update Channel, localizado na paleta
Functions»User Libraries»Basics I Course. Esse VI simula a geração de uma tensão
em um canal de saída analógica.
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• A função Wait Until Next ms Multiple, localizada na paleta
Functions»Time & Dialog, faz com que o For Loop seja executado
a cada 500 ms.

• A variável local, localizada na paleta Functions»Structures,
grava um valor 0.0 no indicador Voltage Out após a conclusão do
For Loop. Você pode utilizar variáveis locais para gravar em um
indicador em diferentes locais de um diagrama de bloco. Consulte
o Manual de treinamento do LabVIEW Básico II para obter mais
informações sobre variáveis locais.

3. Feche o diagrama de bloco e abra o VI Voltmeter.

4. Configure a escala do medidor de 0.0 para 10.0.

5. Digite chan1 em Channel no painel frontal do VI Voltmeter. Defina
os controles de limite, como mostrado no painel frontal a seguir.

6. Ligue a chave Power e execute o VI Voltmeter.

7. Para adquirir e exibir a saída de tensão, execute o Exemplo de VI de
saída de tensão.

O VI AO Update Channel gera a tensão de saída em graduações de
0,5 V, variando de 0 a 9,5 V. Após a conclusão de execução do For
Loop, o VI envia 0 V para reinicializar o canal de saída analógica.
Uma variável local grava 0.0 no indicador Voltage Out após a conclusão
do For Loop. No painel frontal do VI Voltmeter, o medidor adquire e
exibe a saída de tensão.

8. Feche os dois VIs.

Final do exercício 8-9
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I. Entrada e saída digital
Utilize os VIs Digital I/O, localizados na paleta Functions»Data
Acquisition»Digital I/O para ler ou gravar em uma porta digital
inteira ou em uma linha específica dessa porta.

O VI Write to Digital Line define uma linha específica em uma porta
configurada pelo usuário como estado lógico alto ou baixo. Device é o
número do dispositivo DAQ. Digital Channel especifica a porta onde a
linha está localizada. Line especifica a linha digital a ser gravada. Line
State grava uma condição verdadeira ou falsa na linha determinada.

O VI Read from Digital Line lê o estado lógico de uma linha digital em uma
porta configurada pelo usuário. Device é o número do dispositivo DAQ.
Digital Channel especifica a porta onde a linha está localizada. Line
especifica a linha digital a ser lida. Line State retorna o estado lógico da
linha especificada.

O VI Write to Digital Port fornece um padrão decimal de saída a uma porta
digital específica. Device é o número do dispositivo DAQ. Digital Channel
especifica a porta digital do dispositivo DAQ a ser utilizada. Pattern
especifica o novo estado das linhas a serem gravadas na porta. Port Width
é o número de bits da porta.

O VI Read from Digital Port lê uma porta configurada pelo usuário. Device
é o número do dispositivo DAQ. Digital Channel especifica a porta digital
a ser lida. A leitura é exibida em um número decimal em pattern. Port
Width especifica o número total de bits da porta.

Se ocorrer um erro durante a operação de um VI de I/O digital, uma caixa
de diálogo exibirá o código de erro e você terá a opção de anular a operação
ou continuar a execução.
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Exercise 8-10 Exemplo de VI digital
Objetivo: Controlar as linhas de I/O digital no dispositivo DAQ.

Complete os passos a seguir para examinar o VI que acende os LEDs da
porta 0 no DAQ Signal Accessory, com base no valor digital definido no
painel frontal. Cada LED é ligado a uma linha digital no dispositivo DAQ.
As linhas são numeradas 0, 1, 2 e 3, iniciando com o LED do lado direito.

Nota Os LEDs utilizam lógica negativa. Quer dizer, escrever o número 1 na linha digital
do LED apaga o LED. Escrever um 0 na linha digital do LED acende o LED.

1. Abra o Exemplo de VI digital.

2. Exiba e examine o diagrama de bloco.

3. Execute o VI. Digite números diferentes, entre 0 e 15, dentro de Pattern
Input. Os LEDs exibem o equivalente binário do número que você
inserir.

4. Feche o VI. Não salve nenhuma alteração.

Final do exercício 8-10
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J. DAQ com buffer (opcional)
Uma aplicação DAQ comum executa aquisição contínua ou com buffer.

VIs intermediários
A figura a seguir mostra como utilizar os VIs intermediários Analog Input,
localizados na segunda linha da paleta Functions»Data Acquisition»
Analog Input, no diagrama de bloco. Todas as entradas necessárias não
estão ligadas aos VIs nestas figuras. As figuras são apresentadas para
demonstrar a ordem de execução dos VIs e a utilização do taskID para
controlar o fluxo de dados. A figura mostra um diagrama de bloco
simplificado para aplicações que obtêm formas de onda de dados utilizando
um buffer na memória do computador e temporização de hardware a partir
de contadores internos. O diagrama de bloco chama AI Config, AI Start,
AI Read, AI Clear e Simple Error Handler.

AI Config configura os canais, aloca um buffer na memória do computador
e gera uma taskID. AI Start programa os contadores do dispositivo DAQ
e inicia a aquisição. AI Read lê os dados do buffer na memória do
computador. AI Clear libera os recursos do computador e do dispositivo
DAQ. O cluster de erro é propagado através dos VIs e o Simple Error
Handler exibe um caixa de diálogo se ocorrer um erro.

Nota No diagrama de bloco anterior, o parâmetro buffer size de AI Config está definido
como 2,000. O parâmetro number of scans to acquire de AI Start é deixado desligado
e tem uma entrada padrão –1. O valor –1 informa ao AI Start para adquirir o mesmo
número de pontos que o tamanho da memória alocada (buffer size) em AI Config.
De forma semelhante, o parâmetro number of scans to read de AI Read também está
desligado e possui uma entrada padrão –1. Novamente, o valor –1 informa ao AI Read
para ler o número de pontos que o AI Start especifica.
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DAQ contínua
A aquisição de dados contínua, ou em tempo real, retorna dados de
uma aquisição em andamento sem interromper a aquisição. Esse método
geralmente envolve um esquema circular de buffers, como mostrado na
próxima figura. Você especifica o tamanho de um buffer circular grande ao
configurar a aquisição. Após o início da aquisição, o dispositivo DAQ coleta
dados e armazena-os nesse buffer. O LabVIEW transfere os dados para fora
do buffer, um bloco de cada vez, para traçar gráficos e armazenar em disco.
Quando o buffer está cheio, o dispositivo começa a gravar dados no início
do buffer, substituindo os dados armazenados anteriormente. Esse processo
continua até que o sistema adquira o número de amostras especificado, o
LabVIEW limpe a operação ou ocorra um erro. A DAQ contínua é útil para
aplicações, como fluxo de dados em disco e exibição de dados em tempo
real.

Você configura o LabVIEW para DAQ contínua, instruindo o AI Start a
adquirir dados indefinidamente. Essa aquisição é assíncrona, significando
que outras operações do LabVIEW podem ser executadas durante a
aquisição. A seguinte figura ilustra um típico diagrama de bloco de DAQ
contínua. Para iniciar a aquisição, defina number of scans to acquire em

1 Dados recebidos do dispositivo
para o computador(VI AI Start)

2 Fim de dados
3 Marca de leitura atual

4 Dados transferidos do buffer do
computador para o LabVIEW
(VI AI Read)

A

1

3 3

4

2 2 3 3

2 3 3 2

B

C D
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AI Start como 0. O AI Read é chamado em uma estrutura de loop para
recuperar dados do buffer. Você pode então enviar os dados para o disco,
para um gráfico, e assim por diante. O AI Clear interrompe a aquisição,
desaloca os buffers e libera qualquer recurso do dispositivo.
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Exercise 8-11 Aquisição contínua com o VI MIO (opcional)

Objetivo: Executar DAQ contínua.

Complete os passos a seguir para montar um VI que execute uma operação
contínua de aquisição e plote os últimos dados adquiridos em um diagrama.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

a. Você pode criar a maioria dos controles do painel frontal no
diagrama de bloco, clicando com o botão direito nos terminais
apropriados dos VIs de aquisição de dados e selecionando
Create»Control no menu de atalho.

b. Adquira dados de vários canais do DAQ Signal Accessory e
exiba-os no gráfico. Defina a Scan Rate como 1,000 varreduras/seg.
e # of Scans in Buffer como 3,000.

c. Defina a entrada de controle da string de canal como 0,1,2 ou 0:2.

d. Estabeleça as seguintes conexões no DAQ Signal Accessory.

• Conecte a saída de onda senoidal à entrada analógica CH1.

• Conecte a saída de onda quadrada à entrada analógica CH2.
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Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

a. Selecione o VI AI Config, localizado na paleta Functions»Data
Acquisition»Analog Input. Esse VI configura a operação de
entrada analógica para um conjunto específico de canais, configura
o hardware e aloca um buffer na memória do computador.

b. Selecione o VI AI Start, localizado na paleta Functions»Data
Acquisition»Analog Input. Esse VI inicia a operação de entrada
analógica contínua e com buffer e define a taxa a que os dados serão
adquiridos.

c. Selecione o VI AI Read, localizado na paleta Functions»Data
Acquisition»Analog Input. Esse VI lê os dados do buffer, alocados
pelo VI AI Config. Ele controla o número de pontos a serem lidos
do buffer, retorna os dados de tensão escalonados e define a
localização do buffer de onde deverão ser lidos os dados.

d. Selecione o VI AI Clear, localizado na paleta Functions»Data
Acquisition»Analog Input. Esse VI limpa a operação de entrada
analógica e desaloca o buffer da memória do computador.

e. Selecione o VI Simple Error Handler, localizado na paleta
Functions»Time & Dialog. No caso de um erro, esse VI exibe
uma caixa de diálogo com informações a respeito do erro e de
sua localização.

f. Selecione a função Unbundle by Name, localizada na paleta
Functions»Cluster. Essa função separa o status Booleano do
cluster de erro.

3. Salve o VI como Continuous Acquire with MIO.vi.

4. Exiba o painel frontal. Execute o VI e monitore os dados plotados no
gráfico à medida que você altera o botão freqüência no DAQ Signal
Accessory. A constante numérica 0 que você ligou à entrada number of
scans to acquire do VI AI Start habilita uma DAQ contínua ou circular.
Os dados enchem o buffer de tamanho fixo na memória e, em seguida,
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quando alcançam o fim do buffer, substituem os valores a partir do
início do buffer.

5. Defina Read/Search Position como Relative to read mark.

6. Execute o VI e monitore Scan Backlog à medida que você diminui
a taxa de varredura ou o número de pontos a serem lidos a cada vez.
Scan backlog é definido como o número de pontos adquiridos no buffer
de aquisição, mas que ainda não foram lidas. Scan backlog é uma forma
de saber qual o grau de eficiência com que você está lidando com a
aquisição contínua. Se o valor de Scan backlog aumentar de repente,
significará que você não está lendo dados do buffer rápido o suficiente
e que, conseqüentemente, perderá dados. Se isso ocorrer, o VI AI Read
retornará um erro.

7. Feche o VI.

Final do exercício 8-11
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Resumo, dicas e suplementos

• A maioria dos VIs de aquisição de dados localizados na paleta
Functions»Data Acquisition possui os níveis a seguir na subpaleta,
de acordo com sua funcionalidade, incluindo VIs fáceis, intermediários,
utilitários e avançados.

• Os VIs fáceis executam operações DAQ simples e geralmente estão
localizados na primeira linha de VIs em uma subpaleta. Você pode
executar esses VIs no painel frontal ou utilizá-los como subVIs em
aplicações básicas.

• Você necessita de apenas um VI fácil para executar cada operação DAQ
básica. Diferentemente dos VIs intermediários e avançados, os VIs
fáceis automaticamente alertam você para erros com uma caixa de
diálogo que permitem interromper a execução do VI ou ignorar o erro.

• Os VIs intermediários têm uma maior funcionalidade de hardware
e eficiência no desenvolvimento de aplicações do que os VIs fáceis.
Utilize os VIs intermediários na maioria das aplicações.

• Você pode utilizar aquisição ou geração de formas de onda para adquirir
ou gerar dados mais rapidamente e a uma taxa de amostragem mais
constante do que nas conversões de pontos individuais.

• Você pode adquirir dados continuamente, utilizando os VIs
intermediários Analog Input, incluindo AI Config, AI Start,
AI Read e AI Clear.

• Os VIs de aquisição de dados retornam dados como uma forma de onda.
O tipo de dados de forma de onda combina os dados medidos com as
informações de tempo. Você liga uma forma de onda diretamente a
um gráfico de forma de onda e as escalas x e y são automaticamente
ajustadas aos dados.
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Exercícios adicionais
8-12 Monte um VI que meça constantemente a temperatura duas vezes

por segundo e exiba-a em um diagrama de forma de onda. Se a
temperatura ultrapassar um limite predefinido, o VI deverá acender
um LED no painel frontal e o LED 0 no DAQ Signal Accessory.
Os LEDs da caixa estão rotulados. O diagrama deve plotar a
temperatura e o limite.

Salve o VI como Temp Monitor with LED.vi.

8-13 Utilize o DAQ Solution Wizard para abrir um VI que leia e exiba
os dados registrados no Exercício 8-4 e é chamado Simple Data 
Reader.vi.
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Anotações
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Anotações
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Lição 9
Controle de instrumento

Esta lição descreve como você pode utilizar o LabVIEW para controlar
e adquirir dados de instrumentos GPIB e de porta serial externos. Utilize
drivers de instrumento juntamente com as funções de nível inferior para
executar a I/O de instrumentos.

Você aprenderá:

A. Sobre controle de instrumento

B. Sobre configuração e comunicação GPIB

C. Sobre drivers de instrumento

D. Como utilizar VIs de drivers de instrumento

E. Sobre VISA

F. Como utilizar os VIs e as funções VISA

G. Sobre comunicação de porta serial

H. Sobre transferências de forma de onda
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A. Visão geral de controle de instrumento
Você não estará limitado ao tipo de instrumento que você controla se
optar por tecnologias de controle de padrão de mercado. É possível utilizar
instrumentos de várias categorias diferentes, incluindo serial, GPIB, VXI,
PXI, instrumentos baseados em computador, Ethernet, SCSI, CAMAC
e dispositivos de porta paralela. Esta lição descreve os dois métodos mais
comuns de comunicação de instrumentos, GPIB e comunicação de porta
serial.

Observe os seguintes detalhes a respeito do controle de instrumentação
de PC:

• Tipo de conector (pinos) do instrumento

• Cabos necessários—modem nulo, número de pinos, macho/fêmea

• Propriedades elétricas envolvidas—níveis de sinal, aterramento,
restrições quanto a comprimento de cabo

• Protocolos de comunicação utilizados—comandos ASCII, comandos
binários, formato de dados

• Drivers de software disponíveis
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B. Comunicação e configuração GPIB
A Norma 488.1-1987 do ANSI/IEEE, também conhecida como barramento
de interface de uso geral (GPIB—General Purpose Interface Bus), descreve
uma interface padrão para comunicação entre instrumentos e controladores
de diversos fornecedores, como scanners e gravadores em filme. Essa
norma contém informações sobre especificações elétricas, mecânicas e
funcionais. GPIB é uma interface paralela de comunicação digital de 8 bits,
com taxas de transferência de dados de 1 Mbyte/s e superiores, utilizando
um handshake de três fios. O barramento suporta um controlador de sistema,
geralmente um computador, e até 14 instrumentos adicionais. A Norma
ANSI/IEEE 488.2-1992 expande o IEEE 488.1 definindo um protocolo de
comunicação de barramento, um conjunto comum de códigos e formatos de
dados e um conjunto genérico de comandos comuns de dispositivo.

Os instrumentos GPIB oferecem a engenheiros de teste e de produção a
mais ampla gama de fabricantes e instrumentos para aplicações de teste
de mercado vertical especializado ou de uso geral. Tradicionalmente,
os instrumentos GPIB têm sido utilizados como instrumentos autônomos
de bancada, em que as medições são feitas manualmente.

O GPIB é um barramento paralelo de 24 condutores que consiste em oito
linhas de dados, cinco linhas de gerenciamento de barramento (ATN, EOI,
IFC, REN e SRQ), três linhas de handshake e oito linhas de terra. O GPIB
utiliza um esquema de transferência de dados assíncrono em byte serial.
Isto significa que todos os bytes são enviados em seqüência através do
barramento a uma velocidade de transmissão que será determinada pelo
participante mais lento da transferência. Como a unidade de dados no GPIB
é um byte, as mensagens transferidas são freqüentemente codificadas como
strings de caracteres ASCII.

Todos os dispositivos e interfaces GPIB devem possuir um endereço GPIB
exclusivo entre 0 e 30. O endereço 0 normalmente é atribuído à interface
GPIB. Os instrumentos GPIB podem utilizar endereços 1 a 30. Os
dispositivos GPIB podem ser transmissores, receptores ou controladores.
Um transmissor envia mensagens de dados. Os receptores recebem
mensagens de dados. O controlador, geralmente um computador, gerencia
o fluxo de informações no barramento. É ele que define os enlaces de
comunicação e envia comandos GPIB aos dispositivos. Os VIs GPIB
automaticamente gerenciam o endereçamento e a maioria das outras
funções de gerenciamento do barramento.
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Você pode encerrar uma transferência de dados GPIB de três maneiras:

• O GPIB inclui uma linha de hardware (EOI) que pode ser expressa pelo
último byte de dados. Esse é o método mais utilizado.

• Insira um caractere específico de final de string (EOS—End-of-String)
no final da própria string de dados. Alguns instrumentos utilizam esse
método, em vez da assertiva de linha EOI ou além dela.

• O receptor conta os bytes enviados por handshake e pára a leitura
quando atinge um limite de contagem de bytes. Esse método muitas
vezes é utilizado como um método de terminação padrão, pois a
transferência pára no OR lógico de EOI, EOS (se utilizado) juntamente
com a contagem de byte. Sendo assim, você geralmente define a
contagem de byte de forma que ela seja igual ou exceda o número
esperado de bytes a serem lidos.

Para alcançar uma taxa de transferência de dados mais alta do que a taxa
para a qual o dispositivo GPIB foi projetado, você deve limitar o número
de dispositivos no barramento e a distância física entre eles. As seguintes
restrições são comuns:

• Uma distância máxima de 4 m entre qualquer um dos dois dispositivos
e uma distância média de 2 m em relação ao barramento inteiro

• Um comprimento total máximo de cabo de 20 m

• Uma quantidade máxima de 15 dispositivos conectados a cada
barramento, com pelo menos dois terços deles ligados

Para operações de alta velocidade, aplicam-se as seguintes restrições:

• Todos os dispositivos do sistema devem estar ligados.

• O comprimento dos cabos deve ser o mais curto possível, atingindo
um comprimento máximo de 15 m para cada sistema.

• Deve haver, pelo menos, uma carga de dispositivo equivalente por
metro de cabo.

Se você desejar exceder essas limitações, poderá utilizar um extensor de
barramento para aumentar o comprimento do cabo ou o número de cargas
do dispositivo. Você pode solicitar extensores e expansores de barramento
junto à National Instruments.

Nota Consulte o site de suporte GPIB da National Instruments na Web, em
ni.com/support/gpibsupp.htm, para obter mais informações sobre GPIB.
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Arquitetura de software
A arquitetura de software para controle de instrumentos GPIB que utiliza
o LabVIEW é similar à arquitetura para DAQ. Sua interface GPIB inclui
um conjunto de drivers para essa interface. Esses drivers também estão
disponíveis no CD do LabVIEW. Sempre instale a versão mais recente
desses drivers, a não ser que você seja orientado de outra forma nas notas
de versão da interface GPIB ou do LabVIEW. A ilustração a seguir mostra
a arquitetura de software em ambiente Windows.

(Windows) Utilize o Measurement & Automation Explorer (MAX) para
configurar e testar a interface GPIB. O Measurement & Automation
Explorer interage com as diversas ferramentas de configuração e
diagnóstico instaladas com o driver, e também com o Registro do Windows
e o Gerenciador de dispositivos. O software de nível de driver está no
formato de uma DLL e contém todas as funções que se comunicam
diretamente com a interface GPIB. Os VIs e as funções de Instrument I/O
chamam diretamente o software de driver.

Software de configuração (Windows)

Nota (Macintosh e UNIX) Consulte a documentação de sua interface GPIB para obter
informações sobre configuração e teste da interface.

O Measurement & Automation Explorer é um utilitário de configuração
para o hardware e software da National Instruments. Ele também pode
executar diagnósticos de sistemas, adicionar novos canais, interfaces e
canais virtuais, bem como visualizar dispositivos e instrumentos conectados

Configuration and
Diagnostic Tools

Measurement &
Automation Explorer

LabVIEW

Windows Registry
and Device Manager

Instrument I/O
VIs and Functions

Driver Software
(DLL)

GPIB Interface
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ao seu sistema. Abra o Measurement & Automation Explorer clicando
duas vezes em seu ícone na área de trabalho ou selecionando Tools»
Measurement & Automation Explorer.

O painel Configuration do Measurement & Automation Explorer inclui
as seguintes seções:

• Data Neighborhood: utilize essa seção para criar canais virtuais, aliases
e marcações (tags) para canais ou medições configuradas em Devices
and Interfaces, como você fez na Lição 8, Aquisição de dados e formas
de onda.

• Devices and Interfaces: utilize essa seção para configurar recursos e
outras propriedades físicas de dispositivos e interfaces e para visualizar
atributos de um ou vários dispositivos, como números de série.

• Scales: utilize essa seção para executar operações simples com dados,
como definir a escala de leitura de temperatura do DAQ Signal
Accessory de volts para graus Celsius.

• Software: utilize essa seção para determinar quais drivers e aplicativos
de software estão instalados e quais são os números de suas versões.

Configure os objetos listados no Measurement & Automation Explorer,
clicando com o botão direito no item e selecionando uma opção no menu de
atalho. O exemplo a seguir mostra uma interface GPIB no Measurement &
Automation Explorer após clicar no botão Scan for Instruments da barra
de ferramentas.
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Exercise 9-1 (Apenas para Windows)
Objetivo: Utilizar o Measurement & Automation Explorer para examinar as configurações da

interface GPIB, detectar instrumentos e comunicar-se com um instrumento.

1. Desligue o NI Instrument Simulator e o configure-o para se comunicar
através da interface GPIB, definindo o seguinte banco de chaves à
esquerda, localizado na lateral da caixa.

2. Ligue o NI Instrument Simulator e verifique se os LEDs Power e Ready
estão acesos.

3. Inicie o Measurement & Automation Explorer clicando duas vezes no
ícone da área de trabalho ou selecionando Tools»Measurement &
Automation Explorer no LabVIEW.

4. Expanda a seção Devices and Interfaces para exibir as interfaces
instaladas. Se uma interface GPIB estiver listada, o software NI-488.2
estará corretamente carregado em seu computador.

5. Selecione a interface GPIB e clique no botão Properties da barra de
ferramentas para exibir a caixa de diálogo Properties.

6. Examine as definições da interface GPIB, mas não as altere, e clique no
botão OK.

7. Verifique se a interface GPIB ainda está selecionada na seção Devices
and Interfaces e clique no botão Scan for Instruments da barra de
ferramentas.

8. Expanda a seção GPIB board. Um instrumento denominado
Instrument0 aparece.

9. Clique em Instrument0 para exibir informações sobre o instrumento
no painel da direita do Measurement & Automation Explorer.

O NI Instrument Simulator possui um endereço primário
(PAD—Primary Address) de GPIB 2.

Nota Você pode precisar fechar a ajuda on-line, clicando no botão Show/Hide,
localizado no canto superior direito do Measurement & Automation Explorer, para
exibir as informações sobre Instrument0.

10. Clique no botão Communicate with Instrument da barra de
ferramentas. Uma janela interativa aparece, que você pode utilizar
para consultar, gravar e ler esse instrumento.
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11. Digite *IDN? em Send String e clique no botão Query. O instrumento
retorna seu número de fabricação e modelo em String Received. Você
pode utilizar essa janela para depurar problemas do instrumento ou
verificar se comandos específicos funcionam como descrito na
documentação do instrumento.

12. Digite MEAS:DC? em Send String e clique no botão Query.
O NI Instrument Simulator retorna uma medição simulada de tensão.

13. Clique no botão Query novamente para obter um valor diferente.

14. Clique no botão Exit.

15. Defina um alias VISA para o NI Instrument Simulator, para que você
possa utilizar o alias, em vez de ter de se lembrar do endereço primário
do instrumento.

a. Enquanto a opção Instrument0 estiver selecionada no
Measurement & Automation Explorer, clique no botão VISA
Properties para exibir a caixa de diálogo Properties.

b. Digite devsim em VISA Alias e clique no botão OK.
Você irá utilizar esse alias em toda esta lição.

16. Selecione File»Exit para sair do Measurement & Automation Explorer.

Final do exercício 9-1
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C. Comunicando-se com instrumentos
Você pode utlizar o LabVIEW para comunicar-se com instrumentos GPIB
de uma destas duas formas principais:

• Os VIs e as funções de Instrument I/O comunicam-se com o software
de nível de driver da interface GPIB. Dessa forma, você pode montar
VIs que utilizam esses VIs e essas funções diretamente. Entretanto,
cada instrumento possui um conjunto de comandos ou um protocolo
específico para envio e recebimento de dados. A aprendizagem e a
utilização desses comandos e protocolos pode ser difícil.

• Um driver de instrumento é um conjunto de funções de software
modulares que utilizam os comandos ou o protocolo do instrumento
para executar operações comuns com o instrumento. O driver de
instrumento também chama os VIs e as funções apropriadas para cada
instrumento. Os drivers de instrumento do LabVIEW descartam a
necessidade de se aprender os complexos comandos de programação
de baixo nível de cada instrumento.

Drivers de instrumento
A biblioteca de drivers de instrumento do LabVIEW contém drivers
de instrumento para uma grande variedade de instrumentos programáveis
que utilizam as interfaces GPIB, VXI ou interface serial.

Os drivers de instrumento recebem, analisam e escalonam as strings de
resposta dos instrumentos em dados com escala que você pode utilizar
em aplicações de teste. Esses drivers ajudam a facilitar a manutenção das
aplicações de teste, pois eles contêm todas as informações de I/O referentes
a um instrumento em uma única biblioteca, separada de outro código.
Quando você vai fazer a atualização do hardware, esses drivers facilitam a
atualização de sua aplicação, pois todos os códigos específicos para aquele
instrumento está contido no driver de instrumento.

A biblioteca de drivers de instrumento do LabVIEW está localizada no
CD do LabVIEW. Você também pode fazer download dos drivers a partir
do site da National Instruments na Web, em ni.com. Para instalar os
drivers de instrumento do LabVIEW, descompacte o arquivo de drivers de
instrumento para obter um diretório com arquivos. Coloque esse diretório
em labview\instr.lib. A próxima vez que você abrir o LabVIEW,
poderá acessar os VIs dos drivers de instrumento na paleta Functions»
Instrument I/O»Instrument Drivers.

Exemplo de introdução ao instrumento
Todos os drivers de instrumento contêm um exemplo que você pode utilizar
para testar se os VIs do driver estão se comunicando com o instrumento.
Especifique o endereço GPIB correto para o instrumento, conforme
configurado no Measurement & Automation Explorer.
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Exercise 9-2 VI NI DEVSIM Getting Started
Objetivo: Examinar os drivers de instrumento do LabVIEW instalados e utilizar o exemplo

de VI do driver de instrumento NI DevSim.

Nota Se você tiver um instrumento diferente, instale gratuitamente um driver do
LabVIEW a partir do site da National Instruments na Web ou do CD do LabVIEW.
No LabVIEW, selecione Tools»Instrumentation»Instrument Driver Network
para visitar a seção Instrument Driver Network em ni.com.

1. Abra um novo VI e exiba o diagrama de bloco.

2. Selecione a paleta Functions»Instrument I/O»Instrument Drivers
e registre quais os drivers instalados:

3. Selecione a subpaleta NI Device Simulator e examine as categorias
de VIs de drivers de instrumento.

4. Selecione a subpaleta Application Examples e coloque o VI NI
DEVSIM Getting Started no diagrama de bloco.

Painel frontal
5. Clique duas vezes no VI NI DEVSIM Getting Started para exibir

e examinar o painel frontal a seguir.

6. Execute o VI. O simulador fornece uma tensão DC aleatória e gera a
forma de onda solicitada no gráfico. O simulador pode demorar alguns
segundos para obter a forma de onda.

Você pode simular diferentes formas de onda, movendo o controle
deslizante Waveform e executando o VI novamente.
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Diagrama de bloco
7. Exiba e examine o diagrama de bloco a seguir.

O VI Initialize inicializa o dispositivo e o VI Application Example
envia comandos para configurar e solicitar informações do instrumento.
O VI Close encerra a comunicação. Todos os VIs que utilizam drivers
de instrumento implementam essa estrutura de inicialização,
comunicação e encerramento.

8. Feche o VI. Não salve nenhuma alteração.

Final do exercício 9-2
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D. Utilizando VIs de drivers de instrumento
No Exercício 9-2, o diagrama de bloco do VI NI DEVSIM Getting Started
continha VIs gerais para o simulador, que são montados no LabVIEW e
organizados em categorias por funções de instrumento.

Componentes de um driver de instrumento
Todos os drivers de instrumento da biblioteca possuem a mesma hierarquia
básica de VI. A hierarquia, a seqüência de VIs e o tratamento de erro são
iguais àqueles utilizados em outras áreas de I/O no LabVIEW, como I/O
de arquivos, DAQ, TCP/IP. Consulte a Seção C, Funções e VIs de File I/O,
da Lição 7, Strings e I/O (entrada/saída) de arquivo, para obter mais
informações sobre tratamento de erro.

A ilustração a seguir mostra a hierarquia de um driver de instrumento.

As funções de alto nível são montadas com base nas funções de baixo nível.
Para se ter uma maior controle do instrumento, utilize as funções de baixo
nível. No entanto, as funções de alto nível, como o VI Getting Started no
Exercício 9-2 são fáceis de utilizar e têm painéis frontais simples que se
assemelham ao instrumento. Os drivers de instrumento têm VIs nas
seguintes categorias:

• Initialize: inicializa o canal de comunicação com o instrumento. Esse
VI também pode executar uma consulta de identificação e uma operação
de reinicialização, e também pode executar qualquer ação necessária
para posicionar o instrumento em seu estado padrão de ativação ou em
outro estado especificado.

Getting Started

Initialize Application Example Close

Configuration Action/Status Data Utility
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• Configuration: configura o instrumento para executar operações, como
configurar a taxa de disparo.

• Action/Status: contém dois tipos de VIs. Os VIs de ação fazem com que
o instrumento inicie ou termine operações de teste e medição. Os VIs
de status obtêm o status atual do instrumento ou o status de operações
pendentes. Um exemplo de um VI de ação é Acquire Single Shot.
Um exemplo de VI de status é Query Transfer Pending.

• Data: transfere dados para o instrumento ou do instrumento, como
leituras de uma forma de onda medida a partir do instrumento ou
download de uma forma de onda para o instrumento.

• Utility: executa um ampla variedade de funções, como reinicialização,
autoteste, consulta de erros e consulta de revisões.

• Close: fecha o canal de comunicação com o instrumento e desaloca os
recursos para esse instrumento.

Todos os drivers de instrumento da National Instruments são requeridos
para a implementação das seguintes funções: inicializar, fechar,
reinicializar, autoteste, consulta de erro, consulta de revisão e mensagem
de erro.

Exemplos de aplicação
O LabVIEW também inclui VIs de exemplo de aplicação que mostram
como utilizar os VIs componentes para executar tarefas comuns.
Geralmente, isso inclui configuração, disparo e retorno de medições de um
instrumento. Um VI de exemplo de aplicação não inicializa nem fecha o
driver de instrumento. Esses VIs não foram projetados para serem um painel
frontal simples para o instrumento, mas sim para demonstrar alguns
recursos do driver de instrumento e orientar você no desenvolvimento
de seu próprio driver de instrumento.

Entradas e saídas de VIs de driver de instrumento
Assim como todos os drivers de instrumento compartilham uma hierarquia
comum de VIs, eles também compartilham entradas e saídas comuns.

Nome de recurso ou descritor de instrumento
Quando você inicializa o canal de comunicação com um instrumento, deve
saber o nome do recurso ou o descritor do instrumento. Um recurso é um
instrumento ou uma interface e o descritor do instrumento é o nome e a
localização exata de um recurso no seguinte formato:
Tipo de interface[índice da placa]::Endereço::INSTR

Por exemplo, GPIB::2::INSTR é o descritor de instrumento para um
instrumento GPIB com endereço 2.
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O controle de nome de recurso VISA, localizado na paleta Controls»I/O,
é semelhante ao controle de nome de canal DAQ, mas é especificamente
utilizado para controle de instrumento. Consulte a Seção E, VISA, para obter
mais informações sobre VISA.

Você pode utilizar o Measurement & Automation Explorer para determinar
quais recursos e endereços de instrumento estão disponíveis, como fez no
Exercício 9-1. Naquele exercício, você atribuiu um alias VISA devsim ao
NI Instrument Simulator. O alias torna a comunicação com o instrumento
mais fácil, pois você não precisa mais memorizar qual interface e endereço
cada instrumento utiliza. Você pode utilizar o alias do controle de nome
de recurso VISA, em vez do descritor de instrumento. Por exemplo, pode
digitar devsim, em vez de GPIB::2::INSTR.

Sessões VISA
Após a inicialização de um instrumento, a VI Initialize retorna um número
de sessão VISA. A sessão VISA é uma conexão ou enlace para um recurso,
como o instrumento. Você não precisa exibir esse valor. Entretanto, cada
vez que você se comunica com o dispositivo, precisa ligar a entrada da
sessão VISA nos VIs do driver de instrumento. Depois de encerrar
a comunicação com o instrumento, você pode utilizar o VI Close para
fechar todas as referências ou recursos do instrumento.

Exemplo de aplicação de driver de instrumento
O diagrama de bloco a seguir inicializa o instrumento com o alias devsim,
utiliza um VI de configuração para selecionar uma forma de onda, utiliza
dois VIs de dados para ler a forma de onda e as informações de escala
da forma de onda, fecha o instrumento e verifica o status de erro. Toda
aplicação que utiliza um driver de instrumento possui uma seqüência de
eventos similar.



Lição 9 Controle de instrumento

© National Instruments Corporation 9-15 Manual de treinamento do LabVIEW Básico I

Exercise 9-3 VI Voltage Monitor
Objetivo: Montar um VI que utilize os VIs de driver de instrumento DevSim

para obter e plotar tensões.

Complete os passos a seguir para montar um VI que adquira uma medição
de tensão DC do NI Instrument Simulator uma vez a cada segundo e que
plote os valores em um diagrama de forma de onda até você clicar em um
botão. À medida que cada valor é adquirido, o VI compara-o com os valores
máximo e mínimo anteriores. O VI calcula e exibe os valores máximo e
mínimo continuamente no painel frontal.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

a. Selecione um controle de nome de recurso VISA, localizado na
paleta Controls»I/O.

b. Defina a escala do eixo x do diagrama de forma de onda para exibir
valores incrementais.
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Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

a. Selecione um While Loop, localizado na paleta Functions»
Structures, para continuar a obter medições de tensão DC até
que você clique no botão STOP.

b. Crie dois registradores de deslocamento, clicando com o botão
direito na borda esquerda ou direita do loop e selecionando Add
Shift Register no menu de atalho.

c. Selecione o VI NI DEVSIM Initialize, localizado na paleta
Functions»Instrument I/O»Instrument Drivers»NI Device
Simulator. Esse VI abre a comunicação entre o LabVIEW e
o NI Instrument Simulator.

d. Clique com o botão direito no terminal de entrada ID Query e
selecione Create»Constant no menu de atalho. Utilize a ferramenta
Operating a fim de alterá-lo para um valor FALSE. Também ligue
a constante Booleana ao terminal de entrada Reset.

e. Selecione o VI NI DEVSIM Multimeter Configuration, localizado
na paleta Functions»Instrument I/O»Instrument Drivers»
NI Device Simulator»Configuration. Esse VI configura a faixa de
medições de tensão que o NI Instrument Simulator gera. O padrão
é 0.0 a 10.0 VDC.

f. Selecione o VI NI DEVSIM Measure DC Voltage, localizado
na paleta Functions»Instrument I/O»Instrument Drivers»
NI Device Simulator»Data. Esse VI retorna uma medição
simulada de tensão do NI Instrument Simulator.
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g. Selecione o VI NI DEVSIM Close, localizado na paleta Functions»
Instrument I/O»Instrument Drivers»NI Device Simulator. Esse
VI encerra a comunicação entre o LabVIEW e o NI Instrument
Simulator.

h. Selecione a função Wait Until Next ms Multiple, localizada na
paleta Functions»Time & Dialog. Essa função faz com que o While
Loop seja executado a cada segundo.

i. Selecione a função Max & Min, localizada na paleta Functions»
Comparison. Utilize duas dessas funções para verificar a tensão
atual em relação ao valores máximo e mínimo armazenados nos
registradores de deslocamento.

j. Selecione o VI Simple Error Handler, localizado na paleta
Functions»Time & Dialog. Esse VI exibirá uma caixa de diálogo
se ocorrer um erro e exibirá as informações de erro.

k. Selecione a função Unbundle by Name, localizada na paleta
Functions»Cluster. Essa função remove status do cluster de erro.

l. Selecione a função Or, localizada na paleta Functions»Boolean.
Essa função controla quando o While Loop termina. Se houver um
erro ou você clicar no botão STOP, o While Loop será interrompido.

Nota Você não precisa ligar todos os terminais de cada nó. Ligue apenas as entradas
necessárias para cada nó, como o descritor de instrumento, a sessão VISA e a I/O de erro.

3. Salve o VI como Voltage Monitor.vi.

4. Verifique se o NI Instrument Simulator está ligado.

5. Execute o VI. Os LEDs alternam entre Listen e Talk, à medida que o
LabVIEW se comunica com o instrumento GPIB a cada segundo para
obter a leitura simulada de tensão. Essa tensão é exibida no diagrama
e os valores máximo e mínimo são atualizados de acordo com a tensão
obtida.

6. Pare e feche o VI.

Final do exercício 9-3
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E. VISA
Arquitetura de software de instrumento virtual (VISA - Virtual Instrument
Software Architecture) é a camada mais inferior de funções nos VIs de
driver de intrumento do LabVIEW que se comunica com o software do
driver.

Visão geral
Em 1993, a National Instruments associou-se a GenRad, Racal Instruments,
Tektronix e Wavetek para formar a VXIplug&play Systems Alliance
(Aliança de Sistemas VXI Plug & Play). Os objetivos da aliança eram
assegurar a interoperabilidade entre os diversos fornecedores para sistemas
VXI e reduzir o tempo de desenvolvimento de um sistema operacional.

A função principal desses objetos era desenvolver um novo padrão para
drivers de instrumento, painéis frontais simples e software de interface
de I/O. O termo VXIplug&play surgiu para indicar a conformidade de
hardware e software a esses padrões.

Dirigindo seus esforços à padronização do software, os membros do
VXIplug&play identificaram o seguinte conjunto de princípios de
orientação:

• Maximizar o desempenho e a facilidade de uso.

• Manter a compatibilidade a longo prazo com a base instalada.

• Manter arquiteturas abertas para vários fornecedores.

• Maximizar o recurso de multiplataformas.

• Maximizar a expansibilidade e a modularidade em estruturas de quadro.

• Maximizar a reutilização do software.

• Padronizar a utilização de elementos de software de sistema.

• Tratar drivers de instrumento como parte do instrumento.

• Acomodar padrões estabelecidos.

• Maximizar o suporte cooperativo de usuários.

VISA é a linguagem de software de I/O do VXIplug&play que é a base
para os esforços de padronização de software da VXIplug&play Systems
Alliance. A VISA por si só não fornece capacidade de programação de
instrumentos. É uma API de alto nível que é chamada em drivers de baixo
nível. Essa arquitetura pode controlar instrumentos VXI, GPIB, serial
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ou baseados em computador e faz as chamadas apropriadas de driver,
dependendo do tipo instrumento utilizado. Ao depurar problemas da VISA,
lembre-se de sua hierarquia. Um problema aparente da VISA pode ser um
problema de instalação com um dos drivers que a VISA chama.

No LabVIEW, a VISA é uma biblioteca única de funções que você utiliza
para se comunicar com instrumentos VXI, GPIB, serial ou baseados em
computador. Você não precisa utilizar paletas de I/O distintas para
programar um instrumento. Por exemplo, alguns instrumentos permitem
escolher o tipo de interface. Se o driver de instrumento do LabVIEW foi
gravado com as funções da paleta Functions»Instrument I/O»GPIB,
os VIs de driver de instrumento não funcionarão para instrumentos com
interface serial. A VISA resolve esse problema, fornecendo um conjunto
de funções simples que funcionam em qualquer tipo de interface. Por isso,
todos os drivers de instrumento do LabVIEW utilizam a VISA como
linguagem de I/O.

Terminologia de programação da VISA
As funções que você pode utilizar com um recurso são as operações.
O recurso também possui variáveis, ou atributos, que contêm informações
relacionadas ao recurso. A terminologia a seguir é similar àquela utilizada
para VIs de drivers de instrumento:

• Recurso: qualquer instrumento do sistema, incluindo portas seriais
e paralelas.

• Sessão: você deve abrir uma sessão VISA para que um recurso se
comunique com ela, similar a um canal de comunicação. Quando você
abre uma sessão para um recurso, o LabVIEW retorna um número de
sessão VISA, que é um refnum exclusivo para aquele instrumento.
Utilize o número de sessão em todas as funções VISA subseqüentes.

• Descritor de instrumento: o nome exato de um recurso. O descritor
especifica o tipo de interface (GPIB, VXI, ASRL), o endereço do
dispositivo (endereço lógico ou endereço primário) e o tipo de sessão
VISA (INSTR ou Event).
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O descritor de instrumento é similar a um número de telefone, o recurso
é similar à pessoa com quem você deseja falar e a sessão é similar à linha
telefônica. Cada chamada utiliza sua própria linha e o cruzamento dessas
linhas resulta em um erro. A tabela a seguir mostra a sintaxe apropriada para
o descritor de instrumento.

Você pode utilizar um alias atribuído no Measurement & Automation
Explorer, em vez do descritor do instrumento. (Macintosh) Edite o arquivo
visaconf.ini para atribuir um alias VISA. (UNIX) Utilize o utilitário
visaconf.

Interface Sintaxe

Serial assíncrona ASRL[board][::INSTR]

GPIB GPIB[board]::primary address[::secondary 
address][::INSTR]

Instrumento VXI através de
controlador embutido ou MXIbus

VXI[board]::VXI logical address[::INSTR]

Controlador GPIB-VXI GPIB-VXI[board][::GPIB-VXI primary 
address]::VXI logical address[::INSTR]
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F. Utilizando VIs e funções VISA
As funções de VISA que você utiliza para se comunicar com um
instrumento GPIB na maioria das vezes são VISA Write e VISA Read.
A maioria dos instrumentos GPIB requer que você envie informações
na forma de um comando ou consulta, antes de poder ler as informações
retornadas do instrumento. Dessa forma, a função VISA Write geralmente
é seguida por uma função VISA Read.

A função VISA Write grava a string write buffer no dispositivo
especificado pelo VISA resource name. O dup VISA resource name
retorna o mesmo identificador para aquela sessão. Em plataformas UNIX,
os dados são gravados de maneira síncrona. Em todas as outras plataformas,
são gravados de forma assíncrona. return count contém o número de bytes
realmente tranferidos através do GPIB. Os clusters error in e error out
contêm as informações de erro.

A função VISA Read lê dados do dispositivo especificado pelo VISA
resource name. byte count indica o número de bytes a serem lidos na
string read buffer retornada. dup VISA resource name retorna o mesmo
identificador para aquela sessão. Em plataformas UNIX, os dados são lidos
de maneira síncrona. Em todas as outras plataformas, os dados são lidos
de forma assíncrona. return count contém o número de bytes realmente
transferidos através do GPIB. Os clusters error in e error out contêm as
informações de erro.

O exemplo anterior mostra como você pode fazer uma consulta de
identificação de um dispositivo utilizando as funções VISA. Observe
que o descritor completo de instrumento está especificado na constante
VISA resource name. Você também poderia ter utilizado o alias VISA.
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Exercise 9-4 VI Read VISA Waveform
Objetivo: Montar um VI que utilize as funções VISA para se comunicar

com uma interface GPIB.

Complete os passos a seguir para montar um VI que adquira uma forma
de onda do NI Instrument Simulator.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

a. Utilize a ferramenta Labeling para inserir os seguintes valores
para o controle “text ring” Waveform Type, localizado na paleta
Controls»Ring & Enum:
0 = Sino
1 = Square
2 = Noisy Sine
3 = Random
4 = Chirp

b. Digite a primeira entrada no controle “text ring”. Clique com o botão
direito no controle de anel, selecione Add Item After no menu de
atalho e digite a segunda entrada no controle.
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Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

a. Selecione uma constante de arranjo, localizada na paleta
Functions»Array. Essa constante monta a string de comando
para o NI Instrument Simulator. Cada um dos cinco tipos de
forma de onda é representado por um elemento nesse arranjo.

b. Selecione três constantes de string, localizadas na paleta Functions»
String. Selecione uma na constante de arranjo e redimensione a
constante para mostrar cinco elementos. Selecione as outras duas
constantes de string, como mostrado no diagrama de bloco anterior.

c. Selecione a função Index Array, localizada na paleta Functions»
Array. Essa função extrai o elemento de arranjo da string que
corresponde ao valor de Waveform Type.

d. Selecione a função Concatenate Strings, localizada na paleta
Functions»String. Essa função combina os fragmentos da string
em uma string de comando completa do NI Instrumento Simulator.

e. Selecione a função VISA Write, localizada na paleta Functions»
Instrument I/O»VISA. Essa função grava a string de comando
no NI Instrument Simulator.

Nota Se você não tiver uma interface GPIB ou um NI Instrument Simulator, selecione
o VI (Demo) VISA Write, localizado na paleta Functions»User Libraries»Basics I
Course, para simular a gravação de um comando no instrumento.

f. Selecione a função VISA Read, localizada na paleta Functions»
Instrument I/O»VISA. Essa função lê a resposta do NI Instrument
Simulator.

Nota Se você não tiver uma interface GPIB ou um NI Instrument Simulator, selecione
o VI (Demo) VISA Read, localizado na paleta Functions»User Libraries»Basics I
Course para simular a leitura de uma string do instrumento.
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g. Selecione o VI Simple Error Handler, localizado na paleta
Functions»Time & Dialog. Esse VI exibirá uma caixa de diálogo
se ocorrer um erro e exibirá as informações de erro.

h. Selecione o VI Extract Numbers, localizado na paleta Functions»
User Libraries»Basics I Course. Esse VI converte a string
delimitada por vírgula que foi retornada do NI Instrument Simulator
em um arranjo de números que o VI plota no gráfico de forma
de onda.

3. Salve esse VI como Read VISA Waveform.vi.

4. Exiba o painel frontal, digite devsim ou GPIB::2::INSTR em
Instrument e execute o VI. O VI plota uma forma de onda proveniente
do NI Instrument Simulator que corresponde ao tipo de forma de onda
selecionado.

Nota Se as funções VISA retornarem um erro, a string de comando poderá não estar
formatada corretamente. Verifique com atenção a ortografia, a pontuação, os espaços e
a escrita com maiúsculas e minúsculas. Às vezes, um instrumento trava ou se perde se
uma string de comando errada é enviada. Reinicialize o instrumento, desligando e
ligando a chave Power.

5. Execute o VI algumas vezes, solicitando diferentes formas de onda a
cada vez, para verifiicar como a forma de onda é lida do NI Instrument
Simulator. Demoram alguns segundos para o instrumento processar as
informações e enviar a forma de onda para o computador.

6. Feche o VI.

Final do exercício 9-4
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G. Comunicação de porta serial
Comunicação serial é um meio comum de transmitir dados entre um
computador e um dispositivo periférico, como um instrumento programável
ou mesmo outro computador. A comunicação serial utiliza um transmissor
para enviar os dados, um bit de cada vez, em uma única linha de
comunicação até o receptor. Você pode utilizar esse método quando as
taxas de transferência de dados são baixas ou quando você necessita
transferir dados a uma longa distância. A comunicação serial é popular,
pois a maioria dos computadores possui uma ou mais portas seriais, de
forma que nenhum hardware adicional é necessário além de um cabo para
conectar o instrumento ao computador ou os dois computadores juntos.

A comunicação serial requer que você especifique os quatro seguintes
parâmetros: o baud rate (taxa de transmissão), o número de bits de dados que
codificam um caractere, o sentido do bit de paridade opcional e o número de
bits de parada. Cada caractere transmitido é empacotado em um quadro de
caracteres que consiste em um só bit de início, seguido pelos bits de dados,
o bit de paridade opcional e o bit ou os bits de parada. Um quadro típico de
caracteres que codifica a letra m é mostrado aqui.

Baud rate indica a velocidade que os dados estão se movendo entre
instrumentos que utilizam comunicação serial. RS-232 utiliza apenas dois
estados de tensão, chamados MARK e SPACE. Nesse tipo de esquema de
codificação de dois estados, o valor da taxa de transmissão é idêntico ao
número máximo de bits de informações, incluindo os bits de controle, que
são transmitidos por segundo.

1 Instrumento RS 232 2 Cabo RS-232 3 Porta Serial

76.6F

1

3

2

Idle

Space

Mark

Bit Time

Character Frame

Start
Bit

Data
Bits

Parity
Bit

Stop
Bits

Idle
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MARK é a tensão negativa e SPACE é a tensão positiva. A ilustração
anterior mostra como o sinal idealizado aparece em um osciloscópio.
A tabela real para RS-232 é:

Sinal > +3 V = 0

Sinal < –3 V = 1

O nível de sinal de saída geralmente oscila entre +12 V e –12 V. A área
inativa entre +3 V e –3 V foi projetada para absorver ruído de linha.

Um bit de início sinaliza o início de cada quadro de caractere. É a transição
da tensão negativa (MARK) para a positiva (SPACE). Sua duração, em
segundos, é recíproca ao baud rate. Se o instrumento estiver transmitindo a
uma taxa de 9600 bauds, a duração do bit de início e de cada bit subseqüente
será de cerca de 0,104 ms. O quadro de caracteres inteiro de 11 bits seria
transmitido em aproximadamente 1,146 ms.

Bits de dados são transmitidos invertidos e de trás para frente. Isto é, a lógica
invertida é utilizada e a ordem de transmissão é do bit menos significativo
(LSB—Least Significant Bit) para o bit mais significativo (MSB—Most
Significant Bit). Para interpretar os bits de dados em um quadro de
caracteres, você deve ler da direita para a esquerda e ler 1 para tensão
negativa e 0 para tensão positiva. Isso produz 1101101 (binário) ou 6D
(hexadecimal). Uma tabela de conversão ASCII mostra que esta é a letra m.

Um bit de paridade opcional vem após os bits de dados no quadro de
caracteres. O bit de paridade, se presente, também segue a lógica invertida,
1 para tensão negativa e 0 para tensão positiva. Esse bit é incluído como uma
maneira simples de tratamento de erro. Você especifica anteriormente se a
paridade da transmissão é par ou ímpar. Se a paridade escolhida for ímpar,
o transmissor definirá o bit de paridade de forma que estabeleça um número
ímpar de um entre os bits de dados e o bit de paridade. Essa transmissão
utiliza paridade ímpar. Existem cinco uns entre os bits de dados, que já é
um número ímpar. Dessa forma, o bit de paridade será definido como 0.

A última parte de um quadro de caracteres consiste em 1, 1.5 ou 2 bits
de parada. Esses bits são sempre representados por uma tensão negativa.
Se nenhum outro caractere for transmitido, a linha continua com a condição
negativa (MARK). A transmissão do próximo quadro de caracteres, se
houver, é precedido por um bit de início de tensão positiva (SPACE).
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Qual a velocidade que eu posso transmitir?
Conhecendo a estrutura do quadro de caracteres e a maneira com a qual o
baud rate se aplica à comunicação serial, você pode calcular a máxima taxa
de transmissão, em caracteres por segundo, para uma dada configuração de
comunicação. Esta taxa é apenas a taxa de transmissão dividida pelos bits
por quadro. No exemplo anterior, existe um total de 11 bits por quadro de
caracteres. Se a taxa de transmissão for definida a 9600 bauds, você terá
9600/11 = 872 caracteres por segundo. Note que essa é a taxa máxima de
transmissão de caracteres. O hardware em uma ou na outra extremidade do
enlace serial pode não ser capaz de atingir essas taxas, por qualquer razão.

Visão geral do hardware
Existem diversos padrões diferentes de comunicação de porta serial
recomendados, incluindo os seguintes tipos mais comuns.

RS-232
O RS-232 é um padrão desenvolvido pela Electronic Industries Association
(EIA) e outros parceiros interessados, que especifica a interface serial entre
equipamento do terminal de dados (DTE) e equipamento de comunicação
de dados (DCE). O padrão RS-232 inclui características de sinais elétricos
(níveis de tensão), características mecânicas de interface (conectores),
descrição funcional dos circuitos de troca (a função de cada sinal elétrico)
e algumas receitas para tipos comuns de conexões de terminal a modem.
A versão mais comumente encontrada desse padrão é chamada RS-232C.
Partes desse padrão foram adotadas (em diversos graus de fidelidade)
para utilização em comunicação serial entre computadores e impressoras,
modems e outros equipamentos. As portas seriais em PCs compatíveis com
o padrão IBM seguem o padrão RS-232.

RS-449, RS-422, RS-423
O RS-449, RS-422 e RS-423 são padrões adicionais de comunicação serial
EIA relacionados ao RS-232. O RS-449 foi lançado em 1975 e supunha-se
que ele superasse o RS-232, mas poucos fabricantes adotaram o novo
padrão. O RS-449 contém duas subespecificações chamadas RS-422 e
RS-423. Enquanto o RS-232 modula um sinal em relação a um fio-terra
comum, ou transmissão de um só ponto, o RS-422 modula dois sinais, sendo
um contra o outro, ou transmissão diferencial. O receptor RS-232C percebe
quando o sinal recebido é suficientemente negativo em relação ao terra para
ser 1 lógico, ao passo que o receptor RS-422 percebe qual linha é a mais
negativa. Isso torna o RS-422 mais imune ao ruído e à interferência e mais
versátil sobre longas distâncias. As portas seriais do Macintosh seguem o
padrão RS-422, que pode ser convertido para RS-423 através da ligação
adequada de um cabo externo. O RS-423 pode se comunicar com a maioria
dos dispositivos RS-232 em distâncias superiores a 15 m.
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Cabeamento RS-232
Os dispositivos que utilizam cabos seriais para comunicação são divididos
em duas categorias: DCE e DTE. DCE são dispositivos como modem,
adaptador TA, plotadora, entre outros, ao passo que DTE é um computador
ou um terminal. As portas seriais RS-232 são fornecidas em dois tamanhos,
o conector de 25 pinos de tipo D e o conector de 9 pinos de tipo D. Esses
dois conectores são machos na parte posterior do PC. Dessa forma, é
necessário ter um conector fêmea no dispositivo. A tabela seguinte mostra
as conexões de pinos para os conectores de tipo D de 9 e 25 pinos.

O conector DB de 9 pinos ocasionalmente é encontrado em equipamentos
de laboratório RS-232 menores. Ele é compacto, mas tem pinos suficientes
para o conjunto principal de pinos seriais (com um pino extra).

Nota Os números do conector DB de 9 pinos para transmissão e recepção (3 e 2) são
opostos àqueles utilizados no conector DB de 25 pinos (2 e 3). Tome cuidado com esta
diferença quando estiver determinando se um dispositivo é DTE ou DCE.

Função Sinal PINO DTE DCE

Dados TxD

RxD

3

2

Saída

Entrada

Entrada

Saída

Handshake RTS

CTS

DSR

DCD

DTR

7

8

6

1

4

Saída

Entrada

Entrada

Entrada

Saída

Entrada

Saída

Saída

Saída

Entrada

Comum Com 5 — —

Outro RI 9 Entrada Saída
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O conector DB de 25 pinos é o conector padrão RS-232, com pinos
suficientes para cobrir todos os sinais especificados no padrão. A tabela
a seguir mostra apenas o conjunto principal de pinos que são utilizados
na maioria das interfaces RS-232.

Resumo do software
Utilize os VIs e as funções disponíveis na paleta Functions»Instrument
I/O»Serial para comunicação de porta serial.

Você utilizou algumas das funções VISA nessa paleta para comunicação
GPIB. As funções VISA Write e VISA Read funcionam com qualquer tipo
de comunicação de instrumento e são iguais, independentemente de você
estar fazendo uma comunicação serial ou GPIB. Entretanto, como a
comunicação serial requer que você configure parâmetros extras, inicie
a comunicação de porta serial com o VI VISA Configure Serial Port.

O VI VISA Configure Serial Port inicializa a porta identificada por VISA
resource name para as definições especificadas. timeout define o valor de
tempo limite para a comunicação serial. baud rate, data bits, parity e flow
control indicam aqueles parâmetros específicos da porta serial. Os clusters
error in e error out mantêm as condições de erro para esse VI.

Função Sinal PINO DTE DCE

Dados TxD

RxD

2

3

Saída

Entrada

Entrada

Saída

Handshake RTS

CTS

DSR

DCD

DTR

4

5

6

8

20

Saída

Entrada

Entrada

Entrada

Saída

Entrada

Saída

Saída

Saída

Entrada

Comum Com 7 — —
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O exemplo anterior mostra como enviar o comando de consulta de
identificação *IDN? para o instrumento conectado à porta serial COM2.
O VI VISA Configure Serial Port abre a comunicação com a porta COM2 e
define-a como 9600 bauds, 8 bits de dados, paridade ímpar, um bit de parada
e handshake de software XON/XOFF. Em seguida, a função VISA Write
envia o comando. A função VISA Read relê até 200 bytes do buffer de
leitura e a condição de erro é verificada pelo VI Simple Error Handler.

Nota Os VIs e as funções disponíveis na paleta Functions»Instrument I/O»Serial
também são utilizadas para comunicação de porta paralela. Você especifica o nome
de recurso VISA como sendo uma das portas LPT. Por exemplo, você pode utilizar o
Measurement & Automation Explorer para determinar que LPT1 tenha um nome de
recurso VISA ASRL10::INSTR.
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Exercise 9-5 VI Serial Write & Read
Objetivo: Montar um VI que se comunique com um dispositivo RS-232.

Complete os passos a seguir para montar um VI que se comunique com
o NI Instrument Simulator. Para se comunica com qualquer dispositivo
externo através da porta serial, você deve saber exatamente como esse
dispositivo se conecta à porta serial, quais definições de porta serial são
suportadas e qual a formatação exata das strings de comando e resposta.

NI Instrument Simulator
1. Desligue o NI Instrument Simulator e configure-o para que se

comunique através da porta serial, definindo as seguintes chaves
na lateral da caixa.

Essas definições de chave configuram o instrumento como um
dispositivo serial com as seguintes características:

• Taxa de transmissão = 9600

• Bits de dados = 8

• Paridade = no parity

• Bits de parada = 1

• Parâmetros de controle de fluxo= hardware handshaking

Handshaking é um meio de controle de fluxo de dados. O handshaking
de software envolve a incorporação de caracteres de controle em dados
transmitidos. Por exemplo, o controle de fluxo XON/XOFF funciona
encapsulando uma mensagem transmitida entre dois caracteres de
controle, XON e XOFF. O handshaking de hardware utiliza tensões em
cabos físicos para controlar o fluxo de dados. As linhas RTS e CTS do
dispositivo RS-232 são freqüentemente utilizadas para essa finalidade.
A maioria dos equipamentos de laboratório utiliza handshaking de
hardware.

2. Verifique se o NI Instrument Simulator está conectado a uma porta
serial de seu computador através de um cabo serial. Anote o número
da porta.
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3. Ligue o NI Instrument Simulator. Os LEDs Power, Ready e Listen
estão acesos, indicando que o dispositivo está em modo de
comunicação serial.

Painel frontal
4. Abra um novo VI e monte o seguinte painel frontal.

Diagrama de bloco
5. Monte o seguinte diagrama de bloco.

a. Selecione o VI VISA Configure Serial Port, localizado na paleta
Functions»Instrument I/O»Serial. Esse VI inicializa a porta serial
com as mesmas definições que o NI Instrument Simulator.

b. Selecione a constante linefeed, localizada na paleta Functions»
String. O NI Instrument Simulator requer uma constante linefeed
como o caractere de fim de string.

c. Selecione a função Concatenate Strings, localizada na paleta
Functions»String. Essa função combina a string a ser gravada
na porta serial com a linefeed.

d. Selecione a função VISA Write localizada na paleta Functions»
Instrument I/O»Serial. Essa função grava a string de comando
no NI Instrument Simulator.
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Nota Se você não possuir uma porta serial ou um NI Instrument Simulator, selecione
o VI (Demo) VISA Write, localizado na paleta Functions»User Libraries»Basics I
Course, para simular a gravação de um comando no instrumento.

e. Selecione duas funções VISA Read, localizada na paleta
Functions»Instrument I/O»Serial. Essa função lê a resposta
do NI Instrument Simulator.

Nota Se você não possuir uma porta serial ou um NI Instrument Simulator, selecione
dois VIs (Demo) VISA Read, localizados na paleta Functions»User Libraries»Basics I
Course para simular a leitura de uma string do instrumento.

f. Selecione a função Scan From String, localizada na paleta
Functions»String. O NI Instrument Simulator primeiro envia sete
caracteres que indicam o tamanho do pacote de dados a ser enviado.
Essa função converte os primeiros sete caracteres em um número
para utilizar como contagem de byte da segunda função VISA Read.

g. Selecione o VI Simple Error Handler, localizado na paleta
Functions»Time & Dialog. Esse VI exibirá uma caixa de
diálogo se ocorrer um erro e exibirá as informações de erro.

6. Salve o VI como Serial Read & Write.vi.

7. Exiba o painel frontal, digite ASRL1::INSTR em VISA Resource
Name e digite *IDN? em String to Write.

8. Execute o VI. O NI Instrument Simulator retorna suas informações
de identificação em String Read.

9. Envie outros comandos ao NI Instrument Simulator, como os seguintes:

Nota Pode demorar alguns segundos para o simulador gerar os dados de forma de onda.

10. Feche o VI.

Final do exercício 9-5

MEAS: DC? Retorna uma leitura de tensão

SOUR:FUNC SIN; SENS:DATA? Saída de forma de onda
senoidal

SOUR:FUNC SQU; SENS:DATA? Saída de forma de onda
quadrada

SOUR:FUNC RAND; SENS:DATA? Saída de forma de onda de
ruído aleatório

SOUR:FUNC PCH; SENS:DATA? Saída de forma de onda de
pulso (chirp)
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H. Transferências de forma de onda (opcional)
Diversos instrumentos retornam uma forma de onda como uma string
binária ou ASCII. Assumindo-se a mesma forma de onda, a transferência
de uma string binária é mais rápida e requer menos memória do que a
transferência de uma string ASCII. Codificação binária requer menos
bytes do que codificação ASCII.

Formas de onda em ASCII
Como um exemplo, considere uma forma de onda composta por
1.024 pontos, cada ponto tendo um valor entre 0 e 255. Utilizando
codificação ASCII, você necessitará de no máximo 4 bytes para representar
cada ponto (no máximo 3 bytes para o valor do ponto e 1 byte para o
separador, como uma vírgula). Você necessitará de no máximo 4.096
(4 * 1.024) bytes mais todos os bytes de cabeçalho e rodapé para representar
a forma de onda como uma string ASCII. O exemplo a seguir é uma string
de forma de onda ASCII.

Você pode utilizar o VI Extract Numbers, localizado na paleta Functions»
User Libraries»Basics I Course para converter uma forma de onda ASCII
em um arranjo numérico, conforme indicado.

Formas de onda binárias codificadas como inteiros de 1 byte
A mesma forma de onda que utiliza codificação binária requer apenas
1.024 bytes (1 * 1.024) mais todos os bytes de cabeçalho e rodapé para
representar uma string binária. Utilizando codificação binária, você
necessita de apenas 1 byte para representar o ponto, assumindo que cada
ponto é um inteiro de 8-bits sem sinal. O exemplo a seguir é uma string
de forma de onda binária.

Header
(6 bytes)

Data Point (up to 4 bytes each) Trailer
(2 bytes)

CURVE {12,28,63,...1024 points in total...,}CR L

Numeric
Array

ASCII Waveform
String

Extract Numbers.vi
Waveform

Header
(7 bytes)

Data Point
(1 byte each)

Trailer
(3 bytes)

CURVE % {MSB}{LSB} {ÅÅ¤å...1024 bytes in total...} {Chk} CR

Count
(4 bytes)
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A conversão da string binária em um arranjo numérico é um pouco mais
complexa. Você deve converter a string em um arranjo de inteiros. Você
pode fazer isso utilizando a função String To Byte Array, localizada na
paleta Functions»String»String/Array/Path Conversion. Você deve
remover todas as informações de cabeçalho e rodapé da string antes de a
converter em um arranjo. Do contrário, essas informações também serão
convertidas.

Formas de onda binárias codificadas como inteiros de 2 byte
Se cada ponto na string de forma de onda binária for codificado como um
inteiro de 2-bytes, será muito mais fácil e rápido utilizar a função Type Cast,
localizada na paleta Functions»Advanced»Data Manipulation. Consulte
o Manual de treinamento do LabVIEW Básico II para obter mais
informações sobre conversão de tipos.

Por exemplo, considere um osciloscópio GPIB que transfere dados de forma
de onda em notação binária. A forma de onda é composta por 1.024 pontos
de dados. Cada ponto de dados é um inteiro de 2-bytes com sinal.
Conseqüentemente, a forma de onda inteira é composta por 2.048 bytes.
No exemplo a seguir, a forma de onda possui um cabeçalho de 4-bytes,
DATA, e um rodapé de 2-bytes—um retorno de carro seguido por uma
mudança de linha.

Numeric Array

Binary Waveform
String (without
header or trailer)

String Waveform

4-byte header 2-byte trailer (carriage return) (line feed)

2 bytes representing the first data point

Memory

DATA«HB1»«LB1» «HB2»«LB2»...«HB1024»«LB1024»«CR»«LF»

from instrument

«LF»«CR»«LB1024»«HB1024»...«LB2»«HB2»«LB1»«HB1»ATAD
GPIB

0
2
4
6

A
A

LB1
LB2

D
T

HB1
HB2

2050
2052

LB1024

LF

HB1024

CR
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O diagrama de bloco a seguir mostra como utilizar a função Type Cast para
converter a string de forma de onda binária em um arranjo de inteiros de
16 bits.

Você pode precisar utilizar a função Swap Bytes, localizada na paleta
Functions»Advanced»Data Manipulation, para trocar os 8 bits mais
significativos e os 8 bits menos significativos para todos os elementos.
Lembre-se, o GPIB é um barramento de 8 bits, podendo transferir somente
um byte de cada vez. Se o instrumento enviar primeiro o byte menos
significativo e depois o byte mais significativo, você não precisará utilizar
a função Swap Bytes.

No exemplo anterior, você precisou utilizar a função Swap Bytes porque
o instrumento enviou primeiro o byte mais significativo. Como o byte mais
significativo é recebido primeiro, ele é colocado em um local de memória
mais inferior do que o byte menos significativo, enviado depois do byte
mais significativo.

Memory

0
2
4
6

A
A

LB1
LB2

D
T

HB1
HB2

2050
2052

LB1024

LF

HB1024

CR

Memory

0
2
4
6

D
T

HB1
HB2

A
A

LB1
LB2

2050
2052

HB1024

CR

LB1024

LF
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Exercise 9-6 VI Waveform Example (opcional)
Objetivo: Traçar um gráfico de forma de onda que um instrumento, como um osciloscópio

digital, retorna como uma string binária ou ASCII.

Para a string de forma de onda ASCI, a forma de onda consiste
em 128 pontos. Até quatro caracteres ASCII separados por vírgulas
representam cada ponto. O seguinte cabeçalho precede os pontos de dados:
CURVE {12,28,63,...128 points in total...,}CR LF

Para a string de forma de onda binária, a forma de onda consiste em
128 pontos. Cada ponto é representado por um inteiro de 1 byte sem
sinal. O seguinte cabeçalho precede os pontos de dados:
CURVE % {Bin Count MSB}{Bin Count LSB}{åå¤Å...128 bytes in 
total...} {Checksum} CR LF

Complete os passos a seguir para examinar o VI que converte a forma de
onda em um arranjo de números. O VI traça o gráfico do arranjo e lê a string
de forma de onda do NI Instrument Simulator ou de um arranjo armazenado
anteriormente.

NI Instrument Simulator
1. Desligue o NI Instrument Simulator e configure-o para se comunicar

através da interface GPIB, definindo as seguintes chaves na lateral
da caixa.

Essas definições de chave configuram o instrumento como um
dispositivo GPIB com endereço 2.

2. Ligue o NI Instrument Simulator. Apenas os LEDs Power e Ready estão
acesos, indicando que o NI Instrument Simulator está em modo de
comunicação GPIB.
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Painel frontal
3. Abra o VI Waveform Example. O seguinte painel frontal já estará

montado.

Waveform String exibe a string de forma de onda. # of bytes em string
exibe o tamanho da string de forma de onda. Data Format especifica
uma forma de onda ASCII ou binária. Data Source especifica se
os dados são simulados ou lidos do NI Instrument Simulator através
do GPIB.

Diagrama de bloco
4. Examine o seguinte diagrama de bloco.
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• A função String Subset, localizada na paleta Functions»String
retorna uma substring de 128 elementos que inicia no quinto byte
da string de forma de onda binária, excluindo os bytes de cabeçalho
e rodapé.

• A função String to Byte Array, localizada na paleta Functions»
String»String/Array/Path Conversion, converte a string binária
em um arranjo de inteiros sem sinal.

• A função String Length, localizada na paleta Functions»String,
retorna o número de caracteres na string de forma de onda.

• O VI Extract Numbers, localizado na paleta Functions»User
Libraries»Basics I Course, extrai números da string de forma de
onda ASCII e os coloca em um arranjo. Caracteres não numéricos,
como vírgulas, separam os números na string.

• Os VIs VISA Write e VISA Read, localizados na paleta Functions»
Instrument I/O»VISA, consultam o NI Instrument Simulator para
obter uma onda quadrada em formato ASCII ou binário de 1 byte.

• O VI Simple Error Handler, localizado na paleta Functions»
Time & Dialog relata todos os erros.

5. Exiba o painel frontal e execute o VI.

A condição TRUE adquire e converte a string de forma de onda binária
em um arranjo numérico. A condição FALSE adquire e converte a string
de forma de onda ASCII em um arranjo numérico.

6. Defina Data Format como ASCII e execute o VI. A string de forma de
onda ASCII é exibida, o VI converte os valores em um arranjo numérico
e exibe o tamanho da string e o arranjo numérico.

7. Defina Data Format como Binary e execute o VI novamente. A string
de forma de onda binária e o tamanho da string são exibidos, o VI
converte a string em um arranjo numérico e exibe-a no gráfico.

Nota A forma de onda binária é similar à forma de onda ASCII. Entretanto, o número
de bytes na string é menos significativo. Ele é mais eficiente para transferir formas de
onda como strings binárias do que como strings ASCII, porque a codificação binária
requer menos bytes para transferir as mesmas informações.

8. Feche o VI. Não salve nenhuma alteração.

Final do exercício 9-6
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Exercise 9-7 VI Binary Waveform (opcional)
Objetivo: Ler uma string de forma de onda binária de 2-bytes de um instrumento GPIB e plotar

os dados em um gráfico.

Adquira uma forma de onda de um osciloscópio de digitalização GPIB.
O osciloscópio envia os dados de forma de onda em formato binário.
A forma de onda é composta por 128 pontos de dados. Cada ponto de dados
é um inteiro de 2-bytes com sinal (I16). Portanto, a forma de onda completa
é composta por 256 bytes, excluindo os bytes de cabeçalho e rodapé.
A forma de onda tem um cabeçalho de 5 bytes e um rodapé de 1 byte,
um caractere de mudança de linha, como mostrado no exemplo a seguir.

Monte um VI que adquira uma string de forma de onda binária do
NI Instrument Simulator, converta os dados em um arranjo de números
de 16 bits plote o arranjo em um gráfico.

Você pode configurar o NI Instrument Simulator para retornar dados
de forma de onda codificados como inteiros de 2 bytes, enviando
primeiramente o comando FORM:DATA INT, 16: e consultando a forma
de onda no simulador, enviando o comando SENS:DATA?. A forma de onda
contém um cabeçalho de 5 bytes e um rodapé de 1 byte, como mostrado no
exemplo anterior.

Salve o VI como Binary Waveform.vi.

Final do exercício 9-7

5-byte header 1-byte terminating character (line feed)

2 bytes representing the first data point

#3256<MSB 0><LSB 0><MSB 1><LSB 1>...<MSB 127><LSB 127><LF>
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Resumo, dicas e suplementos

• O LabVIEW pode se comunicar com um instrumento que esteja
conectado ao seu computador, contanto que você saiba que tipo de
interface está sendo utilizado e que tipo de cabeamento é necessário.

• Utilize o Measurement & Automation Explorer para configurar e testar
as placas de interface GPIB, conectadas a instrumentos, portas seriais
e portas paralelas.

• Os drivers de instrumento do LabVIEW descartam a necessidade de se
aprender os complexos comandos de programação de baixo nível de
cada instrumento.

• A biblioteca de drivers de instrumento do LabVIEW está localizada no
CD do LabVIEW. Você também pode fazer o download dos drivers a
partir do site da National Instruments na Web, em ni.com.

• Todos os drivers de instrumento da biblioteca possuem a mesma
hierarquia básica de VI.

• As funções VISA são utilizadas para a interface de I/O controlar
instrumentos VXI, GPIB, RS-232 e outros tipos de instrumentos.

• Comunicação serial é um meio comum de transmitir dados entre
um computador e um dispositivo periférico, como um instrumento
programável ou mesmo outro computador. A biblioteca serial do
LabVIEW contém funções utilizadas para operações de porta serial.

• Os instrumentos podem transferir dados em diversos formatos
diferentes. Dados ASCII podem ser lidos facilmente, ao passo que os
dados binários são mais compactos e podem estar em qualquer formato.
O LabVIEW contém diversos VIs e funções para converter dados de
forma de onda em um formato mais utilizável.
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Exercícios adicionais
9-8 Utilize o VI NI DEVSIM Getting Started, como você fez no

Exercício 9-2, para testar e examinar o driver de instrumento NI
Instrument Simulator à medida que ele se comunica em modo serial.

9-9 Abra o VI Voltage Monitor, que você montou no Exercício 9-3.
Modifique o diagrama de bloco, de forma que os dados sejam
gravados em um arquivo de planilha voltage.txt no seguinte
formato.

Salve o VI como Voltage Data to File.vi.
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Anotações
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Anotações



© National Instruments Corporation 10-1 Manual de treinamento do LabVIEW Básico I

Lição 10
Personalizando VIs

Esta lição descreve como configurar a aparência e o comportamento de VIs
e o ambiente LabVIEW.

Você aprenderá:

A. Como configurar a aparência do painel frontal

B. Como exibir painéis frontais de subVIs quando um VI é executado

C. Como utilizar e atribuir atalhos de teclado

D. Como editar VIs com propriedades de VIs personalizadas

E. Como personalizar exibições de paletas
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A. Configurando a aparência de painéis frontais
Após a montagem de um VI, você pode configurar a aparência do painel
frontal, de forma que os usuários possam operar o VI com mais facilidade.
Por exemplo, você pode ocultar a barra de menus e a barra de ferramentas
para remover opções que são desnecessárias durante a execução do VI.

Selecione File»VI Properties para configurar a aparência e o
comportamento de um VI. Você também pode clicar com o botão direito
no ícone localizado no canto superior direito do painel frontal e selecionar
VI Properties no menu de atalho. A caixa de diálogo VI Properties não
pode ser acessada enquanto o VI estiver sendo executado. Consulte o
Manual de treinamento do LabVIEW Básico II para obter mais informações
sobre configuração do comportamento de VIs.

Utilize o menu Category na barra de ferramentas, localizado na parte
superior da caixa de diálogo, para selecionar entre várias categorias
diferentes de opções, incluindo:

• General: exibe o caminho atual em que um VI está salvo, seu número
e histórico de revisão e todas as alterações feitas desde a última vez
que o VI foi salvo. Você também pode utilizar esta página para editar
um ícone.

• Documentation: utilize esta página para adicionar uma descrição do VI
e vincular um tópico do arquivo de ajuda. Consulte o Exercício 3-2 para
obter mais informações sobre documentação de VIs.

• Security: utilize esta página para bloquear o VI ou protegê-lo com
senha.

• Window Appearance: utilize esta página para configurar várias
definições de janela.

• Window Size: utilize esta página para definir o tamanho da janela.

• Execution: utilize esta página para configurar como um VI é executado.

Aparência da janela
Na caixa de diálogo VI Properties, selecione Window Appearance
no menu Category na barra de ferramentas para configurar as diversas
definições de janela para o VI durante sua execução.

Como padrão, o título da janela do VI é o mesmo que o nome do VI. Você
pode personalizar o título da janela para torná-lo mais descritivo que o nome
de arquivo do VI. Isso é útil para VIs localizados, pois o título de sua janela
pode ser traduzido para o idioma local. Para alterar o título da janela do VI,
desmarque a caixa de seleção Same as VI Name e digite um título para o
VI na caixa de texto Window Title.
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Para configurar a aparência da janela, selecione um dos estilos de janela a
seguir. Uma representação gráfica de cada estilo é exibida à direita, quando
você seleciona o estilo.

• Top-level Application Window: exibe a barra de título e a barra de
menus, oculta as barras de rolagem e a barra de ferramentas, permite
que o usuário feche a janela, permite menus de atalho em tempo de
execução, não permite redimensionamento e exibe o painel frontal
quando chamado.

• Dialog: o VI funciona como uma caixa de diálogo no sistema
operacional, de forma que o usuário não pode interagir com outras
janelas do LabVIEW enquanto a janela do VI está aberta. Essa opção
não impede que você ative janelas de outras aplicações na janela do VI.
(UNIX) Você não pode fazer com que uma janela fique na frente de todas
as outras janelas.

As janelas com estilo de caixa de diálogo ficam em primeiro plano, não
possuem barra de menus, barras de rolagem nem barra de ferramentas,
permitem que o usuário feche a janela, mas não que a redimensione,
permite menus de atalho em tempo de execução e exibem o painel
frontal quando chamado. Além disso, se um parâmetro Booleano
do painel frontal estiver associado à tecla <Enter> ou <Return>,
o LabVIEW destacará o parâmetro com uma borda escura.

• Default: o mesmo estilo de janela utilizado no ambiente de
desenvolvimento do LabVIEW.

• Custom: clique no botão Customize para definir um estilo de janela
personalizado.
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Tamanho de janela
Na caixa de diálogo VI Properties, selecione Window Size no menu
Category na barra de ferramentas para configurar o tamanho da janela e
dos objetos do painel frontal. Esta página inclui os seguintes componentes:

• Minimum Panel Size: define o tamanho mínimo do painel frontal.
Se você permitir que o usuário redimensione a janela nas opções do
menu Window Appearance na barra de ferramentas, ele não poderá
redimensionar o painel frontal menor que a largura e a altura definidas
nesta página.

• Size the Front Panel to the Width and Height of the Entire Screen:
redimensiona automaticamente a janela do painel frontal para que ela
se ajuste à tela quando você executar o VI. O VI não retém um registro
de seu tamanho original e de sua localização. Dessa forma, o VI
permanecerá no novo local se você voltar ao modo de edição.

• Maintain Proportions of Window for Different Monitor
Resolutions: redimensiona a janela do painel frontal para que ocupe
aproximadamente a mesma quantidade de espaço de tela que quando
for executada em um computador com resolução de monitor diferente.
Por exemplo, se você desenvolver um VI em um computador com uma
resolução de monitor de 1024 × 768, poderá desejar executar o VI em
um computador com uma resolução de monitor de 800 × 600.

• Scale All Objects on Panel as the Window Resizes: redimensiona
automaticamente todos os objetos do painel frontal com relação ao
tamanho da janela do painel frontal e em proporção a ele. Texto não
é redimensionado, pois os tamanhos de fonte são fixos. Utilize essa
opção quando você permitir que o usuário redimensione a janela do
painel frontal.



Lição 10 Personalizando VIs

© National Instruments Corporation 10-5 Manual de treinamento do LabVIEW Básico I

B. Abrindo painéis frontais de subVIs durante a execução de um VI
Às vezes, um painel frontal simples é muito restritivo para apresentar
numerosas opções ou exibições. Para resolver esse problema, organize os
VIs de maneira que o VI mais elevado apresente opções de alto nível e que
os subVIs apresentem opções relacionadas.

Tip Você também pode utilizar controles de guia para tornar o painel frontal mais
organizado.

Quando o LabVIEW chama um subVI, geralmente o subVI é executado sem
que seu painel frontal seja aberto. Se você desejar que uma única ocorrência
do subVI abra seu painel frontal quando for chamado, utilize a caixa de
diálogo SubVI Node Setup. Se desejar que todas as ocorrências do subVI
abram seu painel frontal quando for chamado, utilize a caixa de diálogo
VI Properties.

Única ocorrência
Clique com o botão direito no subVI e selecione SubVI Node Setup no
menu de atalho para exibir a caixa de diálogo SubVI Node Setup. Marque
as caixas de seleção Show Front Panel when called e Close afterwards if
originally closed para abrir o painel frontal do subVI quando chamado.
Essa caixa de diálogo inclui também os seguintes componentes:

• Open Front Panel when loaded: exibe o painel frontal quando o subVI
é carregado ou quando o VI que o chama é carregado.

• Show Front Panel when called: exibe o painel frontal quando o subVI
é chamado.

• Close afterwards if originally closed: se a opção Show Front Panel
when called também contiver uma marca de verificação e se o subVI foi
fechado anteriormente, o painel frontal será fechado após a execução do
subVI.

• Suspend when called: suspende um subVI quando chamado e espera
pela interação do usuário. A seleção dessa opção é o mesmo que
selecionar Operate»Suspend when Called.

Todas as ocorrências
Abra o subVI e selecione File»VI Properties. Selecione Window
Appearance no menu Category na barra de ferramentas, clique no botão
Customize e marque as caixas de seleção Show Front Panel When Called
e Close Afterwards if Originally Closed.
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Exercise 10-1 VI Use Pop-Up Graph e VI Pop-Up Graph
Objetivo: Exibir o painel frontal de um subVI enquanto um VI é executado.

Complete os passos a seguir para montar um VI que atinja a temperatura
uma vez a cada 0,5 seg, durante 10 seg, exiba o painel frontal de um subVI
que mostra os dados obtidos em um gráfico e mantenha o painel frontal
aberto até que você clique em um botão.

Painel frontal
1. Abra um novo VI e monte o seguinte painel frontal.

a. Clique com o botão direito no termômetro e selecione Visible
Items»Digital Display no menu de atalho para exibir o valor digital.

b. Altere o campo # of data values para a representação I32.

Diagrama de bloco
2. Monte o seguinte diagrama de bloco.

a. Selecione um For Loop, localizado na paleta Functions»
Structures. O For Loop faz com que o VI repita 20 medições.

b. Selecione o VI Thermometer, que você montou no Exercício 3-2.
Esse VI atinge o valor atual de temperatura.

c. Selecione a função Wait Until Next ms Multiple, localizada na
paleta Functions»Time & Dialog. Essa função faz com que o
For Loop seja executado a cada 500 ms.
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d. Selecione a função Multiply, localizada na paleta Functions»
Numeric. Essa função multiplica cada elemento do arranjo de saída
por 0.5 com o intuito de escalonar os valores de x para representar
o intervalo de tempo em que o VI tira as medições.

e. Selecione o VI Pop-Up Graph, que já está montado. Esse VI plota os
dados de temperatura em um gráfico XY.

3. Salve o VI como Use Pop-Up Graph.vi.

4. Configure o subVI para exibir seu painel frontal quando for chamado.

a. Clique duas vezes no subVI Pop-Up Graph para abrir seu painel
frontal.

b. Selecione File»VI Properties.

c. Selecione Window Appearance no menu Category na barra
ferramentas.

d. Clique no botão Customize. Configure a aparência da janela,
como mostrado na caixa de diálogo a seguir.

e. Clique no botão OK duas vezes e salve e feche o subVI. Se o painel
frontal não estiver fechado, ele não será fechado após a execução do
subVI.

5. Execute o VI Use Pop-Up Graph.

Depois de o VI obter 10 seg de dados de temperatura, o painel frontal do
VI Pop-Up Graph exibirá e plotará os dados de temperatura. Clique no
botão DONE para retornar a chamada de VI.

6. Altere as definições de aparência da janela do subVI Pop-Up Graph para
o estilo de janela Dialog.

7. Salve e feche o subVI.
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8. Execute o VI Use Pop-Up Graph novamente. O painel frontal do subVI
Pop-Up Graph funciona como uma caixa de diálogo. Por exemplo, a
janela fica na frente de todas as outras janelas e utiliza a cor do sistema.

9. Feche todos os VIs abertos.

Final do exercício 10-1
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C. Atalhos de teclado para controles
Enquanto um VI é executado, você pode pressionar a tecla <Tab> para
alterar o foco chave de um controle para o próximo. O foco chave tem o
mesmo efeito que se você tivesse clicado no controle. Enquanto um controle
tiver o foco chave, você poderá utilizar o teclado para inserir o valor do
controle. Se o controle for um controle de texto ou digital, o LabVIEW
destacará o valor no controle quando o controle tiver o foco chave. Se um
controle Booleano tiver o foco chave, pressione a barra de espaço ou a tecla
<Enter> para alterar seu valor.

Você também pode atribuir atalhos de teclado a controles para que os
usuários possam navegar pelo painel frontal pressionando outras teclas.
Clique com o botão direito no controle e selecione Advanced»Key
Navigation no menu de atalho para exibir a caixa de diálogo Key
Navigation.

Nota O item do menu de atalho Advanced»Key Navigation fica apagado para
indicadores, pois não é possível inserir dados em um indicador.

Selecione a tecla de atalho a ser atribuída ao controle na seção Key
Assignment. Os nomes dos controles do painel frontal que aparecem
na caixa de lista Current Assignments correspondem aos títulos desses
controles.

Para evitar que os usuários acessem um controle pressionando a tecla <Tab>
durante a execução de um VI, marque a caixa de seleção Skip this control
when tabbing.
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Exercise 10-2 VI Temperature System
Objetivo: Definir atalhos de teclado para controles do painel frontal e exibir o painel frontal

de um subVI durante a execução de um VI.

Complete os passos a seguir para montar um sistema de monitoração
de temperatura que você possa utilizar para visualizar três testes diferentes
sob pedido.

Painel frontal
1. Abra o VI Temperature System. O seguinte painel frontal já estará

montado.

O painel frontal contém quatro botões Booleanos. A ação mecânica dos
três primeiros botões é Latch When Pressed e do botão STOP é Latch
When Released.

2. Clique com o botão direito em um controle e selecione Advanced»
Key Navigation no menu de atalho para exibir a caixa de diálogo
Key Navigation.

3. Na seção Key Assignment, atribua a tecla de atalho mostrada no painel
frontal anterior.

4. Repita os passos 2 e 3 para cada controle.

Diagrama de bloco
5. Monte o seguinte diagrama de bloco, deixando todas as condições

FALSE vazias.
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a. Selecione uma estrutura While Loop e três estruturas Case,
localizadas na paleta Functions»Structures.

b. Selecione o VI Display Temp, localizado na paleta Functions»
User Libraries»Basics I Course. Esse VI simula uma medição de
temperatura a cada 500 ms e plota-a em um Strip Chart.

c. Selecione o VI Display and Log Temp, localizado na paleta
Functions»User Libraries»Basics I Course. Esse VI simula uma
medição de temperatura a cada 500 ms, plota-a em um Strip Chart
e registra-a em um arquivo.

d. Selecione o VI Display Logged Temp, localizado na paleta
Functions»User Libraries»Basics I Course. Esse VI abre um
arquivo que você seleciona, lê os dados registrados e exibe-os
em um gráfico.

e. Selecione a função Wait Until Next ms Multiple, localizada na
paleta Functions»Time & Dialog. Essa função faz com que o
While Loop seja executado a cada 100 ms.

6. Clique duas vezes em cada ícone de subVI para abrir seu painel frontal,
examine o diagrama de bloco e feche o subVI.

7. Configure cada subVI para exibir seu painel frontal quando chamado.

a. Clique com o botão direito no subVI e selecione SubVI Node Setup
no menu de atalho.

b. Marque as caixas de seleção Show Front Panel when called
e Close afterwards if originally closed.

c. Repita os passos a e b para os dois subVIs restantes.

8. Salve o VI.

9. Exiba o painel frontal e execute o VI.

10. Clique em cada botão e pressione os atalhos de teclado correspondentes.

Nota Os três subVIs retornam ao painel frontal do VI Temperature System quando você
pressiona a tecla <Enter>. Tente pressionar a tecla <Enter> para fazer isso.

11. Pare o VI.

12. Configure o VI Temperature System para ser executado
automaticamente quando você abrir o VI.

a. Selecione File»VI Properties.

b. Selecione Execution no menu Category na barra de ferramentas.

c. Marque a caixa de seleção Run When Opened.
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13. Configure o VI, de forma que a barra de menus e a barra de ferramentas
não fiquem visíveis durante a execução do VI.

a. Selecione Window Appearance no menu Category na barra
ferramentas.

b. Clique no botão Customize.

c. Remova as marcas de verificação das caixas de seleção
Show Menu Bar e Show Toolbar When Running.

d. Clique no botão OK duas vezes.

14. Salve e feche todos os VIs.

15. Abra o VI Temperature System novamente. O VI é executado
automaticamente quando você o abre.

16. Clique nos botões do painel frontal ou utilize os atalhos de teclado.

17. Pare e feche todos os VIs.

Final do exercício 10-2
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D. Editando propriedades do VI (opcional)
Às vezes, você pode selecionar propriedades do VI que tornam difícil a sua
edição. Por exemplo, você pode selecionar a opção Run When Opened e
desabilitar a barra de menus e a barra de ferramentas. Se você definir para o
VI fechar e sair do LabVIEW após sua execução, não poderá interromper a
execução do VI e editá-lo sem que ele feche e saia do LabVIEW. Seria
muito difícil editar esse VI.

Nota Você pode utilizar a função Quit LabVIEW, localizada na paleta Functions»
Application Control, para sair do LabVIEW. Essa função cancela todos os VIs em
execução e finaliza a sessão atual do LabVIEW. A função tem uma entrada e, se ela
estiver ligada, a finalização da sessão do LabVIEW ocorrerá somente se essa entrada
for TRUE. Se a entrada não estiver ligada, a sessão será encerrada quando o nó for
executado.

Antes de alterar as propriedades do VI, faça uma cópia de backup do VI em
um novo local para evitar que ocorram situações como aquelas mencionadas
nos exemplos anteriores, selecionando File»Save with Options.

Selecione a opção Development Distribution para salvar o VI em um novo
local juntamente com toda a sua hierarquia. Você também pode incluir os
arquivos vi.lib nesse processo. Após o salvamento da cópia de backup do
VI, altere as propriedades do VI original. Se você encontrar um problema,
poderá retornar à cópia de backup do VI.

Nota Se você selecionar a opção Remove diagrams, removerá o código fonte do VI.
Selecione essa opção apenas se nunca mais for precisar editar o VI novamente. Antes de
salvar um VI sem o diagrama de bloco, faça uma cópia de backup do VI com o diagrama
de bloco.

Se você já salvou um VI de desenvolvimento com propriedades que
dificultam a edição do VI, consulte o Exercício 10-3 para obter mais
informações sobre edição do VI.
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Exercise 10-3 VI Edit Me (opcional)
Objetivo: Editar um VI com propriedades que dificultam sua edição.

Complete os passos a seguir para modificar um VI que esteja configurado
para ser executado quando estiver aberto e para sair do LabVIEW após sua
execução.

Painel frontal
1. Feche todos os VIs abertos e abra o VI Edit Me. O seguinte painel

frontal já estará montado.

O VI já está sendo executado ao ser aberto. Durante a execução do VI,
você não pode utilizar a barra de menus, a barra de ferramentas ou os
atalhos de teclado para editá-lo ou cancelá-lo.

2. Clique no botão Start. Após 10 segundos, o VI pára a execução e sai
do LabVIEW.

3. Reinicialize o LabVIEW e abra um novo VI.

4. Se o VI a ser editado não tiver subVIs ou você não souber o que ele
contém, complete os passos 5 a 13.

Entretanto, se o VI a ser editado tiver subVIs, abra um dos subVIs e
modifique o diagrama de bloco para interromper o subVI. Por exemplo,
selecione uma função Add no diagrama de bloco e não ligue as entradas.
Abra o VI a ser editado. Como seu subVI não é executável, o VI que o
chama também se torna não executável. Ele abre em modo de edição e
o botão Run aparece quebrado. Corrija o subVI depois de editar a
chamada de VI.

5. Exiba o diagrama de bloco do novo VI.

6. Selecione o VI Edit Me, que já está montado, no diagrama de bloco.
O painel frontal do VI Edit Me é exibido.

Apesar de você poder exibir o diagrama de bloco do VI Edit Me, não
o pode editar.

7. Selecione Operate»Change to Edit Mode. Uma caixa de diálogo
informa que o VI está bloqueado.
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8. Clique no botão Unlock. Agora você pode editar o VI. Você também
pode desbloquear o VI, selecionando File»VI Properties e Security
no menu Category na barra de ferramentas.

9. Selecione e exclua a função Quit LabVIEW do diagrama de bloco.

10. Salve e feche o VI Edit Me. Feche o novo VI e não salve nenhuma
alteração.

11. Abra o VI Edit Me novamente.

12. Após a execução do VI, tente editá-lo.

13. Feche o VI Edit Me.

Final do exercício 10-3
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E. Personalizando as paletas Controls e Functions (opcional)
Você pode personalizar as paletas Controls e Functions para adicionar VIs
e controles a elas, ocultar VIs e funções ou reorganizar as paletas internas
para tornar mais acessíveis os VIs e as funções utilizadas com mais
freqüência.

Adicionando VIs e controles às bibliotecas de usuários e de instrumentos
O método mais simples para adicionar VIs e controles às paletas Controls
e Functions é salvá-las no diretório user.lib. Quando você reinicia
o LabVIEW, as paletas Functions»User Libraries e Controls»User
Controls contêm subpaletas para cada diretório, biblioteca de VIs (.llb)
ou arquivo de menu (.mnu) em user.lib e ícones para cada arquivo
contido no diretório user.lib. O LabVIEW atualiza automaticamente
as paletas, à medida que você adiciona arquivos a diretórios específicos ou
remove arquivos deles. Por exemplo, a paleta Functions»User Libraries
contém a subpaleta Basics I Course para o arquivo lvbasics.llb no
diretório user.lib.

A paleta Functions»Instrument I/O corresponde ao diretório instr.lib.
Salve drivers de instrumento nesse diretório para facilitar o acesso a eles na
paleta Functions.

Quando você adiciona VIs ou controles às paletas Controls e Functions
utilizando este método, não é possível determinar a localização exata dos
VIs ou controles nas paletas.

Criando e editando exibições de paletas
Para controlar a localização exata dos VIs e controles adicionados às paletas
Controls e Functions, você deve criar uma exibição de paleta. O LabVIEW
inclui quatro exibições padrão de paleta: padrão, básica, aquisição de dados
e teste e medição. Para alterar para uma outra exibição de paleta, clique no
botão Options da barra de ferramentas das paletas Controls ou Functions
para exibir a caixa de diálogo Function Browser Options. Selecione uma
exibição no menu Palette Set na barra de ferramentas.

Você também pode alterar para uma exibição de paleta somente de ícone
ou de texto, selecionando no menu Format na barra de ferramentas.

Para editar uma exibição de paleta já existente, clique no botão Edit
Palettes. Na caixa de diálogo Edit Control and Function Palettes que
aparece, selecione uma exibição de paleta no menu Palette Set na barra
de ferramentas.
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Exclua, personalize ou insira objetos, clicando com o botão direito em uma
paleta ou em um objeto de uma subpaleta e selecionando uma opção no
menu de atalho. Você também pode reorganizar o conteúdo das paletas,
pressionado a tecla <Shift> enquanto arrasta objetos para novos locais.
Para adicionar uma nova linha ou coluna, clique com o botão direito no
espaço existente na borda direita ou na parte inferior da subpaleta.

O LabVIEW armazena informações das paletas Controls e Functions
no diretório labview\menus. Quando você cria uma nova exibição de
paleta, o LabVIEW copia a paleta original interna, localizada no diretório
labview\menus, antes que qualquer alteração seja feita. A proteção das
paletas internas assegura que você faça experiências com as paletas sem
danificar a exibição original. Consulte o LabVIEW User Manual para obter
mais informações sobre exibições de paletas.

Para inserir uma nova subpaleta vazia na paleta Controls ou Functions
ou para conectá-la a uma paleta já existente, clique com o botão direito na
paleta e selecione Insert»Submenu no menu de atalho. Na caixa de diálogo
Insert Submenu que aparece, as opções a seguir estão disponíveis. A
seleção de qualquer uma das três últimas opções também cria subpaletas de
forma recursiva para cada subdiretório, biblioteca de VIs ou arquivo.mnu
no diretório. Essas paletas serão atualizadas automaticamente se você
adicionar ou remover arquivos dos diretórios selecionados.

• Create a new menu file (.mnu): insere uma nova paleta vazia.
Quando for solicitado um nome para a paleta e um arquivo para
contê-la, adicione uma extensão .mnu ao arquivo para indicar que
ele é um menu ou uma paleta.

• Link to an existing menu file (.mnu): adiciona uma paleta já existente
(.mnu). Utilize essa opção para criar uma paleta com entradas para
todos os arquivos no diretório.

• Link to a library (.llb): conecta a bibliotecas de VIs.

• Link to a directory: cria uma paleta com entradas para todos os
arquivos de um diretório.
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Exercise 10-4 Exibições de paletas (opcional)
Objetivo: Criar uma nova exibição de paleta e editar a paleta Functions.

Complete os passos a seguir para criar uma nova exibição de paleta e
editar a paleta Functions com o intuito de incluir os VIs em exercises\
LV Basics I.

1. Abra um novo VI.

2. Exiba a paleta Controls ou Functions e clique no botão Options
da barra de ferramentas da paleta.

3. Clique no botão Edit Palettes para exibir a caixa de diálogo Edit
Controls and Functions Palettes.

4. Selecione new setup no menu Palette Set na barra de ferramentas.

5. Digite LabVIEW Course na caixa de diálogo que aparece e clique
no botão OK.

6. Clique com o botão direito na paleta Functions e selecione Insert»
Submenu no menu de atalho para exibir a caixa de diálogo Insert
Submenu.

7. Selecione Link to a directory e clique no botão OK. Uma caixa de
diálogo exibe o conteúdo do diretório de exibição LabVIEW Course.

8. Selecione o diretório a ser associado ao submenu ou à subpaleta,
exercises\LV Basics I. O LabVIEW cria uma subpaleta para
o conteúdo do diretório LV Basics I e utiliza um ícone padrão.

9. Clique na nova subpaleta LV Basics I.

10. Exclua os ícones em branco e reorganize os ícones cliclando com o
botão direito neles e selecionando opções no menu de atalho. Você
também pode pressionar a tecla <Shift> enquanto arrasta objetos para
reorganizá-los.

11. Clique no botão Save Changes da caixa de diálogo Edit Controls and
Functions Palettes.

12. Exiba o diagrama de bloco e selecione a paleta Functions»LV Basics I.

13. Clique no botão Options novamente e altere entre as exibições de
paletas, selecionando-as no menu Palette Set na barra de ferramentas.

14. Altere novamente para a exibição padrão.

Final do exercício 10-4
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Resumo, dicas e suplementos

• Selecione File»VI Properties para configurar a aparência e o
comportamento de um VI. Você também pode clicar com o botão
direito no ícone localizado no canto superior direito do painel frontal
e selecionar VI Properties no menu de atalho.

• Se você desejar que uma ocorrência única do subVI abra seu painel
frontal quando for chamado, clique com o botão direito no subVI e
selecione SubVI Node Setup no menu de atalho. Marque as caixas
de seleção Show Front Panel when called e Close afterwards if
originally closed.

• Se você desejar que todas as ocorrências do subVI abram seu painel
frontal quando for chamado, selecione File»VI Properties e Window
Appearance no menu Category na barra de ferramentas. Clique no
botão Customize e marque as caixas de seleção Show Front Panel
When Called e Close Afterwards if Originally Closed.

• Atribua atalhos de teclado aos controles, clicando com o botão
direito no controle e selecionando Advanced»Key Navigation no
menu de atalho.

• Antes de você alterar as propriedades do VI, faça uma cópia de backup
do VI em um novo local para evitar que a edição de um VI se torne
difícil, selecionando File»Save with Options.

• Para editar um VI com propriedades que dificultam sua edição:

– Interrompa um de seus subVIs. O VI é aberto em modo de edição,
pois ele não pode ser executado com um subVI com defeito.

– Se o VI não possuir subVIs, insira-o no diagrama de bloco de um
novo VI.

• O método mais simples para adicionar VIs e controles às paletas
Controls e Functions é salvá-las no diretório user.lib.

• Para alterar para uma outra exibição de paleta, clique no botão Options
da barra de ferramentas das paletas Controls ou Functions para exibir
a caixa de diálogo Function Browser Options. Selecione uma exibição
no menu Palette Set na barra de ferramentas.

• Altere para uma exibição de paleta somente de ícone ou de texto,
selecionando no menu Format na barra de ferramentas.

• Para inserir uma nova subpaleta vazia na paleta Controls ou Functions
ou para conectá-la a uma paleta já existente, clique com o botão direito
na paleta e selecione Insert»Submenu no menu de atalho.
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Anotações
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Apêndice

Este apêndice contém informações adicionais sobre o LabVIEW.

A. Informações adicionais
Esta seção descreve como você pode receber mais informações a respeito
do LabVIEW, de drivers de instrumentos e de outros tópicos relacionados
a este curso.

Opções de suporte técnico da National Instruments
A melhor maneira para se obter suporte técnico e outras informações sobre
o LabVIEW, teste e medição, instrumentação e outros produtos e serviços
da National Instruments é através do site da NI na Web, em ni.com.

A página de suporte do site da National Instruments na Web contém links
para notas sobre o aplicativo, base de conhecimento de suporte, centenas
de exemplos e assistentes de solução de problemas para todos os tópicos
discutidos neste curso e muito mais.

Um outro excelente local para se obter suporte durante o desenvolvimento
de diversas aplicações com produtos da National Instruments é a
NI Developer Zone, em ni.com/zone.

A NI Developer Zone também inclui links diretos para a rede de drivers
de instrumentos e as páginas da Web dos membros do Alliance Program.

O Alliance Program
O Alliance Program da National Instruments agrega integradores de
sistemas, consultores e fornecedores de hardware para fornecer um serviço
completo e especializado aos clientes. O programa assegura assistência
especializada e qualificada para o desenvolvimento de aplicações e
sistemas. Informações sobre os membros do Alliance Program e links
para muitos dos membros do Alliance Program estão disponíveis no site
da National Instruments na Web.
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User Support Newsgroups
Os User Support Newsgroups da National Instruments são um conjunto
de grupos de notícias da Usenet que abrangem produtos da National
Instruments, bem como campos gerais na área de ciência e engenharia.
Você pode ler, pesquisar e postar para os grupos de notícias com o intuito
de compartilhar soluções e localizar suporte adicional proveniente de outros
usuários. Você pode acessar o User Support Newsgroups na página de
suporte da National Instruments na Web.

Outros cursos de treinamento da National Instruments
A National Instruments oferece diversos cursos de treinamento para
usuários do LabVIEW. Os cursos estão listados no catálogo da National
Instruments e on-line em ni.com/custed. Esses cursos serão uma
continuidade do treinamento que você receberá com este manual e serão
expandidos a outras áreas. Você pode adquirir apenas os materiais do curso
ou inscrever-se para um curso prático orientado por instrutor, entrando em
contato com a National Instruments.

Publicações do LabVIEW
Boletim informativo LabVIEW Technical Resource (LTR)
Assine o boletim informativo LabVIEW Technical Resource para descobrir
poderosas dicas e técnicas de desenvolvimento de aplicações do LabVIEW.
Esta publicação trimestral oferece informações técnicas detalhadas para
usuários principiantes e avançados. Além disso, todas as edições contêm
um disco de VIs e utilitários do LabVIEW que implementam os métodos
abordados na edição. Para solicitar o LabVIEW Technical Resource,
ligue para a editora LTR, no telefone (214) 706-0587, ou visite o site
www.ltrpub.com.

Manuais do LabVIEW
Vários manuais foram escritos sobre aplicações e programação do
LabVIEW. O site da National Instruments na Web contém uma lista
de todos os manuais publicados e links para os locais onde os adquirir.
Também estão incluídas informações sobre a editora, de forma que você
pode entrar diretamente em contato com ela para obter mais informações
sobre o conteúdo, e também para obter informações sobre pedido do
LabVIEW e de manuais de automação e medição baseados em computador
relacionados.



Apêndice

© National Instruments Corporation A-3 Manual de treinamento do LabVIEW Básico I

O info-labview Listserve
Info-labview é um grupo de usuários de e-mail do mundo inteiro que
discutem questões inerentes ao LabVIEW. As pessoas desta lista podem
responder questões sobre montagem de sistemas LabVIEW para aplicações
específicas, onde obter drivers de instrumentos ou ajuda com um
dispositivos e problemas que possam surgir.

Envie mensagens de assinatura para o processador da lista
info-labview, em:
listmanager@pica.army.mil

Envie outras mensagens administrativas para o mantenedor da lista
info-labview, em:
info-labview-REQUEST@pica.army.mil

Envie uma mensagem aos assinantes, em:
info-labview@pica.army.mil

Você também pode desejar pesquisar arquivos em ftp em:
ftp://ftp.pica.army.mil/pub/labview/

Os arquivos contêm um grande conjunto de VIs doados para executar
um ampla variedade de tarefas.
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B. Tabela de códigos equivalentes de caracteres ASCII
A tabela a seguir contém os códigos hexadecimais, octais e decimais
equivalentes para códigos de caracteres ASCII.

Hexa-
decimal Octal Decimal ASCII

Hexa-
decimal Octal Decimal ASCII

00 000 0 NUL 20 040 32 SP

01 001 1 SOH 21 041 33 !

02 002 2 STX 22 042 34 "

03 003 3 ETX 23 043 35 #

04 004 4 EOT 24 044 36 $

05 005 5 ENQ 25 045 37 %

06 006 6 ACK 26 046 38 &

07 007 7 BEL 27 047 39 '

08 010 8 BS 28 050 40 (

09 011 9 HT 29 051 41 )

0A 012 10 LF 2A 052 42 *

0B 013 11 VT 2B 053 43 +

0C 014 12 FF 2C 054 44 ,

0D 015 13 CR 2D 055 45 –

0E 016 14 SO 2E 056 46 .

0F 017 15 SI 2F 057 47 /

10 020 16 DLE 30 060 48 0

11 021 17 DC1 31 061 49 1

12 022 18 DC2 32 062 50 2

13 023 19 DC3 33 063 51 3

14 024 20 DC4 34 064 52 4

15 025 21 NAK 35 065 53 5

16 026 22 SYN 36 066 54 6
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17 027 23 ETB 37 067 55 7

18 030 24 CAN 38 070 56 8

19 031 25 EM 39 071 57 9

1A 032 26 SUB 3A 072 58 :

1B 033 27 ESC 3B 073 59 ;

1C 034 28 FS 3C 074 60 <

1D 035 29 GS 3D 075 61 =

1E 036 30 RS 3E 076 62 >

1F 037 31 US 3F 077 63 ?

40 100 64 @ 60 140 96 `

41 101 65 A 61 141 97 a

42 102 66 B 62 142 98 b

43 103 67 C 63 143 99 c

44 104 68 D 64 144 100 d

45 105 69 E 65 145 101 e

46 106 70 F 66 146 102 f

47 107 71 G 67 147 103 g

48 110 72 H 68 150 104 h

49 111 73 I 69 151 105 i

4A 112 74 J 6A 152 106 j

4B 113 75 K 6B 153 107 k

4C 114 76 L 6C 154 108 l

4D 115 77 M 6D 155 109 m

4E 116 78 N 6E 156 110 n

4F 117 79 O 6F 157 111 o

50 120 80 P 70 160 112 p

Hexa-
decimal Octal Decimal ASCII

Hexa-
decimal Octal Decimal ASCII
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51 121 81 Q 71 161 113 q

52 122 82 R 72 162 114 r

53 123 83 S 73 163 115 s

54 124 84 T 74 164 116 t

55 125 85 U 75 165 117 u

56 126 86 V 76 166 118 v

57 127 87 W 77 167 119 w

58 130 88 X 78 170 120 x

59 131 89 Y 79 171 121 y

5A 132 90 Z 7A 172 122 z

5B 133 91 [ 7B 173 123 {

5C 134 92 \ 7C 174 124 |

5D 135 93 ] 7D 175 125 }

5E 136 94 ^ 7E 176 126 ~

5F 137 95 _ 7F 177 127 DEL

Hexa-
decimal Octal Decimal ASCII

Hexa-
decimal Octal Decimal ASCII
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C. Notas do instrutor

1. Verifique se cada estação contém os seguintes componentes:

• Manual de treinamento do LabVIEW Básico I

• LabVIEW Professional Development System 6.0 ou superior

• Dispositivo DAQ multifunção configurado como Board ID 1

• DAQ Signal Accessory e cabo para conexão do dispositivo DAQ
ao DAQ Signal Accessory

• Interface GPIB

• NI Instrument Simulator, fonte de alimentação, cabo GPIB para
conectar a interface GPIB ao NI Instrument Simulator e cabo serial
para conectar o computador ao NI Instrument Simulator

• Fios, dois por estação

2. Copie os arquivos dos discos que são fornecidos com este manual,
conforme descrito na Seção C, Instalando o software do curso, do
Guia do usuário, e no arquivo readme.txt dos discos.

3. Teste a estação iniciando o LabVIEW, selecionando Start»Programs»
Station Tests»LV Station Test para executar o VI LV Station Test.
Consulte o coordenador de recursos de treinamento de cliente para
este VI.

4. Abra o Measurement & Automation Explorer para verificar se o
dispositivo DAQ e a interface GPIB estão funcionando de forma
adequada.

5. Verifique se o driver de instrumento NI DEVSIM está instalado
e se o NI Instrument Simulator funciona nos modos GPIB e serial.
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Notas
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National Instruments encoraja o preenchimento de nosso formulário de avaliação, fornecido com nossos produtos.
Estas informações nos ajudam a oferecer produtos de qualidade que atendam as suas necessidades.

Título: Manual de treinamento do LabVIEW Básico I

Data da Edição: novembro de 2001

Part Number: 322682A-01

Por favor dê sua opinião a respeito do conteúdo, organização e clareza das informações apresentadas neste manual.

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

Se você encontrou erros neste manual, por favor indique abaixo o número da página e uma descrição do erro.

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

____________________________________________________________________________________________

Data em que o manual foi comprado (mês/ano): _____________________________________________________

Obrigado pela sua ajuda.

Nome _______________________________________________________________________________________

Cargo _______________________________________________________________________________________
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____________________________________________________________________________________________
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Telefone ( ___ )____________________________________ Fax ( ___ ) _________________________________

Endereço para Correspondência Envie um Fax para:
Customer Education Customer Education
National Instruments Corporation National Instruments Corporation
11500 North Mopac Expressway 512 683 6837
Austin, Texas 78759-3504





Avaliação do Curso
Curso ________________________________________________________________________________________

Local ________________________________________________________________________________________

Instrutor __________________________________________ Date ____________________________________

Informações do Estudante (opcional)
Nome ________________________________________________________________________________________

Compania ________________________________________ Telefone _________________________________

Instrutor
Por favor avaliar o instrutor assinalando o círculo apropriado. Péssimo Ruim Regular Bom Excelente

Habilidade do Instrutor em passar os conceitos do curso ❍ ❍ ❍ ❍ ❍

Conhecimento do Instrutor sobre o assunto ❍ ❍ ❍ ❍ ❍

Habilidade de apresentação do Instrutor ❍ ❍ ❍ ❍ ❍

Sensibilidade do instrutor às necessidades da turma ❍ ❍ ❍ ❍ ❍

Preparação do Instrutor para o curso ❍ ❍ ❍ ❍ ❍

Curso
Qualidade do Centro de Treinamento ❍ ❍ ❍ ❍ ❍

Qualidade do Equipamento de Treinamento ❍ ❍ ❍ ❍ ❍

A configuração do hardware estava correta? ❍ Sim ❍ Não

A duração do Curso foi ❍ Muito longa ❍ Exata ❍ Muito curta

O nível de detalhes nos tópicos abordados foi ❍ Muito grande ❍ Exato ❍ Muito pequeno

O material do curso era claro e de fácil compreensão ❍ Sim ❍ Não ❍ As vezes

O Curso atendeu as expectaticas conforme anunciado ? ❍ Sim ❍ Não

Eu possuia as habilidades e conhecimentos necessários à realização deste curso ? ❍ Sim ❍ Não Se não, de

que maneira você poderia estar melhor preparado para o curso ? _________________________________________

_____________________________________________________________________________________________

Quais os pontos fortes do curso ? __________________________________________________________________

_____________________________________________________________________________________________

Que tópicos você gostaria de incluir no curso ? _______________________________________________________

_____________________________________________________________________________________________

Qual parte (s) do curso necessitam ser resumidas ou eliminadas ? ________________________________________

_____________________________________________________________________________________________

O que deve ser adicionado ao curso para torná-lo melhor ? ______________________________________________

_____________________________________________________________________________________________

Que benefícios você teve por participar do curso? ____________________________________________________

_____________________________________________________________________________________________

Existem outras pessoas em sua empresa que necessitam de treinamento ? Favor Listar ________________________

_____________________________________________________________________________________________

_____________________________________________________________________________________________

Você tem outras necessidades de treinamento nas quais possamos ajudá-lo ? ________________________________

_____________________________________________________________________________________________

Como você tomou conhecimento deste Curso? ❍ Página WEB National Instruments ❍ Representante de Vendas

National Instruments ❍ Correio ❍ Colegas de trabalho ❍ Outros __________________________________




